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Using This Online Manual

= Symbols Used in This Document
= Touch-enabled Device Users (Windows)

Symbols Used in This Document

A\ Warning
Instructions that, if ignored, could result in death or serious personal injury caused by incorrect
operation of the equipment. These must be observed for safe operation.

/A Caution
Instructions that, if ignored, could result in personal injury or material damage caused by incorrect
operation of the equipment. These must be observed for safe operation.

32 Important
Instructions including important information. To avoid damage and injury or improper use of the
product, be sure to read these indications.

»>» Note

Instructions including notes for operation and additional explanations.

Instructions explaining basic operations of your product.

»>» Note

* |cons may vary depending on your product.

Touch-enabled Device Users (Windows)

For touch actions, you need to replace "right-click" in this document with the action set on the operating
system. For example, if the action is set to "press and hold" on your operating system, replace "right-click"
with "press and hold."
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Trademarks and Licenses

» Microsoft is a registered trademark of Microsoft Corporation.

» Windows is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other
countries.

» Windows Vista is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other
countries.

* Internet Explorer is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or
other countries.

* Mac, Mac OS, AirPort, Safari, Bonjour, iPad, iPhone and iPod touch are trademarks of Apple Inc.,
registered in the U.S. and other countries. App Store, AirPrint and the AirPrint logo are trademarks of
Apple Inc.

* 10S is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under
license.

» Google Cloud Print, Google Chrome, Chrome OS, Chromebook, Android, Google Play and Picasa are
either registered trademarks or trademarks of Google Inc.

» Adobe, Flash, Photoshop, Photoshop Elements, Lightroom, Adobe RGB and Adobe RGB (1998) are
either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or
other countries.

* Bluetooth is a trademark of Bluetooth SIG, Inc., U.S.A. and licensed to Canon Inc.

»>» Note

» The formal name of Windows Vista is Microsoft Windows Vista operating system.

Copyright (c) 2003-2004, Apple Computer, Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of Apple Computer, Inc. ("Apple") nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS 1S" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

Apache License
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Version 2.0, January 2004

http://www.apache.org/licenses/
TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by
Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting
the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled
by, or are under common control with that entity. For the purposes of this definition, "control" means
(i) the power, direct or indirect, to cause the direction or management of such entity, whether by
contract or otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii)
beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this
License.

"Source" form shall mean the preferred form for making modifications, including but not limited to
software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source
form, including but not limited to compiled object code, generated documentation, and conversions to
other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under
the License, as indicated by a copyright notice that is included in or attached to the work (an example
is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or
derived from) the Work and for which the editorial revisions, annotations, elaborations, or other
modifications represent, as a whole, an original work of authorship. For the purposes of this License,
Derivative Works shall not include works that remain separable from, or merely link (or bind by name)
to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any
modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to
Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity
authorized to submit on behalf of the copyright owner. For the purposes of this definition, "submitted"
means any form of electronic, verbal, or written communication sent to the Licensor or its
representatives, including but not limited to communication on electronic mailing lists, source code
control systems, and issue tracking systems that are managed by, or on behalf of, the Licensor for the
purpose of discussing and improving the Work, but excluding communication that is conspicuously
marked or otherwise designated in writing by the copyright owner as "Not a Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution
has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable
copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform,
sublicense, and distribute the Work and such Derivative Works in Source or Object form.
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3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as
stated in this section) patent license to make, have made, use, offer to sell, sell, import, and otherwise
transfer the Work, where such license applies only to those patent claims licensable by such
Contributor that are necessarily infringed by their Contribution(s) alone or by combination of their
Contribution(s) with the Work to which such Contribution(s) was submitted. If You institute patent
litigation against any entity (including a cross-claim or counterclaim in a lawsuit) alleging that the
Work or a Contribution incorporated within the Work constitutes direct or contributory patent
infringement, then any patent licenses granted to You under this License for that Work shall terminate
as of the date such litigation is filed.

4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in
any medium, with or without modifications, and in Source or Object form, provided that You meet the
following conditions:

1. You must give any other recipients of the Work or Derivative Works a copy of this License; and

2. You must cause any modified files to carry prominent notices stating that You changed the files;
and

3. You must retain, in the Source form of any Derivative Works that You distribute, all copyright,
patent, trademark, and attribution notices from the Source form of the Work, excluding those
notices that do not pertain to any part of the Derivative Works; and

4. If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that
You distribute must include a readable copy of the attribution notices contained within such
NOTICE file, excluding those notices that do not pertain to any part of the Derivative Works, in at
least one of the following places: within a NOTICE text file distributed as part of the Derivative
Works; within the Source form or documentation, if provided along with the Derivative Works; or,
within a display generated by the Derivative Works, if and wherever such third-party notices
normally appear. The contents of the NOTICE file are for informational purposes only and do not
modify the License. You may add Your own attribution notices within Derivative Works that You
distribute, alongside or as an addendum to the NOTICE text from the Work, provided that such
additional attribution notices cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or
different license terms and conditions for use, reproduction, or distribution of Your modifications,
or for any such Derivative Works as a whole, provided Your use, reproduction, and distribution of
the Work otherwise complies with the conditions stated in this License.

5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally
submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions of
this License, without any additional terms or conditions. Notwithstanding the above, nothing herein
shall supersede or modify the terms of any separate license agreement you may have executed with
Licensor regarding such Contributions.

6. Trademarks. This License does not grant permission to use the trade names, trademarks, service
marks, or product names of the Licensor, except as required for reasonable and customary use in
describing the origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides
the Work (and each Contributor provides its Contributions) on an "AS I1S" BASIS, WITHOUT
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without
limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or
FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the
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appropriateness of using or redistributing the Work and assume any risks associated with Your
exercise of permissions under this License.

8. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence),
contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent
acts) or agreed to in writing, shall any Contributor be liable to You for damages, including any direct,
indirect, special, incidental, or consequential damages of any character arising as a result of this
License or out of the use or inability to use the Work (including but not limited to damages for loss of
goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages
or losses), even if such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works thereof,
You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or other
liability obligations and/or rights consistent with this License. However, in accepting such obligations,
You may act only on Your own behalf and on Your sole responsibility, not on behalf of any other
Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for any
liability incurred by, or claims asserted against, such Contributor by reason of your accepting any
such warranty or additional liability.

END OF TERMS AND CONDITIONS

---- Part 1: CMU/UCD copyright notice: (BSD like) -----

Copyright 1989, 1991, 1992 by Carnegie Mellon University

Derivative Work - 1996, 1998-2000

Copyright 1996, 1998-2000 The Regents of the University of California
All Rights Reserved

Permission to use, copy, modify and distribute this software and its documentation for any purpose and
without fee is hereby granted, provided that the above copyright notice appears in all copies and that both
that copyright notice and this permission notice appear in supporting documentation, and that the name of
CMU and The Regents of the University of California not be used in advertising or publicity pertaining to
distribution of the software without specific written permission.

CMU AND THE REGENTS OF THE UNIVERSITY OF CALIFORNIA DISCLAIM ALL WARRANTIES
WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL CMU OR THE REGENTS OF THE
UNIVERSITY OF CALIFORNIA BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL
DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM THE LOSS OF USE, DATA OR
PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION,
ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

---- Part 2: Networks Associates Technology, Inc copyright notice (BSD) -----
Copyright (c) 2001-2003, Networks Associates Technology, Inc
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
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* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the Networks Associates Technology, Inc nor the names of its contributors may be
used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

--—-- Part 3: Cambridge Broadband Ltd. copyright notice (BSD) -----
Portions of this code are copyright (c) 2001-2003, Cambridge Broadband Ltd.
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* The name of Cambridge Broadband Ltd. may not be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER ""AS I1S" AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

--—-- Part 4: Sun Microsystems, Inc. copyright notice (BSD) -----

Copyright ¢ 2003 Sun Microsystems, Inc., 4150 Network Circle, Santa Clara, California 95054, U.S.A. All
rights reserved.

Use is subject to license terms below.

This distribution may include materials developed by third parties.
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Sun, Sun Microsystems, the Sun logo and Solaris are trademarks or registered trademarks of Sun
Microsystems, Inc. in the U.S. and other countries.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of the Sun Microsystems, Inc. nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 5: Sparta, Inc copyright notice (BSD) -----
Copyright (c) 2003-2009, Sparta, Inc
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Sparta, Inc nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 6: Cisco/BUPTNIC copyright notice (BSD) -----
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Copyright (c) 2004, Cisco, Inc and Information Network Center of Beijing University of Posts and
Telecommunications.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* Neither the name of Cisco, Inc, Beijing University of Posts and Telecommunications, nor the names of
their contributors may be used to endorse or promote products derived from this software without specific
prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 7: Fabasoft R&D Software GmbH & Co KG copyright notice (BSD) -----
Copyright (c) Fabasoft R&D Software GmbH & Co KG, 2003 oss@fabasoft.com
Author: Bernhard Penz

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

* The name of Fabasoft R&D Software GmbH & Co KG or any of its subsidiaries, brand or product names
may not be used to endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER "AS I1S" AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
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IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

The following applies only to products supporting Wi-Fi.
(c) 2009-2013 by Jeff Mott. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions, and the
following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions, and the
following disclaimer in the documentation or other materials provided with the distribution.

* Neither the name CryptoJS nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS,"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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Enter keywords in the search window and click E (Search).

You can search for target pages in this guide.

Entry example: "(your product's model name) load paper"

Search Tips

You can search for target pages by entering keywords in the search window.

Canon

Contents | > MNotes on Site Usage and Cookies

Online Manual

- series -

E Satug | E Change Preduct

&) Featured Topics

32 Important

+ This function may not be available in some countries/regions.

»» Note

The displayed screen may vary.
When searching from this page without entering your product's model name or your application's name,
all products supported by this guide will be considered for the search.

If you want to narrow down the search results, add your product's model name or your application's
name to the keywords.

Searching for Functions

Enter your product's model name and a keyword for the function you want to learn about
Example: When you want to learn how to load paper

Enter "(your product's model name) load paper" in the search window and perform a search
Troubleshooting Errors

Enter your product's model name and a support code

Example: When the following error screen appears
Enter "(your product's model name) 1003" in the search window and perform a search
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Media Type : Flain Faper
Page Size - Letter 857017 Zacdiem

Start

»>» Note

» The displayed screen varies depending on your product.

» Searching for Application Functions
Enter your application's name and a keyword for the function you want to learn about
Example: When you want to learn how to print collages with My Image Garden
Enter "My Image Garden collage" in the search window and perform a search

» Searching for Reference Pages

Enter your model name and a reference page title*
* You can find reference pages more easily by entering the function name as well.

Example: When you want to browse the page referred to by the following sentence on a scanning
procedure page

Refer to "Color Settings Tab" for your model from Home of the Online Manual for details.

Enter "(your product's model name) scan Color Settings Tab" in the search window and perform a
search
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Using the Machine
» Printing Photos from a Computer

» Copying Originals
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Printing Photos from a Computer

This section describes how to print photos with My Image Garden.

This section uses windows displayed when the Windows 8.1 operating system (hereinafter referred to as

Windows 8.1) is used.
1. Open the paper support (A).

2. Pull out the paper output tray (B), then open the output tray extension (C).

3. Load paper vertically WITH THE PRINT SIDE FACING YOU.

4. Align the paper guides (D) with the paper width.

5. Click the My Image Garden icon (E) in Quick Menu.
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The Guide Menu screen is displayed.

HaD3d6 0

> Note

* The number and types of icons displayed vary depending on your region, the registered printer/
scanner and the installed applications.

6. Click the Photo Print icon (F).

7. Click the folder (G) with photos you want to print.

8. Click the photos (H) you want to print.

For Windows:

To select two or more photos at a time, click photos while pressing the Ctrl key.

For Mac OS:

To select two or more photos at a time, click photos while pressing the command key.

9. Click Print (1).
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10. Specify the number of copies, your machine name, media type, etc. (J).

11. Click Print (K).

For Mac OS:

Click OK when the confirmation message appears, then click Print.

»» Note

* My Image Garden lets you use images on your computer, such as photos taken with a digital camera, in
a number of ways.

= My Image Garden Guide (Windows)
= My Image Garden Guide (Mac OS)
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Copying Originals

This section describes how to load originals and copy them to plain paper.
1. Open the paper support (A).

2. Pull out the paper output tray (B), then open the output tray extension (C).

3. Load paper vertically WITH THE PRINT SIDE FACING YOU.

4. Align the paper guides (D) with the paper width.

5. Open the document cover (E).
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6. Load the original WITH THE SIDE TO COPY FACING DOWN and align it with the
alignment mark (F).

F E

7. Close the document cover gently.

8. Press the Black button or Color button (G).

22 Important

* Do not open the document cover until copying is complete.

»>» Note

 For details on copy features, refer to Copying.
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Printer Functions
» Print Photos Easily Using My Image Garden
» Easy Scan with the Auto Function
» Scan Originals Larger than the Platen
» Scan Multiple Originals at One Time

» Online Storage Integration Function
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Print Photos Easily Using My Image Garden

Organize Images Easily

In My Image Garden, you can register the names of people and events to photos.
You can organize photos easily as you can display them not only by folder but also by calendar, event,
and person. This also allows you to find the target photos easily when you search for them later on.

<Calendar View>

Display Recommended Items in Slide Shows

Based on the information registered to photos, Quick Menu automatically selects the photos on your
computer and creates recommended items such as collages and cards. The created items appear in slide
shows.

If there is an item you like, you can easily print it in just two steps.

1. In Image Display of Quick Menu, select the item you want to print.
2. Print the item with My Image Garden.
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Place Photos Automatically

Delightful items are created easily as the selected photos are placed automatically according to the
theme.

Other Various Functions

My Image Garden has many other useful functions.
Refer to the following for details.

= \What You Can Do with My Image Garden (Windows)
= \What You Can Do with My Image Garden (Mac OS)
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Easy Scan with the Auto Function

By using the auto function of IJ Scan Utility, you can scan easily by automatically detecting the item type.
Refer to the following for details.

= Easy Scanning with Auto Scan (Windows)

= Easy Scanning with Auto Scan (Mac OS)
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Scan Originals Larger than the Platen

By using the stitch function of IJ Scan Utility, you can scan the left and right halves of an item larger than the
platen and combine them back into one image. Items up to approximately twice as large as the platen are
supported.

Refer to the following for details.

= Scanning Originals Larger than the Platen (Image Stitch) (Windows)
= Scanning Originals Larger than the Platen (Image Stitch) (Mac OS)
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Scan Multiple Originals at One Time

By using IJ Scan Ultility, you can scan two or more photos (small items) placed on the platen at one time and
save each image individually.

Refer to the following for details.

= Scanning Multiple Originals at One Time (Windows)
= Scanning Multiple Originals at One Time (Mac OS)
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Online Storage Integration Function

The printer can integrate with online storage services such as Evernote.

Integration with Online Notetaking Service [%3 "Evernote"

If an Evernote client application is installed on your computer, you can import scanned images into the
application and upload them to the Evernote server.

The uploaded images can be browsed from other computers, smartphones, etc.

To use Evernote, you need to create an account. See the "CREATE ACCOUNT" page of Evernote for
account creation.

Settings

For Windows:

In the Settings Dialog Box of IJ Scan Utility, select the item you want to set, then select Evernote for
Send to an application in Application Settings.

Refer to "Settings Dialog Box" for your model from Home of the Online Manual for details.

For Mac OS:

In the Settings Dialog of IJ Scan Ultility, select the item you want to set, then select Evernote for Send
to an application in Application Settings.

Refer to "Settings Dialog" for your model from Home of the Online Manual for details.

22 Important

» The Evernote service features are subject to change or termination without prior notice.
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Handling Paper, Originals, Ink Tanks, etc.
» Loading Paper
@« Loading Plain Paper / Photo Paper
@« Loading Envelopes
» Loading Originals
@« Loading Originals on the Platen Glass
@ Originals You Can Load
» Refilling Ink Tanks
@ REéfilling Ink Tanks

@« Checking Ink Status
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Loading Paper
» Loading Plain Paper / Photo Paper

» Loading Envelopes
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Loading Plain Paper / Photo Paper
You can load plain paper or photo paper.

3% Important

« If you cut plain paper into small size such as 4" x 6" (10 x 15 cm), 5" x 7" (13 x 18 cm), Square 5" x 5"
(13 x 13 cm), or Card 2.17" x 3.58" (55 x 91 mm) to perform trial print, it can cause paper jams.

»» Note

* We recommend Canon genuine photo paper for printing photos.

For details on the Canon genuine paper, see Media Types You Can Use.

* You can use general copy paper or Canon Red Label Superior WOP111/Canon Océ Office Colour
Paper SAT213.

For the page size and paper weight you can use for this machine, see Media Types You Can Use.

1. Prepare paper.

Align the edges of paper. If paper is curled, flatten it.

»» Note

+ Align the edges of paper neatly before loading. Loading paper without aligning the edges may
cause paper jams.

* If paper is curled, hold the curled corners and gently bend them in the opposite direction until the
paper becomes completely flat.

For details on how to flatten curled paper, see "Correct curl before loading paper." in Paper Is
Smudged / Printed Surface Is Scratched.

» When using Photo Paper Plus Semi-gloss SG-201, even if the sheet is curled, load one sheet at a

time as it is. If you roll up this paper to flatten, this may cause cracks on the surface of the paper
and reduce the print quality.

2. Open the paper support (A).

3. Pull out the paper output tray (B) and open the output tray extension (C).
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4. Slide the paper guides (D) to open them, and load the paper in the center of the rear tray
WITH THE PRINT SIDE FACING YOU.

5. Slide the paper guides (D) to align them with both sides of the paper stack.

Do not slide the paper guides too hard against the paper. The paper may not be fed properly.

~

J'rx_ih“‘“;

2» Important

» Always load paper in the portrait orientation (E). Loading paper in the landscape orientation (F)
can cause paper jams.
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»» Note

* Do not load sheets of paper higher than the load limit mark (G).

»» Note

» When printing, select the size and type of the loaded paper on the print settings screen of the printer
driver.
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Loading Envelopes

You can load Envelope DL and Envelope Com 10.

The address is automatically rotated and printed according to the envelope's direction by specifying with the

printer driver properly.

32 Important

* Printing of envelopes from the operation panel is not supported.
» Do not use the following envelopes. They could jam in the machine or cause the machine to

malfunction.

» Envelopes with an embossed or treated surface

» Envelopes with a double flap
» Envelopes whose gummed flaps are already moistened and adhesive

1. Prepare envelopes.

* Press down on all four corners and edges of the envelopes to flatten them.

« If the envelopes are curled, hold the opposite corners and gently twist them in the opposite

direction.

« If the corner of the envelope flap is folded, flatten it.
» Use a pen to press the leading edge in the inserting direction flat and sharpen the crease.

The figures above show a side view of the leading edge of the envelope.

2% Important

» The envelopes may jam in the machine if they are not flat or the edges are not aligned. Make sure
that no curl or puff exceeds 0.1 inch (3 mm).

2. Open the paper support (A).

3. Pull out the paper output tray (B) and open the output tray extension (C).
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4. Slide the paper guides (D) to open them, and load the envelopes in the center of the rear
tray WITH THE ADDRESS SIDE FACING YOU.

The folded flap of the envelope will be faced down on the left side.

Up to 10 envelopes can be loaded at a time.

5. Slide the paper guides (D) to align them with both sides of envelopes.

Do not slide the paper guides too hard against the envelopes. The envelopes may not be fed properly.

~
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E: Rear side

F: Address side
2> Note

* Do not load envelopes higher than the load limit mark (G).

»» Note

» When printing, select the size and type of the loaded envelopes on the print settings screen of the
printer driver.
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Loading Originals
» Loading Originals on the Platen Glass

» Originals You Can Load
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Loading Originals on the Platen Glass
1. Open the document cover.

2. Load the original WITH THE SIDE TO SCAN FACING DOWN on the platen glass.

= QOriginals You Can Load

Align the corner of the original with the alignment mark IS )

2% Important

» Be sure to observe the following when loading the original on the platen glass.

* Do not place any objects weighing 4.4 Ib (2.0 kg) or more on the platen glass.
» Do not put any pressure of 4.4 Ib (2.0 kg) or more on the platen glass, such as pressing down
the original.

Failure to observe the above may cause the scanner to malfunction or the platen glass to break.

* The machine cannot scan the shaded area (A) (0.04 inch (1 mm) from the edges of the platen
glass).

3. Close the document cover gently.
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22 Important

+ After loading the original on the platen glass, be sure to close the document cover before starting to
copy or scan.

46



Originals You Can Load

Item

Details

Types of originals

- Text document, magazine, newspaper

- Printed photo, postcard, business card, disc (BD/DVD/CD, etc.)

Size (width x height)

Max. 8.5 x 11.7 inches (216 x 297 mm)
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Refilling Ink Tanks
» Refilling Ink Tanks

» Checking Ink Status
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Refilling Ink Tanks

Check the remaining ink level with the ink tank indicator on the front of the machine. If the ink level is near
the lower limit line (A), refill the ink tank.

»» Note

« If the function for notifying the remaining ink level (remaining ink level notification function) is enabled,
the Ink lamp and the Alarm lamp inform you of the error when a remaining ink error occurs. Check the
Ink lamp and the Alarm lamp statuses and take appropriate action.

= An Error Occurs
For details on the remaining ink level notification function, see below.

= Changing the remaining ink level notification setting (Windows)
= Changing the remaining ink level notification setting (Mac OS)

« If print results become faint or white streaks appear despite sufficient ink levels, see Maintenance
Procedure.
» For precautionary notes on handling ink bottles, see Notes on ink bottles.

Refilling Procedure
When you need to refill an ink tank, follow the steps below.

2% Important

» Please ensure the printer remains flat after initial setup and is NOT turned upside down or on its side,
as ink in the printer may leak.

« If the remaining ink level notification function is enabled, refill all four ink tanks until full. If the
remaining ink level counter is reset when the ink tanks are not full, the machine cannot detect the ink
level correctly.

1. Make sure the machine is on.

2. Open the scanning unit / cover (B) all the way until it stops.
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32 Important

+ Do not place any object on the document cover. It will fall into the rear tray when the scanning
unit / cover is opened and cause the machine to malfunction.
» Do not touch tubes or other parts inside the machine.

3. Open ink tank cover.

To refill the black ink tank, open the left ink tank cover (C).

To refill color ink tanks, open the right ink tank cover (D).

4. Grab and remove the tank cap (E) of the ink tank to be refilled.

Place the removed tank cap on the upper tank cap holder (F).
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22 Important

+ Carefully remove the tank cap of the ink tank. Ink on the inside of the tank cap may spatter
when removing it.

5. Take a new ink bottle out of its package.




32 Important

» When removing the bottle cap, avoid squeezing the sides of the ink bottle. Hold the ink bottle as
shown in the figure above. If you push the sides of the ink bottle, ink will spatter.

» Do not shake the ink bottle. Ink may spatter when opening the cap.

» Even if the ink bottle is dented, the ink contained in the bottle can still be used without problem.

7. Reéfill the ink tank.

Aligning the nozzle of the ink bottle with the bottle guide (H) on the machine, insert the nozzle into the
inlet (1).

Next stand the ink bottle upside down and squeeze the sides of the ink bottle to refill the ink tank.

32 Important

» Make sure that each color of ink tanks is filled with corresponding color of ink bottles.

» When refilling ink tanks, do not squeeze the bottle sides too hard. Ink may spatter.

» Do not fill the ink tank above the ink tank's upper limit line (J). Ink above this line may spill over,
causing malfunction or damage to the machine, and preventing the printing operation.

» Discard empty ink bottles in compliance with local laws and regulations regarding disposal of
consumables.

8. Recap the inlet with the tank cap (E) of the ink tank.

Make sure the tank cap is completely inserted.
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»» Note

* When inserting the tank cap, be careful not to twist the tank cap rubber.

9. Close the ink tank cover.

3% Important

« If you cannot properly close the ink tank cover, check if you forgot to insert any tank caps of the
ink tanks. If the tank cap is left on the tank cap holder, the ink tank cover cannot be closed.

10. Lift the scanning unit / cover once, and then close it gently.

»» Note

« If the remaining ink level notification function is enabled, the Ink lamp and the Alarm lamp are
lit when ink runs out. This setting is enabled by default.
« If the lamps are lit, perform the following.

+ To continue enabling the remaining ink level notification function

Hold down the Black button or the Color button for at least 5 seconds. The Alarm lamp goes
off and the remaining ink level counter is reset.

+ To disable the remaining ink level notification function
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Press down and immediately release the Black button or the Color button. The Alarm lamp
goes off and the remaining ink level notification function is disabled.

* You can also set the remaining ink level notification function or reset the remaining ink level
counter from your computer.

= Changing the remaining ink level notification setting (Windows)
= Changing the remaining ink level notification setting (Mac OS)

32 Important

« If the remaining ink level notification function is disabled, check remaining ink levels and refill the ink
tanks as necessary. Continuing printing with ink below the lower limit line of an ink tank may prevent
satisfactory print quality or may cause malfunction or damage to the machine.

»>» Note

« |f the Alarm lamp flashes, take appropriate action.
= An Error Occurs

* The machine may make noise during operation.

Notes on ink bottles
22 Important

» Keep out of reach of children.

* Do not drink ink.

» Be careful not to get any ink in your eyes or in your mouth. (In case of eye contact or swallowing,
rinse with water and contact a doctor immediately).

* When you store ink bottles, close bottle caps completely and place bottles in standing position. If the
ink bottles are laid down, ink may leak.

* When refilling ink tanks, take sufficient care to prevent ink from spattering onto surroundings.

* Ink may stain clothes or other belongings permanently. Washing may not remove ink stains.

» Do not use ink bottles and ink contained therein except to refill tanks of printers specified by Canon.

» Do not leave ink bottles in areas exposed to high temperature, such as near fire or a heater or in a
car. Bottles may warp and cause ink leakage or ink may become poor quality.

» Do not subject ink bottles to impacts. Ink bottles may be damaged or bottle caps may come off by
such impact, and ink may leak.

» Do not transfer ink to other containers. This may result in accidental ingestion, inappropriate use, or
poor ink quality.

* Do not mix ink with water or other ink. This may damage the printer.

* Refill ink tanks quickly. Do not leave ink tanks with cap off.

» Once an ink bottle has been opened, do not leave it with bottle cap off. Ink will dry out, possibly
preventing proper operation of the machine when an ink tank is refilled using this bottle.

»>» Note

» Color ink may be consumed even when printing a black-and-white document or when black-and-
white printing is specified. Every ink is also consumed in the standard cleaning and deep cleaning of
the print head, which may be necessary to maintain the performance of the machine.
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When an ink tank is out of ink, promptly refill it.

= |nk Tips
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Checking Ink Status

Check ink status with the ink tank indicator on the front of the machine.
When ink reaches the upper limit line (A), ink is full.

When ink is near the lower limit line (B), ink is running low. Refill the ink tank.

»>» Note

» To check the remaining ink level, visually inspect the remaining ink in the ink tank.

32 Important

« If printing is continued when the remaining ink level is below the lower limit line, the printer may
consume a certain amount of ink to return to printable status and may also become damaged.

»>» Note

» This machine has a function for notifying the remaining ink level, called the remaining ink level
notification function. When the remaining ink level notification function is enabled, refill all ink tanks until
ink reaches the upper limit line (A). If ink does not reach the upper limit line, the remaining ink level is
not detected correctly.

= Changing the remaining ink level notification setting (Windows)
= Changing the remaining ink level notification setting (Mac OS)

+ If a remaining ink error occurs, the Ink lamp and the Alarm lamp will flash to inform you of the error.
Count the number of flashes of the Ink lamp and take appropriate action.

= An Error Occurs

» The remaining ink level natification function works from initial printing to the time when one of the inks
reaches the lower limit line shown on the ink tank. For the remaining ink level notification function to
work appropriately, each ink tank must be filled with entire contents of the corresponding color ink bottle
bundled with the printer before printing. After the initial filling, if either of the ink tanks is refilled before
the remaining ink level reaches the lower limit line, a significant error may occur in the accuracy of the
remaining ink level notification function. If you want to refill an ink tank before the remaining ink level
reaches the lower limit line, be sure to follow the procedure in the manual.

» To ensure you receive premium print quality and to help protect your print head, a certain amount of ink
remains in the ink tank when the printer indicates to refill the ink tank. The estimated page yields of the
ink bottle do not include this amount.

If the remaining ink level notification function is enabled

You can check if ink has run out with the Ink lamp.
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C: Alarm lamp

D: Ink lamp

Ink lamp lights and Alarm lamp lights:
Color ink and/or black ink has run out.

Refill ink tanks with ink.
»» Note

» For details on the remaining ink level notification function, see below.

= Changing the remaining ink level notification setting (Windows)
= Changing the remaining ink level notification setting (Mac OS)
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Maintenance

Y

If Printing Is Faint or Uneven

Y

Performing Maintenance Functions from Your Computer (Windows)

Y

Performing Maintenance Functions from Your Computer (Mac OS)

Y

Cleaning
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If Printing Is Faint or Uneven

» Maintenance Procedure

¥

Printing the Nozzle Check Pattern

¥

Examining the Nozzle Check Pattern

¥

Cleaning the Print Head

¥

Cleaning the Print Head Deeply

¥

Aligning the Print Head
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Maintenance Procedure

If print results are blurred, colors are not printed correctly, or print results are unsatisfactory (e.g. misaligned
printed ruled lines), perform the maintenance procedure below.

22 Important

» Do not rinse or wipe the print head. This can cause cartridge problems.

»» Note

» Check the remaining ink level.
If the ink level is low, take appropriate action.

= Checking Ink Status

+ If the Alarm lamp is on or flashing, see An Error Occurs.
* Increasing the print quality in the printer driver settings may improve the print result.

= Changing the Print Quality and Correcting Image Data (Windows)
= Changing the Print Quality and Correcting Image Data (Mac OS)

When the Print Results Are Blurred or Uneven:

Print the nozzle check pattern.

From the machine

= Printing the Nozzle Check Pattern

From the computer

= Printing a Nozzle Check Pattern (Windows)
= Printing a Nozzle Check Pattern (Mac OS)

Examine the nozzle check pattern.

If there are missing lines or horizontal white streaks in the pattern:
| Step3 | Clean the print head.

From the machine

= Cleaning the Print Head

From the computer

= Cleaning the Print Heads (Windows)
= Cleaning the Print Heads (Mac OS)

After cleaning the print head, print and examine the nozzle check pattern: s Step1

If the problem is not resolved after performing from step 1 to step 3 twice:

"v"
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Clean the print head deeply.

From the machine

= Cleaning the Print Head Deeply

From the computer

= Cleaning the Print Heads (Windows)
= Cleaning the Print Heads (Mac OS)

> Note

« If problem is not resolved after performing print head deep cleaning, perform system cleaning from a
computer.

= Cleaning the Print Heads (Windows)
= Cleaning the Print Heads (Mac OS)

If the problem is still not resolved, the print head may be damaged. Contact the service center.

When the Print Results Are Not Even such as the Ruled Lines Are
Misaligned:

Align the print head.

From the machine

= Aligning the Print Head

From the computer

= Aligning the Print Head Position Automatically (Windows)
= Aligning the Print Head Position Automatically (Mac OS)
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Printing the Nozzle Check Pattern

Print the nozzle check pattern to determine whether the ink ejects properly from the print head nozzle.

»» Note

+ If the remaining ink level is low, the nozzle check pattern will not be printed correctly. Refill any ink tanks
that are low.

You need to prepare: a single sheet of A4 or Letter-sized plain paper

1. Make sure that the power is turned on.
2. Load a single sheet of A4 or Letter-sized plain paper in the rear tray.
3. Pull out the paper output tray, then open the output tray extension.

4. Hold down the Stop button until the Alarm lamp flashes once, then release it immediately.
The nozzle check pattern will be printed.

Do not perform any other operations until the machine completes the printing of the nozzle check
pattern.

5. Examine the nozzle check pattern.
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Examining the Nozzle Check Pattern

Examine the nozzle check pattern, and clean the print head if necessary.

1. Check if there are missing lines in pattern A or horizontal white streaks in pattern B.

o "
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If there are missing lines in pattern A:

Cleaning the print head is required.

SESS =l

c D

C: Good
D: Bad (lines are missing)
If there are horizontal white streaks in pattern B:

Cleaning the print head is required.

E: Good

F: Bad (horizontal white streaks are present)
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Cleaning the Print Head

Clean the print head if lines are missing or if horizontal white streaks are present in the printed nozzle check
pattern. Cleaning unclogs the nozzles and restores the print head condition. Cleaning the print head
consumes ink, so clean the print head only when necessary.

1. Make sure that the power is turned on.

2. Hold down the Stop button until the Alarm lamp flashes twice, then release it immediately.

The machine starts cleaning the print head.
The cleaning will be complete when the ON lamp lights after flashing.

Do not perform any other operations until the machine completes the cleaning of the print head. This
takes about 1 minute.

3. Check the print head condition.

To check the print head condition, print the nozzle check pattern.

»» Note

« If the problem is not resolved after cleaning the print head twice, clean the print head deeply.
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Cleaning the Print Head Deeply

If print quality does not improve by the standard cleaning of the print head, clean the print head deeply.
Cleaning the print head deeply consumes more ink than the standard cleaning of the print head, so clean
the print head deeply only when necessary.

1. Make sure that the power is turned on.

2. Hold down the Stop button until the Alarm lamp flashes three times, then release it
immediately.
The machine starts cleaning the print head deeply.
The cleaning will be complete when the ON lamp lights after flashing.

Do not perform any other operations until the machine completes the deep cleaning of the print head.
This takes about 3 minutes.

3. Check the print head condition.

To check the print head condition, print the nozzle check pattern.
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Aligning the Print Head

If printed ruled lines are misaligned or print results are otherwise unsatisfactory, adjust the print head
position.

»>» Note

+ If the remaining ink level is low, the print head alignment sheet will not be printed correctly.

Refill any ink tanks that are low.

You need to prepare: a single sheet of A4 or Letter-sized plain paper (including recycled paper)*

* Be sure to use paper that is white and clean on both sides.
1. Make sure that the power is turned on.
2. Load a single sheet of A4 or Letter-sized plain paper in the rear tray.
3. Pull out the paper output tray, then open the output tray extension.

4. Hold down the Stop button until the Alarm lamp flashes eight times, then release it
immediately.

The print head alignment sheet will be printed.
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2% Important

» Do not touch any printed part on the print head alignment sheet. If the sheet is stained or wrinkled,
it may not be scanned properly.

« If the print head alignment sheet was not printed correctly, press the Stop button, then redo this
procedure from the beginning.

5. Load the print head alignment sheet on the platen glass.

Load the print head alignment sheet WITH THE PRINTED SIDE FACING DOWN and align the mark 4

on the bottom right corner of the sheet with the alignment mark N

6. Close the document cover gently, then press the Black or Color button.

The machine starts scanning the print head alignment sheet, and the print head position will be adjusted
automatically.

The print head position adjustment will be complete when the ON lamp lights after flashing.

Remove the print head alignment sheet on the platen glass.

2 Important

* Do not open the document cover or move the print head alignment sheet on the platen glass until
adjusting the print head position is complete.

« If adjusting the print head position has failed, the Alarm lamp flashes. Press the Black or Color
button to release the error, then take appropriate action.

= An Error Occurs

»» Note

« If the print results are still not satisfactory after adjusting the print head position as described above,
adjust the print head position manually from the computer.

= Aligning the Print Head Position (Windows)
= Aligning the Print Head Position (Mac OS)

+ To print and check the current head position adjustment values, hold down the Stop button until the
Alarm lamp flashes ten times, then release it immediately.
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Performing Maintenance Functions from Your Computer
(Windows)

» Cleaning the Print Heads

¥

Cleaning the Paper Feed Rollers

¥

Aligning the Print Head

¥

Aligning the Print Head Position Automatically

¥

Aligning the Print Head Position

¥

Printing a Nozzle Check Pattern

¥

Cleaning Inside the Printer
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Cleaning the Print Heads

The print head cleaning and deep cleaning functions allow you to clear up clogged print head nozzle.
Perform print head cleaning if printing is faint or a specific color fails to print, even though there is enough
ink.

If you perform deep cleaning and the condition still does not improve, perform system cleaning.

The procedure for cleaning is as follows:

©

N\

Cleaning

1. Open the printer driver setup window

2. Click Cleaning on the Maintenance tab

When the Print Head Cleaning dialog box opens, select the ink group for which cleaning is to be
performed.
Click Initial Check Items to display the items you need to check before performing cleaning.

3. Execute cleaning

Make sure that the printer is on and then click Execute.

Print head cleaning starts.

4. Complete cleaning

The Nozzle Check dialog box opens after the confirmation message.

5. Check the results

To check whether the print quality has improved, click Print Check Pattern. To cancel the check
process, click Cancel.

If cleaning the head once does not resolve the print head problem, clean it once more.

22 Important

* Cleaning consumes a small amount of ink.
Cleaning the print head frequently will rapidly deplete your printer's ink supply. Consequently, perform
cleaning only when necessary.

Deep Cleaning

Deep Cleaning is more thorough than cleaning. Perform deep cleaning when two Cleaning attempts do
not resolve the print head problem.
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1. Open the printer driver setup window

2. Click Deep Cleaning on the Maintenance tab

When the Deep Cleaning dialog box opens, select the ink group for which deep cleaning is to be
performed.
Click Initial Check Items to display the items you need to check before performing deep cleaning.

3. Execute deep cleaning

Make sure that the printer is on and then click Execute.
Click OK when the confirmation message appears.

Print head deep cleaning starts.

4. Complete deep cleaning

The Nozzle Check dialog box opens after the confirmation message.

5. Check the results

To check whether the print quality has improved, click Print Check Pattern. To cancel the check
process, click Cancel.

32 Important

* Deep Cleaning consumes a larger amount of ink than Cleaning.
Cleaning the print head frequently will rapidly deplete your printer's ink supply. Consequently, perform
cleaning only when necessary.

System Cleaning

Execute System Cleaning if the status does not improve even after Deep Cleaning is performed.

1. Open the printer driver setup window

2. Click System Cleaning on the Maintenance tab

When the System Cleaning dialog box opens, select the ink group for which system cleaning is to be
performed.

Click Initial Check Items to display the items you need to check before performing system cleaning.
Be sure to check the remaining ink level before running System Cleaning.

3. Execute system cleaning

Make sure that the printer is on and then click Execute.
Click OK when the confirmation message appears.

System cleaning starts.
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4. Complete system cleaning

The Nozzle Check dialog box opens after the confirmation message.

5. Check the results

To check whether the print quality has improved, click Print Check Pattern. To cancel the check
process, click Cancel.

32 Important

» System Cleaning consumes an extremely large amount of ink.

Executing system cleaning frequently will rapidly deplete your printer's ink supply. Therefore, execute
system cleaning only when necessary.

+ If System Cleaning is run when the remaining ink level is insufficient, it may cause a failure.

»>» Note

+ If there is no sign of improvement after System Cleaning, turn off the printer, wait 24 hours, and then
perform Deep Cleaning again. If there is still no sign of improvement, the ink may have run out or the
print head may be worn. For details on the remedial action to be taken, see "No Ink Comes Out."

Related Topic

= Printing a Nozzle Check Pattern

71



Cleaning the Paper Feed Rollers

Cleans the paper feed rollers. Perform feed roller cleaning when there are paper particles sticking to the
paper feed rollers and paper is not fed properly.

The procedure for performing the feed roller cleaning is as follows:

Roller Cleaning

1. Prepare the printer

Remove all sheets of paper from the rear tray.

2. Open the printer driver setup window

3. Click Roller Cleaning on the Maintenance tab

The confirmation message appears.

4. Execute paper feed roller cleaning

Make sure that the printer is on and then click OK.
Paper feed roller cleaning starts.

5. Complete paper feed roller cleaning

After the rollers have stopped, follow the instruction in the message, load three sheets of plain paper
into the rear tray, and click OK.

Paper will be ejected and feed roller cleaning will be completed.
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Aligning the Print Head

When you perform head position adjustment, errors in the print head adjustment position are corrected and
conditions such as color and line streaking are improved.

If the print results appear uneven because of line shifts or other conditions, adjust the position of the print
head.

On this printer, you can adjust the print head either automatically or manually.
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Aligning the Print Head Position

Print head alignment corrects the installation positions of the print head and improves deviated colors and

lines.

This printer supports two head alignment methods: automatic head alignment and manual head alignment.

The procedure for performing manual print head alignment is as follows:

. Open the printer driver setup window

Print Head Alignment

Click Custom Settings on the Maintenance tab

The Custom Settings dialog box opens.

Switch head alignment to manual

Check the Align heads manually check box.

Apply the settings

Click OK and when the confirmation message appears, click OK.

Click Print Head Alignment on the Maintenance tab

The Start Print Head Alignment dialog box opens.

Load paper in the printer

Load two sheets of A4 size or Letter size plain paper into the rear tray.

. Execute head alignment

Make sure that the printer is on and click Align Print Head.
Follow the instruction in the message.

32 Important

» Do not open the scanning unit / cover while printing is in progress.

. Check the printed pattern

Enter the numbers of the patterns with the least noticeable streaks or stripes in the associated boxes.
Even if the patterns with the least noticeable streaks or stripes are clicked in the preview window, their
numbers are automatically entered in the associated boxes.
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When you have entered all the necessary values, click OK.

2> Note
« Ifit is difficult to pick the best pattern, pick the setting that produces the least noticeable vertical
streaks.
| |
A
(&) (B)

(A) Least noticeable vertical streaks
(B) Most noticeable vertical streaks

« If it is difficult to pick the best pattern, pick the setting that produces the least noticeable
horizontal stripes.

(A) (B)

(A) Least noticeable horizontal stripes
(B) Most noticeable horizontal stripes

9. Confirm the displayed message and click OK

The second pattern is printed.

32 Important

» Do not open the scanning unit / cover while printing is in progress.

10. Check the printed pattern

Enter the numbers of the patterns with the least noticeable stripes in the associated boxes.
Even if the patterns with the least noticeable stripes are clicked in the preview window, their numbers
are automatically entered in the associated boxes.
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When you have entered all the necessary values, click OK.

> Note

« If it is difficult to pick the best pattern, pick the setting that produces the least noticeable
horizontal stripes.

(A) (B)

(A) Least noticeable horizontal stripes
(B) Most noticeable horizontal stripes

»» Note

+ To print and check the current setting, open the Start Print Head Alignment dialog box, and click
Print Alignment Value.
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Aligning the Print Head Position Automatically

Print head alignment corrects the installation positions of the print head and improves deviated colors and
lines.

This printer supports two head alignment methods: automatic head alignment and manual head alignment.
Normally, the printer is set for automatic head alignment. If the printing results of automatic print head
alignment are not satisfactory, perform manual head alignment.

The procedure for performing automatic print head alignment is as follows:

1. Open the printer driver setup window

Print Head Alignment

2. Click Print Head Alignment on the Maintenance tab

The Start Print Head Alignment dialog box opens.

3. Load paper in the printer

Load one sheet of A4 size or Letter size plain paper into the rear tray.

> Note

* The number of sheets to be used differs when you select the manual head alignment.

4. Print head alignment pattern printing

Make sure that the printer is on and click Align Print Head.
The adjustment pattern is printed.

3% Important

* Do not open the scanning unit / cover while printing is in progress.

5. Adjustment pattern scanning

After the adjustment pattern is printed, a message is displayed.

As instructed in the message, load the adjustment pattern onto the platen, and press the Start button
on the printer.

Print head alignment starts.

»>» Note

» To print and check the current setting, open the Start Print Head Alignment dialog box, and click
Print Alignment Value.
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Printing a Nozzle Check Pattern

The nozzle check function allows you to check whether the print head is working properly by printing a
nozzle check pattern. Print the pattern if printing becomes faint, or if a specific color fails to print.

The procedure for printing a nozzle check pattern is as follows:

Nozzle Check

1. Open the printer driver setup window

2. Click Nozzle Check on the Maintenance tab

The Nozzle Check dialog box opens.
Click Initial Check Items to display the items that you need to check before printing the nozzle check
pattern.

3. Load paper in the printer

Load one sheet of A4 size or Letter size plain paper into the rear tray.

4. Print a nozzle check pattern

Make sure that the printer is on and click Print Check Pattern.
Printing of the nozzle check pattern begins.

Click OK when the confirmation message appears.
The Pattern Check dialog box opens.

5. Check the print result

Check the print result. If the print result is normal, click Exit.

If the print result is smudged or if there are any unprinted sections, click Cleaning to clean the print
head.

Related Topic

= Cleaning the Print Heads
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Cleaning Inside the Printer

Perform bottom plate cleaning before you execute duplex printing to prevent smudges on the back side of
the paper.

Also perform bottom plate cleaning if ink smudges caused by something other than print data appear on the
printed page.

The procedure for performing bottom plate cleaning is as follows:

Bottom Plate Cleaning

1. Open the printer driver setup window

2. Click Bottom Plate Cleaning on the Maintenance tab

The Bottom Plate Cleaning dialog box opens.

3. Load paper in the printer

As instructed in the dialog box, fold the A4 size or Letter size plain paper in half horizontally, and then
unfold the sheet.
Load the paper into the rear tray in the portrait orientation with the crest of the crease facing down.

4. Perform the bottom plate cleaning

Make sure that the printer is on and then click Execute.
Bottom plate cleaning starts.
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Cleaning
» Cleaning the Exterior of the Machine
» Cleaning the Platen Glass and Document Cover
» Cleaning the Paper Feed Roller

» Cleaning the Inside of the Machine (Bottom Plate Cleaning)
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Cleaning the Exterior of the Machine

Be sure to use a soft and dry cloth such as eyeglasses cleaning cloth and wipe off dirt on the surface gently.
Smooth out wrinkles on the cloth if necessary before cleaning.

22 Important

* Be sure to turn off the power and unplug the power cord before cleaning the machine.

» Do not use tissue paper, paper towels, rough-textured cloth, or similar materials for cleaning so as not
to scratch the surface. Paper tissue powder or fine threads may remain inside the machine and cause
problems such as print head blockage and poor printing results.

* Never use volatile liquids such as thinners, benzene, acetone, or any other chemical cleaner to clean
the machine, as this may cause a malfunction or damage the surface of the machine.
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Cleaning the Platen Glass and Document Cover

32 Important

» Be sure to turn off the power and unplug the power cord before cleaning the machine.

» Do not use tissue paper, paper towels, rough-textured cloth, or similar materials for cleaning so as not
to scratch the surface. Paper tissue powder or fine threads may remain inside the machine and cause
problems such as print head blockage and poor printing results.

» Never use volatile liquids such as thinners, benzene, acetone, or any other chemical cleaner to clean
the machine, as this may cause a malfunction or damage the surface of the machine.

Use a soft, clean, lint-free and dry cloth. Wipe the platen glass (A) and the inner side of the document cover
(white sheet) (B) gently. Make sure not to leave any residue, especially on the glass surface.

22 Important

» The inner side of the document cover (white sheet) (B) is easily damaged, so wipe it gently.
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Cleaning the Paper Feed Roller

If the paper feed roller is dirty or paper powder is attached to it, paper may not be fed properly.

In this case, clean the paper feed roller. Cleaning will wear out the paper feed roller, so perform this only
when necessary.

You need to prepare: three sheets of A4 or Letter-sized plain paper
1. Make sure that the power is turned on and remove any paper from the rear tray.

2. Hold down the Stop button until the Alarm lamp flashes eleven times, then release it
immediately.

The paper feed roller will rotate as it is cleaned without paper.

3. Make sure that the paper feed roller has stopped rotating, then load three sheets of A4 or
Letter-sized plain paper in the rear tray.

4. Pull out the paper output tray, then open the output tray extension.

5. Hold down the Stop button until the Alarm lamp flashes eleven times, then release it
immediately.

The machine starts cleaning. The cleaning will be complete when the paper is ejected.

If the problem is not resolved after cleaning the paper feed roller, contact the service center.
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Cleaning the Inside of the Machine (Bottom Plate Cleaning)

Remove stains from the inside of the machine. If the inside of the machine becomes dirty, printed paper may
get dirty, so we recommend performing cleaning regularly.

You need to prepare: a single sheet of A4 or Letter-sized plain paper*

* Be sure to use a new piece of paper.

1. Make sure that the power is turned on and remove any paper from the rear tray.

2. Fold a single sheet of A4 or Letter-sized plain paper in half widthwise, then unfold the
paper.

3. Load only this sheet of paper in the rear tray with the open side facing you.

4. Pull out the paper output tray, then open the output tray extension.

5. Hold down the Stop button until the Alarm lamp flashes twelve times, then release it
immediately.
The paper cleans the inside of the machine as it feeds through the machine.

Check the folded parts of the ejected paper. If they are smudged with ink, perform Bottom Plate Cleaning
again.

> Note

* When performing Bottom Plate Cleaning again, be sure to use a new piece of paper.

If the problem is not resolved after performing cleaning again, the protrusions inside the machine may be
stained. Wipe off any ink from the protrusions using a cotton swab or the like.

32 Important

» Be sure to turn off the power and unplug the power cord before cleaning the machine.
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Safety

» Safety Precautions
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Safety Precautions

Choosing a location

Do not install the printer in a location that is unstable or subject to excessive vibration.

Do not install the printer in locations that are very humid or dusty, in direct sunlight, outdoors, or close
to a heating source.

To avoid the risk of fire or electric shocks, use the printer under the operating environment specified in
the Specification.

Do not place the printer on a thick rug or carpet.

Do not place the printer with its back attached to the wall.

Power supply

Ensure that the area around the power outlet is kept clear at all times so you can easily unplug the
power cord if necessary.

Never remove the plug by pulling on the cord.

Pulling the cord may damage the power cord, leading to possible fire or electrical shock.

Do not use an extension lead/cord.

Working around the printer

Never put your hands or fingers in the printer while it is printing.

When moving the printer, carry the printer at both ends. In case the printer weighs more than 14kg, it
is recommended to have two people lifting the printer. Accidental dropping of the printer may cause
injury. For the printer's weight, refer to the Specification.

Do not place any object on the printer. Especially do not place metal objects (paper clips, staples,
etc.) or containers of flammable solvents (alcohol, thinners, etc.) on top of the printer.

Do not transport or use the printer on a slant, vertically or upside-down, as the ink may leak and
damage the printer.

When loading a thick book on the Platen Glass, do not press hard on the Document Cover. The
Platen Glass may break and cause injury.

Print Heads/ink tanks and FINE Cartridges

Keep ink tanks out of the reach of children. In case ink is accidentally licked or swallowed, rinse out
mouth or give one or two glasses of water to drink. If irritation or discomfort occurs, obtain medical
advice immediately.

In case ink gets in contact with eyes, rinse with water immediately. In case ink gets in contact with
skin, wash with soap and water immediately. If irritation to eyes or skin persists, obtain medical advice
immediately.

Never touch the electrical contacts on a Print Head or FINE Cartridges after printing.

The metal parts may be very hot and could cause burns.

Do not throw ink tanks and FINE Cartridges into fire.

Do not attempt to disassemble or modify the Print Head, ink tanks, and FINE Cartridges.
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Regulatory Information

Users in the U.S.A.

FCC Notice (U.S.A. Only)
For 120V, 60Hz model
Model Number: K10431

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

Note: This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications.

However, there is no guarantee that interference will not occur in a particular installation. If this equipment
does cause harmful interference to radio or television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the interference by one or more of the
following measures:

» Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

» Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

» Consult the dealer or an experienced radio/TV technician for help.

Use of a shielded cable is required to comply with Class B limits in Subpart B of Part 15 of the FCC Rules.

Do not make any changes or modifications to the equipment unless otherwise specified in the manual. If
such changes or modifications should be made, you could be required to stop operation of the equipment.

Canon U.S.A,, Inc.

One Canon Park
Melville, New York 11747
1-800-652-2666

Only for European Union and EEA (Norway, Iceland and Liechtenstein)

h24

This symbol indicates that this product is not to be disposed of with your household waste, according to
the WEEE Directive (2012/19/EU) and national legislation. This product should be handed over to a
designated collection point, e.g., on an authorized one-for-one basis when you buy a new similar product
or to an authorized collection site for recycling waste electrical and electronic equipment (EEE). Improper
handling of this type of waste could have a possible negative impact on the environment and human
health due to potentially hazardous substances that are generally associated with EEE. At the same time,
your cooperation in the correct disposal of this product will contribute to the effective usage of natural
resources. For more information about where you can drop off your waste equipment for recycling, please
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contact your local city office, waste authority, approved WEEE scheme or your household waste disposal
service. For more information regarding return and recycling of WEEE products, please visit www.canon-
europe.com/weee.

Nur fiir Europaische Union und EWR (Norwegen, Island und Liechtenstein)

hid

Dieses Symbol weist darauf hin, dass dieses Produkt gemafR der EU-Richtlinie Gber Elektro- und
Elektronik-Altgerate (2012/19/EU) und nationalen Gesetzen nicht Gber den Hausmdill entsorgt werden
darf. Dieses Produkt muss bei einer dafiir vorgesehenen Sammelstelle abgegeben werden. Dies kann z.
B. durch Rickgabe beim Kauf eines ahnlichen Produkts oder durch Abgabe bei einer autorisierten
Sammelstelle fur die Wiederaufbereitung von Elektro- und Elektronik-Altgeraten geschehen. Der
unsachgemafle Umgang mit Altgeraten kann aufgrund potentiell gefahrlicher Stoffe, die generell mit
Elektro- und Elektronik-Altgeraten in Verbindung stehen, negative Auswirkungen auf die Umwelt und die
menschliche Gesundheit haben. Durch die umweltgerechte Entsorgung dieses Produkts tragen Sie
auflerdem zu einer effektiven Nutzung natirlicher Ressourcen bei. Informationen zu Sammelstellen fir
Altgerate erhalten Sie bei Ihrer Stadtverwaltung, dem 6ffentlich-rechtlichen Entsorgungstrager, einer
autorisierten Stelle fir die Entsorgung von Elektro- und Elektronik-Altgeraten oder Ihrem értlichen
Entsorgungsunternehmen. Weitere Informationen zur Riickgabe und Entsorgung von Elektro- und
Elektronik-Altgeraten finden Sie unter www.canon-europe.com/weee.

Union Européenne, Norvége, Islande et Liechtenstein uniquement.

)= 4

Ce symbole indique que ce produit ne doit pas étre jeté avec les ordures ménagéres, conformément a la
directive DEEE (2012/19/UE) et a la réglementation de votre pays. Ce produit doit &tre confié au
distributeur a chaque fois que vous achetez un produit neuf similaire, ou a un point de collecte mis en
place par les collectivités locales pour le recyclage des Déchets des Equipements Electriques et
Electroniques (DEEE). Le traitement inapproprié de ce type de déchet risque d'avoir des répercussions
sur I'environnement et la santé humaine, du fait de la présence de substances potentiellement
dangereuses généralement associées aux équipements électriques et électroniques. Parallélement, votre
entiere coopération dans le cadre de la mise au rebut correcte de ce produit favorisera une meilleure
utilisation des ressources naturelles. Pour plus d'informations sur les points de collecte des équipements
a recycler, contactez vos services municipaux, les autorités locales compétentes, le plan DEEE approuvé
ou le service d'enlévement des ordures ménagéres. Pour plus d'informations sur le retour et le recyclage
des produits DEEE, consultez le site: www.canon-europe.com/weee.
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Uitsluitend bestemd voor de Europese Unie en EER (Noorwegen, IJsland en
Liechtenstein)

hid

Dit symbool geeft aan dat dit product in overeenstemming met de AEEA-richtlijn (2012/19/EU) en de
nationale wetgeving niet mag worden afgevoerd met het huishoudelijk afval. Dit product moet worden
ingeleverd bij een aangewezen, geautoriseerd inzamelpunt, bijvoorbeeld wanneer u een nieuw
gelijksoortig product aanschaft, of bij een geautoriseerd inzamelpunt voor hergebruik van elektrische en
elektronische apparatuur (EEA). Een onjuiste afvoer van dit type afval kan leiden tot negatieve effecten op
het milieu en de volksgezondheid als gevolg van potentieel gevaarlijke stoffen die veel voorkomen in
elektrische en elektronische apparatuur (EEA). Bovendien werkt u door een juiste afvoer van dit product
mee aan het effectieve gebruik van natuurlijke hulpbronnen. Voor meer informatie over waar u uw
afgedankte apparatuur kunt inleveren voor recycling kunt u contact opnemen met het gemeentehuis in uw
woonplaats, de reinigingsdienst, of het afvalverwerkingsbedrijf. U kunt ook het schema voor de afvoer van
afgedankte elektrische en elektronische apparatuur (AEEA) raadplegen. Ga voor meer informatie over het
inzamelen en recyclen van afgedankte elektrische en elektronische apparatuur naar www.canon-
europe.com/weee.

Sélo para la Unién Europea y el Area Econémica Europea (Noruega,
Islandia y Liechtenstein)

hid

Este simbolo indica que este producto no debe desecharse con los desperdicios domésticos, de acuerdo
con la directiva RAEE (2012/19/UE) y con la legislacion nacional. Este producto debe entregarse en uno
de los puntos de recogida designados, como por ejemplo, entregandolo en el lugar de venta al comprar
un producto similar o depositandolo en un lugar de recogida autorizado para el reciclado de residuos de
aparatos eléctricos y electronicos (RAEE). La manipulacion inapropiada de este tipo de desechos podria
tener un impacto negativo en el entorno y la salud humana, debido a las sustancias potencialmente
peligrosas que normalmente estan asociadas con los RAEE. Al mismo tiempo, su cooperacién a la hora
de desechar correctamente este producto contribuira a la utilizacion eficazde los recursos naturales. Para
mas informacién sobre como puede eliminar el equipo para su reciclado, pdngase en contacto con las
autoridades locales, con las autoridades encargadas de los desechos, con un sistema de gestion RAEE
autorizado o con el servicio de recogida de basuras doméstico. Si desea mas informacién acerca de la
devolucién y reciclado de RAEE, visite la web www.canon-europe.com/weee.

Només per a la Unié Europea i a I’Espai Economic Europeu (Noruega,
Islandia i Liechtenstein)

hid
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Aquest simbol indica que aquest producte no s’ha de llengar a les escombraries de la llar, d’acord amb la
Directiva RAEE (2012/19/UE) i la legislacié nacional. Aquest producte s’hauria de lliurar en un dels punts
de recollida designats, com per exemple, intercanviant-lo un per un en comprar un producte similar o
lliurant-lo en un lloc de recollida autoritzat per al reciclatge de residus d’aparells eléctrics i electronics
(AEE). La manipulacioé inadequada d’aquest tipus de residus podria tenir un impacte negatiu en I'entorn i
en la salut humana, a causa de les substancies potencialment perilloses que normalment estan
associades als AEE. Aixi mateix, la vostra cooperacié a I'hora de llengar correctament aquest producte
contribuira a la utilitzacio efectiva dels recursos naturals. Per a més informacio sobre els punts on podeu
lliurar aquest producte per procedir al seu reciclatge, adreceu-vos a la vostra oficina municipal, a les
autoritats encarregades dels residus, al pla de residus homologat per la RAEE o al servei de recollida de
deixalles domestiques de la vostra localitat. Per a més informacié sobre la devolucié i el reciclatge de
productes RAEE, visiteu www.canon-europe.com/weee.

Solo per Unione Europea e SEE (Norvegia, Islanda e Liechtenstein)

h24

Questo simbolo indica che il prodotto deve essere oggetto di raccolta separata in conformita alla Direttiva
RAEE (2012/19/UE) e alla normativa locale vigente. Il prodotto deve essere smaltito presso un centro di
raccolta differenziata, un distributore autorizzato che applichi il principio delluno contro uno", ovvero del
ritiro della vecchia apparecchiatura elettrica al momento dell'acquisto di una nuova, o un impianto
autorizzato al riciclaggio dei rifiuti di apparecchiature elettriche ed elettroniche. La gestione impropria di
questo tipo di rifiuti pud avere un impatto negativo sull'ambiente e sulla salute umana causato dalle
sostanze potenzialmente pericolose che potrebbero essere contenute nelle apparecchiature elettriche ed
elettroniche. Un corretto smaltimento di tali prodotti contribuira inoltre a un uso efficace delle risorse
naturali ed evitera di incorrere nelle sanzioni amministrative di cui all'art. 255 e successivi del Decreto
Legislativo n. 152/06. Per ulteriori informazioni sullo smaltimento e il recupero dei Rifiuti di
Apparecchiature Elettriche ed Elettroniche, consultare la Direttiva RAEE, rivolgersi alle autorita
competenti, oppure visitare il sito www.canon-europe.com/weee.

Apenas para a Unidao Europeia e AEE (Noruega, Islandia e Liechtenstein)

)= 4

Este simbolo indica que o produto ndo deve ser colocado no lixo doméstico, de acordo com a Directiva
REEE (2012/19/UE) e a legislacao nacional. Este produto devera ser colocado num ponto de recolha
designado, por exemplo, num local préprio autorizado quando adquirir um produto semelhante novo ou
num local de recolha autorizado para reciclar residuos de equipamentos eléctricos e electrénicos (EEE).
O tratamento inadequado deste tipo de residuo podera causar um impacto negativo no ambiente e na
saude humana devido as substancias potencialmente perigosas normalmente associadas aos
equipamentos eléctricos e electronicos. Simultaneamente, a sua cooperagao no tratamento correcto
deste produto contribuira para a utilizagao eficaz dos recursos naturais. Para mais informagdes sobre os
locais onde o equipamento podera ser reciclado, contacte os servigos locais, a autoridade responsavel
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pelos residuos, o esquema REEE aprovado ou o servigo de tratamento de lixo doméstico. Para mais
informacgdes sobre a devolugao e reciclagem de produtos REEE, va a www.canon-europe.com/weee.

Galder kun i Europaiske Union og EGS (Norge, Island og Liechtenstein)

h24

Dette symbol angiver, at det pageeldende produkt ikke ma bortskaffes sammen med dagrenovation jf.
direktivet om affald af elektrisk og elektronisk udstyr (WEEE) (2012/19/EU) og geeldende national
lovgivning. Det pageeldende produkt skal afleveres pa et naermere specificeret indsamlingssted, f.eks. i
overensstemmelse med en godkendt én-til-én-procedure, nar du indkgber et nyt tilsvarende produkt, eller
produktet skal afleveres pa et godkendt indsamlingssted for elektronikaffald. Forkert handtering af denne
type affald kan medfere negative konsekvenser for miljget og menneskers helbred pa grund af de
potentielt sundhedsskadelige stoffer, der generelt kan forefindes i elektrisk og elektronisk udstyr. Nar du
foretager korrekt bortskaffelse af det pagaeldende produkt, bidrager du til effektiv brug af
naturressourcerne. Yderligere oplysninger om, hvor du kan bortskaffe dit elektronikaffald med henblik pa
genanvendelse, far du hos de kommunale renovationsmyndigheder. Yderligere oplysninger om
returnering og genanvendelse af affald af elektrisk og elektronisk udstyr far du ved at besgge www.canon-
europe.com/weee.

Mévo yia Tnv Eupwtraiki ‘Evwon kai Tov EOX (NopBnyia, loAavdia kai
AixtevoTdiv)

)= 4

Autd 10 oUpPBoAo utTodnAwvel &TI auTd TO TTPOIGV OEV TTPETTEI VA ATTOPPITITETAI HAdi Y€ TA OIKIOKA
amoppiyuara, ocuuewva pe Tnv Odnyia oxetikd pe Ta AToRAnTa HAekTpikoU kal HAekTpovikoU EEotTAIGOU
(AHHE) (2012/19/EE) kan TnVv €BvIKN oag vopoBbeaia. Autd To TTpoidv TTPETTEl va TTapadideTal o€
kaBopiouévo anueio aulAoyng, TT.X. o€ pia eEouaiodoTnuévn Baon aviaAlayng otav ayopadeTte £va véo
TTapduolo TTPOoIdV 1) o€ pia gouciodoTnuévn BEan CUANOYAG YIa TV AVOKUKAWGON TwV ATTORARTWY
HAekTpikoU kai HAekTpovikoU E¢otrAiopou (HHE). O akatdAAnAog xeipioudg autou Tou TUTToU aTToBAATWYV
MTTOPED va €xel apvnTIKO avTiKTUTTO OTO TTEPIBAAAOV Kal TNV uyeia Tou avBpwTTou, Adyw duvnTIKWG
ETMKIVOUVWYV OUCIWV TToU YeVIKA ouvdéovTtal e Tov HHE. Tautdxpova, n cuvepyacia gag 6cov agopd T
owaTh atméppiyn auTtol Tou TTPOIGVTOG Ba CUUBAAEI TNV ATTOTEAECUATIKA XPRON TWV QUOIKWY TTOpwvV. MNa
TTEPICOOTEPES TTANPOPOPIEG OXETIKA E T aNUEia OTTOU PTTOPEITE VA ATTOPPIYETE TOV EEOTTAICUO Tag yia
AVOKUKAWGOTN, ETTIKOIVWVAOTE PE TO TOTTIKO YPAQPEIO TNG TTOANG 0AG, TV UTINPECIa aTToppINNATWY, TO
eykekpipgévo oxnua AHHE ) tnv uttnpecia amméppiyng oikiakwy atmmoRAnTwy. MNa TTepIcoOTEPES
TTANPOPOPIEG OXETIKA PE TNV ETTICTPOPI KAI TNV aVAKUKAWON Twv TTpoidovTiwv AHHE, emoke@Beite TNV
ToTT00E0i0 Www.canon-europe.com/weee.
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Gjelder kun den europeiske union og E@S (Norge, Island og Liechtenstein)

hid

Dette symbolet indikerer at dette produktet ikke skal kastes sammen med husholdningsavfall, i henhold til
WEEE-direktiv (2012/19/EU) og nasjonal lov. Produktet ma leveres til et dertil egnet innsamlingspunkt, det
vil si pa en autorisert en-til-en-basis nar du kjgper et nytt lignende produkt, eller til et autorisert
innsamlingssted for resirkulering av avfall fra elektrisk og elektronisk utstyr (EE-utstyr). Feil handtering av
denne typen avfall kan vaere miljg- og helseskadelig pa grunn av potensielt skadelige stoffer som ofte
brukes i EE-utstyr. Samtidig bidrar din innsats for korrekt avhending av produktet til effektiv bruk av
naturressurser. Du kan f& mer informasjon om hvor du kan avhende utrangert utstyr til resirkulering ved a
kontakte lokale myndigheter, et godkjent WEEE-program eller husholdningens renovasjonsselskap. Du
finner mer informasjon om retur og resirkulering av WEEE-produkter pd www.canon-europe.com/weee.

Vain Euroopan unionin seka ETA:n (Norja, Islanti ja Liechtenstein) alueelle.

hid

Tama tunnus osoittaa, ettd sahko- ja elektroniikkalaiteromua koskeva direktiivi (SER-direktiivi,
2012/19/EU) seka kansallinen lainsaadanto kieltavat tuotteen havittamisen talousjatteen mukana. Tuote
on vietava asianmukaiseen kerdyspisteeseen, esimerkiksi kodinkoneliikkeeseen uutta vastaavaa tuotetta
ostettaessa tai viralliseen sahko- ja elektroniikkalaiteromun kerayspisteeseen. Sahko- ja
elektroniikkalaiteromun virheellinen kasittely voi vahingoittaa ymparist6a ja ihmisten terveytta, koska
laitteet saattavat sisaltaa ymparistolle ja terveydelle haitallisia aineita. Lisaksi tuotteen asianmukainen
havittdminen saastaa luonnonvaroja. Lisatietoja sdhkd- ja elektroniikkalaiteromun kerdyspisteista saat
kaupunkien ja kuntien tiedotuksesta, jatehuoltoviranomaisilta, sahko- ja elektroniikkalaiteromun
kierratysjarjestelman yllapitajalta ja jatehuoltoyhtiolta. Lisatietoja sahko- ja elektroniikkalaiteromun
kerayksesta ja kierratyksesta on osoitteessa www.canon-europe.com/weee.

Endast for Europeiska unionen och EES (Norge, Island och Liechtenstein)

hid

Den har symbolen visar att produkten enligt WEEE-direktivet (2012/19/EU) och nationell lagstiftning inte
far sorteras och slangas som hushallsavfall. Den har produkten ska [dmnas in pa en darfor avsedd
insamlingsplats, t.ex. pa en atervinningsstation auktoriserad att hantera elektrisk och elektronisk
utrustning (EE-utrustning) eller hos handlare som ar auktoriserade att byta in varor da nya, motsvarande
kops (en mot en). Olamplig hantering av avfall av den har typen kan ha en negativ inverkan pa miljéon och
manniskors halsa pa grund av de potentiellt farliga amnen som kan aterfinnas i elektrisk och elektronisk
utrustning. Din medverkan till en korrekt avfallshantering av den har produkten bidrar dessutom till en
effektiv anvandning av naturresurserna. Kontakta ditt lokala kommunkontor, berérd myndighet, féretag for
avfallshantering eller ta del av en godkand WEEE-organisation om du vill ha mer information om var du
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kan lamna den kasserade produkten for atervinning. For mer information om inlamning och atervinning av
WEEE-produkter, se www.canon-europe.com/weee.

Pouze Evropska unie a EHP (Norsko, Island a Lichtenstejnsko)

h24

Tento symbol znamena, ze podle smérnice o OEEZ (2012/19/EU) a podle vnitrostatnich pravnich
predpisli nema byt tento vyrobek likvidovan s odpadem z domacnosti. Tento vyrobek ma byt vracen do
sbérného mista, napf. v rdmci autorizovaného systému odbéru jednoho vyrobku za jeden nové prodany
podobny vyrobek nebo v autorizovaném sbé&rném misté pro recyklaci odpadnich elektrickych a
elektronickych zafizeni (OEEZ). Nevhodné nakladani s timto druhem odpadu by mohlo mit negativni
dopad na zivotni prostfedi a lidské zdravi, protoZe elektricka a elektronicka zafizeni zpravidla obsahu;ji
potencialné nebezpecné latky. Vase spoluprace na spravné likvidaci tohoto vyrobku sou¢asné napom(ize
efektivnimu vyuzivani pfirodnich zdroju. Dal$i informace o mistech sbéru vaseho odpadniho zafizeni

k recyklaci vam sdéli mistni ufad vasi obce, spravni organ vykonavajici dozor nad likvidaci odpadu,
sbérny OEEZ nebo sluzba pro odvoz komunalniho odpadu. DalSi informace tykajici se vraceni a
recyklace OEEZ naleznete na adrese www.canon-europe.com/weee.

Csak az Eurépai Unié és az EGT (Norvégia, Izland és Liechtenstein)
orszagaiban

h2d

Ez a szimbodlum azt jelzi, hogy a helyi térvények és a WEEE-iranyelv (2012/19/EU) szerint a termék nem
kezelhetd haztartasi hulladékként. A terméket a kijeldlt nyilvanos gydiijtépontokon kell leadni, példaul
hasonlé cserekésziilék vasarlasakor, illetve barmelyik, elektromos és elektronikai berendezésekbdl
szarmazé hulladék (WEEE) atvételére feljogositott gyUjtéponton. Az ilyen jellegl hulladékok a nem
megfelel6 kezelés esetén a benniik talalhaté veszélyes anyagok révén artalmasak lehetnek a kérnyezetre
és az emberek egészségére. Tovabba, a termékbél szarmazd hulladék megfeleld kezelésével
hozzajarulhat a természetes nyersanyagok hatékonyabb hasznositasahoz. A berendezésekbdl szarmazo,
Ujrahasznosithatd hulladékok elhelyezésére vonatkozd tovabbi tudnivaldkért forduljon a helyi
onkormanyzathoz, a kozterullet-fenntartd vallalathoz, a haztartasi hulladék begydijtését végzé vallalathoz,
illetve a hivatalos WEEE-képviselethez. Tovabbi tudnivalokat a WEEE-termékek visszajuttatédsardl és
Ujrahasznositasarol a www.canon-europe.com/weee.

Tylko dla krajow Unii Europejskiej oraz EOG (Norwegia, Islandia i
Liechtenstein)

hid
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Ten symbol oznacza, ze zgodnie z dyrektywg WEEE dotyczgca zuzytego sprzetu elektrycznego i
elektronicznego (2012/19/UE) oraz przepisami lokalnymi nie nalezy wyrzucac tego produktu razem z
odpadami gospodarstwa domowego. Produkt nalezy przekaza¢ do wyznaczonego punktu gromadzenia
odpadow, np. firmie, od ktorej kupowany jest nowy, podobny produkt lub do autoryzowanego punktu
gromadzenia zuzytego sprzetu elektrycznego i elektronicznego w celu poddania go recyklingowi.
Usuwanie tego typu odpaddéw w nieodpowiedni sposéb moze mie¢ negatywny wptyw na otoczenie i
zdrowie innych oséb ze wzgledu na niebezpieczne substancje stosowane w takim sprzecie. Jednoczesnie
pozbycie sie zuzytego sprzetu w zalecany sposdb przyczynia sie do wtasciwego wykorzystania zasobow
naturalnych. Aby uzyska¢ wiecej informacji na temat punktow, do ktérych mozna dostarczy¢ sprzet do
recyklingu, prosimy skontaktowac sie z lokalnym urzedem miasta, zaktadem utylizacji odpadow,
skorzystac¢ z instrukcji zatwierdzonej dyrektywg WEEE lub skontaktowac¢ sie z przedsiebiorstwem
zajmujgcym sie wywozem odpadow domowych. Wiecej informacji o zwracaniu i recyklingu zuzytego
sprzetu elektrycznego i elektronicznego znajduje sie w witrynie www.canon-europe.com/weee.

Plati len pre Staty Eurdpskej unie a EHP (N6rsko, Island a Lichtenstajnsko)

hid

Tento symbol znamena, Ze podla Smernice 2012/19/EU o odpade z elektrickych a elektronickych
zariadeni (OEEZ) a podra platnej legislativy Slovenskej republiky sa tento produkt nesmie likvidovat spolu
s komunalnym odpadom. Produkt je potrebné odovzdat do uréenej zberne, napr. prostrednictvom vymeny
za kupu nového podobného produktu, alebo na autorizované zberné miesto, ktoré spracuva odpad z
elektrickych a elektronickych zariadeni (EEZ). Nespravna manipulacia s takymto typom odpadu mdze mat
negativny vplyv na Zivotné prostredie a ludské zdravie, pretoZe elektrické a elektronické zariadenia
obsahuju potencialne nebezpecné latky. Spolupracou na spravne;j likvidacii produktu prispejete

k Gginnému vyuzivaniu prirodnych zdrojov. Dal$ie informacie o mieste recyklacie opotrebovanych
zariadeni ziskate od miestneho uradu, uradu zivotného prostredia, zo schvaleného planu OEEZ alebo od
spolocnosti, ktora zaistuje likvidaciu komunalneho odpadu. Viac informacii najdete aj na webovej stranke:
www.canon-europe.com/weee.

Uksnes Euroopa Liit ja EMP (Norra, Island ja Liechtenstein)

)= 4

See sumbol néitab, et antud toodet ei tohi vastavalt elektri- ja elektroonikaseadmete jaatmeid kasitlevale
direktiivile (2012/19/EL) ning teie riigis kehtivatele digusaktidele utiliseerida koos olmejaatmetega. Antud
toode tuleb anda selleks maaratud kogumispunkti, nt mtdgipunkt, mis on volitatud Uks the vastu
vahetama, kui ostate uue sarnase toote, voi elektri- ja elektroonikaseadmete jaatmete imbertéotlemiseks
mdeldud kogumispunkti. Tédiendava teabe saamiseks elektri- ja elektroonikaseadmetest tekkinud jaatmete
tagastamise ja imbertootlemise kohta votke ihendust kohaliku omavalitsusega, asjakohase
valitsusasutusega, asjakohase tootjavastutusorganisatsiooniga voi olmejaatmete kaitlejaga. Lisateavet
leitate ka Interneti-lehekdljelt www.canon-europe.com/weee.
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Tikai Eiropas Savienibai un EEZ (Norvégijai, Islandei un Lihtensteinai)

hid

Sis simbols norada, ka atbilstosi ES Direktivai (2012/19/ES) par elektrisko un elektronisko iekartu
atkritumiem (EEIA) un vietéjiem tiesibu aktiem no 81 izstradajuma nedrikst atbrivoties, izmetot to kopa ar
sadzives atkritumiem. Sis izstradajums ir janodod piemérota savak$anas vieta, pieméram, apstiprinata
veikala, kur iegadajaties Iidzigu jaunu produktu un atstajat veco, vai apstiprinata vieta izlietotu elektrisko
un elektronisko iekartu parstradei. Nepareiza $ada veida atkritumu apsaimnieko$ana var apdraudét vidi
un cilvéka veselibu tadu iespéjami bistamu vielu dél, kas parasti ir elektriskajas un elektroniskajas
iekartas. Turklat jisu atbalsts pareiza $ada veida atkritumu apsaimnieko$Sana sekmés efektivu dabas
resursu izmantoSanu. Lai sanemtu pilnigaku informaciju par vietam, kur izlietoto iekartu var nodot
parstradei, sazinieties ar vietéjo pasvaldibu, atkritumu savaksanas atbildigo dienestu, pilnvarotu EEIA
struktdru vai sadzives atkritumu apsaimniekoSanas iestadi. Lai sanemtu plasaku informaciju par elektrisko
un elektronisko iekartu nodosanu parstradei, apmeklgjiet timek|a vietni www.canon-europe.com/weee.

Tik Europos Sajungai ir EEE (Norvegijai, Islandijai ir Lichtensteinui)

hid

Sis Zenklas reigkia, kad gaminio negalima imesti su buitinémis atliekomis, kaip yra nustatyta Direktyvoje
(2012/19/ES) ir nacionaliniuose teisé aktuose dél EE| atlieky tvarkymo. Sj gaminj reikia atiduoti j tam
skirtg surinkimo punkta, pvz., pagal patvirtintg keitimo sistema, kai perkamas panaSus gaminys, arba |
elektros ir elektroninés jrangos (EE)) atlieky perdirbimo punktg. Netinkamas tokios risies atlieky
tvarkymas dél elektros ir elektroninéje jrangoje esanciy pavojingy medziagy gali pakenkti aplinkai ir
zmoniy sveikatai. Padédami uztikrinti tinkamg Sio gaminio $alinimo tvarkg, kartu prisidésite prie
veiksmingo gamtos iStekliy naudojimo. Jei reikia daugiau informacijos, kaip Salinti tokias atliekas, kad jos
baty toliau perdirbamos, kreipkités j savo miesto valdzios institucijas, atlieky tvarkymo organizacijas,
patvirtinty EE] atlieky sistemy arba jasy buitiniy atlieky tvarkymo jstaigy atstovus. I8samesnés
informacijos apie EE] atlieky grazinimo ir perdirbimo tvarkg galite rasti apsilanke tinklalapyje www.canon-
europe.com/weee.

Samo za Evropsko unijo in EGP (Norveska, Islandija in Lihtenstajn)

)24

Ta simbol pomeni, da tega izdelka v skladu z direktivo OEEO (2012/19/EU) in drzavno zakonodajo ne
smete odvredi v gospodinjske odpadke. Ta izdelek morate odloziti na ustrezno zbiralno mesto, na primer
pri pooblas€enem prodajalcu, ko kupite podoben nov izdelek ali na zbiralno mesto za recikliranje
elektricne in elektronske opreme. Neprimerno ravnanje s takSnimi odpadki lahko negativno vpliva na
okolje in ¢lovekovo zdravje zaradi nevarnih snovi, ki so povezane z elektri¢no in elektronsko opremo. S
pravilno odstranitvijo izdelka hkrati prispevate tudi k uginkoviti porabi naravnih virov. Ce Zelite veé
informacij o tem, kje lahko odloZite odpadno opremo za recikliranje, pokli€ite ob&inski urad, komunalno
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podjetje ali sluzbo, ki skrbi za odstranjevanje odpadkov, ali si oglejte nasrt OEEO. Ce Zelite ve& informacij
o vra€anju in recikliranju izdelkov v skladu z direktivo OEEQO, obi¢ite www.canon-europe.com/weee.

Cawmo 3a EBponeunckus cbio3 u EUIMN (Hopeerusa, Ucnanamsa m JinxreHwamH)

h24

To3n cMMBOM Noka3ea, Ye To3n NPoAYKT He TpsAbBa a ce N3XBbphs 3aedHOo ¢ buToBuTe oTNagbuu,
cbrnacHo OupekTtuata 3a MYEEO (2012/19/EC) 1 BaweTo HaumoHanHo 3akoHoaaTencteo. To3n NpoaykT
TpsibBa oa Obae npedageH B NpefHa3HaveH 3a LenTta NyHKT 3a cbbupaHe, Hanpumep Ha 6a3a pa3msaHa,
KoraTo KynyBaTe HOB Nogo6eH NpoayKT, unu B ogobpeH cubupareneH nyHKT 3a peuuknmpaHe Ha u3nssno
oT ynoTpeba eneKkTpu4ecko n enekTpoHHo obopyasaHe (MYEEQO). HenpaBunHoTo TpeTupaHe Ha To3u Tun
oTnagbuM MOXe Aa AOBeAe OO0 eBEeHTyarHu oTpuuaTenHu nocneacTens 3a okonHaTa cpega M YoBELLKOTO
3gpaBe nopaan NoTeHUManHo onacHuTe BeLecTBa, KOMTO 0GUMKHOBEHO ca cBbp3aHu ¢ EEO. B cbLyoto
BpeMe Balueto cbaencTBmne 3a NpaBuUHOTO U3XBBLPIISIHE Ha TO3W NPOAYKT Lue AonpuHece 3a
eeKTUBHOTO U3Mon3BaHe Ha NpupogHuTe pecypcu. lNoBeve MHopmaunsi OTHOCHO MecTaTa, KbAETO
MOXe Aa npefaBaTe U3nasno ot ynorpeba obopyasBaHe 3a peumknupaHe, MoxXe Aa nonyynte ot MecTHUTe
BMacTK, OT opraHa, OTFOBOPEH 3a oTnaabuute 1 oT ogobpeHa cucrema 3a manasno ot ynorpeda EEO vnm
ot Bawara mectHa cnyxb6a 3a 6utoBun otnagbum. 3a noseve MHOpMaLnsi OTHOCHO BPbLUAHETO U
peLVKIMPaHETO Ha NPoAyKTK OT M3nA3no ot ynotpeba EEO noceteTe www.canon-europe.com/weee.

Doar pentru Uniunea Europeana si EEA (Norvegia, Islanda si Liechtenstein)

h2d

Acest simbol indica faptul ca acest produs nu trebuie aruncat o data cu reziduurile menajere, in
conformitate cu Directiva DEEE (Directiva privind deseurile de echipamente electrice si electronice)
(2012/19/UE) si legile nationale. Acest produs trebuie transportat la un punct de colectare special, de
exemplu un centru care preia produsele vechi atunci cand achizitionati un produs nou similar, sau la un
punct de colectare autorizat pentru reciclarea deseurilor provenite de la echipamentele electrice si
electronice (EEE). Manuirea necorespunzatoare a acestor tipuri de deseuri poate avea un impact negativ
asupra mediului Tnconjurator si sanatatii indivizilor, din cauza substantelor potential nocive care sunt in
general asociate cu EEE. in acelasi timp, cooperarea dvs. la reciclarea corecta a acestui produs va
contribui la utilizarea efectiva a resurselor naturale. Pentru mai multe informatii privind locurile de reciclare
a deseurilor provenite de la echipamente, contactati biroul primariei locale, autoritatea responsabila cu
colectarea deseurilor, schema DEEE aprobata sau serviciul de colectare a deseurilor menajere. Pentru
mai multe informatji privind returnarea si reciclarea produselor DEEE, vizitati www.canon-europe.com/
weee.

Samo za Europsku uniju i EEZ (Norveska, Island i Lihtenstajn)

hid

98



Ovaj simbol pokazuje da se ovaj proizvod ne smije odlagati s ku¢nim otpadom sukladno WEEE Direktivi
(2012/19/EC) i va8em nacionalnom zakonu. Ovaj proizvod je potrebno predati na posebno mjesto za
sakupljanje otpada, npr. na ovlasteno mjesto gdje mozete zamijeniti staro za novo ukoliko kupujete novi
sli¢an proizvod ili na ovlasteno mjesto za sakupljanje rabljene elektricne i elektroniCke opreme (EEE) za
recikliranje. Nepropisno rukovanje ovom vrstom otpada moze imati negativan ucinak na okolinu i zdravlje
ljudi zbog supstanci koje su potencijalno opasne za zdravlje, a opcenito se povezuju s EEE. Istovremeno,
vasa Ce suradnja kroz propisno odlaganje ovog proizvoda doprinijeti efektivnoj uporabi prirodnih resursa.
Za vi8e informacija o tome gdje moZete odloZiti svoj otpad za recikliranje obratite se vaSem lokalnom
gradskom uredu, komunalnoj sluzbi, odobrenom WEEE programu ili sluzbi za odlaganje kuénog otpada.
Ostale informacije o vracanju i recikliranju WEEE proizvoda potraZite na www.canon-europe.com/weee.

Korisnici u Srbiji

h24

Ovaj simbol oznacava da ovaj proizvod ne sme da se odlaze sa ostalim kuénim otpadom, u skladu sa
WEEE Direktivom (2012/19/EU) i nacionalnim zakonima. Ovaj proizvod treba predati odredenom centru
za prikupljanje, npr. na osnovi "jedan-za-jedan" kada kupujete sli¢an novi proizvod, ili ovla§8¢éenom centru
za prikupljanje za reciklazu istroSene elektri¢ne i elektronske opreme (EEE). Nepravilno rukovanje ovom
vrstom otpada mozZe da ima moguce negativne posledice po Zivotnu sredinu i ljudsko zdravlje usled
potencijalno opasnih materijala koji se uglavhom vezuju za EEE. U isto vreme, vaSa saradnja na
ispravnom odlaganju ovog proizvoda ¢e doprineti efikasnom kori§éenju prirodnih resursa. Za vise
informacija o tome gde mozete da predate vasu staru opremu radi recikliranje, vas molimo, da
kontaktirate lokalne gradske vlasti, komunalne sluzbe, odobreni plan reciklaze ili Gradsku Cistocu. Za vise
informacija o vraéanju i recikliranju WEEE proizvoda, posetite stranicu www.canon-europe.com/weee.

Environmental Information

Reducing your environmental impact

Power Consumption and Operational Modes

The amount of electricity a device consumes depends on the way the device is used. This product is
designed and set in a way to allow you to reduce the power consumption. After the last print it switches
to Ready Mode. In this mode it can print again immediately if required. If the product is not used for a
time, the device switches to its Sleep Mode. The devices consume less power (Watt) in these modes.

Energy Star®

The Energy Star® programme is a voluntary scheme to promote the development and purchase of
energy efficient models, which help to minimise environmental impact.
Products which meet the stringent requirements of the Energy Star® programme for both environmental

benefits and the amount of energy consumption will carry the Energy Star® logo accordingly.
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Paper types
This product can be used to print on both recycled and virgin paper (certified to an environmental
stewardship scheme), which complies with EN12281 or a similar quality standard. In addition it can

support printing on media down to a weight of 64g/m2, lighter paper means less resources used and a
lower environmental footprint for your printing needs.

ENERGY STAR
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Main Components and Their Use
» Main Components

» Power Supply
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Main Components
» Front View
» Rear View
» Inside View

» Operation Panel
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Front View

L

5

(1) document cover
Open to load an original on the platen glass.

(2) paper support

Open to load paper in the rear tray.
(3) paper guides

Align with both sides of the paper stack.
(4) rear tray

Load paper here. Two or more sheets of the same size and type of paper can be loaded at the same
time, and fed automatically one sheet at a time.

= | oading Plain Paper / Photo Paper
= | oading Envelopes

(5) paper output tray
Printed paper is ejected. Open before printing.

(6) output tray extension
Open to support ejected paper.

103



(7) platen glass
Load an original here.

(8) operation panel
Use to change the settings of the machine or to operate it.

= Operation Panel
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Rear View

1

(1) USB port
Plug in the USB cable to connect the machine with a computer.

32 Important

» Do not touch the metal casing.
» Do not plug in or unplug the USB cable while the machine is printing or scanning originals with the
computer.

(2) power cord connector
Plug in the supplied power cord.
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Inside View

3 4 3

(1) ink tank covers
Open to refill ink tanks.

(2) scanning unit / cover
Scans originals. Open to refill ink tanks or to remove jammed paper.

(3) ink tanks
The black ink tank is on the right, and the color ink tanks (cyan, magenta, and yellow) are on the left.

If any ink levels are low, refill the low tanks.

(4) cartridge holder
Install the cartridge here.

»» Note

* For details on refilling ink tanks, see Refilling Ink Tanks.
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Operation Panel

* All lamps on the operation panel are shown lit in the figure below for explanatory purposes.

L K =

(1) ON button
Turns the power on or off.

= Turning the Machine On and Off

(2) ON lamp
Lights after flashing when the power is turned on.

»» Note

* You can check the status of the machine by the ON and Alarm lamps.

* ON lamp is off: The power is off.

» ON lamp lights: The machine is ready to print.

ON lamp flashes: The machine is getting ready to print, or printing is in progress.

Alarm lamp flashes: An error has occurred and the machine is not ready to print.

ON lamp flashes and Alarm lamp flashes alternately: An error that requires contacting the service
center may have occurred.

= An Error Occurs

(3) Alarm lamp

Lights or flashes when an error occurs. When performing machine maintenance or machine settings,
options can be selected according to the number of flashes.

(4) Ink lamp
Lights or flashes when black or color ink runs out.

(5) Stop button
Cancels operation when print, copy, or scan job is in progress.
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Holding this button down lets you select maintenance options or machine settings.

(6) Black button*
Starts black & white copying. You can also press this button to finalize your selection for the setting
item.

(7) Color button*
Starts color copying. You can also press this button to finalize your selection for the setting item.

* In the software applications or manuals, the Color and Black buttons are collectively called the "Start" or
"OK" button.
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Power Supply
» Confirming that the Power Is On
» Turning the Machine On and Off
» Notice for the Power Plug/Power Cord

» Notice for Unplugging the Power Cord
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Confirming that the Power Is On

The ON lamp is lit when the machine is turned on.

»» Note

+ It may take a while for the machine to start printing immediately after you turn on the machine.
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Turning the Machine On and Off
Turning on the machine

1. Press the ON button to turn on the machine.

The ON lamp flashes and then remains lit.

= Confirming that the Power Is On

> Note

* It may take a while for the machine to start printing immediately after you turn on the machine.

« If the Alarm lamp lights up or flashes, see An Error Occurs.

* You can set the machine to automatically turn on when a print or scan operation is performed.
This feature is set to off by default.

= Managing the Printer Power (Windows)
= Managing the Printer Power (Mac OS)

Turning off the machine

1. Press the ON button to turn off the machine.

When the ON lamp stops flashing, the machine is turned off.

3% Important

» When you unplug the power cord after turning off the machine, be sure to confirm that the ON

lamp is off.
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»» Note

* You can set the machine to automatically turn off when no operations are performed or no print
jobs are sent to the machine for a certain interval. This feature is set to on by default.

= Managing the Printer Power (Windows)
= Managing the Printer Power (Mac OS)
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Notice for the Power Plug/Power Cord

Unplug the power cord once a month to confirm that the power plug/power cord does not have anything
unusual described below.

» The power plug/power cord is hot.

» The power plug/power cord is rusty.
» The power plug/power cord is bent.
» The power plug/power cord is worn.
» The power plug/power cord is split.

/I Caution

+ If you find anything unusual with the power plug/power cord described above, unplug the power cord
and call for service. Using the machine with one of the unusual conditions above may cause a fire or an
electric shock.
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Notice for Unplugging the Power Cord
To unplug the power cord, follow the procedure below.

3% Important

* When you unplug the power cord, press the ON button, then confirm that the ON lamp is off.
Unplugging the power cord while the ON lamp is lit or flashing may cause drying or clogging of the print
head and print quality may be reduced.

1. Press the ON button to turn the machine off.

2. Confirm that the ON lamp is off.

D/[-*

3. Unplug the power cord.

The specification of the power cord differs depending on the country or region of use.

114



Changing Settings
» Changing Printer Settings from Your Computer (Windows)
» Changing Printer Settings from Your Computer (Mac OS)
» Changing Settings from Operation Panel

» Initializing Machine Settings
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Changing Printer Settings from Your Computer (Windows)

» Changing the Print Options

¥

Registering a Frequently Used Printing Profile

¥

Changing the remaining ink level notification setting

¥

Managing the Printer Power

¥

Reducing the Printer Noise

¥

Changing the Printer Operation Mode
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Changing the Print Options

You can change the detailed printer driver settings for print data that is sent from an application software.

Specify this option if you encounter print failures such as part of an image data being cut off.

The procedure for changing the print options is as follows:

1. Open the printer driver setup window

2. Click Print Options... on the Page Setup tab
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The Print Options dialog box opens.
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22> Note

» When you use the XPS printer driver, the functions available to you are different.

3. Change the individual settings
If necessary, change the setting of each item, and then click OK.

The Page Setup tab is displayed again.
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Registering a Frequently Used Printing Profile

You can register the frequently used printing profile to Commonly Used Settings on the Quick Setup tab.
Unnecessary printing profiles can be deleted at any time.

The procedure for registering a printing profile is as follows:
Registering a Printing Profile

1. Open the printer driver setup window

2. Set the necessary items

From Commonly Used Settings on the Quick Setup tab, select the printing profile to be used and if
necessary, change the settings after Additional Features.
You can also register necessary items on the Main and Page Setup tabs.

3. Click Save...

Conmrmanly Lnd getinge

4. Save the settings
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Enter a name in the Name field. If necessary, click Options..., set the items, and then click OK.

In the Save Commonly Used Settings dialog box, click OK to save the print settings and return to the
Quick Setup tab.

The name and icon are displayed in Commonly Used Settings.

22 Important

+ To save the page size, orientation, and number of copies that was set in each sheet, click Options...,
and check each item.

»>» Note

* When you re-install the printer driver or upgrade the printer driver version, the print settings that are
already registered will be deleted from Commonly Used Settings.
Registered print settings cannot be saved and preserved. If a profile is deleted, register the print
settings again.

Deleting Unnecessary Printing Profile

1. Select the printing profile to be deleted

Select the printing profile you want to delete from the Commonly Used Settings list on the Quick
Setup tab.

2. Delete the printing profile

Click Delete. When the confirmation message appears, click OK.
The selected printing profile is deleted from the Commonly Used Settings list.

»>» Note

* Printing profiles that are registered in the initial settings cannot be deleted.

119



Changing the remaining ink level notification setting

From the printer driver, you can switch the remaining ink level notification setting and reset the remaining ink
level count.

This section describes the procedure for changing the remaining ink level notification setting.

—— I Remaining Ink Notification Settings

1. Open the printer driver setup window

2. Check that the printer is on, and on the Maintenance tab, click Remaining Ink
Notification Settings.

The Remaining Ink Notification Settings dialog box appears.

3. If necessary, set the following item:

Function for Notifying the Remaining Ink Level
Select the setting for the remaining ink level notification function.
Select Enable to display an error message when the remaining ink level runs low.
Select Disable to prevent the error message from being displayed.
Then click Set to apply the selected setting.

32 Important
» Before enabling Function for Notifying the Remaining Ink Level, replenish all inks to the

upper limit line and reset the remaining ink level count by running Resets the Remaining Ink
Level Count. However, if you reset the count by operating the operation panel of the printer,
the setting in the printer driver is unnecessary.

« If you disable Function for Notifying the Remaining Ink Level, you must visually check the
remaining ink level. Replenish the ink before the ink level falls below the lower limit line.

Resets the Remaining Ink Level Count
Click Reset to reset the remaining ink level count.

32 Important

* When you reset the remaining ink level count, you must replenish all inks to the upper limit
line.

4. Apply the settings

When the confirmation message appears click OK When you select Close, the screen returns to the
Maintenance tab.
From this point on, the setting is applied.
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Managing the Printer Power

This function allows you to manage the printer power from the printer driver.

The procedure for managing the printer power is as follows:

; Power Off

The Power Off function turns off the printer. When you use this function, you will not be able to turn the
printer on from the printer driver.

1. Open the printer driver setup window

2. Execute power off

Click Power Off on the Maintenance tab. When the confirmation message appears, click OK.

The printer power switches off, and the Maintenance tab is displayed again.

‘@
Auto Power allows you to set Auto Power On and Auto Power Off.
The Auto Power On function automatically turns on the printer when data is received.

The Auto Power Off function automatically turns off the printer when there are no operations from the
printer driver or the printer for a specified period of time.

Auto Power

1. Open the printer driver setup window

2. Make sure that the printer is on and then click Auto Power on the Maintenance tab

The Auto Power Settings dialog box opens.

»» Note

« If the printer is off or if communication between the printer and the computer is disabled, an
error message may appear because the computer cannot collect the printer status.
If this happens, click OK to display the most recent settings specified on your computer.

3. If necessary, complete the following settings:

Auto Power On
Specifying Enable from the list will turn the printer on upon receipt of print data.

Auto Power Off
Specify the time from the list. When this time lapses without any operations from the printer driver
or the printer, the printer is turned off automatically.

4. Apply the settings
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Click OK. When the confirmation message appears, click OK.
The Maintenance tab is displayed again.

The setting is enabled after this. When you want to disable this function, select Disable from the list
according to the same procedure.

»>» Note

* When the printer is turned off, the Canon |J Status Monitor message varies depending on the Auto
Power On setting.
When the setting is Enable, "Printer is standing by" is displayed. When the setting is Disable,
"Printer is offline" is displayed.
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Reducing the Printer Noise

The silent function allows you to reduce the operating noise of this printer. Select when you wish to reduce
the operating noise of the printer at night, etc.
Using this function may lower the print speed.

The procedure for using the quiet mode is as follows:

&

1. Open the printer driver setup window

Quiet Settings

2. Click Quiet Settings on the Maintenance tab

The Quiet Settings dialog box opens.
3> Note

« If the printer is off or if communication between the printer and the computer is disabled, an
error message may appear because the computer cannot collect the printer status.

3. Set the quiet mode

If necessary, specify one of the following items:

Do not use quiet mode
Select this option when you wish to use the printer with volume of normal operating noise.

Always use quiet mode
Select this option when you wish to reduce the operating noise of the printer.

Use quiet mode during specified hours
Select this option when you wish to reduce the operating noise of the printer during a specified
period of time.
Set the Start time and the End time of the quiet mode you wish to be activated. If both are set to
the same time, the quiet mode will not function.

3% Important

* You can set the quiet mode from the operation panel of the printer, the printer driver, or
ScanGear (scanner driver).
No matter how you use to set the quiet mode, the mode is applied when you perform operations
from the operation panel of the printer or printing and scanning from the computer.

« If you specify a time for Use quiet mode during specified hours, quiet mode is not applied to
operations (copy, direct print, etc.) performed directly from the printer.

4. Apply the settings

Make sure that the printer is on and click OK.
Click OK when the confirmation message appears.

The settings are enabled hereafter.
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»» Note

» The effects of the quiet mode may be less depending on the print quality settings.
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Changing the Printer Operation Mode

If necessary, switch between various modes of printer operation.

The procedure for configuring Custom Settings is as follows:

— | Custom Settings

1. Open the printer driver setup window

2. Make sure that the printer is on, and then click Custom Settings on the Maintenance
tab

The Custom Settings dialog box opens.

»» Note

« If the printer is off or if communication between the printer and the computer is disabled, an
error message may appear because the computer cannot collect the printer status.
If this happens, click OK to display the most recent settings specified on your computer.

3. If necessary, complete the following settings:

Prevent paper abrasion
The printer can increase the gap between the print head and the paper during high-density
printing to prevent paper abrasion.
Check this check box to prevent paper abrasion.

Align heads manually
Usually, the Print Head Alignment function on the Maintenance tab is set to automatic head
alignment, but you can change it to manual head alignment.
If the printing results of automatic print head alignment are not satisfactory, perform manual head
alignment.
Check this check box to perform the manual head alignment. Uncheck this check box to perform
the automatic head alignment.

Rotate 90 degrees left when orientation is [Landscape]
On the Page Setup tab, you can change the rotation direction of the Landscape in the
Orientation.
To rotate the print data 90 degrees to the left during printing, select this item. To rotate the print
data 90 degrees to the right during printing, clear this item.

32 Important

» Do not change this setting while the print job is displayed in the print wait list. Otherwise,
characters may be omitted or the layout may become corrupt.

Ink Drying Wait Time
You can set the length of the printer rest time until printing of the next page begins. Moving the
slider to the right increases the pause time, and moving the slider to the left decreases the time.
If the paper gets stained because the next page is ejected before the ink on the printed page
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dries, increase the ink drying wait time.
Reducing the ink drying wait time speeds up printing.

4. Apply the settings

Click OK and when the confirmation message appears, click OK.

The printer operates with the modified settings hereafter.
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Changing Settings from Operation Panel
» Quiet setting

» Turning on/off Machine Automatically
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Quiet setting

Enable this function on the machine if you want to reduce the operating noise, such as when printing at
night.

Follow the procedure below to perform setting.

1. Make sure machine is turned on.

2. Press and hold Stop button and release it when Alarm lamp flashes 13 times.

3. Press Color button.

To disable the function, press the Black button.

32 Important

» Operating speed is reduced compared to when the quiet mode is not selected.

»» Note

* You can set the quiet mode from the operation panel of the machine or the machine driver. No
matter how you set the quiet mode, the mode is applied when you perform operations from the
operation panel of the machine or printing and scanning from the computer.

» For Windows, you can set the quiet mode from ScanGear (scanner driver).
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Turning on/off Machine Automatically

You can enable the machine to turn on/off automatically considering the environment.

= Turning on Machine Automatically

= Turning off Machine Automatically

Turning on Machine Automatically

You can enable the machine to turn on automatically when a scanning command from a computer or
printing data is sent to the machine.

1. Make sure machine is turned on.

2. Press and hold Stop button and release it when Alarm lamp flashes 18 times.

3. Press Color button.

To disable the function, press the Black button.

> Note

* You can select whether you turn the machine on automatically from the operation panel of the
machine or the printer driver. No matter how you set the mode, the mode is applied when you
perform printing or scanning operations from the computer.

» For Windows, you can select whether you turn the machine on automatically from ScanGear
(scanner driver).

Turning off Machine Automatically

You can enable the machine to turn off automatically when no operation is made or no printing data is
sent to the machine for a specified period of time.

1. Make sure machine is turned on.

2. Press and hold Stop button and release it when Alarm lamp flashes 17 times.

3. Press Color button.

To disable the function, press the Black button.

»» Note

* You can select whether you turn off the machine automatically from the operation panel of the
machine or the printer driver. From the printer driver, you can specify the time before turning off
the machine.

» For Windows, you can select whether you turn off the machine automatically from ScanGear
(scanner driver). From ScanGear (scanner driver), you can specify the time before turning off
the machine.
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Initializing Machine Settings

You can initialize the machine settings.

To initialize the machine settings, press and hold the Stop button and release it when the Alarm lamp

flashes 24 times.
All the machine settings are initialized.

After initializing the machine, perform setup again as necessary.

»» Note

* You cannot set the current position of the print head back to the default.
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Ensuring Optimal Printing Results

* Ink Tips

¥

Printing Tips

¥

Be Sure to Make Paper Settings after Loading Paper

¥

Canceling a Print Job

¥

Machine Handling Precautions

¥

Keeping Print Quality High

¥

Transporting Your Printer
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Ink Tips

How is ink used for various purposes other than printing?
Ink may be used for purposes other than printing.

During initial setup, some of the ink from the bundled ink bottles is used to fill the print head's nozzles to
ensure the printer is print-ready.

Therefore, the page yield of the initial bundled set of ink bottles is lower than that of the subsequent sets
of bottles.

To keep printer's performance, Canon printer performs cleaning automatically according to its condition.
When the printer performs cleaning, a small amount of ink is consumed. In this case, all colors of ink may
be consumed.

[Cleaning function]

The cleaning function helps the printer to suck air bubbles or ink itself from the nozzle and thus prevents
print quality degradation or nozzle clogging.

Does black-and-white printing use color ink?

Black-and-white printing may use ink other than black ink depending on the type of printing paper or the
settings of the printer driver. So, color ink is consumed even when printing in black-and-white.

Similarly, color inks are also consumed along with black ink during print head cleaning when Black is
specified for cleaning.
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Printing Tips

Check the machine status before printing!
* |s the print head OK?

If a print head nozzle is clogged, print will be faint and papers will be wasted. Print the nozzle check
pattern to check the print head.

= Maintenance Procedure

« Is the inside of the machine smeared with ink?

After printing large quantities of paper or performing borderless printing, the area where papers go
through may get smeared with ink. Clean the inside of your machine with Bottom Plate Cleaning.

Check how to load the paper correctly!
* |Is the paper loaded in the correct orientation?

To load paper in the rear tray, load paper WITH THE PRINTING SIDE FACING YOU.

= | oading Paper

a"“*lh—ur

* |s the paper curled?
The curled paper causes paper jam. Flatten the curled paper, then reload it.

= "Correct curl before loading paper." in Paper Is Smudged / Printed Surface Is Scratched
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Be Sure to Make Paper Settings after Loading Paper

If the media type setting is not the one for the loaded paper, printing results may not be satisfactory. After
loading paper, be sure to select the appropriate media type setting for the loaded paper.

= Print Results Are Unsatisfactory

There are various types of paper: paper with special coating on the surface for printing photos with optimal
quality and paper suitable for documents.

Each media type has specific preset settings, such as how ink is used and sprayed, distance from nozzles,
etc., so that you can print on that type with optimal image quality.

This allows you to print with the settings best suited for the loaded media type just by selecting that media
type.
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Canceling a Print Job

Never press the ON button!

If you press the ON button while printing is in progress, the print data sent from the computer queues in
the machine and you may not be able to continue to print.

Press the Stop button to cancel printing.
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Machine Handling Precautions

Do not place any object on the document cover!

Do not place any object on the document cover. It will fall into the rear tray when the document cover is
opened and cause the machine to malfunction. Also, place the machine where objects will not fall on it.

~
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Keeping Print Quality High

The key to printing with the optimal printing quality is to prevent the print head from drying or clogging.
Always observe the following rules for optimal printing quality.

»>» Note

» Depending on the type of paper, ink may blur if you trace the printed area with a highlight pen or paint-
stick, or bleed if water or sweat comes in contact with the printed area.

Never unplug the power cord until the power is turned off!

If you press the ON button to turn off the power, the machine caps the print head (nozzles) automatically
to prevent from drying. If you unplug the power cord from the wall outlet before the ON lamp is turned off,
the print head will not be capped properly and this will cause drying or clogging.

When unplugging the power cord, make sure that the ON lamp is not lit.

Print periodically!

Just as the tip of a felt pen becomes dry and unusabile if it has not been used for a long time, even if it is
capped, the print head too, may become dried or clogged if the machine has not been used for a long
time. We recommend you to use the machine at least once a month.
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Transporting Your Printer
When relocating the machine for changing your living place or repairing it, make sure of the following.

3% Important

* You cannot take ink out of ink tanks.

» Check if the tank cap is completely inserted. If the ink tank cover is not completely closed, insert the
tank cap properly.

* Do not tilt the machine. Ink may leak.

» Please handle with care and ensure the box remains flat and NOT turned upside down or on its side, as
the printer may be damaged and ink in the printer may leak.

» Pack the machine in a sturdy box so that it is placed with its bottom facing down, using sufficient
protective material to ensure safe transport.

» With the cartridge left installed in the machine, press the ON button to turn off the power. This allows
the machine to automatically cap the print head, thus preventing it from drying.

» Do not remove the cartridge. Ink may leak.

* When transporting the machine, pack the machine in a plastic bag so that ink does not leak.

* When a shipping agent is handling transport of the machine, have its box marked "THIS SIDE UP" to
keep the machine with its bottom facing down. Mark also with "FRAGILE" or "THANDLE WITH CARE".

1. Make sure the machine is on.

2. Hold down the Stop button until the Alarm lamp flashes seven times, then release it
immediately.

The preparation to transport is executed and the machine goes off after the preparation is complete.

Do not perform any other operations until the machine completes the preparation.

3. Confirm that the ON lamp is off and unplug the power cord.

3% Important

» Do not unplug the machine while the ON lamp is lit or flashing, as it may cause malfunction or
damage to the machine, making the machine unable to print.

4. Retract the paper output tray and the output tray extension, then close the paper support.

138



5. Unplug the printer cable from the computer and from the machine, then unplug the power

cord from the machine.

6. Use adhesive tape to secure all the covers on the machine to keep them from opening
during transportation. Then pack the machine in the plastic bag.

7. Attach the protective material to the machine when packing the machine in the box.
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Legal Restrictions on Scanning/Copying

It may be unlawful to make copies of, scan, print, or use reproductions of the following documents.

The list provided is non-exhaustive. When in doubt, check with a legal representative in your jurisdiction.

» Paper money

* Money orders

* Certificates of deposit

» Postage stamps (canceled or uncanceled)

+ Identifying badges or insignias

+ Selective service or draft papers

» Checks or drafts issued by governmental agencies
» Motor vehicle licenses and certificates of title

» Traveler's checks

* Food stamps

» Passports

* Immigration papers

* Internal revenue stamps (canceled or uncanceled)
» Bonds or other certificates of indebtedness

+ Stock certificates

» Copyrighted works/works of art without permission of copyright owner
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Specifications

General Specifications

Printing resolution (dpi)

4800* (horizontal) x 1200 (vertical)

* Ink droplets can be placed with a pitch of 1/4800 inch at minimum.

Interface

USB Port:
Hi-Speed USB *

* A computer that complies with Hi-Speed USB standard is required. Since the
Hi-Speed USB interface is fully upwardly compatible with USB 1.1, it can be
used at USB 1.1.

Print width

8 inches/203.2 mm

(for Borderless Printing: 8.5 inches/216 mm)

Operating environment

Temperature: 41 to 95 °F (5 to 35 °C)
Humidity: 10 to 90 % RH (no condensation)

* The performance of the printer may be reduced under certain temperature
and humidity conditions.

Recommended conditions:
Temperature: 59 to 86 °F (15 to 30 °C)
Humidity: 10 to 80 % RH (no condensation)

* For the temperature and humidity conditions of papers such as photo paper,
refer to the paper's packaging or the supplied instructions.

Storage environment

Temperature: 32 to 104 °F (0 to 40 °C)
Humidity: 5 to 95 % RH (no condensation)

Power supply

AC 100-240 V, 50/60 Hz

Power consumption

Printing (Copy): Approx. 11 W

Standby (minimum): Approx. 0.8 W *1*2
OFF: Approx. 0.4 W *1

*1 USB connection to PC

*2 The wait time for standby cannot be changed.

External dimensions

Approx. 17.6 (W) x 13 (D) x 6.5 (H) inches
Approx. 445 (W) x 330 (D) x 163 (H) mm

* With the Paper Output Tray retracted.

Weight

Approx. 12.7 Ib (Approx. 5.8 kg)
* With the Print Head and ink tanks installed.

Print Head/Ink

Total 1472 nozzles (BK 320 nozzles, C/M/Y each 384 nozzles)
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Copy Specifications

Multiple copy

max. 21 pages

Scan Specifications

Scanner driver

Windows: TWAIN 1.9 Specification, WIA
Mac OS: ICA

Maximum scanning size

Ad/Letter, 8.5" x 11.7"/216 x 297 mm

Scanning resolution

Optical resolution (horizontal x vertical) max: 600 x 1200 dpi *1
Interpolated resolution max: 19200 x 19200 dpi *2

*1 Optical Resolution represents the maximum sampling rate based on ISO
14473.

*2 Increasing the scanning resolution will limit the maximum possible scanning

area.

Gradation (Input / Output)

Gray: 16 bit/8 bit
Color: 48 bit/24 bit (RGB each 16 bit/8 bit)

Minimum System Requirements

Conform to the operating system's requirements when higher than those given here.

Windows

Operating System

Windows 10, Windows 8.1*, Windows 8
Windows 7, Windows 7 SP1

Windows Vista SP2

Windows XP SP3 32-bit only

* Windows 8.1 includes Windows 8.1 Update.

Hard Disk Space

3.1GB
Note: For bundled software installation.

The necessary amount of hard disk space may be changed without notice.

Display

XGA 1024 x 768

Mac OS

Operating System

0OS Xv10.7.5- OS X v10.11

Hard Disk Space

1.5 GB
Note: For bundled software installation.

The necessary amount of hard disk space may be changed without notice.

Display

XGA 1024 x 768
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Other Supported OS

This product cannot be used with the iOS, Android, Windows RT, and Windows 10 Mobile.

An internet connection is required to use Easy-WebPrint EX and all the Online Manual.
Windows: Operation can only be guaranteed on a computer with Windows 10, Windows 8.1,
Windows 8, Windows 7, Windows Vista or Windows XP pre-installed.

Windows: A CD-ROM Drive or internet connection is required during software installation.
Windows: Internet Explorer 8, 9, 10 or 11 is required to install Easy-WebPrint EX.

Windows: Some functions may not be available with Windows Media Center.

Windows: .NET Framework 4 or 4.5 must be installed to use the Windows software.
Windows: XPS Essentials Pack is required to print on Windows XP.

Windows: The TWAIN driver (ScanGear) is based on the TWAIN 1.9 Specification and requires the
Data Source Manager bundled with the operating system.

Mac OS: For Mac OS, an internet connection is required during software installation.

Information in this guide is subject to change without notice.
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Information about Paper

» Media Types You Can Use
@« Paper Load Limit

» Media Types You Cannot Use

* Printing Area
@ Printing Area
@« Other Sizes than Letter, Legal, Envelopes
@« Letter, Legal

« Envelopes
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Media Types You Can Use

To get the best printing result, choose paper suitable for printing. Canon provides various types of paper
suitable for documents as well as paper suitable for photos or illustrations. We recommend the use of Canon
genuine paper for printing your important photos.

Media Types

Commercially available papers

+ Plain Paper (including recycled paper)*1
* Envelopes

Canon genuine papers

The Model Number of Canon genuine paper is shown in brackets. Refer to the instruction manual
supplied with the paper for detailed information on the printable side and notes on handling paper. For
information on the page sizes available for each Canon genuine paper, access our website.

»» Note

* You may not be able to purchase some Canon genuine papers depending on the country or region
of purchase. Paper is not sold in the US by Model Number. Purchase paper by name.

Paper for printing documents:

» Canon Red Label Superior <WOP111>*1
» Canon Océ Office Colour Paper <SAT213>*1

Paper for printing photos:

* Glossy Photo Paper "Everyday Use" <GP-501>
» Photo Paper Glossy <GP-701>

» Photo Paper Plus Glossy Il <PP-201>

* Photo Paper Plus Glossy Il <PP-301>

* Photo Paper Pro Luster <LU-101>

» Photo Paper Plus Semi-gloss <SG-201>

* Matte Photo Paper <MP-101>

Paper for printing business documents:
+ High Resolution Paper <HR-101N>

*1 This machine accepts only A4 or Letter-sized plain paper for copying.

= Paper Load Limit
= Paper Settings on the Printer Driver (Windows)
= Paper Settings on the Printer Driver (Mac OS)

Page Sizes

You can use the following page sizes.
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> Note

» Only the following sizes may be printed from the operation panel.

e A4, Letter

Standard sizes:

* Letter

* Legal

* A5

* A4

* B5

* KG/4"x6"(10x15)

« 2L/5"x7"(13x18)

» 8"x10"(20x25cm)

* L(89x127mm)

» Square 5"x5" 13x13cm
* Hagaki

» Hagaki 2

* Envelope Com 10

* Envelope DL

» Nagagata 3

* Nagagata 4

* Yougata 4

* Yougata 6

* Card 2.17"x3.58" 55x91mm

Non-standard sizes:
You can print on non-standard size paper within the following ranges.

* Minimum size: 2.17 x 3.50 inches (55.0 x 89.0 mm)
* Maximum size: 8.50 x 26.61 inches (215.9 x 676.0 mm)

Paper Weight
You can use paper in the following weight range.
+ 17 to 28 Ib (64 to 105 g /m2) (plain paper except for Canon genuine paper)

Do not use heavier or lighter paper (except for Canon genuine paper), as it could jam in the machine.

Notes on Storing Paper

» Take out only the necessary number of paper from the package, just before printing.
» To avoid curling, when you do not print, put unused paper back into the package and keep it on a level
surface. And also, store it avoiding heat, humidity, and direct sunlight.
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Paper Load Limit

Commercially Available Papers

Media Name

Rear Tray Paper Output Tray

Plain Paper (including recycled paper)*1

Approx.
(10 sheets: Legal)

100 sheets Approx. 50 sheets

(10 sheets: Legal)

Envelopes

10 envelopes 2

Canon Genuine Papers
3> Note

» We recommend that you remove the previously printed sheet from the paper output tray before
continuously printing to avoid blurs and discoloration (except for Canon Red Label Superior
<WOP111>, Canon Oceé Office Colour Paper <SAT213>, and High Resolution Paper <HR-101N>).

Paper for printing documents:
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Media Name <Model No.> Rear Tray Paper Output Tray
Canon Red Label Superior <WOP111> Approx. 100 sheets Approx. 50 sheets
Canon Océ Office Colour Paper <SAT213> Approx. 80 sheets Approx. 50 sheets
Paper for printing photos:
Media Name <Model No.> Rear Tray
Glossy Photo Paper "Everyday Use" <GP-501>*3 10 sheets: A4, Letter
20 sheets: 4" x 6" (10 x 15 cm)
Photo Paper Glossy <GP-701>*3 10 sheets: A4, Letter
20 sheets: 4" x 6" (10 x 15 cm)
Photo Paper Plus Glossy Il <PP-201>*3 10 sheets: A4, Letter, 5" x 7" (13 x 18 cm), 8" x 10" (20
x 25 cm)
20 sheets: 4" x 6" (10 x 15 cm), Square 5" x 5" (13 x 13
cm)
Photo Paper Plus Glossy Il <PP-301>*3 10 sheets: A4, Letter, 5" x 7" (13 x 18 cm), 8" x 10" (20
x 25 cm)
20 sheets: 4" x 6" (10 x 15 cm), Square 5" x 5" (13 x 13
cm)
Photo Paper Pro Luster <LU-101>*3 10 sheets: A4, Letter
Photo Paper Plus Semi-gloss <SG-201>*3 10 sheets: A4, Letter, 5" x 7" (13 x 18 cm), 8" x 10" (20
x 25 cm)
20 sheets: 4" x 6" (10 x 15 cm)
Matte Photo Paper <MP-101> 10 sheets: A4, Letter




20 sheets: 4" x 6" (10 x 15 cm)

Paper for printing business documents:

Media Name <Model No.>

Rear Tray

Paper Output Tray

High Resolution Paper <HR-101N>

80 sheets

50 sheets

*1 Proper feeding of paper may not be possible at the maximum capacity depending on the type of paper
or environmental conditions (either very high or low temperature or humidity). In such cases, reduce the

number of paper you load at a time to less than half.
*2 We recommend that you remove the previously printed paper or envelope from the paper output tray
before continuously printing to avoid blurs and discoloration.
*3 When loading paper in stacks, the print side may become marked as it is fed or paper may not feed

properly. In this case, load one sheet at a time.
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Media Types You Cannot Use

Do not use the following types of paper. Using such paper will cause not only unsatisfactory results, but also
the machine to jam or malfunction.

 Folded, curled, or wrinkled paper

» Damp paper

« Paper that is too thin (weighing less than 17 Ib (64 g /m?))

« Paper that is too thick (plain paper weighing more than 28 Ib (105 g /m?2), except for Canon genuine
paper)

* Plain paper or notepad paper cut to a small size (when printing on paper smaller than A5)

* Picture postcards

 Postcards affixed with photos or stickers

» Envelopes with a double flap

» Envelopes with an embossed or treated surface

» Envelopes whose gummed flaps are already moistened and adhesive

» Any type of paper with holes

» Paper that is not rectangular

» Paper bound with staples or glue

» Paper with adhesives

» Paper decorated with glitter, etc.
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Printing Area
*» Printing Area
» Other Sizes than Letter, Legal, Envelopes
> Letter, Legal

» Envelopes
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Printing Area

To ensure the best print quality, the machine allows a margin along each edge of media. The actual printable
area will be the area inside these margins.

Recommended printing area Il : Canon recommends that you print within this area.

Printable area L1 : The area where it is possible to print. However, printing in this area can affect the print
quality or the paper feed precision.

»» Note

» By selecting Borderless Printing option, you can make prints with no margins.

» When performing Borderless Printing, slight cropping may occur at the edges since the printed image is
enlarged to fill the whole page.

» For Borderless Printing, use the following paper:

* Glossy Photo Paper "Everyday Use" <GP-501>
» Photo Paper Glossy <GP-701>

* Photo Paper Plus Glossy Il <PP-201>

» Photo Paper Plus Glossy Il <PP-301>

* Photo Paper Pro Luster <LU-101>

» Photo Paper Plus Semi-gloss <SG-201>

+ Matte Photo Paper <MP-101>

Performing Borderless Printing on any other type of paper may substantially reduce printing quality
and/or result in printouts with altered color hues.

Borderless Printing on plain paper may result in printouts with reduced quality. Use them only for test
printing. Borderless Printing from the operation panel is not supported. This machine only supports
Borderless Printing from a computer.

» Borderless Printing is not available for A5, B5, or Legal size paper, or envelopes.
» Depending on the type of paper, Borderless Printing may reduce the print quality at the top and bottom
edges of the paper or cause these parts to become smudged.
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Other Sizes than Letter, Legal, Envelopes

Size Printable Area (width x height)
A5 5.56 x 7.95 inches (141.2 x 202.0 mm)
A4 8.00 x 11.38 inches (203.2 x 289.0 mm)
B5 6.90 x 9.80 inches (175.2 x 249.0 mm)
4" x 6" (10 x 15 cm) 3.73 x 5.69 inches (94.8 x 144.4 mm)
5"x 7" (13 x 18 cm) 4.73 x 6.69 inches (120.2 x 169.8 mm)
8" x 10" (20 x 25 cm) 7.73 x 9.69 inches (196.4 x 246.0 mm)
Square 5" x 5" (13 x 13 cm) 4.53 x 4.53 inches (115.0 x 115.0 mm)
Card 2.17" x 3.58" (55 x 91 mm) 1.89 x 3.26 inches (48.2 x 83.0 mm)

1l (]
— —  e—
iB '

E F

Il Recommended printing area

A: 1.23 inches (31.2 mm)
B: 1.28 inches (32.5 mm)

[ Printable area

Other than Square size

C: 0.12inch (3.0 mm)
D: 0.20 inch (5.0 mm)
E: 0.13 inch (3.4 mm)
F: 0.13 inch (3.4 mm)

Square size

C: 0.23 inch (6.0 mm)
D: 0.23 inch (6.0 mm)
E: 0.23 inch (6.0 mm)
F: 0.23 inch (6.0 mm)
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Letter, Legal

Size Printable Area (width x height)
Letter 8.00 x 10.69 inches (203.2 x 271.4 mm)
Legal 8.00 x 13.69 inches (203.2 x 347.6 mm)

Il Recommended printing area

A: 1.23 inches (31.2 mm)
B: 1.28 inches (32.5 mm)

[ Printable area

C: 0.12inch (3.0 mm)
D: 0.20 inch (5.0 mm)
E: 0.25inch (6.4 mm)
F: 0.25 inch (6.3 mm)
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Envelopes

Size

Recommended Printing Area (width x height)

Envelope DL

4.06 x 7.20 inches (103.2 x 183.0 mm)

Envelope Com 10

3.85 x 8.04 inches (97.9 x 204.3 mm)

Il Recommended printing area

A: 0.31 inch (8.0 mm)
B: 1.14 inches (29.0 mm)
C: 0.13 inch (3.4 mm)
D: 0.13 inch (3.4 mm)
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Administrator Password

Depending on the printer you are using, an administrator password is specified at the time of purchase.

The password is either "canon" or the printer serial number if it is specified.

Model whose administrator password is specified as "canon":

» The administrator password is specified as "canon" for the models below.
MG7500 series, MG6700 series, MG6600 series, MG5600 series
MG2900 series, MX490 series, MB5300 series, MB5000 series
MB2300 series, MB2000 series, E480 series, E460 series
iP110 series, iB4000 series, PRO-100S series, PRO-10S series
+ At the time of purchase, the user name "ADMIN" is also specified for the models above.
» The following character restrictions apply to the password that you change:
o Set the password by using 0 to 32 characters.
o The allowed characters are single-byte alphanumeric characters.

o For security reasons, we recommend you use 6 and more alphanumeric characters.

Model whose serial number is used as the administrator password:

» For the models other than the above, the printer serial number is used as the administrator password.

= \Where Serial Number Is Located

 The following character restrictions apply to the password that you change:
o Set the password by using 4 to 32 characters.
o The allowed characters are single-byte alphanumeric characters.

o For security reasons, we recommend you use 6 and more alphanumeric characters.

32 Important

* You can change the password using one of the tools below. (Some tools may not be available
depending on the printer you are using.)

 operation panel of the printer
* 1J Network Tool
+ printer information screen displayed on some Canon application software

« If the password has been changed while you are sharing the printer and you do not know the password,
ask the administrator of the printer you are using.

+ Set the password back to the default setting by initializing the printer settings.

For more on initializing the printer, search for "UG067" or "UG505" on your printer's Online Manual and
see the instructions shown.
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Authentication

Enter the password when the authentication screen is displayed.

= Administrator Password

You need to enter the user name as well as the password depending on the printer you are using. For more
on the user name, see the link above.

22 Important

* A message to warn you that the identification information is not verified may be displayed depending on
the printer you are using.

» For security reasons, we recommend you change the password.

»» Note

* Use an OS or web browser below to use Remote Ul.
+ iOS devices:
0OS:i0S 6.1 or later
Browser: Default browser of iOS device (Mobile Safari)
» Android devices:
OS: Android 2.3.3 or later
Browser: Default browser of Android device (browser or Chrome)
* Mac OS devices:
OS: Mac OS X v.10.6 or later
Browser: Safari 5.1 or later
* Windows devices:
OS: Windows XP or later

Browser: Internet Explorer 8 or later / Google Chrome 38.0.2125.104m or later / Mozilla Firefox
33.0 or later
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Where Serial Number Is Located

The printer serial number is printed on the sticker attached on the printer. It consists of 9 alphanumeric
characters (four alphabets followed by five numbers).

Example:

A

XXXX00000

»» Note

» The printer serial number is written on the warranty.

» Depending on the printer you are using, you can check the serial number by printing out the network
setting information of the printer. For more on printing, search for "NR044" on your printer's Online
Manual and see the instructions shown.

157



List of Function for Each Model

See below to check the models you can/cannot use the card slot via a network.

= MG series
= MX series / MB series / E series /| P series / iP series / iX series / iB series / PRO series / G series

MG series

Model name | Using the card slot via a network

MG7700 ser-
ies

MG7500 ser-
ies

MG7100 ser-
ies

MG6900 ser-
ies

MG6800 ser-
ies

MG6700 ser-
ies

MG6600 ser-
ies

MG6500 ser-
ies

MG6400 ser-
ies

MG5700 ser-
ies

No card slot

MG5600 ser-
ies

No card slot

MG5500 ser-
ies

No card slot

MG3600 ser-
ies

No card slot

MG3500 ser-

. No card slot
ies

MG2900 ser-
ies

No card slot

MG2500 ser-
ies

No card slot

MG2400 ser-
ies

No card slot
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MX series / MB series / E series / P series / iP series / iX series / iB series /
PRO series / G series

Model name | Using the card slot via a network
MX series No card slot
MB series No card slot
E series No card slot
P series No card slot
iP series No card slot
iX series No card slot
iB series No card slot
PRO series No card slot
G series No card slot
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Printing

Printing from Computer
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Printing from Computer
» Printing from Application Software (Windows Printer Driver)
» Printing from Application Software (Mac OS Printer Driver)

» Printing Using Canon Application Software

161



Printing from Application Software (Windows Printer Driver)

» Printing with Easy Setup

¥

Various Printing Methods

¥

Changing the Print Quality and Correcting Image Data

¥

Overview of the Printer Driver

¥

Printer Driver Description

¥

Updating the MP Drivers

¥

Sharing the Printer on a Network
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Printing with Easy Setup

This section describes the simple procedure for setting the Quick Setup tab so that you can carry out
appropriate printing on this printer.

1. Check that the printer is turned on

2. Load paper on the printer

3. Open the printer driver setup window

4. Select a frequently used profile

In Commonly Used Settings on the Quick Setup tab, select a printing profile suited for the purpose.
When you select a printing profile, the Additional Features, Media Type, and Printer Paper Size
settings are automatically switched to the values that were preset.
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5. Select the print quality

For Print Quality, select High, Standard, or Draft according to your purpose.
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= 3% Important

» The print quality settings that can be selected may differ depending on a printing profile.

6. Complete the setup
Click OK.

When you execute print, the document is printed with settings that match your purpose.
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3% Important

When you select the Always Print with Current Settings check box, all settings specified on the

Quick Setup, Main, and Page Setup tabs are saved, and you can print with the same settings from the
next time as well.

In the Commonly Used Settings window, click Save... to register the specified settings.
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Paper Settings on the Printer Driver

When you use this printer, selecting a media type that matches the print purpose will help you achieve the
best print results.
You can use the following media types on this printer.

Canon genuine papers (Document Printing)

Media name <Model No.> Media Type in the printer driver

Canon Red Label Superior <WOP111> Plain Paper

Canon Océ Office Colour Paper <SAT213> | Plain Paper

Canon genuine papers (Photo Printing)

Media name <Model No.> Media Type in the printer driver

Photo Paper Pro Luster <LU-101> Photo Paper Pro Luster

Photo Paper Plus Semi-gloss <SG-201> | Photo Paper Plus Semi-gloss

Photo Paper Glossy <GP-501/GP-601> | Glossy Photo Paper

Matte Photo Paper <MP-101> Matte Photo Paper

Canon genuine papers (Business Letter Printing)

Media name <Model No.> Media Type in the printer driver

High Resolution Paper <HR-101N> | High Resolution Paper

Canon genuine papers (Original Products)

Media name <Model No.> | Media Type in the printer driver

Photo Stickers <PS-101> | Glossy Photo Paper

Commercially available papers

Media name Media Type in the printer driver

Plain Paper (including recycled paper) | Plain Paper

Envelopes Envelope

Other Photo Paper Other Photo Paper
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Various Printing Methods
» Setting a Page Size and Orientation
» Setting the Number of Copies and Printing Order
» Setting the Stapling Margin
» Execute Borderless Printing
» Fit-to-Page Printing
» Scaled Printing
» Page Layout Printing
» Tiling/Poster Printing
» Booklet Printing
*» Duplex Printing
» Stamp/Background Printing
» Registering a Stamp
» Registering Image Data to be Used as a Background
» Setting Up Envelope Printing
» Displaying the Print Results before Printing
» Setting Paper Dimensions (Custom Size)

» Editing the Print Document or Reprinting from the Print History
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Setting a Page Size and Orientation

The paper size and orientation are essentially determined by the application software. When the page size
and orientation set for Page Size and Orientation on the Page Setup tab are same as those set with the
application software, you do not need to select them on the Page Setup tab.

When you are not able to specify them with the application software, the procedure for selecting a page size
and orientation is as follows:
You can also set page size and orientation on the Quick Setup tab.

1. Open the printer driver setup window

2. Select the paper size

Select a page size from the Page Size list on the Page Setup tab.
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3. Set Orientation

Select Portrait or Landscape for Orientation. Check Rotate 180 degrees check box when you want to
perform printing with the original being rotated 180 degrees.

4. Complete the setup

Click OK.
When you execute print, the document will be printed with the selected page size and the orientation.

»» Note

+ If Normal-size is selected for Page Layout, then Automatically reduce large document that the
printer cannot output is displayed.
Normally, you can leave the check box checked. During printing, if you do not want to reduce large
documents that cannot be printed on the printer, uncheck the check box.
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Setting the Number of Copies and Printing Order

The procedure for specifying the number of copies and printing order is as follows:
You can also set the number of copies on the Quick Setup tab.

1. Open the printer driver setup window

2. Specify the number of copies to be printed

For Copies on the Page Setup tab, specify the number of copies to be printed.
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3. Specify the print order

Check the Print from Last Page check box when you want to print from the last page in order, and
uncheck the check box when you want to print from the first page.

Check the Collate check box when you are printing multiple copies of a document and want to print out
all pages in each copy together. Uncheck this check box when you want to print all pages with the same
page number together.

* Print from Last Page: [ /Collate: [

A

* Print from Last Page: [l /Collate: [
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4. Complete the setup

Click OK.
When you execute print, the specified number of copies will be printed with the specified printing order.

32 Important

When the application software that you used to create the document has the same function, specify the
settings on the printer driver. However, if the print results are not acceptable, specify the function
settings on the application software. When you specify the number of copies and the printing order with
both the application software and this printer driver, the number of copies may be multiplied numbers of
the two settings or the specified printing order may not be enabled.

Print from Last Page appears grayed out and is unavailable when Tiling/Poster is selected for Page
Layout.

When Booklet is selected for Page Layout, Print from Last Page and Collate appear grayed out and
cannot be set.

When Duplex Printing (Manual) is selected, Print from Last Page appears grayed out and cannot be
set.

»» Note

By setting both Print from Last Page and Collate, you can perform printing so that papers are collated
one by one starting from the last page.

These settings can be used in combination with Normal-size, Borderless, Fit-to-Page, Scaled, and
Page Layout.
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Setting the Stapling Margin

The procedure for setting the staple side and the margin width is as follows:

1. Open the printer driver setup window

2. Specify the side to be stapled

Check the position of the stapling margin from Stapling Side on the Page Setup tab.
The printer analyzes the Orientation and Page Layout settings, and automatically selects the best

staple position. When you want to change the setting, select from the list.
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3. Set the margin width
If necessary, click Specify Margin... and set the margin width, and then click OK.
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»» Note

» The printer automatically reduces the print area depending on the staple position margin.

4. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the data is printed with the specified staple side and margin width.

22 Important

+ Stapling Side and Specify Margin... appear grayed out and are unavailable when:
» Borderless, Tiling/Poster, or Booklet is selected for Page Layout
+ Scaled is selected for Page Layout (When Duplex Printing (Manual) is also selected, only
Stapling Side can be specified.)
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Execute Borderless Printing

The borderless printing function allows you to print data without any margin by enlarging the data so that it
extends slightly off the paper. In standard printing, margins are created around the document area. However,
in borderless printing function, these margins are not created. When you want to print data such as a photo

without providing any margin around it, set borderless printing.

The procedure for performing borderless printing is as follows:

You can also set borderless printing in Additional Features on the Quick Setup tab.

Setting Borderless Printing

1. Open the printer driver setup window

2. Set borderless printing

Select Borderless from the Page Layout list on the Page Setup tab.
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Click OK when the confirmation message appears.
When a message prompting you to change the media type appears, select a media type from the list

and click OK.
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3. Check the paper size

Check the Page Size list. When you want to change it, select another page size from the list. The list
displays only sizes that can be used for borderless printing.

4. Adjust the amount of extension from the paper

If necessary, adjust the amount of extension using the Amount of Extension slider.
Moving the slider to the right increases the amount extending off the paper, and moving the slider to
the left decreases the amount.

It is recommended to set the slider at the second position from the right for most cases.

L&l 0 (8]

3% Important

+ When the Amount of Extension slider is set to the rightmost position, the back side of the
paper may become smudged.

5. Complete the setup

Click OK.
When you execute print, the data is printed without any margins on the paper.

3% Important

» When a page size that cannot be used for borderless printing is selected, the size is automatically
changed to the valid page sizes for borderless printing.

* When Borderless is selected, the Printer Paper Size, Duplex Printing (Manual), Stapling Side
settings, and the Stamp/Background... (Stamp...) button on the Page Setup tab appear grayed out
and are unavailable.

* When Envelope, or High Resolution Paper is selected from the Media Type list on the Main tab,
you cannot perform borderless printing.

» Depending on the type of the media used during borderless printing, the print quality may deteriorate
at the top and bottom of the sheet or stains may form.

* When the ratio of the height to the width differs from the image data, a portion of the image may not
be printed depending on the size of the media used.

In this case, crop the image data with an application software according to the paper size.

»>» Note

* When Plain Paper is selected for Media Type on the Main tab, borderless printing is not
recommended. Therefore, the message for media selection appears.
When you are using plain paper for test printing, select Plain Paper, and click OK.

Expanding the Range of the Document to Print

Setting a large amount of extension allows you to perform borderless printing with no problems. However,
the portion of the document extending off the paper range will not be printed and for this reason, the
subjects around the perimeter of a photo may not be printed.
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When you are not satisfied with the result of borderless printing, reduce the amount of extension. The
extension amount decreases as the Amount of Extension slider is moved to the left.

22 Important

» When the amount of extension is decreased, an unexpected margin may be produced on the print,
depending on the size of the paper.

»>» Note

* When the Amount of Extension slider is set to the leftmost position, image data will be printed in the
full size.

* When Preview before printing is checked on the Main tab, you can confirm whether there will be no
margin before printing.
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Fit-to-Page Printing
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The procedure for printing a document that is automatically enlarged or reduced to fit the page size to be
used is as follows:

1. Open the printer driver setup window

2. Set fit-to-page printing
Select Fit-to-Page from the Page Layout list on the Page Setup tab.
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3. Select the paper size of the document

Using Page Size, select the page size that is set with your application software.

4. Select the print paper size

Select the size of the paper loaded in the printer from the Printer Paper Size list.
When the Printer Paper Size is smaller than the Page Size, the page image will be reduced. When the
Printer Paper Size is larger than the Page Size, the page image will be enlarged.
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The current settings are displayed in the settings preview on the left side of the printer driver.
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5. Complete the setup

Click OK.
When you execute print, the document will be enlarged or reduced to fit to the page size.
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Scaled Printing
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The procedure for printing a document with pages enlarged or reduced is as follows:

1. Open the printer driver setup window

2. Set scaled printing
Select Scaled from the Page Layout list on the Page Setup tab.
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3. Select the paper size of the document

Using Page Size, select the page size that is set with your application software.

4. Set the scaling rate by using one of the following methods:

» Select a Printer Paper Size
When the printer paper size is smaller than the Page Size, the page image will be reduced. When
the printer paper size is larger than the Page Size, the page image will be enlarged.
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» Specify a scaling factor
Directly type in a value into the Scaling box.
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The current settings are displayed in the settings preview on the left side of the printer driver.

5. Complete the setup

Click OK.
When you execute print, the document will be printed with the specified scale.
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3% Important

* When the application software which you used to create the original has the scaled printing function,

configure the settings on your application software. You do not need to configure the same setting in the
printer driver.

»» Note

+ Selecting Scaled changes the printable area of the document.
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Page Layout Printing

The page layout printing function allows you to print more than one page image on a single sheet of paper.
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The procedure for performing page layout printing is as follows:

1. Open the printer driver setup window

2. Set page layout printing

Select Page Layout from the Page Layout list on the Page Setup tab.
The current settings are displayed in the settings preview on the left side of the printer driver.
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3. Select the print paper size

Select the size of the paper loaded in the printer from the Printer Paper Size list.

4. Set the number of pages to be printed on one sheet and the page order

If necessary, click Specify..., specify the following settings in the Page Layout Printing dialog box, and
click OK.
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Page Layout Printing x|
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To change the number of pages to be printed on a single sheet of paper, select the number of pages
from the list.
Page Order

To change the page arrangement order, select a placement method from the list.

Page Border
To print a page border around each document page, check this check box.

. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the specified number of pages will be arranged on each sheet of paper in the
specified order.
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Tiling/Poster Printing

The tiling/poster printing function allows you to enlarge image data, divide it into several pages, and print
these pages on separate sheets of paper. You can also paste the pages together to create a large print like
a poster.

The procedure for performing tiling/poster printing is as follows:
Setting Tiling/Poster Printing

1. Open the printer driver setup window

2. Set tiling/poster printing

Select Tiling/Poster from the Page Layout list on the Page Setup tab.
The current settings are displayed in the settings preview on the left side of the printer driver.
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3. Select the print paper size

Select the size of the paper loaded in the printer from the Printer Paper Size list.
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4. Set the number of image divisions and the pages to be printed

If necessary, click Specify..., specify the following settings in the Tiling/Poster Printing dialog box,
and then click OK.
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Image Divisions
Select the number of divisions (vertical x horizontal).
As the number of divisions increases, the number of sheets used for printing increases. If you are
pasting pages together to create a poster, increasing the number of divisions allows you to create
a larger poster.

Print "Cut/Paste” in margins
To leave out words "Cut" and "Paste", uncheck this check box.

»» Note

» This feature may be unavailable when certain printer drivers or operating environments are
used.

Print "Cut/Paste” lines in margins
To leave out cut lines, uncheck this check box.

Print page range
Specifies the printing range. Select All under normal circumstances.
To reprint only a specific page, select Pages and enter the page number you want to print. To
specify multiple pages, enter the page numbers by separating them with commas or by entering a
hyphen between the page numbers.

»» Note

* You can also specify the print range by clicking the pages in the settings preview.

5. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the document will be divided into several pages during printing.

Printing Only Specific Pages
If ink becomes faint or runs out during printing, you can reprint only the specific pages by following the

procedure below:

1. Set the print range
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In the settings preview on the left of the Page Setup tab, click the pages that do not need to be
printed.
The pages that were clicked are deleted, and only the pages to be printed are displayed.

| Guack Setp | Man | Fage S0 | Mantenance

B Pags Sgm Letter 8.5%11" 22780

4 Onentwion:  |A| # Porm A Dllangecsn
[ Retate 180 dagrans

O Frrc Poper Size: | Loter 851" 22x28m

Pags Lypouk:  Tiing /Poater

- O @ 9 & =

S L Bomsfess  FlecPage  Scled  Pogelmou [T

T ¥

B

Duplex, Prnting {kanual)
Lorg-sicls staplng el

: [ nesm
Fia b
P of| Prant o Lot Psgas
W Calatn

I | | Concel oy || e

23> Note

* Click the deleted pages to display them again.
» Right-click the settings preview to select Print all pages or Delete all pages.

2. Complete the setup

After completing the page selection, click OK.
When you execute print, only specified pages will be printed.

32 Important

+ Since tiling/poster printing enlarges the document when printing it, the print results may become coarse.
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Booklet Printing

The booklet printing function allows you to print data for a booklet. Data is printed on both sides of the paper.
This type of printing ensures that pages can be collated properly, in page number order, when the printed
sheets are folded and stapled at the center.

‘W

The procedure for performing booklet printing is as follows:

1. Open the printer driver setup window

2. Set booklet printing

Select Booklet from the Page Layout list on the Page Setup tab.
The current settings are displayed in the settings preview on the left side of the window.
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3. Select the print paper size

Select the size of the paper loaded in the printer from the Printer Paper Size list.

4. Set the margin for stapling and the margin width

Click Specify... and specify the following settings in the Booklet Printing dialog box, and then click OK.
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Booklet Printing
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Margin for stapling
Select which side should the stapling margin be on when the booklet is completed.

Insert blank page
To leave one side of a sheet blank, check the check box, and select the page to be left blank.

Margin
Enter the margin width. The specified width from the center of the sheet becomes the margin width
for one page.

Page Border
To print a page border around each document page, check the check box.

. Complete the setup

Click OK on the Page Setup tab.

When you execute print, the document will be printed on one side of a sheet of paper. When the printing
of one side is complete, set the paper correctly by following the message and click OK.

When the printing of the other side is complete, fold the paper at the center of the margin and make a

booklet.

22 Important

» Booklet cannot be selected when a media type other than Plain Paper is selected for Media Type on
the Main tab.

»» Note

» The stamp and background are not printed on the inserted blank sheets with the Insert blank page
function of booklet printing.
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Duplex Printing
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The procedure for printing data on both sides of one sheet of paper is as follows:
You can also set duplex printing in Additional Features on the Quick Setup tab.

1. Open the printer driver setup window

2. Set duplex printing

Check the Duplex Printing (Manual) check box on the Page Setup tab.
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3. Select the layout

Select Normal-size, Fit-to-Page, Scaled, or Page Layout from the Page Layout list.

4. Specify the side to be stapled

The best Stapling Side is selected automatically from the Orientation and Page Layout settings. To
change the setting, select another stapling side from the list.

5. Set the margin width

If necessary, click Specify Margin... and set the margin width, and then click OK.
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6. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the document is first printed on one side of a sheet of paper. After one side is

printed, reload the paper correctly according to the message.
Then click Start Printing to print the opposite side.

22 Important

* When a media type other than Plain Paper is selected from Media Type on the Main tab, Duplex

Printing (Manual) appears grayed out and is unavailable.
* When Borderless, Tiling/Poster or Booklet is selected from the Page Layout list, Duplex Printing

(Manual) and Stapling Side appear grayed out and are unavailable.

»» Note

« If the back side of the paper becomes smudged during duplex printing, perform Bottom Plate Cleaning
in the Maintenance tab.

Related Topics

= Cleaning Inside the Printer
= Changing the Printer Operation Mode
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Stamp/Background Printing

Stamp or Background may be unavailable when certain printer drivers or operating environments are used.

The Stamp function allows you to print a stamp text or a bitmap over or behind document data. It also
allows you to print date, time and user name. The Background function allows you to print a light illustration
behind the document data.

The procedure for performing stamp/background printing is as follows:

Printing a Stamp
"CONFIDENTIAL," "IMPORTANT," and other stamps that are used often in companies are pre-registered.

1. Open the printer driver setup window

2. Click Stamp/Background... (Stamp...) on the Page Setup tab
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»» Note

» With the XPS printer driver, the Stamp/Background... button has become the Stamp... button
and only the stamp function can be used.

3. Select a stamp

Check the Stamp check box, and select the stamp to be used from the list.
The current settings are displayed in the settings preview on the left side of the Page Setup tab.

4. Set the stamp details

If necessary, specify the following settings, and then click OK.

Define Stamp... button
To change the stamp text, bitmap, or position, click this.

Place stamp over text
To print the stamp on the front of the document, check this check box.

> Note

» The stamp is given priority because the stamp is printed over the document data in the
sections where the stamp and the document data overlap. When this check box is
unchecked, the stamp is printed behind the document data and may be hidden in the
overlapping sections depending on the application software used.

» Place stamp over text cannot be used when the XPS printer driver is used.

When the XPS printer driver is used, the stamp is normally printed in the foreground of the
document.

Print semitransparent stamp
Check this check box to print a semi-transparent stamp on the document.
This function is available only when the XPS printer driver is used.

Stamp first page only
To print the stamp only on the first page, check this check box.

5. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the data is printed with the specified stamp.

Printing a Background

Two bitmap files are pre-registered as samples.

1. Open the printer driver setup window

2. Click Stamp/Background... on the Page Setup tab

The Stamp/Background dialog box opens.

3. Select the background
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Check the Background check box, and select the background to be used from the list.
The current settings are displayed in the settings preview on the left side of the Page Setup tab.

4. Set the background details

If necessary, complete the following settings, and then click OK.

Select Background... button
To use another background or change the layout or density of a background, click this.

Background first page only
To print the background only on the first page, check this check box.

5. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the data is printed with the specified background.

32 Important

* When Borderless is selected, the Stamp/Background... (Stamp...) button appears grayed out and is
unavailable.

»» Note

* The stamp and background are not printed on blank sheets inserted with the Insert blank page
function of booklet printing.

Related Topics

= Registering a Stamp
= Registering Image Data to be Used as a Background
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Registering a Stamp

This feature may be unavailable when certain printer drivers or operating environments are used.

You can create and register a new stamp. You can also change and re-register some of the settings of an

existing stamp. Unnecessary stamps can be deleted at any time.

The procedure for registering a new stamp is as follows:

Registering a New Stamp

1. Open the printer driver setup window

2. Click Stamp/Background... (Stamp...) on the Page Setup tab
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3. Click Define Stamp...

The Stamp Settings dialog box opens.
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4. Configure the stamp while viewing the preview window

« Stamp tab

Select Text, Bitmap, or Date/Time/User Name that matches your purpose for Stamp Type.

o For Text registration, the characters must already be entered in Stamp Text. If necessary,
change the TrueType Font, Style, Size, and Outline settings. You can select the color of
the stamp by clicking Select Color....

> For Bitmap, click Select File... and select the bitmap file (.bmp) to be used. If necessary,
change the settings of the Size and Transparent white area.

o For Date/Time/User Name, the creation date/time and user name of the printed object are
displayed in Stamp Text. If necessary, change the settings of TrueType Font, Style, Size,
and Outline. You can select the color of the stamp by clicking Select Color....

22 Important

» Stamp Text appears grayed out and is unavailable when Date/Time/User Name is
selected.

* Placement tab

Select the stamp position from the Position list. You can also select Custom from the Position
list and specify coordinates for X-Position and Y-Position.

You can also change the stamp position by dragging the stamp in the preview window.

To change the stamp position angle, type a value in the Orientation box directly.

32 Important

« Orientation cannot be changed when Bitmap is selected for Stamp Type on the Stamp tab.

5. Save the stamp
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Click the Save settings tab and enter a title in the Title box, and then click Save.
Click OK when the confirmation message appears.

»» Note

» Spaces, tabs, and returns cannot be entered at the beginning or end of a title.

6. Complete the setup

Click OK. The Stamp/Background (Stamp) dialog box opens again.
The registered title appears in the Stamp list.

Changing and Registering Some of Stamp Settings

1. Select the stamp for which the settings are to be changed

Select the Stamp check box in the Stamp/Background (Stamp) dialog box. Then from the list, select
the title of the stamp to be changed.

2. Click Define Stamp...

The Stamp Settings dialog box opens.
3. Configure the stamp while viewing the preview window

4. Overwrite save the stamp

Click Save overwrite on the Save settings tab.
When you want to save the stamp with a different title, type a new title in the Title box and click Save.
Click OK when the confirmation message appears.

5. Complete the setup

Click OK. The Stamp/Background (Stamp) dialog box opens again.
The registered title appears in the Stamp list.

Deleting an Unnecessary Stamp

1. Click Define Stamp... in the Stamp/Background (Stamp) dialog box

The Stamp Settings dialog box opens.

2. Select the stamp to be deleted

Select the title of the stamp you want to delete from the Stamps list on the Save settings tab. Then
click Delete.
Click OK when the confirmation message appears.

3. Complete the setup

Click OK. The Stamp/Background (Stamp) dialog box opens again.
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Registering Image Data to be Used as a Background

This feature may be unavailable when certain printer drivers or operating environments are used.

You can select a bitmap file (.bmp) and register it as a new background. You can also change and register
some of the settings of an existing background. An unnecessary background can be deleted.

The procedure for registering image data to be used as a background is as follows:
Registering New Background

1. Open the printer driver setup window

2. Click Stamp/Background... on the Page Setup tab
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3. Click Select Background...

The Background Settings dialog box opens.
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4. Select the image data to be registered to the background

Click Select File.... Select the target bitmap file (.bmp), and then click Open.

5. Specify the following settings while viewing the preview window

Layout Method
Select how the background image data is to be placed.
When Custom is selected, you can set coordinates for X-Position and Y-Position.
You can also change the background position by dragging the image in the preview window.

Intensity
Set the intensity of the background image data with the Intensity slider. Moving the slider to the
right darkens the background, and moving the slider to the left lightens the background. To print
the background at the original bitmap intensity, move the slider to the rightmost position.

6. Save the background

Click the Save settings tab and enter a title in the Title box, and then click Save.
Click OK when the confirmation message appears.

»» Note

» Spaces, tabs, and returns cannot be entered at the beginning or end of a title.

7. Complete the setup

Click OK, then it returns to Stamp/Background dialog box.
The registered title appears in the Background list.

Changing and Registering Some Background Settings

1. Select the background for which the settings are to be changed
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Select the Background check box in the Stamp/Background dialog box. Then from the list, select
the title of the background you want to change.

2. Click Select Background...

The Background Settings dialog box opens.
3. Specify each item on the Background tab while viewing the preview window

4. Save the background

Click Save overwrite on the Save settings tab. When you want to save the background with a
different title, enter a new title in the Title box and click Save.
Click OK when the confirmation message appears.

5. Complete the setup

Click OK, then it returns to Stamp/Background dialog box.
The registered title appears in the Background list.

Deleting an Unnecessary Background

1. Click Select Background... in the Stamp/Background dialog box

The Background Settings dialog box opens.

2. Select the background to be deleted

Select the title of the background you want to delete from the Backgrounds list on the Save settings
tab, and then click Delete.
Click OK when the confirmation message appears.

3. Complete the setup

Click OK, then it returns to Stamp/Background dialog box.
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Setting Up Envelope Printing

The procedure for performing envelope printing is as follows:

1. Load envelope on the printer

2. Open the printer driver setup window

3. Select the media type

Select Envelope from Commonly Used Settings on the Quick Setup tab.
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4. Select the paper size

When the Envelope Size Setting dialog box is displayed, select Envelope Com 10, Envelope DL,
Yougata 4 4.13"x9.25", or Yougata 6 3.86"x7.48", and then click OK.

5. Set the orientation

To print the addressee horizontally, select Landscape for Orientation.

A

6. Select the print quality

Select High or Standard that matches your purpose for Print Quality.

7. Complete the setup
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Click OK.
When you execute print, the information is printed on the envelope.

32 Important

* When you execute envelope printing, guide messages are displayed.
To hide the guide messages, check the Do not show this message again check box.
To show the guide again, click the View Printer Status button on the Maintenance tab, and start the
Canon IJ Status Monitor.
Then click Envelope Printing from Display Guide Message of the Option menu to enable the setting.
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Displaying the Print Results before Printing

If you are using the XPS printer driver, replace "Canon IJ Preview" with "Canon IJ XPS Preview" when
reading this information.

You can display and check the print result before printing.

The procedure for displaying the print result before printing is as follows:

You can also set the print results display on the Quick Setup tab.

1. Open the printer driver setup window

2. Set the preview

Check the Preview before printing check box on the Main tab.
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3. Complete the setup
Click OK.
When you execute print, the Canon IJ Preview opens and displays the print results.
22 Important

+ In the Manual Color Adjustment dialog box, the Color Adjustment tab contains the Print a pattern
for color adjustment check box. When this check box is selected, the Preview before printing
appears grayed out and is unavailable.

Related Topic

= Canon |J Preview
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Setting Paper Dimensions (Custom Size)

You can specify the height and width of paper when its size cannot be selected from the Page Size. Such a
paper size is called "custom size."

The procedure for specifying a custom size is as follows:

You can also set a custom size in Printer Paper Size on the Quick Setup tab.

1. Open the printer driver setup window

2. Select the paper size

Select Custom... for Page Size on the Page Setup tab.
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3. Set the custom paper size

Specify Units, and enter the Width and Height of the paper to be used. Then click OK.

4. Complete the setup

Click OK on the Page Setup tab.
When you execute print, the data is printed with the specified paper size.
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3% Important

« If the application software that created the document has a function for specifying height and width
values, use the application software to set the values. If the application software does not have such a
function or if the document does not print correctly, perform the above procedure from the printer driver
to set the values.

 Printing may be disabled depending on the size of the specified user-defined media.

For information about printable sizes for user-defined media, see "Supported Media Types."
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Editing the Print Document or Reprinting from the Print History

This function is unavailable when the standard IJ printer driver is used.
In the Canon IJ XPS preview window, you can edit the print document or retrieve the document print history

to print the document.

The procedure for using the Canon IJ XPS Preview is as follows:
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» By clicking l% View Thumbnails, you can display or hide thumbnails of the print documents selected
in the Document Name list.

* Clicking 3 Undo reverses the change that just performed.
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Editing and Printing a Print Document

When printing multiple documents or pages, you can combine documents, change the print sequence of
the documents or pages, or delete documents or pages.

1. Open the printer driver setup window

2. Set the preview

Check the Preview before printing check box on the Main tab.

3. Complete the setup

Click OK.
The Canon IJ XPS Preview will start and the print result will be displayed before printing.

4. Editing print documents and print pages

Combining print documents

You can combine multiple print documents to form a single document. By combining print
documents, you can prevent blank pages from being inserted when you execute duplex printing
or page layout printing.

From the Document Name list, select the documents to be combined. On the Edit menu, select
Combine Documents from Documents to combine the documents in the listed sequence.

To select multiple print documents, hold down the Ctrl key and click the documents to be
merged, or hold down the Shift key and press the upper arrow or lower arrow key. You can also
click a blank area in the document list and drag the mouse to select multiple documents.

When you combine documents, the documents selected before the combining are deleted from
the list and the combined document is added to the list.

Changing the sequence of print documents or print pages

> To change the sequence of the print documents, go to the Document Name list, and select
the print document to be moved. Next, on the Edit menu, select Move Document from
Documents, and select the appropriate item. You can also click and drag a print document
to change the print sequence.

> To change the sequence of the print pages, click View Thumbnails from the Option menu,
and select the print page to be moved. Next, on the Edit menu, select Move Page from
Pages, and select the appropriate item. You can also click and drag a print page to change
the print sequence.

Deleting print documents and print pages

o To delete a print document, select the target document from the Document Name list, and
on the Edit menu, choose Documents and then Delete Document.

> To delete a print page, click View Thumbnails from the Option menu, and select the print
page to be deleted. Next, on the Edit menu, select Delete Page from Pages.

Print page recovery

You can recover pages that were deleted with Delete Page.
To recover pages, select the View Deleted Pages check box from the Option menu, and select
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the pages to be recovered from among the displayed thumbnail pages. Then from the Edit menu
chose Pages and then Restore Page.

After editing the print documents or print pages, you can change the print settings on the Page
Information, Layout and Manual Color Adjustment tabs as necessary.

32 Important

» To display the multiple documents in the list, open the preview and execute print again.

« To return the print documents to their original condition before they were edited in the preview,
on the Edit menu, select Reset Documents from Documents.

« If the documents to be combined have different print settings, a message may be displayed.
Check the contents of the displayed message before combining the documents.

« |If the documents to be combined have different output paper sizes and duplex printing or page
layout printing is to be performed, the printer may not produce the expected print results for
certain print pages.

Check the preview before printing.

» Depending on the print settings of the print document, some functions may not be available in

the Canon IJ XPS preview.

»» Note

* You can rename Document Name to any name.

5. Executing print

Click Print.
When you execute print, the printer uses the specified settings to print the data.

Reprinting from the Print History

When you click Save Print History on the File menu to enable the setting, the document printed from the
preview is saved, and you can reprint the document with the same settings.

1. Displaying the print history

Open the printer driver setup window. Then on the Maintenance tab, select View Print History.
The saved print document is displayed in the preview.

32 Important

+ To limit the number of print history registrations, click History Entry Limit on the File menu.
« If the limit on the number of registration is exceeded, the print history registrations are deleted
starting from the oldest one.

2. Selecting a print document

From the Document Name list, select the document to be printed.

3. Executing print
Click Print.
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Related Topic

= Displaying the Print Results before Printing
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Changing the Print Quality and Correcting Image Data
» Setting the Print Quality Level (Custom)
» Printing a Color Document in Monochrome
» Specifying Color Correction
» Optimal Photo Printing of Image Data
» Adjusting Colors with the Printer Driver
» Printing with ICC Profiles
» Adjusting Color Balance
» Adjusting Color Balance Using Sample Patterns (Printer Driver)
» Adjusting Brightness
» Adjusting Intensity
» Adjusting Contrast

» Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)
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Setting the Print Quality Level (Custom)

The print quality level can be set in the Custom.

The procedure for setting the print quality level is as follows:

1. Open the printer driver setup window

2. Select the print quality

On the Main tab, select Custom for Print Quality, and click Set....
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3. Setting the print quality level

Drag the slider bar to select the print quality level and click OK.

4. Complete the setup

Click OK on the Main tab.
When you execute print, the image data is printed with the selected print quality level.

22 Important

+ Certain print quality levels cannot be selected depending on the settings of Media Type.
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Related Topics

= Specifying Color Correction
= Adjusting Color Balance

= Adjusting Brightness

= Adjusting Intensity

= Adjusting Contrast
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Printing a Color Document in Monochrome

The procedure for printing a color document in monochrome is as follows:

You can also set a grayscale printing in Additional Features on the Quick Setup tab.

1. Open the printer driver setup window

2. Set grayscale printing

Check the Grayscale Printing check box on the Main tab.
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3. Complete the setup

Click OK.
When you execute print, the document is converted to grayscale data. It allows you to print the color
document in monochrome.

32 Important

* When the Grayscale Printing check box is checked, the printer driver processes image data as sRGB
data. In this case, actual colors printed may differ from those in the original image data.
When using the grayscale printing function to print Adobe RGB data, convert the data to sSRGB data
using an application software.
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»» Note

» During Grayscale Printing, inks other than black ink may be used as well.
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Specifying Color Correction

You can specify the color correction method suited to the type of document to be printed.
Normally, the printer driver adjusts the colors by using Canon Digital Photo Color so that data is printed with
color tints that most people prefer. This method is suitable for printing sRGB data.

When you want to print by using the color space (sRGB) of the image data effectively, select ICM (ICC
Profile Matching). When you want to use an application software to specify a printing ICC profile, select
None.

The procedure for specifying color correction is as follows:

You can also set color correction on the Quick Setup tab by choosing Photo Printing under Commonly
Used Settings, and then choosing Color/Intensity Manual Adjustment under Additional Features.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....
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The Manual Color Adjustment dialog box opens.

3. Select color correction

Click Matching tab, select Color Correction setting that matches your purpose from the following, and
click OK.
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Driver Matching
With Canon Digital Photo Color, you can print sSRGB data with color tints that most people prefer.

ICM (ICC Profile Matching)
Adjusts the colors by using an ICC profile when printing.
Specify the input profile to be used.

None
The printer driver does not perform color correction. Select this value when you are specifying an
individually created printing ICC profile in an application software to print data.

4. Complete the setup

Click OK on the Main tab.
When you execute print, the document data is printed with the specified color correction.

3% Important

» When ICM is disabled in the application software, ICM is unavailable for Color Correction and the
printer may not be able to print the image data properly.

* When the Grayscale Printing check box on the Main tab is checked, Color Correction appears
grayed out and is unavailable.

Related Topics

= Optimal Photo Printing of Image Data
= Adjusting Colors with the Printer Driver
= Printing with ICC Profiles
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Optimal Photo Printing of Image Data

When people print images taken with digital cameras, they sometimes feel that the printed color tones differ
from those of actual image or those displayed on the monitor.

To get the print results as close as possible to the desired color tones, you must select a printing method
that is best suited to the application software used or to your purpose.

Color Management

Devices such as digital cameras, scanners, monitors, and printers handle color differently. Color
management (color matching) is a method that manages device-dependent "colors" as a common color
space.

For Windows, a color management system called "ICM" is built into the operating system.
sRGB is one of the common color spaces that is frequently used.

ICC profiles convert device-dependent "colors" into a common color space. By using an ICC profile and
carrying out color management, you can draw out the color space of the image data within the color
reproduction area that the printer can express.

Selecting a Printing Method Suited to the Image Data

The recommended printing method depends on the color space (sRGB) of the image data or the
application software to be used.

There are two typical printing methods.
Check the color space (sRGB) of the image data and the application software to be used, and then select
the printing method suited to your purpose.

Adjusting Colors with the Printer Driver
Describes the procedure for printing sRGB data by using the color correction function of the printer
driver.
* To print using Canon Digital Photo Color

The printer prints data with color tints that most people prefer, reproducing colors of the original
image data and producing three-dimensional effects and high, sharp contrasts.
+ To print by directly applying editing and touch-up results of an application software

When printing the data, the printer brings out subtle color difference between dark and light
areas, while leaving the darkest and lightest areas intact.

When printing the data, the printer applies fine adjustment results, such as brightness
adjustments made with an application software.

Printing with ICC Profiles
Describes the procedure for printing by using the color space of sRGB effectively.
You can print with a common color space by setting up the application software and the printer driver
so that the color management matches the input ICC profile of the image data.
The method for setting up the printer driver differs depending on the application software to be used.
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Adjusting Colors with the Printer Driver

You can specify the color correction function of the printer driver to print SRGB data with color tints that most
people prefer through the use of Canon Digital Photo Color.

When printing from an application software that can identify ICC profiles and allows you to specify them, use
a printing ICC profile in the application software, and select settings for color management.

The procedure for adjusting colors with the printer driver is as follows:

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....
The Manual Color Adjustment dialog box opens.

3. Select color correction

Click Matching tab, and select Driver Matching for Color Correction.

Manual Color Adjustment ﬂ
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4. Set the other items

If necessary, click Color Adjustment tab, and adjust the color balance (Cyan, Magenta, Yellow) and
adjust Brightness, Intensity, and Contrast settings, and then click OK.

5. Complete the setup

Click OK on the Main tab.
When you execute print, the printer driver adjusts the colors when printing the data.

Related Topics

= Setting the Print Quality Level (Custom)
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= Specifying Color Correction

= Adjusting Color Balance
= Adjusting Brightness

= Adjusting Intensity

= Adjusting Contrast
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Printing with ICC Profiles

When the image data has a specified input ICC profile, you can print by using the color space (sRGB) of the
data effectively.

The printer driver setting procedure varies depending on the application software used to print.

Specify an ICC Profile from the Application Software and Print the Data

When you print the editing and touch-up results of Adobe Photoshop, Canon Digital Photo Professional,
or any application software that allows you to specify input and printing ICC profiles, you print by
effectively using the color space of the input ICC profile specified in the image data.

To use this printing method, use your application software to select color management items and specify
an input ICC profile and a printing ICC profile in the image data.

Even if you print using a printing ICC profile that you created yourself from your application software, be
sure to select color management items from your application software.

For instructions, refer to the manual of the application software you are using.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....
The Manual Color Adjustment dialog box opens.

3. Select color correction

Click Matching tab, and select None for Color Correction.

Manual Color Adjustment
Color Adsingrt | Matching
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4. Set the other items
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If necessary, click Color Adjustment tab, and adjust the color balance (Cyan, Magenta, Yellow) and
adjust Brightness, Intensity, and Contrast settings, and then click OK.

5. Complete the setup

Click OK on the Main tab.

When you execute print, the printer uses the color space of the image data.
Specify an ICC Profile with the Printer Driver, and then Print

Print from an application software that cannot identify input ICC profiles or does allow you to specify one
by using the color space of the input ICC profile (sRGB) found in the data.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....
The Manual Color Adjustment dialog box opens.

3. Select color correction

Click Matching tab, and select ICM (ICC Profile Matching) for Color Correction.
Manual Cofor Adjustment
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4. For Input Profile, select Standard.
32 Important

» When the application software specifies an input profile, the input profile setting of the printer
driver becomes invalid.

5. Set the other items
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If necessary, click Color Adjustment tab, and adjust Cyan, Magenta, Yellow, Brightness, Intensity,
and Contrast settings, and then click OK.

6. Complete the setup

Click OK on the Main tab.
When you execute print, the printer uses the color space of the image data.

Related Topics

= Setting the Print Quality Level (Custom)
= Specifying Color Correction

= Adjusting Color Balance

= Adjusting Brightness
=
[

Adjusting Intensity
Adjusting Contrast
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Adjusting Color Balance

You can adjust the color tints when printing.

Since this function adjusts color balance of the output by changing the ink ratios of each color, it changes
the total color balance of the document. Use the application software when you want to change the color
balance significantly. Use the printer driver only when you want to adjust the color balance slightly.

The following sample shows the case when color balance is used to intensify cyan and to diminish yellow so
that the overall colors are more uniform.

"

No adjustment  Adjust color balance

The procedure for adjusting color balance is as follows:

You can also set color balance on the Quick Setup tab by choosing Photo Printing under Commonly
Used Settings, and then choosing Color/Intensity Manual Adjustment under Additional Features.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....

series Printer Printing Preferences

The Manual Color Adjustment dialog box opens.
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3. Adjust color balance

There are individual sliders for Cyan, Magenta, and Yellow. Each color becomes stronger when the
corresponding slider is moved to the right, and becomes weaker when the corresponding slider is moved
to the left. For example, when cyan becomes weaker, the color red becomes stronger.

You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. The
current settings are displayed in the settings preview on the left side of the printer driver.

After adjusting each color, click OK.
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4. Complete the setup

Click OK on the Main tab.
When you execute print, the document is printed with the adjusted color balance.

22 Important

» When the Grayscale Printing check box on the Main tab is checked, the color balance (Cyan,
Magenta, Yellow) appear grayed out and are unavailable.

Related Topics

Setting the Print Quality Level (Custom)

Specifying Color Correction

Adjusting Color Balance Using Sample Patterns (Printer Driver)
Adjusting Brightness

Adjusting Intensity

Adjusting Contrast

Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)

L 2R 2R 2R B 2R 2
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Adjusting Color Balance Using Sample Patterns (Printer Driver)

You can look at the print results of pattern print and adjust the color balance.
When you change the color balance or intensity/contrast of a document, the pattern print function prints the
adjustment results in a list, together with the adjustment values.

Described below is the procedure for adjusting the color balance while looking at the pattern.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....
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The Manual Color Adjustment dialog box opens.

3. Selecting pattern print

On the Color Adjustment tab, select the Print a pattern for color adjustment check box, and click
Pattern Print preferences....

223



&% ABCDEF
£ 1234567

Serrgin Tyga
Rendand w|

[C] Wpesw Cnbor Pattem

(o] Pracd o ot o sk ncpssiriard

4. Setting pattern print
When the Pattern Print dialog box opens, set the following items, and then click OK.
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Parameters to Adjust
Select Cyan/Magenta/Yellow.
32 Important

» When the Grayscale Printing check box on the Main tab is checked, Cyan/Magenta/Yellow
appear grayed out and are unavailable.

Printer Paper Size
Select the paper size to be used for pattern printing.

23> Note

» Depending on the paper size selected on the Page Setup tab, there may be sizes that cannot
be selected.

Amount of Pattern Instances
Select Largest, Large, or Small to set the number of patterns to be printed.

23> Note

» Largest and Large cannot be selected when certain paper sizes or output paper sizes are
selected.
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Color Variation Between Instances
Set the amount of color change between neighboring patterns.

»» Note

* Large is about double the size of Medium, and Small is about half the size of Medium.

5. Checking the print results of pattern print

On the Color Adjustment tab, select OK to close the Manual Color Adjustment dialog box.
On the Main tab, select OK, and then execute printing. The printer then prints a pattern in which the
color balance that you set is the center value.

[T

Beghirma _Horrel imierady -0 Coriees 0
Cn Tyt W = Mageres ¥ = Tilow

6. Adjusting the color balance

Look at the print results and select the image that you like best. Then enter the color balance numbers
indicated at the bottom of that image into the Cyan, Magenta, and Yellow fields on the Color
Adjustment tab.

Clear the Print a pattern for color adjustment check box, and click OK.
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* You can also set color balance on the Quick Setup tab by choosing Photo Printing under
Commonly Used Settings, and then choosing Color/intensity Manual Adjustment under
Additional Features.

7. Complete the setup

Click OK on the Main tab.
Then when you execute printing, the document is printed with the color balance that was adjusted by the
pattern print function.

32 Important

* When Print a pattern for color adjustment is selected on the Color Adjustment tab, the following
items are grayed out and cannot be set:
» Preview before printing on the Main tab
+ Stapling Side and Specify Margin... on the Page Setup tab (When Duplex Printing (Manual) is
set, only Stapling Side can be set.)

* You can print a pattern only if the Page Layout setting on the Page Setup tab is Normal-size or
Borderless.

* When the Grayscale Printing check box on the Main tab is checked, Cyan, Magenta, and Yellow
appear grayed out and are unavailable.

» Depending on your application software, this function may not be available.

Related Topics

= Adjusting Color Balance

= Adjusting Intensity

= Adjusting Contrast

= Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)
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Adjusting Brightness

You can change the brightness of the overall image data during printing.

This function does not change pure white or pure black but it changes the brightness of the intermediate
colors.

The following sample shows the print result when the brightness setting is changed.

Light is selected Normal is selected Dark is selected

The procedure for adjusting brightness is as follows:

You can also set brightness on the Quick Setup tab by choosing Photo Printing under Commonly Used
Settings, and then choosing Color/intensity Manual Adjustment under Additional Features.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....
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The Manual Color Adjustment dialog box opens.

3. Specify the brightness
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Select Light, Normal, or Dark for Brightness, and click OK. The current settings are displayed in the
settings preview on the left side of the printer driver.
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4. Complete the setup

Click OK on the Main tab.
When you execute print, the data is printed at the specified brightness.

Related Topics

= Setting the Print Quality Level (Custom)
= Specifying Color Correction

= Adjusting Color Balance

= Adjusting Intensity

= Adjusting Contrast
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Adjusting Intensity

You can dilute (brighten) or intensify (darken) the colors of the overall image data during printing.
The following sample shows the case when the intensity is increased so that all colors become more intense
when the image data is printed.

No adjustment Higher intensity

The procedure for adjusting intensity is as follows:

You can also set intensity on the Quick Setup tab by choosing Photo Printing under Commonly Used
Settings, and then choosing Color/Intensity Manual Adjustment under Additional Features.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....
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The Manual Color Adjustment dialog box opens.

3. Adjust intensity

Moving the Intensity slider to the right intensifies (darkens) the colors, and moving the slider to the left
dilutes (brightens) the colors.
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You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. The
current settings are displayed in the settings preview on the left side of the printer driver.

After adjusting each color, click OK.
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4. Complete the setup

Click OK on the Main tab.
When you execute print, the image data is printed with the adjusted intensity.

Related Topics

Setting the Print Quality Level (Custom)

Specifying Color Correction

Adjusting Color Balance

Adjusting Color Balance Using Sample Patterns (Printer Driver)
Adjusting Brightness

Adjusting Contrast

Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)

LR 2R 3E 2 2R B
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Adjusting Contrast

You can adjust the image contrast during printing.

To make the differences between the light and dark portions of images greater and more distinct, increase
the contrast. On the other hand, to make the differences between the light and dark portions of images
smaller and less distinct, reduce the contrast.

No adjustment Adjust the contrast

The procedure for adjusting contrast is as follows:

You can also set contrast on the Quick Setup tab by choosing Photo Printing under Commonly Used
Settings, and then choosing Color/intensity Manual Adjustment under Additional Features.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....

Plar Paper
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The Manual Color Adjustment dialog box opens.

3. Adjust the contrast
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Moving the Contrast slider to the right increases the contrast, and moving the slider to the left decreases
the contrast.

You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. The
current settings are displayed in the settings preview on the left side of the printer driver.

After adjusting each color, click OK.
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4. Complete the setup

Click OK on the Main tab.
When you execute print, the image is printed with the adjusted contrast.

Related Topics

Setting the Print Quality Level (Custom)

Specifying Color Correction

Adjusting Color Balance

Adjusting Color Balance Using Sample Patterns (Printer Driver)
Adjusting Brightness

Adjusting Intensity

Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)
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Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)

You can look at the print results of pattern print and adjust the intensity/contrast.
When you change the color balance or intensity/contrast of a document, the pattern print function prints the
adjustment results in a list, together with the adjustment values.

Described below is the procedure for adjusting the intensity/contrast while looking at the pattern.

1. Open the printer driver setup window

2. Select the manual color adjustment

On the Main tab, select Manual for Color/Intensity, and click Set....
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The Manual Color Adjustment dialog box opens.

3. Selecting pattern print

On the Color Adjustment tab, select the Print a pattern for color adjustment check box, and click
Pattern Print preferences....
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4. Setting pattern print

When the Pattern Print dialog box opens, set the following items, and then click OK.
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Parameters to Adjust
Select Intensity/Contrast.

Printer Paper Size
Select the paper size to be used for pattern printing.

23> Note

» Depending on the paper size selected on the Page Setup tab, there may be sizes that cannot
be selected.

Amount of Pattern Instances
Select Largest, Large, or Small to set the number of patterns to be printed.

23> Note

 Largest and Large cannot be selected when certain paper sizes or output paper sizes are
selected.

Color Variation Between Instances
Set the amount of color change between neighboring patterns.

23> Note

» Large is about double the size of Medium, and Small is about half the size of Medium.
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5. Checking the print results of pattern print

On the Color Adjustment tab, select OK to close the Manual Color Adjustment dialog box.
On the Main tab, select OK, and then execute printing. The printer then prints a pattern in which the
intensity/contrast that you set is the center value.

bk

830 1D

[

B0 B0 W [T

¢ J

IF
IE
1

[T

_

EE
4 4

H

ks
E

Ra ks

R CRET="]

&
-
&

A
f

LEs ]

kot ypom - Pt P P (o § Cpae 0 Sagends:d el 0
Prot Gy St T Momal [ = ety = Conmmat

6. Adjusting the intensity/contrast

Look at the print results and select the image that you like best. Then enter the intensity/contrast
numbers indicated at the bottom of that image into the Intensity and Contrast fields on the Color
Adjustment tab.

Clear the Print a pattern for color adjustment check box, and click OK.
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> Note

* You can also set intensity/contrast on the Quick Setup tab by choosing Photo Printing under
Commonly Used Settings, and then choosing Color/intensity Manual Adjustment under

Additional Features.

7. Complete the setup

Click OK on the Main tab.

Then when you execute printing, the document is printed with the intensity/contrast that was adjusted by

the pattern print function.

32 Important

* When Print a pattern for color adjustment is selected on the Color Adjustment tab, the following

items are grayed out and cannot be set:
» Preview before printing on the Main tab

+ Stapling Side and Specify Margin... on the Page Setup tab (When Duplex Printing (Manual) is
set, only Stapling Side can be set.

* You can print a pattern only if the Page Layout setting on the Page Setup tab is Normal-size or

Borderless.

» Depending on your application software, this function may not be available.

)

Related Topics

= Adjusting Color Balance

= Adjusting Color Balance Using Sample Patterns (Printer Driver)

= Adjusting Intensity
= Adjusting Contrast
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Overview of the Printer Driver
» Canon IJ Printer Driver

» How to Open the Printer Driver Setup Window

¥

Canon IJ Status Monitor

¥

Canon IJ Preview

¥

Deleting the Undesired Print Job

¥

Instructions for Use (Printer Driver)
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Canon |IJ Printer Driver

The Canon IJ printer driver (called printer driver below) is a software that is installed on your computer for
printing data with this printer.

The printer driver converts the print data created by your application software into data that your printer can
understand, and sends the converted data to the printer.

Because different models support different print data formats, you need a printer driver for the specific model
you are using.

Printer Driver Types

On Windows Vista SP1 or later, you can install the XPS printer driver in addition to the regular printer
driver.
The XPS printer driver is suited to print from an application software that supports XPS printing.

2% Important

» To use the XPS printer driver, the standard printer driver must already be installed on your computer.

Installing the Printer Driver

 To install the regular printer driver, load the Setup CD-ROM that comes with the printer, and then
install the driver from Start Setup Again.

* To install the XPS printer driver, load the Setup CD-ROM that comes with the printer, and then select
XPS Driver from Add Software.

Specifying the Printer Driver

To specify the printer driver, open the Print dialog box of the application software you are using, and
select "XXX Printer" (where "XXX" is your model name) to specify the regular printer driver or select "XXX
Printer XPS" (where "XXX" is your model name) to specify the XPS printer driver.

Displaying the Manual from the Printer Driver

To display a description of a tab in the printer driver setup window, click the Help button found on the tab.

Related Topic

= How to Open the Printer Driver Setup Window
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How to Open the Printer Driver Setup Window

You can display the printer driver setup window from the application software in use or from the printer icon.

Open the Printer Driver Setup Window through the Application Software

Follow the procedure below to configure printing profile when printing.

1. Select the command that you perform printing on the application software

In general, select Print on the File menu to open the Print dialog box.

2. Select your model name and click Preferences (or Properties)

The printer driver setup window appears.

»» Note

» Depending on application software you use, command names or menu names may vary and
there may be more steps. For details, refer to the user's manual of your application software.

Opening the Printer Driver Setup Window from the Printer Icon

Follow the procedure below to perform printer maintenance operations such as print head cleaning, or to
configure a printing profile that is common to all application software.

1. Select as described below:

« If you are using Windows 10, Windows 8.1, or Windows 8, select Control Panel -> Hardware
and Sound -> Devices and Printers.

* If you are using Windows 7, select the Start menu -> Devices and Printers.

* If you are using Windows Vista, select the Control Panel -> Hardware and Sound -> Printers.

« If you are using Windows XP, select the Control Panel -> Printers and Other Hardware ->
Printers and Faxes.

2. Right-click your model name icon, and then select Printing preferences from the
displayed menu

The printer driver setup window appears.

22 Important

» Opening the printer driver setup window through Printer properties (Windows 10, Windows
8.1, Windows 8, Windows 7) or Properties (Windows Vista, Windows XP) displays such tabs
regarding the Windows functions as the Ports (or Advanced) tab. Those tabs do not appear
when opening through Printing preferences or application software. For tabs regarding
Windows functions, refer to the user's manual for the Windows.
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Canon IJ Status Monitor

The Canon IJ Status Monitor is an application software that shows the status of the printer and the progress
of printing. You will know the status of the printer with graphics, icons, and messages.

Launching the Canon IJ Status Monitor

The Canon IJ Status Monitor launches automatically when print data is sent to the printer. When
launched, the Canon IJ Status Monitor appears as a button on the task bar.
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23> Note

» To open the Canon IJ Status Monitor when the printer is not printing, open the printer driver setup
window and click View Printer Status on the Maintenance tab.

» The information displayed on the Canon IJ Status Monitor may differ depending on the country or
region where you are using your printer.

When Errors Occur

The Canon IJ Status Monitor is automatically displayed if an error occurs (e.g., if the printer runs out of
paper or if the ink is low).

1. Laad paper s the fes iy, 2. Press the pintes Stes
bugion.

T Erex Pocusts

In such cases, take the appropriate action as described.
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Canon |IJ Preview

The Canon IJ Preview is an application software that displays what the print result will look like before a
document is actually printed.

The preview reflects the information that is set within the printer driver and allows you to check the
document layout, print order, and number of pages. You can also change the media type settings.

When you want to display a preview before printing, open the printer driver setup window, click the Main
tab, and check the Preview before printing check box.

When you do not want to display a preview before printing, uncheck the check box.

22 Important

+ If you are using the XPS printer driver, see "Editing the Print Document or Reprinting from the Print
History."

Related Topic

= Displaying the Print Results before Printing
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Deleting the Undesired Print Job

If you are using the XPS printer driver, replace "Canon |J Status Monitor" with "Canon IJ XPS Status
Monitor" when reading this information.

If the printer does not start printing, canceled or failed print job data may be remaining.
Delete the undesired print job by using the Canon IJ Status Monitor.

1. Display the Canon IJ Status Monitor

Click the icon of the Canon |J Status Monitor displayed on the task bar.
The Canon |J Status Monitor appears.

2. Display the print jobs

Click Display Print Queue.
The print queue window opens.

3. Delete the print jobs

Select Cancel All Documents from the Printer menu.
When the confirmation message appears, click Yes.

The deletion of the print job is complete.

22 Important

» Users who have not been granted access permission for printer management cannot delete the print
job of another user.

»» Note

* When you perform this operation, all print jobs are deleted. If the print queue list contained a necessary
print job, start the printing process over from the beginning.
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Instructions for Use (Printer Driver)

This printer driver is subject to the following restrictions. Keep the following points in mind when using the
printer driver.

Restrictions on the Printer Driver

» With some applications, the Copies setting in the Page Setup tab of the printer driver may not be
enabled.
In this case, use the copies setting in the Print dialog box of the application software.
« If the selected Language in the About dialog box of the Maintenance tab does not match the
operating system interface language, the printer driver setup window may not be displayed properly.
» Do not change the Advanced tab items of the printer properties. If you change any of the items, you
will not be able to use the following functions correctly.
Also, if Print to file is selected in the Print dialog box of the application software and with applications
that prohibit EMF spooling, such as Adobe Photoshop LE and MS Photo Editor, the following
functions will not operate.
> Preview before printing on the Main tab
> Prevention of Print Data Loss in the Print Options dialog box on the Page Setup tab
o Page Layout, Tiling/Poster, Booklet, Duplex Printing (Manual), Specify Margin..., Print from
Last Page, Collate, and Stamp/Background... (Stamp...) on the Page Setup tab
o Print a pattern for color adjustment on the Color Adjustment tab in the Manual Color
Adjustment dialog box

» Since the resolution in the preview display differs from the printing resolution, text and lines in the
preview display may appear different from the actual print result.

* With some applications, the printing is divided into multiple print jobs.
To cancel printing, delete all divided print jobs.

« If image data is not printed correctly, display the Print Options dialog box from the Page Setup tab
and change the setting of Disable ICM required from the application software. This may solve the
problem.

> Note

» Disable ICM required from the application software cannot be used when the XPS printer
driver is used.

Points to Note About Applications with Restrictions

 There are following restrictions in Microsoft Word (Microsoft Corporation).
o When Microsoft Word has the same printing functions as the printer driver, use Word to specify
them.
o When Fit-to-Page, Scaled, or Page Layout is used for Page Layout on the Page Setup tab of
the printer driver, the document may not print normally in certain versions of Word.
o When Page Size in Word is set to "XXX Enlarge/Reduce", the document may not print normally in
certain versions of Word.
If this happens, follow the procedure below.
1. Open Word's Print dialog box.
2. Open the printer driver setup window, and on the Page Setup tab, set Page Size to the same
paper size that you specified in Word.
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Set the Page Layout that you want, and then click OK to close the window.
Without starting printing, close the Print dialog box.

Open Word's Print dialog box again.

Open the printer driver setup window and click OK.

7. Start printing.

o g R

« If bitmap printing is enabled in Adobe lllustrator (Adobe Systems Incorporated), printing may take time
or some data may not be printed. Print after unchecking the Bitmap Printing check box in the Print
dialog box.
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Quick Setup tab Description

The Quick Setup tab is for registering commonly used print settings. When you select a registered setting,
the printer automatically switches to the preset items.
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Commonly Used Settings

The names and icons of frequently used printing profiles are registered. When you select a printing
profile according to the purpose of the document, settings that match the purpose are applied.
In addition, functions that are thought to be useful for the selected printing profile are displayed in
Additional Features.
You can also change a printing profile and register it under a new name. You can delete the registered
printing profile.
You can rearrange the profiles either by dragging the individual profiles or by holding down the Ctrl key
and pressing the up or down arrow keys.
Standard
These are the factory settings.
If Page Size, Orientation, and Copies were set from the application software, those settings have
priority.

Photo Printing
If you select this setting when printing a photo, the photo paper and photo size generally used are
set. The Borderless Printing check box is checked automatically.
If Orientation and Copies were set from the application software, those settings have priority.

Business Document
Select this setting when printing a general document.
If Page Size, Orientation, and Copies were set from the application software, those settings have
priority.

Paper Saving
Select this setting to save paper when printing a general document. The 2-on-1 Printing and
Duplex Printing (Manual) check boxes are checked automatically.
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If Page Size, Orientation, and Copies were set from the application software, those settings have
priority.

Envelope
If you select this setting for printing an envelope, Media Type is set automatically to Envelope. In
the Envelope Size Setting dialog box, select the size of the envelope to be used.

»» Note

» The combination of the Additional Features that was displayed for the printing profile that had
been selected when the added printing profile was saved is also displayed when that added
printing profile is selected.

Save...
Displays the Save Commonly Used Settings dialog box.
Click this button when you want to save the information that you set on the Quick Setup, Main, and
Page Setup tabs to Commonly Used Settings.

Delete
Deletes a registered printing profile.
Select the name of the setting to be deleted from Commonly Used Settings, and click Delete. When a
confirmation message is displayed, click OK to delete the specified printing profile.

»» Note

+ Printing profiles that are registered in the initial settings cannot be deleted.

Settings Preview
The paper illustration shows how the original will be laid out on a sheet of paper.
You can check an overall image of the layout.

Preview before printing
Shows what the print result will look like before you actually print the data.
Check this check box to display a preview before printing.
Uncheck this check box if you do not want to display a preview.
32 Important

» To use the Canon IJ XPS Preview, you must have Microsoft .NET Framework 4 Client Profile
installed on your computer.

Additional Features
Displays the frequently used, convenient functions for the printing profile that you selected for
Commonly Used Settings on the Quick Setup tab.
When you move the mouse pointer near a function that can be changed, a description of that function is
displayed.
To enable a function, check the corresponding check box.
For some functions, you can set detailed settings from the Main and Page Setup tabs.
32 Important

» Depending on the printing profiles, certain function may be grayed out and you will not be able to
change them.
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2-on-1 Printing
Prints two pages of the document, side by side, on one sheet of paper.
To change the page sequence, click the Page Setup tab, select Page Layout for Page Layout,
and click Specify.... Then in the Page Layout Printing dialog box that appears, specify the Page
Order.

4-on-1 Printing
Prints four pages of the document, side by side, on one sheet of paper.
To change the page sequence, click the Page Setup tab, select Page Layout for Page Layout,
and click Specify.... Then in the Page Layout Printing dialog box that appears, specify the Page
Order.

Duplex Printing (Manual)
Select whether to print the document to both sides of the paper manually or to one side of the
paper.
To change the staple side or the margins, set the new values from the Page Setup tab.

Borderless Printing
Performs borderless printing without any margins on the paper.
With the borderless printing function, the document to be printed is enlarged, so that it extends
slightly off the paper. In other words, the document is printed without any margin.
To adjust the amount that the document extends beyond the paper, click the Page Setup tab,
choose Borderless, and enter the value in Amount of Extension.

Grayscale Printing
This function converts the data to monochrome data when printing your document.

Draft
This setting is appropriate for test printing.

Rotate 180 degrees
Prints the document by rotating it 180 degrees against the paper feed direction.
The width of print area and the amount of extension that are configured in other application
software will be reversed vertically and horizontally.

Color/Intensity Manual Adjustment
Select when you set the Color Correction method and individual settings such as Cyan, Magenta,
Yellow, Brightness, Intensity, and Contrast, etc.

Media Type
Selects a type of printing paper.
Select a media type that matches the paper that is loaded in the printer. This ensures that printing is
carried out properly for the specified paper.

Printer Paper Size
Selects the size of paper actually loaded into the printer.
Normally, the paper size is set automatically according to the output paper size setting, and the
document is printed with no scaling.
When you set 2-on-1 Printing or 4-on-1 Printing in Additional Features, you can manually set the
paper size with Page Size on the Page Setup tab.
If you select a paper size that is smaller than the Page Size, the document size will be reduced. If you
select a paper size that is larger, the document size will be enlarged.
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Also if you select Custom..., the Custom Paper Size dialog box opens and allows you to specify any
vertical and horizontal dimensions for the paper size.

Orientation
Selects the printing orientation.
If the application used to create your document has a similar function, select the same orientation that
you selected in that application.
Portrait
Prints the document so that its top and bottom positions are unchanged relative to the paper feed
direction. This is the default setting.

Landscape
Prints the document by rotating it 90 degrees relative to the paper feed direction.
You can change the rotation direction by going to the Maintenance tab, opening the Custom
Settings dialog box, and then using Rotate 90 degrees left when orientation is [Landscape]
check box.
To rotate the document 90 degrees to the left when printing, select the Rotate 90 degrees left
when orientation is [Landscape] check box.

Print Quality
Selects your desired printing quality.
Select one of the following to set the print quality level that is appropriate for the purpose.
To set the print quality level individually, click the Main tab, and for Print Quality, select Custom. The
Set... becomes enabled. Click Set... to open the Custom dialog box, and then specify the desired
settings.
High
Gives priority to print quality over printing speed.

Standard
Prints with average speed and quality.

Draft
This setting is appropriate for test printing.

Paper Source
Shows the source from which paper is supplied.

Rear Tray
Paper is always supplied from the rear tray.

Copies
Specifies the number of copies you want to print. You can specify a value from 1 to 999.

22 Important

» When the application software that you used to create the document has the same function,
specify the settings on the printer driver. However, if the print results are not acceptable, specify the
function settings on the application software.

Always Print with Current Settings
Prints documents with the current settings starting from the next print execution.
When you select this function and then close the printer driver setup window, the information that you
set on the Quick Setup, Main, and Page Setup tabs are saved and printing with the same settings is
possible starting from the next print execution.
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3» Important

« If you log on with a different user name, the settings that were set when this function was enabled
are not reflected in the print settings.
« If a setting was specified on the application software, it has priority.

Defaults
Restores all the settings you have changed to their default values.
Click this button to return all settings on the Quick Setup, Main, and Page Setup tabs to their default
values (factory settings).

Save Commonly Used Settings dialog box

This dialog box allows you to save the information that you set on the Quick Setup, Main, and Page
Setup tabs and add the information to the Commonly Used Settings list on the Quick Setup tab.

Name
Enter the name for the printing profile you wish to save.
Up to 255 characters can be entered.
The name appears, with its associated icon, in the Commonly Used Settings list on the Quick
Setup tab.

Options...
Opens the Save Commonly Used Settings dialog box.
Changes the details of printing profile to be saved.

Save Commonly Used Settings dialog box

Select the icons of the printing profiles to be registered to Commonly Used Settings, and change the
items to be saved in the printing profiles.

Icon
Select the icon for the printing profile you wish to save.
The selected icon appears, with its name, in the Commonly Used Settings list on the Quick
Setup tab.

Save the paper size setting
Saves the paper size to the printing profile in Commonly Used Settings.
To apply the saved paper size when the printing profile is selected, check this check box.
If this check box is unchecked, the paper size is not saved, and consequently the paper size setting
is not applied when the printing profile is selected. Instead the printer prints with the paper size
specified with the application software.

Save the orientation setting
Saves the Orientation to the printing profile in Commonly Used Settings.
To apply the saved print orientation when the printing profile is selected, check this check box.
If this check box is unchecked, the print orientation is not saved, and consequently the Orientation
setting is not applied when the printing profile is selected. Instead the printer prints with the print
orientation specified with the application software.
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Save the copies setting
Saves the Copies setting to the printing profile in Commonly Used Settings.
To apply the saved copies setting when the printing profile is selected, check this check box.
If this check box is unchecked, the copies setting is not saved, and consequently the Copies
setting is not applied when the printing profile is selected. Instead the printer prints with the copies
setting specified with the application software.

Custom Paper Size dialog box

This dialog box allows you to specify the size (width and height) of the custom paper.

Units
Select the unit for entering a user-defined paper size.

Paper Size
Specifies the Width and the Height of the custom paper. Measurement is shown according to the
units specified in Units.

Related Topics

Printing with Easy Setup

Setting a Page Size and Orientation

Setting the Number of Copies and Printing Order

Execute Borderless Printing

Duplex Printing

Setting Up Envelope Printing

Displaying the Print Results before Printing

Setting Paper Dimensions (Custom Size)

Printing a Color Document in Monochrome

Specifying Color Correction

Adjusting Color Balance

Adjusting Color Balance Using Sample Patterns (Printer Driver)
Adjusting Brightness

Adjusting Intensity

Adjusting Contrast

Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)
Registering a Frequently Used Printing Profile
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Main tab Description

The Main tab allows you to create a basic print setup in accordance with the media type. Unless special
printing is required, normal printing can be performed just by setting the items on this tab.
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Settings Preview
The paper illustration shows how the original will be laid out on a sheet of paper.
You can check an overall image of the layout.

Media Type
Selects a type of printing paper.
Select a media type that matches the paper that is loaded in the printer. This ensures that printing is
carried out properly for the specified paper.

Paper Source
Shows the source from which paper is supplied.

Rear Tray
Paper is always supplied from the rear tray.

Print Quality
Selects your desired printing quality.
Select one of the following to set the print quality level that is appropriate for the purpose.

32 Important

» Depending on the Media Type settings, the same print results may be produced even if the Print
Quality is changed.

High
Gives priority to print quality over printing speed.

Standard
Prints with average speed and quality.
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Draft
This setting is appropriate for test printing.

Custom
Select this when you want to set the printing quality level individually.

Set...
Select Custom for Print Quality to enable this button.
Open the Custom dialog box. You can then individually set the print quality level.

Color/intensity
Selects color adjustment method.
Auto
Cyan, Magenta, Yellow, Brightness, Intensity, and Contrast, and so on are adjusted
automatically.

Manual
Select when you set the individual settings such as Cyan, Magenta, Yellow, Brightness,
Intensity, and Contrast, etc. and Color Correction method.

Set...
Select Manual for Color/Intensity to enable this button.
In the Manual Color Adjustment dialog box, you can adjust individual color settings such as
Cyan, Magenta, Yellow, Brightness, Intensity, and Contrast on the Color Adjustment tab, and
select the Color Correction method on the Matching tab.

»>» Note

* If you want to use an ICC profile to adjust colors, use the Manual Color Adjustment dialog
box to set the profile.

Grayscale Printing
This function converts the data to monochrome data when printing your document.
Check this check box to print a color document in monochrome.

Preview before printing
Shows what the print result will look like before you actually print the data.
Check this check box to display a preview before printing.

32 Important

» To use the Canon IJ XPS Preview, you must have Microsoft .NET Framework 4 Client Profile
installed on your computer.

Defaults
Restores all the settings you have changed to their default values.
Clicking this button restores all the settings on the current screen to their default values (factory
settings).
Custom dialog box

Set the quality level, and select the desired print quality.

Quality
You can use the slider bar to adjust the print quality level.
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3% Important

 Certain print quality levels cannot be selected depending on the settings of Media Type.

»>» Note

» The High, Standard, or Draft print quality modes are linked with the slider bar. Therefore when
the slider bar is moved, the corresponding quality and value are displayed on the left. This is the
same as when the corresponding radio button is selected for Print Quality on the Main tab.

Color Adjustment Tab

This tab allows you to adjust the color balance by changing the settings of the Cyan, Magenta, Yellow,
Brightness, Intensity, and Contrast options.

Preview
Shows the effect of color adjustment.
The color and brightness change when each item is adjusted. You can check the color adjustment
status easily by changing the preview image to one similar to the results to be printed with Sample
Type.
»» Note

» The graphic is in monochrome when the Grayscale Printing check box is checked.

Sample Type
Selects a preview image displayed on the Color Adjustment tab.
If necessary, select a preview image from Standard, Landscape, or Graphics, whichever is most
similar to the print results.

View Color Pattern
Displays a pattern for checking color changes produced by color adjustment.
If you want to display the preview image with a color pattern, check this check box.

Cyan / Magenta / Yellow
Adjusts the strengths of Cyan, Magenta, and Yellow.
Moving the slider to the right makes a color stronger, and moving the slider to the left makes a color
weaker.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50.
This adjustment changes the relative amount of ink of each color used, which alters the total color
balance of the document. Use your application if you want to change the total color balance
significantly. Use the printer driver only if you want to adjust the color balance slightly.

3% Important

* When Grayscale Printing is checked on the Main tab, Cyan, Magenta, and Yellow appear
grayed out and are unavailable.

Brightness
Selects the brightness of your print.
You cannot change the levels of pure white and black. However, the brightness of the colors between
white and black can be changed.
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Intensity
Adjusts the overall intensity of your print.
Moving the slider to the right increases the intensity, and moving the slider to the left decreases the
intensity.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50.

Contrast
Adjusts the contrast between light and dark in the image to be printed.
Moving the slider to the right increases the contrast, moving the slider to the left decreases the
contrast.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50.

Print a pattern for color adjustment
When the color balance or intensity/contrast is changed, the pattern printing function prints a list of
the adjustment results along with the adjustment values.
Select this function when printing a pattern for color adjustment.

Pattern Print preferences...
Check Print a pattern for color adjustment to enable this button.
The Pattern Print dialog box opens and allows you to set pattern printing settings.

Pattern Print dialog box

Performs the setup for printing of patterns that allow you to check the color balance and intensity/
contrast of documents.

Parameters to Adjust
Select the item to be checked by pattern printing.
Cyan/Magenta/Yellow
Prints a pattern that allows you to check the cyan/magenta/yellow balance.
3% Important

* When Grayscale Printing is checked on the Main tab, Cyan/Magenta/Yellow appear
grayed out and are unavailable.

Intensity/Contrast
Prints a pattern that allows you to check the intensity/contrast balance.

Printer Paper Size
Selects the paper size to be used for pattern printing.
This setting is linked to Printer Paper Size on the Page Setup tab.

> Note

» Depending on the paper size selected on the Page Setup tab, there may be sizes that cannot
be selected.

Amount of Pattern Instances
Sets the number of patterns to be printed.
You can select from Largest, Large, and Small. When you select a pattern size, the number of
patterns that can be printed is as follows:
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> Note

» Largest and Large cannot be selected when certain paper sizes or output paper sizes are

selected.
» The setting preview on the Main tab displays an image that allows you to check the overall

layout.

Largest
Cyan/Magenta/Yellow 37
Intensity/Contrast 49

Large
Cyan/Magenta/Yellow 19
Intensity/Contrast 25

Small
Cyan/Magenta/Yellow 7
Intensity/Contrast 9

Color Variation Between Instances
Sets the amount of color change between neighboring patterns.
Select from Large, Medium, and Small. Large produces a large amount of change, and Small

produces a small amount of change.

»>» Note

» Large is about double the size of Medium, and Small is about half the size of Medium.

Matching Tab

Allows you to select the method for adjusting colors to match the type of document to be printed.

Color Correction
Allows you to select Driver Matching, ICM (ICC Profile Matching), or None to match the purpose of

the print operation.
32 Important
* When Grayscale Printing is checked on the Main tab, Color Correction appears grayed out
and is unavailable.

Driver Matching
With Canon Digital Photo Color, you can print sSRGB data with color tints that most people prefer.

ICM (ICC Profile Matching)
Adjusts the colors by using an ICC profile when printing.
Specify the input profile to be used.

22 Important

« If the application software is set so that ICM is disabled, ICM (ICC Profile Matching) is
unavailable for Color Correction and the printer may not be able to print the image data

properly.

None
Disables color adjustment with the printer driver.
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Input Profile
Specifies the input profile to be used when you select ICM (ICC Profile Matching) for Color
Correction.
Standard
The standard printer profile (SRGB), which supports the color space of ICM, is used. This is the
default setting.

»» Note

* In the XPS printer driver, ICM has become ICC Profile Matching.

Related Topics

Setting the Print Quality Level (Custom)

Adjusting Color Balance

Adjusting Brightness

Adjusting Intensity

Adjusting Contrast

Adjusting Color Balance Using Sample Patterns (Printer Driver)
Adjusting Intensity/Contrast Using Sample Patterns (Printer Driver)
Specifying Color Correction

Adjusting Colors with the Printer Driver

Printing with ICC Profiles

Printing a Color Document in Monochrome

Displaying the Print Results before Printing
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Page Setup tab Description

The Page Setup tab allows you to determine how a document is to be arranged on the paper. Also, this tab
allows you to set the number of copies and the order of printing. If the application which created the
document has a similar function, set them with the application.
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Settings Preview
The paper illustration shows how the original will be laid out on a sheet of paper.
You can check an overall image of the layout.

Page Size
Selects a page size.
Ensure that you select the same page size as you selected within the application.
If you select Custom..., the Custom Paper Size dialog box opens and allows you to specify any
vertical and horizontal dimensions for the paper size.

Orientation
Selects the printing orientation.
If the application used to create your document has a similar function, select the same orientation that
you selected in that application.
Portrait
Prints the document so that its top and bottom positions are unchanged relative to the paper feed
direction. This is the default setting.

Landscape
Prints the document by rotating it 90 degrees relative to the paper feed direction.
You can change the rotation direction by going to the Maintenance tab, opening the Custom
Settings dialog box, and then using Rotate 90 degrees left when orientation is [Landscape]
check box.
To rotate the document 90 degrees to the left when printing, select the Rotate 90 degrees left
when orientation is [Landscape] check box.
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Rotate 180 degrees
Prints the document by rotating it 180 degrees against the paper feed direction.
The width of print area and the amount of extension that are configured in other application software will
be reversed vertically and horizontally.

Printer Paper Size
Selects the size of paper actually loaded into the printer.
The default setting is Same as Page Size to perform normal-sized printing.
You can select a printer paper size when you select Fit-to-Page, Scaled, Page Layout, Tiling/Poster,
or Booklet for Page Layout.
If you select a paper size that is smaller than the Page Size, the document size will be reduced. If you
select a paper size that is larger, the document size will be enlarged.
Also if you select Custom..., the Custom Paper Size dialog box opens and allows you to specify any
vertical and horizontal dimensions for the paper size.

Page Layout
Selects the size of the document you want to print and the type of printing.
Normal-size
This is the normal printing method. Select this when you do not specify any page layout.
Automatically reduce large document that the printer cannot output
If the printer cannot print the paper size of a document, the printer can automatically reduce
the size when it prints the document.
Check this check box to reduce the size when printing the document.

Borderless

Chooses whether you are printing on a full page without any page margins or printing with page

margins.

In borderless printing, originals are enlarged to extend slightly off the paper. Thus, printing can be

performed without any margins (border).

Use Amount of Extension to adjust how much of the document extends off the paper during

borderless printing.

Amount of Extension
Adjusts how much of the document extends off the paper during borderless printing.
Moving the slider to the right increases the amount of extension and allows you to perform
borderless printing with no problems.
Moving the slider to the left reduces the amount of extension and expands the range of the
document to print.

Fit-to-Page
This function enables you to automatically enlarge or reduce documents to fit to the paper size
loaded in the printer without changing the paper size you specified in your application software.

Scaled
Documents can be enlarged or reduced to be printed.
Specify the size in Printer Paper Size, or enter the scaling ratio in the Scaling box.
Scaling
Specifies an enlargement or reduction ratio for the document you want to print.

Page Layout
Multiple pages of document can be printed on one sheet of paper.
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Specify...
Opens the Page Layout Printing dialog box.
Click this button to set details on page layout printing.

Tiling/Poster
This function enables you to enlarge the image data and divide the enlarged data into several
pages to be printed. You can also glue together these sheets of paper to create large printed
matter, such as a poster.
Specify...
Opens the Tiling/Poster Printing dialog box.
Click this button to set details on tiling/poster printing.

Booklet
The booklet printing function allows you to print data for a booklet. Data is printed on both sides of
the paper. This type of printing ensures that pages can be collated properly, in page number order,
when the printed sheets are folded and stapled at the center.
Specify...
Opens the Booklet Printing dialog box.
Click this button to set details on booklet printing.

Duplex Printing (Manual)
Select whether to print the document to both sides of the paper manually or to one side of the paper.
Check this check box to print the document on both sides.
This function can be used only when Plain Paper is selected for Media Type and one of Normal-size,
Fit-to-Page, Scaled, or Page Layout is selected.

Stapling Side
Selects the stapling margin position.
The printer analyzes the Orientation and Page Layout settings, and automatically selects the best
stapling margin position. Check Stapling Side, and select from the list to change it.

Specify Margin...
Opens the Specify Margin dialog box.
You can specify the width of the margin.

Copies
Specifies the number of copies you want to print. You can specify a value from 1 to 999.
22 Important

« If the application used to create your document has a similar function, specify the number of copies
with the application without specifying it here.

Print from Last Page
Check this check box when you want to print from the last page in order. If you do this, you do not need
to sort the pages into their correct order after printing.
Uncheck this check box to print your document in normal order, starting from the first page.

Collate
Check this check box to group together the pages of each copy when you want to print multiple copies.
Uncheck this check box when you want to print with all pages of the same page number grouped
together.
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3» Important

+ When the application software that you used to create the document has the same function, give
priority to the printer driver settings. However, if the print results are not acceptable, specify the
function settings on the application software. When you specify the number of copies and the
printing order with both the application and this printer driver, the number of copies may be
multiplied numbers of the two settings or the specified printing order may not be enabled.

Print Options...
Opens the Print Options dialog box.
Changes detailed printer driver settings for print data that is sent from applications.

Stamp/Background... (Stamp...)
Opens the Stamp/Background (Stamp) dialog box.
The Stamp function allows you to print a stamp text or a bitmap over or behind document data. It also
allows you to print date, time and user name. The Background function allows you to print a light
illustration behind the document data.

»» Note

» With the XPS printer driver, the Stamp/Background... button has become the Stamp... button and
only the stamp function can be used.

Depending on the type of printer driver you are using and the environment, Stamp and Background
may not be available.

Custom Paper Size dialog box
This dialog box allows you to specify the size (width and height) of the custom paper.
Units

Select the unit for entering a user-defined paper size.

Paper Size
Specifies the Width and the Height of the custom paper. Measurement is shown according to the
units specified in Units.

Page Layout Printing dialog box

This dialog box allows you to select the number of document pages to be placed on one sheet of paper,
the page order, and whether a page border line is to be printed around each document page.
The settings specified in this dialog box can be confirmed in the settings preview on the printer driver.

Preview Icon
Shows the settings made on the Page Layout Printing dialog box.
You can check what the print result will look like before you actually print the data.

Pages
Specifies the number of document pages to fit on one sheet.

Page Order
Specifies the document orientation to be printed on a sheet of paper.
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Page Border
Prints a page border line around each document page.
Check this check box to print the page border line.

Tiling/Poster Printing dialog box

This dialog box allows you to select the size of the image to be printed. You can also make settings for cut
lines and paste markers which are convenient for pasting together the pages into a poster.
The settings specified in this dialog box can be confirmed in the settings preview on the printer driver.

Preview Icon
Shows the settings of the Tiling/Poster Printing dialog box.
You can check what the print result will look like.

Image Divisions
Select the number of divisions (vertical x horizontal).
As the number of divisions increases, the number of sheets used for printing increases. If you are
pasting pages together to create a poster, increasing the number of divisions allows you to create a
larger poster.

Print "Cut/Paste" in margins
Specifies whether to print the words "Cut" and "Paste" in the margins. These words serve as
guidelines for pasting together the pages into a poster.
Check this check box to print the words.

»>» Note

» Depending on the type of printer driver you are using and the environment, this function may not
be available.

Print "Cut/Paste" lines in margins
Specifies whether to print cut lines that serve as guidelines for pasting together the pages into a
poster.
Check this check box to print the cut lines.

Print page range
Specifies the printing range. Select All under normal circumstances.
Select Pages to specify a specific page or range.

»» Note

+ If some of the pages have not been printed well, specify the pages that do not need to be printed
by clicking them in the settings preview of the Page Setup tab. Only the pages shown on the
screen will be printed this time.

Booklet Printing dialog box

This dialog box allows you to set how to bind the document as a booklet. Printing only on one side and
printing a page border, can also be set in this dialog box.
The settings specified in this dialog box can be confirmed in the settings preview on the printer driver.
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Preview Icon
Shows the settings made on the Booklet Printing dialog box.
You can check what the document will look like when printed as a booklet.

Margin for stapling
Specifies which side of the booklet is to be stapled.

Insert blank page
Selects whether to print the document on one side or both sides of the booklet.
Check this check box to print the document on one side of the booklet and select the side to be left
blank from the list.

Margin
Specifies the width of the stapling margin.
The specified width becomes the stapling margin from the center of the sheet.

Page Border
Prints a page border line around each document page.
Check this check box to print the page border line.

Specify Margin dialog box

This dialog box allows you to specify the margin width for the side to be stapled. If a document does not fit
on one page, the document is reduced when printed.

Margin
Specifies the width of the stapling margin.
The width of the side specified by Stapling Side becomes the stapling margin.

Print Options dialog box
Makes changes to print data that is sent to the printer.

Depending on the type of printer driver you are using and the environment, this function may not be
available.

Disable ICM required from the application software
Disables the ICM function required from the application software.
When an application software uses Windows ICM to print data, unexpected colors may be produced
or the printing speed may decrease. If these problems occur, checking this check box may resolve
the problems.

32 Important

» Uncheck this check box under normal circumstances.
+ This function does not work when ICM is selected for Color Correction on the Matching tab of
the Manual Color Adjustment dialog box.

»» Note

» Disable ICM required from the application software tab cannot be used with the XPS printer
driver.
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Disable the color profile setting of the application software
Checking this check box disables information in the color profile that was set on the application
software.
When the information in the color profile set on the application software is output to the printer driver,

the print result may contain unexpected colors. If this happens, checking this check box may resolve
the problem.

3% Important

» Even when this check box is checked, only some of the information in the color profile is
disabled, and the color profile can still be used for printing.
» Uncheck this check box under normal circumstances.

Ungroup Papers
Sets the display method of Media Type, Page Size, and Printer Paper Size.
To display the items separately, select the check box.
To display the items as a group, clear the check box.

Do not allow application software to compress print data
Compression of the application software print data is prohibited.

If the print result has missing image data or unintended colors, selecting this check box may improve
the condition.

22 Important

» Uncheck this check box under normal circumstances.

»>» Note

» Do not allow application software to compress print data tab cannot be used with the XPS
printer driver.

Print after creating print data by page

The print data is created in page units, and printing starts after the processing of one page of print
data is complete.

If a printed document contains unintended results such as streaks, selecting this check box may
improve the results.

22 Important

* Uncheck this check box under normal circumstances.

Scale images using nearest-neighbor interpolation

When an image is to be enlarged or reduced when printed, the printer uses a simple interpolation
process to enlarge or reduce the image.

If the image data in a printed document is not printed clearly, selecting this check box may improve
the results.

32 Important

» Uncheck this check box under normal circumstances.

»» Note

» Scale images using nearest-neighbor interpolation can be used only with the XPS printer
driver.
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Prevention of Print Data Loss
You can reduce the size of the print data that was created with the application software and then print
the data.
Depending on the application software being used, the image data may be cut off or may not be
printed properly. In such cases, select On. If you will not be using this function, select Off.
22 Important

» When using this function, the print quality may drop depending on the print data.

Unit of Print Data Processing
Selects the processing unit of the print data to be sent to the printer.
Select Recommended under normal circumstances.

32 Important

» A large amount of memory may be used for certain settings.
Do not change the setting if your computer has a small amount of memory.

»» Note

+ Unit of Print Data Processing tab cannot be used with the XPS printer driver.

Stamp/Background (Stamp...) dialog box

The Stamp/Background (Stamp...) dialog box allows you to print a stamp and/or background over or
behind the document pages. In addition to the pre-registered ones, you can register and use your original
stamp or background.

»>» Note

» With the XPS printer driver, the Stamp/Background... button has become the Stamp... button and
only the stamp function can be used.

Stamp
Stamp printing is a function that prints a stamp over a document.
Check this check box and select a title from the list to print a stamp.

Define Stamp...
Opens the Stamp Settings dialog box.
You can check the details of a selected stamp or save a new stamp.

Place stamp over text
Sets how the stamp is to be printed over the document.
Check the Stamp check box to enable this.
Check this check box to print a stamp over the printed document page. The printed data may be
hidden behind the stamp.
Uncheck this check box to print the document data over the stamp. The printed data will not be
hidden behind the stamp. However, the sections of the stamp that are overlapped by the document
may be hidden.

Print semitransparent stamp
Sets how the stamp is to be printed over the document.
Check the Stamp check box to enable this.
Check this check box to print a semi-transparent stamp over the printed document page.
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Uncheck this check box to print the stamp over the document data. The printed data may be hidden
behind the stamp.

> Note

* You can use Print semitransparent stamp only with the XPS printer driver.

Stamp first page only
Selects whether the stamp is to be printed on the first page only or on all pages when the document
has two or more pages.
Check the Stamp check box to enable this.
Check this check box to print a stamp on the first page only.

Background
Background printing is a function that allows you to print an illustration or a similar object (bitmap)
behind the document.
Check this check box to print a background and select a title from the list.

Select Background...
Opens the Background Settings dialog box.
You can register a bitmap as a background, and change layout method and intensity of the selected
background.

Background first page only
Selects whether to print the background on the first page only or print on all pages when the
document has two or more pages.
Check the Background check box to enable this.
Check this check box to print a background on the first page only.

Stamp Tab

The Stamp tab allows you to set the text and bitmap file (.bmp) to be used for a stamp.

Preview Window
Shows the status of the stamp configured in each tab.

Stamp Type
Specifies the stamp type.
Select Text to create a stamp with characters. Select Bitmap to create with a bitmap file. Select
Date/Time/User Name to display the creation date/time and user name of the printed document.
The setting items in the Stamp tab change depending on the selected type.

When Stamp Type is Text or Date/Time/User Name

Stamp Text
Specifies the stamp text string.
Up to 64 characters can be entered.
For Date/Time/User Name, the creation date/time and user name of the printed object are
displayed in Stamp Text.

32 Important

- Stamp Text appears grayed out and is unavailable if Date/Time/User Name is selected.

TrueType Font
Selects the font for the stamp text string.
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Style
Selects the font style for the stamp text string.

Size
Selects the font size for the stamp text string.

Outline
Selects a frame that encloses the stamp text string.
If a large font size is selected for Size, characters may extend outside of the stamp border.

Color/Select Color...
Shows the current color for the stamp.
To select a different color, click Select Color... to open the Color dialog box, and select or create a
color you wish to use as a stamp.

When Stamp Type is Bitmap

File
Specifies the name of the bitmap file to be used as the stamp.

Select File...
Opens the dialog box to open a file.
Click this button to select a bitmap file to be used as a stamp.

Size
Adjusts the size of the bitmap file to be used as a stamp.

Moving the slider to the right increases the size, moving the slider to the left decreases the size.

Transparent white area
Specifies whether to make white-filled areas of the bitmap transparent.
Check this check box to make white-filled areas of the bitmap transparent.

»» Note

+ Click Defaults to set Stamp Type to text, Stamp Text to blank, TrueType Font to Arial, Style to
Regular, Size to 36 points, Outline unchecked, and Color to gray with the RGB values (192, 192,
192).

Placement Tab

The Placement tab allows you to set the position where the stamp is to be printed.

Preview Window
Shows the status of the stamp configured in each tab.

Position
Specifies the stamp position on the page.
Selecting Custom from the list allows you to enter values for the X-Position and Y-Position
coordinates directly.

Orientation
Specifies the angle of rotation for the stamp. The angle can be set by entering the number of
degrees.
Negative values rotate the stamp clockwise.
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> Note

 Orientation is enabled only when Text or Date/Time/User Name is selected for Stamp Type
on the Stamp tab.

»» Note

* Click Defaults to set the stamp position to Center and the orientation to 0.

Save settings Tab

The Save settings tab allows you to register a new stamp or delete an unnecessary stamp.

Title
Enter the title to save the stamp you created.
Up to 64 characters can be entered.

> Note

» Spaces, tabs, and returns cannot be entered at the beginning or end of a title.

Stamps
Shows a list of saved stamp titles.
Specify a title to display the corresponding stamp in Title.

Save/Save overwrite
Saves the stamp.
Enter a title in Title, and then click this button.

Delete
Deletes an unnecessary stamp.
Specify the title of an unnecessary stamp from the Stamps list, and click this button.

Background Tab

The Background tab allows you to select a bitmap file (.bmp) to be used as a background or determine
how to print the selected background.

Preview Window

Shows the status of the bitmap set on the Background tab.
File

Specifies the name of the bitmap file to be used as the background.
Select File...

Opens the dialog box to open a file.
Click this button to select a bitmap file (.bmp) to be used as the background.

Layout Method
Specifies how the background image is to be placed on the paper.
When Custom is selected, you can set coordinates for X-Position and Y-Position.

Intensity
Adjusts the intensity of the bitmap to be used as a background.
Moving the slider to the right increases the intensity, and moving the slider to the left decreases the
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intensity. To print the background at the original bitmap intensity, move the slider to the rightmost
position.

»» Note

» Depending on the type of printer driver you are using and the environment, this function may not be
available.

+ Click Defaults to set File to blank, Layout Method to Fill page, and the Intensity slider to the
middle.

Save settings Tab

The Save settings tab allows you to register a new background or delete an unnecessary background.

Title
Enter the title to save the background image you specified.
Up to 64 characters can be entered.

> Note

» Spaces, tabs, and returns cannot be entered at the beginning or end of a title.

Backgrounds
Shows a list of registered background titles.
Specify a title to display the corresponding background in Title.

Save/Save overwrite
Saves the image data as a background.
After inserting the Title, click this button.

Delete
Deletes an unnecessary background.
Specify the title of an unnecessary background from the Backgrounds list, and then click this
button.
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Maintenance tab Description

The Maintenance tab allows you to perform printer maintenance or change the settings of the printer.
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Cleaning

Performs print head cleaning.

Print head cleaning removes any blockage in the print head nozzles.

Perform cleaning when printing becomes faint, or a specific color fails to print, even though all ink levels
are sufficiently high.

3
Deep Cleaning

Performs deep cleaning.
Perform deep cleaning when two cleaning attempts do not resolve the print head problem.

»» Note

» Deep Cleaning consumes a larger amount of ink than Cleaning.
Cleaning the print heads frequently will rapidly deplete your printer's ink supply. Therefore, perform
cleaning only when necessary.

Ink Group
When you click Cleaning or Deep Cleaning, the Ink Group window is displayed.
Selects the ink group that you want to clean the print head for.
Click Initial Check Items to display the items that you need to check before you execute cleaning

or deep cleaning.
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System Cleaning

Performs system cleaning.

Execute this function if the status does not improve even after deep cleaning is performed.

System Cleaning consumes an extremely large amount of ink.

Executing system cleaning frequently will rapidly deplete your printer's ink supply. Therefore execute
system cleaning only when necessary.

3» Important

+ If System Cleaning is run when the remaining ink level is insufficient, it may cause a failure.
Be sure to check the remaining ink level before running System Cleaning.

Ink Group
When you click System Cleaning, the Ink Group window is displayed.
Selects the ink group that you want to clean the print head for.
Click Initial Check Items to display the items that you need to check before you execute cleaning,
deep cleaning or system cleaning.

Print Head Alignment
Print head alignment corrects the installation positions of the print head and improves deviated colors
and lines.
Align the print head immediately after installing the print head.
When you click Print Head Alignment, the Start Print Head Alignment dialog box is displayed.

Nozzle Check

Prints a nozzle check pattern.
Perform this function if printing becomes faint or a specific color fails to print. Print a nozzle check
pattern, and check whether the print head is working properly.
If the print result for a specific color is fainted, or if there are any unprinted sections, click Cleaning to
clean the print head.
To display a list of items that you should check before printing the nozzle check pattern, click Initial
Check Items.
Print Check Pattern

This function prints a pattern that allows you to check whether the any of the ink nozzles are

clogged.

Click Print Check Pattern. When the confirmation message is displayed, click OK. The Pattern

Check dialog box is then displayed.

Left-side bitmap (good)

The print head nozzles are not clogged.

Right-side bitmap (bad)
The print head nozzles may be clogged.

Exit
Closes the Pattern Check dialog box, and returns to the Maintenance tab.

271



Cleaning
Performs print head cleaning.
Print head cleaning removes any blockage in the print head nozzles.
Perform cleaning when printing becomes faint, or if a specific color fails to print, even though
all ink levels are sufficiently high.

Remaining Ink Notification Settings
Displays the Remaining Ink Notification Settings dialog box.
Run this function to switch the remaining ink level notification setting and to reset the remaining ink level

count.

Bottom Plate Cleaning

Performs cleaning of the bottom plate of the printer.

To prevent smudges on the back side of a sheet of paper, perform Bottom Plate Cleaning before you
perform duplex printing.

Also perform Bottom Plate Cleaning if ink smudges caused by something other than print data appear
on the printed page.

Roller Cleaning

Cleans the paper feed rollers.

Paper feeding may fail if paper dust has stuck to the printer's paper feed rollers. In this case, clean the
paper feed rollers to improve the print result.

Power Off

Turns off the printer from the printer driver.

Perform this function to turn off the printer when you cannot press the ON button (POWER button) on
the printer because the printer is out of your reach.

You must press the ON button (POWER button) on the printer to turn the printer on again after clicking
this button. When you use this function, you will not be able to turn the printer on from the printer driver.

[,

Auto Power
Opens the Auto Power Settings dialog box.
Specify settings for operating the printer power automatically. Perform this function if you want to
change the auto power settings.

»» Note

« If the printer is off or if communication between the printer and the computer is disabled, an error
message may appear because the computer cannot collect the printer status.
If this happens, click OK to display the most recent settings specified on your computer.

272



Quiet Settings
Opens the Quiet Settings dialog box.
Quiet Settings dialog box allows you to specify a setting that reduces the operating noise of the printer.
This mode comes in handy when the operating noise of the printer becomes a concern, such when
printing at night. Perform this operation when you want to change the quiet mode setting.

»» Note

« If the printer is off or if communication between the printer and the computer is disabled, an error
message may appear because the computer cannot collect the printer status.

Custom Settings
Opens the Custom Settings dialog box.
Perform this function to change the settings of this printer.

»» Note

« If the printer is off or if communication between the printer and the computer is disabled, an error
message may appear because the computer cannot collect the printer status.
If this happens, click OK to display the most recent settings specified on your computer.

View Print History
This function starts the Canon IJ XPS preview, and displays the print history.

»» Note

* You can use this function only with the XPS printer driver.

View Printer Status
Starts the Canon IJ Status Monitor.
Perform this function when you want to check the printer status and how a print job is proceeding.

»» Note

* If you are using the XPS printer driver, the "Canon IJ Status Monitor" becomes the "Canon IJ XPS
Status Monitor".

About
Opens the About dialog box.
The version of the printer driver, plus a copyright notice, can be checked.
In addition, the language to be used can be switched.

Initial Check Items (Cleaning / Deep Cleaning)

Before running Cleaning or Deep Cleaning, check that the printer power is on.
Then check the following item:

¢ |s there ink remaining?
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Initial Check Items (System Cleaning)

Before running System Cleaning, check that the printer power is on.
Then check the following items:

* When you ran Nozzle Check, were there areas where the print was smeared or unprinted areas?
+ Did the condition not improve even after Deep Cleaning was run?
+ Are the remaining ink levels insufficient?

o Visually check whether the remaining ink levels are insufficient.

If System Cleaning is run when the remaining ink levels are insufficient, it may trigger a failure.

o If you selected All Colors or Black for Ink Group, check that all remaining ink levels are at least
at the single dot position indicated on the ink tanks. (The color inks are consumed even if Black
was selected.)

If you selected Color, check that the remaining ink levels for all color inks are at least at the single
dot position indicated on the ink tanks.

o If any remaining ink level is below the single dot position, replenish the ink to at least the single
dot position. However, if Remaining Ink Notification Settings is enabled, replenish all remaining
ink levels to the upper limit line indicated on the ink tanks, regardless of the Ink Group setting.

Start Print Head Alignment dialog box

This dialog box allows you to adjust the attachment position for the print head, or to print the current
setting value for the print head position.

Align Print Head
Aligns the print head.
Print head alignment corrects the installation positions of the print head and improves deviated colors
and lines.
Align the print head immediately after installing the print head.

Print Alignment Value
Click this button to check the current setting value of the print head position.
Prints the current setting value for the print head position.

Print Head Alignment dialog box

To adjust the print head position manually, click Align Print Head in the Start Print Head Alignment
dialog box, and perform the operations instructed in the messages. The Print Head Alignment dialog
box is then displayed.

This dialog box allows you to check the printed pattern and adjust the print head position.

Preview Window
Displays the pattern of Print Head Alignment, and checks the position of the selected pattern.
You can also change the setting by clicking the pattern on the screen directly.

Select the Pattern Number
Compare the printed adjustment patterns, and enter the pattern number of the pattern with the
least visible streaks or horizontal stripes into the corresponding box.

»» Note

+ If you do not know how to analyze the printed pattern, see Aligning the Print Head Position.
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Initial Check Items (Nozzle Check)

Before running Nozzle Check, check that the printer power is on.
Then check the following item:

« |s there ink remaining?

Remaining Ink Notification Settings dialog box

When you click Remaining Ink Notification Settings, the Remaining Ink Notification Settings dialog
box appears.

Then from the print driver, you can switch the remaining ink level notification setting and reset the
remaining ink level count.

Function for Notifying the Remaining Ink Level
Select the setting for the remaining ink level notification function.
Select Enable to display an error message when the remaining ink level runs low.
Select Disable to prevent the error message from being displayed.
Then click Set to enable the selected setting.

22 Important

+ Before enabling Function for Notifying the Remaining Ink Level, replenish all inks to the
upper limit line and reset the remaining ink level count by running Resets the Remaining Ink
Level Count. However, if you reset the count by operating the operation panel of the printer, the

setting in the printer driver is unnecessary.
* If you disable Function for Notifying the Remaining Ink Level, you must visually check the
remaining ink level. Replenish the ink before the ink level falls below the lower limit line.

Resets the Remaining Ink Level Count
Click Reset to reset the remaining ink level count.

3% Important

* When you reset the remaining ink level count, you must replenish all inks to the upper limit line.

Auto Power Settings dialog box

When you click Auto Power, the Auto Power Settings dialog box is displayed.
This dialog box allows you to manage the printer power from the printer driver.

Auto Power On
Selects the auto power-on setting.
Specify Disable to prevent the printer from turning on automatically when print data is sent to it.
Make sure the printer is on and then click OK to change the printer settings.
Specify Enable to turn the printer on automatically when print data is sent to it.

Auto Power Off
Selects the auto power-off setting.
If a printer driver operation or a printer operation is not performed within the specified time, the printer
turns off.
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Quiet Settings dialog box

When you click Quiet Settings, the Quiet Settings dialog box is displayed.

Quiet Settings dialog box allows you to specify a setting that reduces the operating noise of the printer.
Select when you wish to reduce the operating noise of the printer at night, etc.

Using this function may lower the print speed.

Do not use quiet mode
Select this option when you wish to use the printer with volume of normal operating noise.

Always use quiet mode
Select this option when you wish to reduce the operating noise of the printer.

Use quiet mode during specified hours
Select this option when you wish to reduce the operating noise of the printer during a specified period
of time.
Set the Start time and the End time of the quiet mode you wish to be activated. If both are set to the
same time, the quiet mode will not function.

3% Important

* You can set the quiet mode from the operation panel of the printer, the printer driver, or ScanGear
(scanner driver).
No matter how you use to set the quiet mode, the mode is applied when you perform operations from
the operation panel of the printer or printing and scanning from the computer.

« If you specify a time for Use quiet mode during specified hours, quiet mode is not applied to
operations (copy, direct print, etc.) performed directly from the printer.

Custom Settings dialog box

When you click Custom Settings, the Custom Settings dialog box is displayed.
If necessary, switch between various modes of printer operation.

Prevent paper abrasion
The printer can increase the gap between the print head and the paper during high-density printing to
prevent paper abrasion.
Check this check box to enable this function.

Align heads manually
Usually, the Print Head Alignment function on the Maintenance tab is set to automatic head
alignment, but you can change it to manual head alignment.
If the printing results of automatic print head alignment are not satisfactory, perform manual head

alignment.
Check this check box to perform the manual head alignment.

Rotate 90 degrees left when orientation is [Landscape]
On the Page Setup tab, you can change the rotation direction of the Landscape in the Orientation.
To rotate the document 90 degrees to the left when printing, select the check box.

Ink Drying Wait Time
The printer can pause before printing a subsequent page. Moving the slider to the right increases the

pause time, and moving the slider to the left decreases the time.
If the paper gets stained because the next page is ejected before the ink on the printed page dries,
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increase the ink drying wait time.
Reducing the ink drying wait time speeds up printing.

About dialog box

When you click About, the About dialog box is displayed.
This dialog box displays the version, copyright, and module list of the printer driver. You can select the
language to be used and switch the language displayed in the setup window.

Modules
Lists the printer driver modules.
Language
Specifies the language you wish to use in the printer driver setup window.
32 Important

« If the font for displaying the language of your choice is not installed in your system, the
characters will be garbled.

Related Topics

Cleaning the Print Heads
Aligning the Print Head Position
Printing a Nozzle Check Pattern

Changing the remaining ink level notification setting
Cleaning Inside the Printer

Cleaning the Paper Feed Rollers

Managing the Printer Power

Reducing the Printer Noise

Changing the Printer Operation Mode

LR 2R 3 2B 2R 3R 2R 2%
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Canon IJ Preview Description

Canon |J Preview is an application software that displays what the print result will look like before a
document is actually printed.

The preview reflects the information that is set within the printer driver and allows you to check the
document layout, print order, and number of pages. You can also change the media type and paper source
settings.

When you want to display a preview before printing, open the printer driver setup window, and check the
Preview before printing check box on the Main tab.
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File Menu
Selects the print operation.
Start Printing
Ends the Canon |J Preview and then starts printing the document that is displayed on the preview
screen.
This command has the same function as the Start Printing on the toolbar.

Cancel Printing
Ends the Canon IJ Preview and cancels the printing of the document that is displayed on the
preview screen.
This command has the same function as the Cancel Printing on the toolbar.

Exit
Ends the Canon |J Preview.
Page Menu

This menu includes the following commands to select page to be displayed.
All of these commands except Page Selection... can also be selected from the toolbar.

»» Note

« If the pages are being spooled, the last spooled page becomes the last page.
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« If the Page Layout setting on the Page Setup tab is specified to Page Layout, Tiling/Poster, or
Booklet, the number of pages is the number of sheets to be used for printing, and not the number
of pages in the original document created with the application software.

« If duplex printing manually has been set, the front pages which will be printed first are all displayed
together, and then the back pages are displayed.

First Page
Displays the first page of the document.
If the currently displayed page is the first page, this command is grayed out and cannot be
selected.

Previous Page
Displays the page located before the currently displayed page.
If the currently displayed page is the first page, this command is grayed out and cannot be
selected.

Next Page
Displays the page located after the currently displayed page.
If the currently displayed page is the last page, this command is grayed out and cannot be
selected.

Last Page
Displays the last page of the document.
If the currently displayed page is the last page, this command is grayed out and cannot be
selected.

Page Selection...
Displays the Page Selection dialog box.
This command allows you to specify the page number of the page to be displayed.

Zoom Menu
Selects the ratio of the actual size printed on the paper to the preview display size.
You can also select the ratio from the drop-down list box located on the toolbar.
Whole
Displays the entire page of data as one page.

50%
Reduces the displayed data to 50% of the actual size to be printed.

100%
Displays the data at the actual size to be printed.

200%
Enlarges the displayed data to 200% of the actual size to be printed.

400%
Enlarges the displayed data to 400% of the actual size to be printed.

Option Menu
This menu includes the following command:
Displays Print Page Information
Displays print setup information (including printer paper size, media type, and page layout) for each
page at the left side of the preview screen.
This screen also allows you to change the media type and paper source settings.
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Help Menu
When you select this menu item, the Help window for Canon IJ Preview is displayed, and you can
check the version and copyright information.

Start Printing button
Prints the documents selected in the document list.
The printed documents are deleted from the list, and when all documents are printed, the Canon IJ XPS
Preview closes.

Cancel Printing button
Ends the Canon IJ Preview, and cancels the printing of the document that is displayed on the preview
screen.
You can click this button while spooling.

Print Page Information Screen
Displays print setup information for each page at the left side of the preview screen.
This screen also allows you to change the media type and paper source settings.

32 Important

« If the media type and paper source are set from the application software, those settings have
priority and the changed settings may become ineffective.

Printer Paper Size
Displays the paper size of the document to be printed.

Media Type
You can select the media type of the document to be printed.

Paper Source
You can select the paper source of the document to be printed.

Page Layout
Displays the page layout of the document to be printed.
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Canon IJ XPS Preview Description

Canon IJ XPS Preview is an application software that displays what the print result will look like before a
document is actually printed.

The preview reflects the information which is set within the printer driver and allows you to check the
document layout, print order, and number of pages. The preview also allows you to edit the print document,
edit the print pages, change the print settings, and perform other functions.

When you want to display a preview before printing, open the printer driver setup window, and check the
Preview before printing check box on the Main tab.

3% Important

» To use the Canon IJ XPS Preview, you must have Microsoft .NET Framework 4 Client Profile installed
on your computer.
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File Menu
Selects print operation and print history settings:
Print

Prints the documents selected in the document list.
The printed documents are deleted from the list, and when all documents are printed, the Canon IJ
XPS Preview closes.

This command has the same function as @ (Print) on the toolbar and the Print in the print
settings area.

Print All Documents
Prints all documents in the document list and closes the Canon IJ XPS Preview.

Save Print History
Switches whether the documents printed from the Canon IJ XPS Preview are to be saved as print
history entries.
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History Entry Limit
Switches the maximum number of print history registrations.
Select 10 Entries, 30 Entries, or 100 Entries.

32 Important

« If the limit on the number of registration is exceeded, the print history registrations are deleted
starting from the oldest one.

Add documents from history to the list
Adds the document saved in the print history to the document list.

Exit
Ends the Canon IJ XPS Preview. The documents remaining in the document list will be deleted
from the list.
This command has the same function as the Exit in the print settings area.

Edit Menu

Selects the method for editing multiple documents or pages.

Undo
Reverses the previous change.
If the change cannot be reversed, this function is grayed out and cannot be selected.
This command has the same function as the @(Undo) on the toolbar.

Documents

Selects the method for editing print documents.
Combine Documents
Combines the documents selected in the document list into one document.
If only one document is selected, this command is grayed out and cannot be selected.

This command has the same function as the *J(Combine Documents) on the toolbar.

Reset Documents
Returns the document selected in the document list to their status before they were added to
the Canon IJ XPS Preview.
The combined documents are separated, and the original documents are restored.

This command has the same function as the E (Reset Documents) on the toolbar.

Move Document
Use the following command to change the order of the documents selected in the document
list.

Move to First
Moves the selected print document to the beginning of the document list.
If the currently selected document is the first document, this command is grayed out and
cannot be selected.

Move Up One
Moves the selected print document one up from its current position.
If the currently selected document is the first document, this command is grayed out and
cannot be selected.
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Move Down One
Moves the selected print document one down from its current position.
If the currently selected document is the last document, this command is grayed out and
cannot be selected.

Move to Last
Moves the selected print document to the end of the document list.
If the currently selected document is the last document, this command is grayed out and
cannot be selected.

Delete Document
Deletes the selected document from the document list.
If the document list contains only one document, the document is grayed out and cannot be
selected.

This command has the same function as the 1s;h((Delete Document) on the toolbar.

Grayscale Printing
Allows you to change the monochrome print settings.
This command has the same functionality as the Grayscale Printing check box in the print
settings area.

Page Layout Printing...
Opens the Page Layout Printing dialog box.
This dialog box allows you to set Page Layout Printing, Pages, Page Order, and Page
Border.

Duplex Printing...
Opens the Duplex Printing dialog box.
This dialog box allows you to set Duplex Printing (Manual), Stapling Side, and Margin.

Copies...
Opens the Copies dialog box.
This dialog box allows you to set Copies, Collate, and Print from Last Page.

Pages
Selects the method for editing print pages.
Delete Page
Deletes the currently selected page.
If page layout printing is set, the pages enclosed with red frame will be deleted.

This command has the same function as the *(Delete Page) on the toolbar.

Restore Page
Restores pages that were deleted with the Delete Page function.
To restore pages, you must select the View Deleted Pages check box on the Option menu
and display the deleted pages as thumbnails.

Move Page
Use the following command to change the order of the currently selected pages.

Move to First
Moves the currently selected page to the beginning of the document.
If the currently selected page is the first page, this command is grayed out and cannot be
selected.
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Move Forward One
Moves the currently selected page one position in front of its current position.
If the currently selected page is the first page, this command is grayed out and cannot be
selected.

Move Backward One
Moves the currently selected page one position after its current position.
If the currently selected page is the last page, this command is grayed out and cannot be
selected.

Move to Last
Moves the currently selected page to the end of the document.
If the currently selected page is the last page, this command is grayed out and cannot be
selected.

View Menu
Selects the documents and pages to be displayed.
Documents
Use the following command to select the document to display.
First Document
Displays the first document in the document list.
If the currently selected document is the first document, this command is grayed out and
cannot be selected.

Previous Document
Displays the document located before the currently displayed document.
If the currently selected document is the first document, this command is grayed out and
cannot be selected.

Next Document
Displays the document located after the currently displayed document.
If the currently selected document is the last document, this command is grayed out and
cannot be selected.

Last Document
Displays the last document in the document list.
If the currently selected document is the last document, this command is grayed out and
cannot be selected.

Pages
Use the following command to select the page to be displayed.

»» Note

« If the Page Layout setting in the printer driver is specified to Tiling/Poster, or Booklet, the
number of pages is the number of sheets to be used for printing, and not the number of pages
in the original document created with the application software.

First Page
Displays the first page of the document.
If the currently displayed page is the first page, this command is grayed out and cannot be
selected.
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Previous Page
Displays the page located before the currently displayed page.
If the currently displayed page is the first page, this command is grayed out and cannot be
selected.

Next Page
Displays the page located after the currently displayed page.
If the currently displayed page is the last page, this command is grayed out and cannot be
selected.

Last Page
Displays the last page of the document.
If the currently displayed page is the last page, this command is grayed out and cannot be
selected.

Page Selection...
Displays the Page Selection dialog box.
This command allows you to specify the page number of the page to be displayed.

Zoom Menu
Selects the ratio of the actual size printed on the paper to the preview display size.
You can also select the ratio from the drop-down list box located on the toolbar.
Whole
Displays the entire page of data as one page.

50%
Reduces the displayed data to 50% of the actual size to be printed.

100%
Displays the data at the actual size to be printed.

200%
Enlarges the displayed data to 200% of the actual size to be printed.

400%
Enlarges the displayed data to 400% of the actual size to be printed.

Option Menu
Toggles the show / hide status of the following information.
View Thumbnails
Reduces all pages in the document selected in the document list and displays them at the bottom
of the preview window.

This command has the same function as the ll;ln(View Thumbnails) on the toolbar.

View Document List
Displays the print document list at the top of the preview window.

View Print Settings Area
Displays the print settings area at the right side of the preview window.

View Deleted Pages
When the thumbnails are displayed, this function displays pages that were deleted with the Delete
Page function.
To check deleted pages, you must first select the View Thumbnails check box.
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Keep printed documents on the list
Leaves the printed document in the document list.

Print Settings Displayed at Startup
Switches the tab of the print settings area to be displayed when the Canon IJ XPS Preview is
started.
Select Page Information, Layout, or Manual Color Adjustment.

Help Menu
When you select this menu item, the Help window for Canon IJ XPS Preview is displayed, and you can
check the version and copyright information.

@ (Print)

Prints the documents selected in the document list.
The printed documents are deleted from the list, and when all documents are printed, the Canon IJ XPS
Preview closes.

'ﬂ_'](Combine Documents)
Combines the documents selected in the document list into one document.
If only one document is selected, this command is grayed out and cannot be selected.

1=3‘E(Delete Document)
Deletes the selected document from the document list.
If the document list contains only one document, the document is grayed out and cannot be selected.

E (Reset Documents)
Returns the document selected in the document list to their status before they were added to the Canon
IJ XPS Preview.
The combined documents are separated, and the original documents are restored.

%(View Thumbnails)
Reduces all pages in the document selected in the document list and displays them at the bottom of the
preview window.
To hide the print pages, click View Thumbnails again.

!r(Move to First)
Moves the selected print document to the beginning of the document list.
If the currently selected document is the first document, this command is grayed out and cannot be
selected.

El‘(Move Up One)
Moves the selected print document one up from its current position.
If the currently selected document is the first document, this command is grayed out and cannot be
selected.

é’(Move Down One)
Moves the selected print document one down from its current position.
If the currently selected document is the last document, this command is grayed out and cannot be
selected.
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EiL(Move to Last)
Moves the selected print document to the end of the document list.
If the currently selected document is the last document, this command is grayed out and cannot be
selected.

£3(Undo)
Reverses the previous change.
If the change cannot be reversed, this function is grayed out and cannot be selected.

- k(Delete Page)
Deletes the currently selected page.
If page layout printing is set, the pages enclosed with red frame will be deleted.

Document list
Displays the list of the print documents.
The document selected in the document list becomes the target for preview display and editing.
Document Name
Displays the name of the print document.
If you click the name of the selected print document, a text box is displayed, and you can rename
the document to any name.

Pages
Displays the number of pages in the print document.

22 Important

» The number displayed in Pages and the output page count are different.
» To check the output page count, check the status bar at the bottom of the preview window.

Status
Displays the status of the print documents.
Documents that are undergoing data processing are displayed as Processing data.

2% Important

* Documents showing Processing data cannot be printed or edited.
Wait until the data processing ends.

Print Settings Area Screen
Allows you to check and change the print settings of the documents selected in the document list.
Print Settings Area is displayed on the right side of the preview window.
Page Information tab
The print settings are displayed for each page.
You can change the media type and paper source settings.
Printer Paper Size
Displays the paper size of the document to be printed.

Media Type
Allows you to select the media type of the document to be printed.

Paper Source
Allows you to select the paper source of the document to be printed.

Page Layout
Displays the page layout of the document to be printed.
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Layout tab
You can specify settings for page layout printing.
To apply the specified settings, click Apply.
If the page layout print settings cannot be changed for the print document, the individual items are
grayed out and cannot be selected.

Manual Color Adjustment tab

This tab allows you to adjust the color balance by changing the settings of the Cyan, Magenta,

Yellow, Brightness, Intensity, and Contrast options.

Cyan/Magenta/Yellow
Adjusts the strengths of Cyan, Magenta, and Yellow.
Moving the slider to the right makes a color stronger, and moving the slider to the left makes a
color weaker.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to
50.
This adjustment changes the relative amount of ink of each color used, which alters the total
color balance of the document.
Use your application software if you want to change the total color balance significantly. Use
the printer driver only if you want to adjust the color balance slightly.

22 Important

* When Grayscale Printing is checked, Cyan, Magenta, and Yellow appear grayed out
and are unavailable.

Brightness
Selects the brightness of your print.
Pure white and black will not change, but colors between white and black will change.

Intensity
Adjusts the overall intensity of your print.
Moving the slider to the right increases the intensity, and moving the slider to the left
decreases the intensity.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to
50.

Contrast
Adjusts the contrast between light and dark in the image to be printed.
Moving the slider to the right increases the contrast, moving the slider to the left decreases the
contrast.
You can also directly enter a value linked to the slider. Enter a value in the range from -50 to
50.

Defaults
Restores all the settings you have changed to their default values.
Clicking this button restores all the settings on this tab to their default values (factory settings).

Grayscale Printing
Allows you to change the monochrome print settings.

Duplex Printing (Manual)
Select whether to print the document to both sides of the paper manually or to one side of the
paper.
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If the duplex print settings cannot be changed for the print document, this item is grayed out and is
unavailable.

32 Important

* When you select Booklet for Page Layout, Duplex Printing (Manual) of the print settings
area will be set automatically. In this case, Duplex Printing (Manual) is grayed out and is
unavailable.

Copies
Specifies the number of copies you want to print. You can specify a value from 1 to 999.
If the numbers of copies cannot be changed for the print document, this item is grayed out and is
unavailable.

Exit
Ends the Canon IJ XPS Preview.
The documents remaining in the document list will be deleted from the list.

Print
Prints the documents selected in the document list.
The printed documents are deleted from the list, and when all documents are printed, the Canon IJ
XPS Preview closes.
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Canon |J Status Monitor Description

The Canon IJ Status Monitor displays the status of the printer and the printing progress. The monitor uses
graphics, icons, and messages to let you know the printer status.
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Canon |J Status Monitor Features
The Canon IJ Status Monitor offers the following advantages:

You can check the status of the printer on the screen.
The status of the printer is shown on the screen in real time.
You can check the printing progress of each printing document (print job).

Error types and solutions are shown on the screen.
Shown when a printer error occurs.
You can immediately check how to respond.

Canon IJ Status Monitor Overview

Canon IJ Status Monitor allows you to check the status of the printer and ink with messages.
You can check the information on the printing document and the printing progress during printing.
When a printer error occurs, it shows the cause and solution. Follow the instruction in the message.

Printer
Canon |J Status Monitor shows an icon when a warning or error occurs to the printer.

1': Indicates that a warning (operator call error) has occurred or the printer is working.
@ : There has been an error which requires a service.

Document Name
Shows the name of the document to be printed.

Owner
Shows the owner's name of the document to be printed.

Printing Page
Shows the number of printing page and total printing pages.

Display Print Queue
Shows the print window used to manage the print job that is being printed or being in the print

queue.

Cancel Printing
Cancels the current print job.
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3» Important

* The Cancel Printing button is enabled only while print data is being sent to the printer.
Once the print data has been sent, the button is grayed out and becomes unavailable.

Option Menu
If you select Enable Status Monitor, when a printer related message is generated the Canon |J
Status Monitor starts.
When Enable Status Monitor is selected, following commands are available.
Always Display Current Job
Displays the Canon IJ Status Monitor during printing.

Always Display on Top
Displays the Canon IJ Status Monitor in front of other windows.

Display Guide Message

Displays the guide for operations in which how to set paper is complicated.

Envelope Printing
Displays the guide message when envelope printing starts.
To hide this guide message, select the Do not show this message again check box.
To display the guide messages again, click Envelope Printing on the Display Guide
Message in the Option menu and enable this setting.

Hagaki Printing
Displays the guide message before the printer begins hagaki printing.
To hide this guide message, select the Do not show this message again check box.
To display the guide messages again, click Hagaki Printing on the Display Guide
Message in the Option menu and enable this setting.

Start when Windows is Started
Starts the Canon IJ Status Monitor automatically when you start Windows.

Ink Details Menu
Select this menu to check information such as the ink tank types for your printer.

Help Menu
When you select this menu item, the Help window for Canon IJ Status Monitor is displayed, and

you can check the version and copyright information.
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Updating the MP Drivers
» Obtaining the Latest MP Drivers
» Deleting the Unnecessary MP Drivers
» Before Installing the MP Drivers

» Installing the MP Drivers
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Obtaining the Latest MP Drivers

The MP Drivers include a printer driver and ScanGear (scanner driver).

By updating the MP Drivers to the latest version of the MP Drivers, unresolved problems may be solved.

You can access our website and download the latest MP Drivers for your model.

22 Important

* You can download the MP Drivers for free, but any Internet access charges incurred are your

responsibility.
+ Before installing the latest MP Drivers, delete the previously installed version.

Related Topics

= Before Installing the MP Drivers
= |nstalling the MP Drivers
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Deleting the Unnecessary MP Drivers

The MP Drivers which you no longer use can be deleted.
When deleting the MP Drivers, first exit all programs that are running.

The procedure to delete the unnecessary MP Drivers is as follows:

1. Start the uninstaller

Select Control Panel -> Programs -> Programs and Features.
From the program list, select "XXX MP Drivers" (where "XXX" is your model name) and then click

Uninstall.

The confirmation window for uninstalling the model appears.

32 Important

* In Windows 10, Windows 8.1, Windows 8, Windows 7, or Windows Vista, a confirmation/warning
dialog box may appear when starting, installing or uninstalling software.
This dialog box appears when administrative rights are required to perform a task.
When you are logged on to an administrator account, click Yes (or Continue, Allow) to continue.
Some applications require an administrator account to continue. In such cases, switch to an
administrator account, and restart the operation from the beginning.

2. Execute the uninstaller

Click Execute. When the confirmation message appears, click Yes.
When all the files have been deleted, click Complete.

The deletion of the MP Drivers is complete.

32 Important

* Printer driver, XPS printer driver, and ScanGear (scanner driver) will be deleted when you uninstall the
MP Drivers.
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Before Installing the MP Drivers

This section describes the items that you should check before installing the MP Drivers. You should also
refer to this section if the MP Drivers cannot be installed.

Checking the Printer Status

» Confirm that the USB port of this printer and the computer are firmly connected with the USB cable.
» Turn off the printer.

Checking the Personal Computer Settings

» Terminate all running applications.
* Log on as a user who has the administrator account.

32 Important

 Before installing the latest MP Drivers, delete the previously installed version.

Related Topics

= Obtaining the Latest MP Drivers
= |nstalling the MP Drivers
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Installing the MP Drivers

You can access our web site through the Internet and download the latest MP Drivers and XPS printer driver
for your model.

The procedure for installing the downloaded MP Drivers is as follows:
1. Turn off the printer

2. Start the installer

Double-click the icon of the downloaded file.
The installation program starts.

3% Important

* In Windows 10, Windows 8.1, Windows 8, Windows 7, or Windows Vista, a confirmation/warning
dialog box may appear when starting, installing or uninstalling software.
This dialog box appears when administrative rights are required to perform a task.
When you are logged on to an administrator account, click Yes (or Continue, Allow) to continue.
Some applications require an administrator account to continue. In such cases, switch to an
administrator account, and restart the operation from the beginning.

3. Install the MP Drivers
Take the appropriate action as described on the screen.

> Note

+ To use this printer on a network, you must manually select the connection destination from the

client.

To manually select a connection destination, click Cancel in the Connect Cable window. When
the confirmation message appears, click Yes.

In the Installation Incomplete window, select the Select printer port check box, click Manual
Selection, and then select the appropriate port.

4. Complete the installation

Click Complete.

Depending on the environment you are using, a message prompting you to restart the computer may be
displayed. To complete the installation properly, restart the computer.

22 Important

* You can install the XPS printer driver with the same procedure for installing the MP Drivers. However,
when installing the XPS printer driver, first complete installation of the MP Drivers.

* You can download the MP Drivers and XPS printer driver for free, but any Internet access charges
incurred are your responsibility.

» Before installing the latest MP Drivers, delete the previously installed version.
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Related Topics

= QObtaining the Latest MP Drivers
= Deleting the Unnecessary MP Drivers
= Before Installing the MP Drivers
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Sharing the Printer on a Network

When multiple computers are being used in the network environment, you can share the printer connected
to one computer with the other computers.
The Windows versions of the computers connected to the network do not necessarily have to be the same.
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» Settings on Print Server

This section describes the procedure for setting a computer that connects with this printer directly
through a USB cable.
+ Settings on Client PC

This section describes the procedure for setting a computer that uses this printer though a network.
When you execute print, the data is sent to the printer through the print server system.

32 Important

* In case an error occurred when a document is printed by the client system to a shared printer, the error
message of Canon |J Status Monitor will be displayed both on the client system and the print server
system. For regular printing, Canon IJ Status Monitor will be displayed only on the client system.

»» Note

* You must install a print driver in the print server and in each client.

Related Topic

= Restrictions on Printer Sharing
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Settings on Print Server
When you use the printer on a network, set up the printer driver for sharing on the print server system.

The procedure for setting up the print server systems is as follows:

1. Install the MP Drivers on the print server system

2. Select as described below:

* If you are using Windows 10, Windows 8.1, or Windows 8, select Control Panel -> Hardware and
Sound -> Devices and Printers.

* If you are using Windows 7, select the Start menu -> Devices and Printers.

+ If you are using Windows Vista, select the Control Panel -> Hardware and Sound -> Printers.

« If you are using Windows XP, select the Control Panel -> Printers and Other Hardware ->
Printers and Faxes.

The Devices and Printers window (Windows 10, Windows 8.1, Windows 8, Windows 7), Printers
window (Windows Vista) or Printers and Faxes window (Windows XP) is displayed.

3. Click the icon for the model name of printer to be shared

* If you are using Windows 10, Windows 8.1, Windows 8, or Windows 7, press the Alt key on your
keyboard and then select Printer properties -> Sharing tab from the displayed File menu.

« If you are using Windows Vista, press the Alt key on your keyboard and then select Run as
administrator -> Sharing... from the displayed File menu.

* If you are using Windows XP, select Sharing... from the File menu.

2% Important

* In Windows 10, Windows 8.1, Windows 8, Windows 7, or Windows Vista, a confirmation/warning
dialog box may appear when starting, installing or uninstalling software.
This dialog box appears when administrative rights are required to perform a task.
When you are logged on to an administrator account, click Yes (or Continue, Allow) to continue.
Some applications require an administrator account to continue. In such cases, switch to an
administrator account, and restart the operation from the beginning.

> Note

+ Windows XP may display a message recommending the user to use the Network Setup Wizard to

set up sharing.
When this message appears, choose not to use the wizard and then set up sharing.

4. Set sharing
Select Share this printer on the Sharing tab to set a shared name if necessary, and click OK.

The setup on the print server system is complete. Next, set up the client systems.
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Settings on Client PC
After setting up the print server system, set up the client system.

The procedure for setting up the client systems is as follows:

If you are using Windows 10, Windows 8.1, Windows 8, Windows 7, or
Windows Vista

1. Install the MP Drivers on the client systems

»» Note

* You must manually select the connection destination on the client computer.
During installation, click Cancel in the Connect Cable window. When the confirmation
message appears, click Yes.
In the Installation Incomplete window, select the Select printer port check box, click Manual
Selection, and then select the appropriate port.

2. Start the wizard

« |If you are using Windows 10, Windows 8.1 or Windows 8, select Control Panel -> Hardware
and Sound -> Devices and Printers -> Add a printer.

+ If you are using Windows 7, select the Start menu -> Devices and Printers -> Add a printer.

« If you are using Windows Vista, select the Start menu -> Network -> Add Printer.

The Add Printer window appears.

3. Add a printer

« If you are using Windows 10, Windows 8.1 or Windows 8, click the icon for the printer that you
have configured on the print server system to be shared, and then click Next.

* If you are using Windows 7 or Windows Vista, select Add a network, wireless or Bluetooth
printer, and click the icon for the printer that you have configured on the print server system to
be shared, and then click Next.

»» Note

« If the icon for the printer is not displayed, check that the printer is actually connected to the print
server.
* It may take some time for the icon for the printer to appear.

4. Complete the setup

Take the appropriate action as described on the screen and then click Finish.

* If you are using Windows 10, Windows 8.1, Windows 8 or Windows 7, the icon for the shared
printer will be created in the Devices and Printers window.

« If you are using Windows Vista, the icon for the shared printer will be created in the Printers
window.

The setup on the client systems is complete. You can now share the printer in the network.
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If you are using Windows XP

1. Install the printer driver on the client systems

For installation instructions, see "Installing the MP Drivers."

»» Note

* You must manually select the connection destination on the client computer.
During installation, click Cancel in the Connect Cable window. When the confirmation
message appears, click Yes.
In the Installation Incomplete window, select the Select printer port check box, click Manual
Selection, and then select the appropriate port.

2. Start the wizard

Select the start menu -> Control Panel -> Printers and Other Hardware -> Printers and Faxes ->
Add a printer.

When Welcome to the Add Printer Wizard screen appears, click Next.

3. Add a printer

Select A network printer, or a printer attached to another computer, then click Next.
On the Specify a Printer window, click Next and then search for the print server system.

Click the icon for the printer that you have configured on the print server system to be shared, and
then click Next.

»» Note

« If the icon for the printer is not displayed, check that the printer is actually connected to the print
server.

4. Complete the setup

Take the appropriate action as described on the screen and then click Finish.
The icon for the shared printer will be created in the Printers and Faxes window.

The setup on the client systems is complete. You can now share the printer in the network.
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Restrictions on Printer Sharing

If you are using the XPS printer driver, replace "Canon |J Preview" with "Canon IJ XPS Preview" when
reading this information.

These are restrictions that apply when you are using a printer in a network environment. Check the
restrictions for the environment you are using.

When You Are Sharing a Printer in a Network

« A print completion message may be displayed. To disable the message from being displayed, follow
the procedure below.
o If you are using Windows 10, Windows 8.1 or Windows 8:

In the Devices and Printers window of the client, select the printer from Printers, and click Print
server properties on the command bar.
Uncheck Show informational notifications for network printers on the Advanced tab, and
then restart the computer.

o If you are using Windows 7:

In the Devices and Printers window of the client, select the printer from Printers and Faxes, and
click Print server properties on the command bar.
Uncheck Show informational notifications for network printers on the Advanced tab, and
then restart the computer.

o If you are using Windows Vista:

Press the Alt key from the Printers window on the client system. Open Run as administrator ->
Server Properties... from the displayed File menu.
Uncheck Show informational notifications for network printers on the Advanced tab, and
then restart the computer.

o If you are using Windows XP:

Open Server Properties from the File menu of the Printers and Faxes window on the print
server system.

Uncheck Notify when remote documents are printed on the Advanced tab, and then restart
the computer.

» The bi-directional communication function is disabled and the correct printer status may not be
recognized.
If a client user opens the printer driver properties and then clicks OK with the Enable bidirectional
support check box cleared on the Ports tab, the bidirectional communication function of the print
server may also be disabled.
In this case, check Enable bidirectional support check box on both the print server system and the
client system.

* When you print from a client system, you cannot use Canon IJ Preview.

* When the functions on the Maintenance tab cannot be set properly from a client system, they may be
grayed out. In this case, change the settings from the print server.
When you change the settings of the print server, you should delete the icon of the shared printer from
the client system, and then specify the shared settings again in the client system.
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When the Same Printer Driver is Installed in the Print Server System and the
Client System as the Local Printer

» The net crawl function may automatically create a network printer icon on the client system.
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Printing Using Canon Application Software

» My Image Garden Guide
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My Image Garden Guide

You can learn about the operations and screens of My
Image Garden.

For Windows:

Latest Version

My Image Garden V3.3.x/V3.2.x J

It is recommended that you use the latest version of the application.
Access the Canon website and download the latest application.

How to Check the Version®®

Earlier Versions
Select the version of your My Image Garden.

= V3.1.x/V3.0.x
B \V2.1.x
= V2.0.x
= V1.1.x

For Mac OS:

Latest Version

My Image Garden V3.3.x/V3.2.x J

It is recommended that you use the latest version of the application.
Access the Canon website and download the latest application.

How to Check the Version®

Earlier Versions
Select the version of your My Image Garden.

= V3.1.x/V3.0.x
= V2.1.x
= V2.0.x
= V1.1.x
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Copying

Making Copies on Plain Paper JBasics

s
=9 =}

Switching Page Size between A4 and
Letter
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Making Copies on Plain Paper

Load the original on the platen glass to copy on A4 sized plain paper.

1. Make sure machine is turned on.

2. Load A4 or Letter-sized plain paper.

3. Load original on platen glass.

> Note

* You can switch the size of paper loaded in the rear tray between A4 and Letter.

= Switching Page Size between A4 and Letter

4. Press Color button for color copying, or Black button for black & white copying.
The machine starts copying.

Remove the original on the platen glass after copying is complete.

+ To make multiple copies

Press the Color button or the Black button repeatedly according to the number of copies you
want.

Press the same button (Color button or Black button) as the one which you previously pressed.

» To cancel copying:

Press the Stop button.

32 Important

» Do not open the document cover or remove the original from the platen glass until scanning is
completed.

While the machine is scanning the original, the ON lamp keeps flashing.

»» Note

» To set the print quality to "Draft" (speed priority)
You can set the print quality to "Draft" (speed priority) following the procedure below.
1. Press and hold down Color or Black button for 2 or more seconds in step 4.
The ON lamp flashes once.
2. Release button.
The machine starts copying.

When the print quality is set to "Draft", print speed is given priority over quality. To give priority to quality,
press the Color or Black button for less than 2 seconds to copy in the print quality "Standard".
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Switching Page Size between A4 and Letter

You can switch the size of paper loaded in the rear tray between A4 and Letter.

This setting is useful if you usually load Letter-sized paper in the rear tray.

1. Make sure machine is turned on.

2. Press and hold Stop button and release it when Alarm lamp flashes 14 times.

The ON lamp starts flashing instead of remaining lit.

3. Press Black button to select A4, or Color button to select Letter.

The ON lamp stops flashing and remains lit and the paper size is changed.

»» Note

* When you switch the page size to A4 or Letter, load paper of the selected size.
When the page size is set to A4, load A4 plain paper.
When the page size is set to Letter, load Letter-sized plain paper.

+ This setting is retained even if the machine is turned off.
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Scanning

Scanning from Computer (Windows) Scanning from Computer (Mac OS)

309



Scanning from Computer (Windows)
» Using IJ Scan Utility
» Scanning Using Application Software (ScanGear)
» Other Scanning Methods
» Scanning Tips

» Positioning Originals (Scanning from Computer)
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Using IJ Scan Utility

>

>

What Is IJ Scan Utility (Scanner Software)?

Starting IJ Scan Utility

Easy Scanning with Auto Scan 7Basics

Scanning Documents

Scanning Photos

Scanning with Favorite Settings

Scanning Originals Larger than the Platen (Image Stitch)
@« Adjusting Cropping Frames in the Image Stitch Window

Scanning Multiple Originals at One Time

Saving after Checking Scan Results

Sending Scanned Images via E-mail

Extracting Text from Scanned Images (OCR)

IJ Scan Utility Screens
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What Is IJ Scan Utility (Scanner Software)?

IJ Scan Ultility is an application that allows you to easily scan documents, photos, etc.

You can complete from scanning to saving at one time by simply clicking the corresponding icon in the IJ
Scan Utility main screen.

= Canon U Scan Utility “

Prothact Mame: Caran ErieE b

=) =) Bl =) Bl s

Auta Dooument Fhoto Cushom Stitch ScaniGear

instnxctons Sethngs...

What You Can Do with IJ Scan Utility

Scan Easily according to Purposes

You can scan by simply clicking an icon such as Auto to scan easily, Document to sharpen text in a
document or magazine for better readability, or Photo to scan with settings suitable for photos,
according to the item type or your purpose.

»» Note

» Refer to "lJ Scan Utility Main Screen" for details on the IJ Scan Utility main screen.

Save Scanned Images Automatically

Scanned images are automatically saved in a preset folder. You can change the folder as required.

»» Note

* The default save folders are as follows.

* Windows 10/Windows 8.1/Windows Vista:

Documents folder

* Windows 8/Windows 7/Windows XP:
My Documents folder

» Refer to "Settings Dialog Box" for how to specify a folder.

Integrate with Applications

You can utilize scanned images through integration with other applications; display scanned images in
your favorite application, attach them to e-mails, extract text from images, and more.
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| s

| ¢ Documents

|uta

PEG Inage Qualty! |standard

POF Comprensan: |5|:nch-d

[ Creale a POF fie Sak supperts keyword ssarch

[[] Save b & subvisider with current date

appbcaton Setngs
18] Doy i i nopbcation: [mwmww

(1 Band b o pppication: 1. Peeview
(1 Gend ba o daldiers e

(0 Aoty b e vrads

() Stert OCR:

() Do pat St iy pqscation

% Important

+ Some functions are available only when My Image Garden is installed.

12> Note

» Refer to "Settings Dialog Box" for how to set the applications to integrate with.
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Starting IJ Scan Utility

Follow the steps below to start IJ Scan Utility.

Windows 10:

From Start menu, select All apps > Canon Utilities > IJ Scan Utility.

Windows 8.1/Windows 8:

Select IJ Scan Utility on the Start screen.

If IJ Scan Utility is not displayed on the Start screen, select the Search charm, and then search for "IJ Scan
Utility".

Windows 7/Windows Vista/Windows XP:

From Start menu, select All Programs > Canon Utilities > IJ Scan Utility > IJ Scan Utility.

L¥) Canon U Scan Utility E

Pracuct Name: Canon SariEE b

m ] W= s

At Doument Photo Cushom Stitch ScanGear

instructions ' | Setbings...
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Easy Scanning with Auto Scan
You can scan easily by automatically detecting the item type.

3% Important

» The following types of items may not be scanned correctly. In that case, adjust the cropping frames
(scan areas) in whole image view of ScanGear (scanner driver) and scan again.

» Photos that have a whitish background

* |tems printed on white paper, hand-written documents, business cards, etc.
» Thin items

» Thick items

1. Make sure that your scanner or printer is turned on.

2. Place items on the platen of your scanner or printer.

= Positioning Originals (Scanning from Computer)

3. Start IJ Scan Utility.

4. Click Auto.

=5 Canon U Scan Utility “

Praduct Name: Canan SR b

=) =) W =) B s

Auta Deoument Photo Cusbom Stitch ScanGear

instrnuctons Sethngs...

Scanning starts.

»» Note

+ Click Cancel to cancel the scan.

+ To apply suitable corrections based on the item type, click Settings..., then select the Apply
recommended image correction checkbox in the Settings (Auto Scan) dialog box.

» Scanned images are saved in the folder set for Save in in the Settings (Auto Scan) dialog box
displayed by clicking Settings.... In the Settings (Auto Scan) dialog box, you can also make advanced
scan settings.

» Refer to the following pages to scan by specifying the item type.

= Scanning Photos
= Scanning Documents
= Scanning with Favorite Settings
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Scanning Documents

You can scan items placed on the platen with settings suitable for documents.

1. Place the item on the platen.

= Positioning Originals (Scanning from Computer)

2. Start IJ Scan Utility.

3. Click Settings..., then set the paper size, resolution, etc. in the Settings (Document Scan)

dialog box as required.

When setting is completed, click OK.

4. Click Document.

=5 Canon 1) Scan Utility

Praduct Name: Canadn farEE

EX|
| ] | =) B <

Auta Dooument Fhoto Cushom Stitch

Enstruchons ' | Settings...

Scanning starts.

»>» Note

+ Click Cancel to cancel the scan.

» Scanned images are saved in the folder set for Save in in the Settings (Document Scan) dialog box
displayed by clicking Settings.... In the Settings (Document Scan) dialog box, you can also make
advanced scan settings.

316



Scanning Photos

You can scan photos placed on the platen with settings suitable for photos.

1. Place the photo on the platen.

= Positioning Originals (Scanning from Computer)

2. Start IJ Scan Utility.

3. Click Settings..., then set the paper size, resolution, etc. in the Settings (Photo Scan)

dialog box as required.

When setting is completed, click OK.

4. Click Photo.

' Canon L' Scan Utility

Praduct Name: Canadn farEE

EX|
m G| W= B s
Aut Dooument Photo HCanGear

Cushom Stibch

Enstruchons ' | Settings...

Scanning starts.

»>» Note

» Click Cancel to cancel the scan.

» Scanned images are saved in the folder set for Save in in the Settings (Photo Scan) dialog box
displayed by clicking Settings.... In the Settings (Photo Scan) dialog box, you can also make
advanced scan settings.
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Scanning with Favorite Settings

You can scan items placed on the platen with your favorite settings saved beforehand.

This is convenient for saving frequently used settings or when specifying scan settings in detail.

1. Start IJ Scan Utility.

2. Click Settings..., then set the item type, resolution, etc. in the Settings (Custom Scan)

dialog box as required.
When setting is completed, click OK.
»» Note

* Once the settings are made, you can scan with the same settings from the next time.

3. Place the item on the platen.

= Positioning Originals (Scanning from Computer)

4. Click Custom.

L} Canon 1) Scan Utility

Praduct Name: Canan TR

K
m = E| S|l s

Auta Deaument Photo Cushom Stitch

instructons ' | Settings...

Scanning starts.

»» Note

* Click Cancel to cancel the scan.

» Scanned images are saved in the folder set for Save in in the Settings (Custom Scan) dialog box
displayed by clicking Settings.... In the Settings (Custom Scan) dialog box, you can also make
advanced scan settings.
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Scanning Originals Larger than the Platen (Image Stitch)

You can scan the left and right halves of an item larger than the platen and combine them back into one
image. ltems up to approximately twice as large as the platen are supported.

22> Note

 The following explains how to scan from the item to be placed on the left side.

1. Start IJ Scan Utility.

2. Click Settings..., then set the item type, resolution, etc. in the Settings (Scan and Stitch)
dialog box as required.

When setting is completed, click OK.

3. Click Stitch.

The Image Stitch window appears.

4. In Select Output Size, select an output size according to the paper size.

Select Gutput Size

a3 fasx 2

Sean Doeciion

|5zan tom Lett

scan Image 1

Start Scanming Image 1
I—I|

Sean Image 2

Start Scanning Image £

[ Aechust oropping Sames

Save
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5. Make sure that Scan from Left is selected in Scan Direction.

XA|g2a 9

Sean Image 2

Start Scanning Image £

[ Aechust cropping Sames

6. Place the item that is to be displayed on the left side of the screen face-down on the platen.

7. Click Start Scanning Image 1.

Sean Image 2

Start Scanning Image

[T Aedhust erapping Samas

The first item is scanned and appears in 1.
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23 Note

¢ Click Cancel to cancel the scan.

8. Place the item that is to be displayed on the right side of the screen face-down on the
platen.

9. Click Start Scanning Image 2.

IVEETE;
—:

Select iput Size

a3 fatx)

Semn Dwgciion

|5can trom Lett

Scan Image 1

Start Scanning Image 1

Sean Image 2

The second item is scanned and appears in 2.

12> Note

* Click Cancel to cancel the scan.

10. Adjust the scanned images as required.

Use the Toolbar to rotate or zoom in/out, or drag the images to adjust their positions.

321



Select Duiput Size

EB{M:!}

Soan Image 1

Start Scanning Image L

Sean Image 2

“tart Scanning Image 2

122> Note

» Select the Adjust cropping frames checkbox to specify the area to be saved.

= Adjusting Cropping Frames in the Image Stitch Window

» To scan an item again, select the image in the Preview area or the thumbnail at the top of the

screen, then click x (Delete). The selected image is deleted, allowing you to scan the item
again.

11. Click Save.
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Select Diput Size

EB{M:!}

Soan Image 1

Start Scanning Image L

Sean mage 2

“tart Scanning Image 2

The combined image is saved.

13> Note

» Refer to "Image Stitch Window" for details on the Image Stitch window.
* You can make advanced scan settings in the Settings (Scan and Stitch) dialog box displayed by
clicking Settings....
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Adjusting Cropping Frames in the Image Stitch Window

"Cropping" is the act of selecting the area you want to keep in an image and discarding the rest when
scanning it.

In the Image Stitch window, you can specify a cropping frame on the image displayed in the Preview area.

»» Note

» Refer to "Adjusting Cropping Frames (ScanGear)" for your model from Home of the Online Manual for
how to adjust cropping frames with ScanGear (scanner driver).

Initial Cropping Frame

No cropping frame is specified. When you select the Adjust cropping frames checkbox, an active
cropping frame is automatically specified around the image in the Preview area. You can drag the
cropping frame to specify the area.

When you perform a scan, the image in the area specified with the cropping frame will be scanned.

Adjusting a Cropping Frame

The cursor will change into = jt Rﬂ '3;] (Arrow) when it is positioned over a cropping frame. Click and
drag the mouse to expand or contract the cropping frame.

The cursor will change into 4%) (Crosshair Arrow) when it is positioned within a cropping frame. Click and
drag the mouse to move the entire cropping frame.

Deleting Cropping Frames

To delete the cropping frame, deselect the Adjust cropping frames checkbox.
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Scanning Multiple Originals at One Time

You can scan two or more photos (small items) placed on the platen at one time and save each image
individually.

22 Important

» The following types of items may not be scanned correctly. In that case, adjust the cropping frames
(scan areas) in whole image view of ScanGear (scanner driver) and scan again.

» Photos that have a whitish background

* Items printed on white paper, hand-written documents, business cards, etc.
» Thin items

» Thick items

Refer to "Scanning Multiple Documents at One Time with ScanGear (Scanner Driver)" for your model
from Home of the Online Manual for details.

Using Auto Scan:

Whether there are multiple items or not is detected automatically. Click Auto in the IJ Scan Utility main
screen and scan.

= Easy Scanning with Auto Scan

Not Using Auto Scan:

In the Settings dialog box, set Paper Size to Auto scan and scan.

»>» Note

» The screens for scanning with favorite settings are used as examples in the following descriptions.

1. Place the items on the platen.

= Positioning Originals (Scanning from Computer)

2. Start IJ Scan Utility.

3. Click Settings....

& Canon U Scan Utility “

Praduct Name: Canan SEriEE M.

=) =) 0| =) Bl s

Auta Doaument Photo Cushom Stitch Scanear

Enstnackons Sertngs..,

The Settings dialog box appears.
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4. Click Custom Scan.

JPEG Imags Cualby:

POF Coimge essa0n
[+ Creabe & FOF fie $at supports keyword search

[ '5ave to.a subduider with cunrent dabe

Al ateeh Ta vy

5. Select Select Source according to the items to be scanned.

PEG Inage Quakty

[ 5ave to o subdidar wth current dabe.

[ ched: scan results

Appscaon Sattngs
() Dy v a0 appbcation:

6. Select Auto scan for Paper Size, then click OK.
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JPEG Image Gualbyr
[ '5ave to.a subdnider wih cunrent date
[ ched: scan results

Appboaten Bettings
() Oy Wi ppbcation:

The IJ Scan Utility main screen appears.

23» Note

» Refer to the following pages for details on the setting items in the Settings dialog box.

= Settings (Document Scan) Dialog Box
= Settings (Photo Scan) Dialog Box
= Settings (Custom Scan) Dialog Box

7. Click Custom.

an Utility

Multiple items are scanned at one time.

13 Note

+ Click Cancel to cancel the scan.

» Scanned images are saved in the folder set for Save in in the corresponding Settings dialog box
displayed by clicking Settings.... In each Settings dialog box, you can also make advanced scan
settings.
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Saving after Checking Scan Results
You can check the scan results, then save the images to a computer.

2 3% Important

* You cannot check the scan results before saving when scanned using Auto scan.

13 Note

» The screens for scanning photos are used as examples in the following descriptions.

1. Start IJ Scan Utility.

2. Click Settings....

in Litility

The Settings dialog box appears.

3. Click Photo Scan.

JPEG Imags Gualiby:
[ 5ave to.a subdnider with cunrent dabe

[ chech: s rasults

Appheaten Sattngs
() Oy Wiy ppbcation:

4. Select the Check scan results checkbox, then click OK.
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JPEG Imags Cualby:
[ '5ave to.a subdnider with cunrent date

[ Ched: scan results

Appboanen Sattngs
() Oy Wi ppbcation:

The IJ Scan Utility main screen appears.

23» Note

» Refer to the following pages for details on the setting items in the Settings dialog box.

= Settings (Document Scan) Dialog Box
= Settings (Photo Scan) Dialog Box

= Settings (Custom Scan) Dialog Box
= Settings (Scan and Stitch) Dialog Box
= Settings (ScanGear) Dialog Box

5. Click Photo.

Scanning starts.

When scanning is completed, the Save Settings dialog box appears.

23 Note

¢ Click Cancel to cancel the scan.

6. Change the image order or file save options as required.
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You can change the image order or file save options in the Save Settings dialog box.

> Note

* The default save folders are as follows.

* Windows 10/Windows 8.1/Windows Vista:

Documents folder

* Windows 8/Windows 7/Windows XP:

My Documents folder

7. Click OK.

Scanned images are saved according to the settings.
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Sending Scanned Images via E-mail
You can send scanned images via e-mail.

13 Note

» The screens for scanning photos are used as examples in the following descriptions.

1. Start IJ Scan Utility.

2. Click Settings....

The Settings dialog box appears.

3. Click Photo Scan.

JPEG Imags Gualiby:
[ 5ave to.a subdnider with cunrent dabe

[ chech: s rasults

Appboaten Bettings
() Oy Wi ppbcation:

4. Select Attach to e-mail in Application Settings, then select an e-mail client.
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Fia Mame:

SavE Nl

Duata Formmak

JPEG Imags Qualby:

[ 5ave to.a subdnider with cunrent dabe

[ chedk scan results
Applenten Sattngs

{7 D wih an appbcation:

(Z15and to an appication:

(2 5end b fobder:

(8] Attach by & -madr

{7100 notskart any apphcation

122> Note

* You can add e-mail clients to use for attachments from the pull-down menu.
« If None (Attach Manually) is selected, manually attach scanned and saved images to e-mail.

5. Click OK.

JPEG Image Gualiby:
[l mave s subfobcher with cunrent dabe
[ ched: semn rasults

Appboaen Settngs

() Bipen wizh an apphcation:
(21 Band to.an epplcaton:
(T1sand to a folder:

(8] Attach b e -mad:

(7100 nobskard any apphoation

The IJ Scan Utility main screen appears.
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»» Note

» Refer to the following pages for details on the setting items in the Settings dialog box.

= Settings (Auto Scan) Dialog Box

= Settings (Document Scan) Dialog Box
= Settings (Photo Scan) Dialog Box

= Settings (Custom Scan) Dialog Box
= Settings (ScanGear) Dialog Box

6. Click Photo.

=5 Canon U Scan Utility

Praduct Name: Canion EarEE

EX]
= )| =) | s

s boem Stibch

nsinuctions ' | Settings...

Scanning starts.

When scanning is completed, the specified e-mail client starts and the images will be attached to a new
message.

»» Note

+ Click Cancel to cancel the scan.

* The scanned images are saved according to the settings made in the Settings dialog box.

» When the Check scan results checkbox is selected in the Settings dialog box, the Save Settings
dialog box appears. After you set the save options and click OK, the scanned images are saved
and automatically attached to a new message of the specified e-mail client.

7. Specify the recipient, enter the subject and message, then send e-mail.

Refer to the manual of your e-mail client for e-mail settings.
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Extracting Text from Scanned Images (OCR)
Scan text in scanned magazines and newspapers and display it in your text editor.

13 Note

* You can extract text when scanning via Document, Custom, or ScanGear.
» The screens for scanning documents are used as examples in the following descriptions.

1. Start IJ Scan Utility.

2. Click Settings....

in Litility

N | =)

Phato Cusshoem Stikch

The Settings dialog box appears.

3. Click Document Scan.

= i

B awesan

Elila Decirmen b Soan

o

[+ Creabe & FOF fie $at supports keyword search

[ '5ave toa subduider with cunrent dabe

[ chad: sen rasults

Anwbeaneey Lot

27» Note

» For Resolution, only 300 dpi or 400 dpi can be set when Start OCR is selected in Application
Settings.
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4. Select Start OCR for Application Settings, then select the application in which you want
to display the result.

|

ALt Soan

JPEG Image Qualityr
[ S b subficier wh ournent clabe

[ ched: semn rasults

Apabeanan St
() Eipean wish & apphcation:
(21 Band to.an epplcation:
(Z15and to a folder:

(Z) attech by e -mad:

(8] Start DCR

(Z)Do nat skart any applcation

122> Note

« If a compatible application is not installed, the text in the image is extracted and appears in your
text editor.
Text to be displayed is based on Document Language in the Settings (General Settings) dialog
box. Select the language you want to extract in Document Language and scan.

* You can add the application from the pull-down menu.

5. Click OK.
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JPEG Image Qualityr
[ S b subficier wh ournent clabe

[ ched: semn rasults

Apabeanan St
() Eipean wish & apphcation:
(21 Band to.an epplcation:
(Z15and to p folder:

(71 artach boe-mad:

(8] Start DCR

(Z)Do nat skart any applcation

The IJ Scan Utility main screen appears.

23» Note

» Refer to the following pages for details on the setting items in the Settings dialog box.

= Settings (Document Scan) Dialog Box
= Settings (Custom Scan) Dialog Box
= Settings (ScanGear) Dialog Box

6. Click Document.

Canon 1) Scan Utility

Scanning starts.

When scanning is completed, the scanned images are saved according to the settings, and the extracted
text appears in the specified application.

23» Note

¢ Click Cancel to cancel the scan.

» Text displayed in your text editor is for guidance only. Text in the image of the following types of
documents may not be detected correctly.

» Documents containing text with font size outside the range of 8 points to 40 points (at 300 dpi)
+ Slanted documents
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Documents placed upside down or documents with text in the wrong orientation (rotated
characters)

Documents containing special fonts, effects, italics, or hand-written text

Documents with narrow line spacing

Documents with colors in the background of text

Documents containing multiple languages
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IJ Scan Utility Screens

» |J Scan Utility Main Screen

» Settings Dialog Box

]

]

]

]

Settings (Auto Scan) Dialog Box
Settings (Document Scan) Dialog Box
Settings (Photo Scan) Dialog Box
Settings (Custom Scan) Dialog Box
Settings (Scan and Stitch) Dialog Box
Settings (ScanGear) Dialog Box

Settings (General Settings) Dialog Box

» Save Settings Dialog Box

» Image Stitch Window

338



IJ Scan Utility Main Screen

Follow the steps below to start IJ Scan Utility.

Windows 10:
From Start menu, select All apps > Canon Utilities > IJ Scan Utility to start IJ Scan Utility.

Windows 8.1/Windows 8:

Select IJ Scan Utility on Start screen to start IJ Scan Utility.

If IJ Scan Utility is not displayed on the Start screen, select the Search charm, and then search for "IJ Scan
Utility".

Windows 7/Windows Vista/Windows XP:

From Start menu, select All Programs > Canon Utilities > IJ Scan Utility > IJ Scan Utility to start IJ Scan
Utility.

You can complete from scanning to saving at one time by simply clicking the corresponding icon.

EX Canon U Scan Utility Ex

Prodhsct Name: A SAfEE b

= =] W =) s

Auta Doument Fhoto Cushom Stitch ScanGear

Enstrachons Sethngs...

Product Name
Displays the name of the product that IJ Scan Utility is currently set to use.

If the displayed product is not the one you want to use, select the desired product from the list.

Auto
Detects the item type automatically and saves them to a computer. The data format for saving will also
be set automatically.

Save settings and the response after scanning can be specified in the Settings (Auto Scan) dialog
box.

Document
Scans items as documents and saves them to a computer.

Scan/save settings and the response after scanning can be specified in the Settings (Document Scan)
dialog box.

Photo
Scans items as photos and saves them to a computer.
Scan/save settings and the response after scanning can be specified in the Settings (Photo Scan)
dialog box.

Custom
Scans items with your favorite settings and saves the images to a computer. The item type can be
automatically detected.
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Scan/save settings and the response after scanning can be specified in the Settings (Custom Scan)
dialog box.

Stitch
Displays the Image Stitch window in which you can scan the left and right halves of an item larger than
the platen and combine the scanned images back into one image.

Scan/save settings and the response after scanning can be specified in the Settings (Scan and Stitch)
dialog box.

ScanGear
Starts ScanGear (scanner driver) in which you can make image corrections and color adjustments

when scanning.

Scan/save settings and applications can be specified in the Settings (ScanGear) dialog box.

Instructions
Opens this guide.

Settings...
Displays the Settings dialog box in which you can specify the scan/save settings and the response after
scanning.
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Settings Dialog Box

A0
There are two tabs in the Settings dialog box: E: (Scanning from a Computer) and ] (General
Settings). When you click a tab, the view in the red frame switches and you can make advanced settings to
functions on each tab.
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E: (Scanning from a Computer) Tab

You can specify how to respond when scanning from IJ Scan Utility or My Image Garden.

= Settings (Auto Scan) Dialog Box

= Settings (Document Scan) Dialog Box
= Settings (Photo Scan) Dialog Box

= Settings (Custom Scan) Dialog Box
[
=

Settings (Scan and Stitch) Dialog Box
Settings (ScanGear) Dialog Box

|
Iﬁ (General Settings) Tab

You can set the product to use, file size restriction on e-mail attachment, language to detect text in
images, and folder in which to save images temporarily.

= Settings (General Settings) Dialog Box

341



Settings (Auto Scan) Dialog Box
Click Auto Scan on the (Scanning from a Computer) tab to display the Settings (Auto Scan) dialog
box.

In the Settings (Auto Scan) dialog box, you can make advanced scan settings to scan by automatically
detecting the item type.

Settings (Auto Scan)
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() Atehy by & wnad: 1. Hone (Sikach Marualy)

() D i S By oyl bt

Insfructions Defaults =4

= (1) Scan Options Area
= (2) Save Settings Area
= (3) Application Settings Area

32 Important

* When the Settings dialog box is displayed from My Image Garden, the setting items for Application
Settings do not appear.

Supported Items

Photos, postcards, business cards, magazines, newspapers, documents, and BD/DVD/CD.

22 Important

+ To scan the following types of items, specify the item type and size in the Settings (Document Scan)
dialog box, Settings (Photo Scan) dialog box, or Settings (Custom Scan) dialog box, then click
Photo, Document, or Custom in the IJ Scan Utility main screen. You cannot scan correctly with Auto.

* A4 size photos
» Text documents smaller than 2L (5 inches x 7 inches) (127 mm x 178 mm), such as paperback
pages with the spine cut off
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* |tems printed on thin white paper
» Long narrow items such as panoramic photos

» Reflective disc labels may not be scanned as expected.
* Place items to be scanned on the platen correctly. Otherwise, items may not be scanned correctly.

Refer to "Positioning Originals (Scanning from Computer)" for how to place items.

»» Note

+ To reduce moire in scans, set Select Source to Magazine in the Settings (Document Scan) dialog
box or Settings (Custom Scan) dialog box, then click Document or Custom in the IJ Scan Utility main
screen.

(1) Scan Options Area

Apply recommended image correction
Applies suitable corrections automatically based on the item type.

22 Important

» The color tone may differ from the source image due to corrections. In that case, deselect the
checkbox and scan.

»» Note

» Scanning takes longer than usual when you enable this function.

(2) Save Settings Area

File Name
Enter the file name of the image to be saved. When you save a file, the date and four digits are
appended to the set file name in the "_20XX0101_0001" format.

»» Note

* When you select the Save to a subfolder with current date checkbox, the date and four digits
are appended to the set file name.

Save in
Displays the folder in which to save the scanned images. To add a folder, select Add... from the pull-
down menu, then click Add in the displayed Select Destination Folder dialog box and specify the
destination folder.

The default save folders are as follows.

* Windows 10/Windows 8.1/Windows Vista:

Documents folder

* Windows 8/Windows 7/Windows XP:

My Documents folder

32 Important

* When the Settings dialog box is displayed from My Image Garden, this option does not appear.

343



Data Format
Auto is selected. The following data formats are automatically applied according to the item type
when saving.

» Photos, postcards, BD/DVD/CD, and business cards: JPEG
* Magazines, newspapers, and documents: PDF

32 Important

» The save format may differ depending on how you place the item.

= Positioning Originals (Scanning from Computer)

JPEG Image Quality
You can specify the image quality of JPEG files.

PDF Compression
Select the compression type for saving PDF files.

Standard
It is recommended that you normally select this setting.
High
Compresses the file size when saving, allowing you to reduce the load on your network/server.
Create a PDF file that supports keyword search

Select this checkbox to convert text in images into text data and create PDF files that support
keyword search.

»>» Note

1
» PDF files that are searchable in the language selected in Document Language on the [
(General Settings) tab of the Settings dialog box are created.

Save to a subfolder with current date
Select this checkbox to create a current date folder in the folder specified in Save in and save
scanned images in it. The folder will be created with a name such as "20XX_01_01"
(Year_Month_Date).

If this checkbox is not selected, files are saved directly in the folder specified in Save in.

(3) Application Settings Area

Open with an application
Select this when you want to enhance or correct the scanned images.

You can specify the application from the pull-down menu.

Send to an application
Select this when you want to use the scanned images as they are in an application that allows you to
browse or organize images.

You can specify the application from the pull-down menu.

Send to a folder
Select this when you also want to save the scanned images to a folder other than the one specified in
Save in.
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You can specify the folder from the pull-down menu.

Attach to e-mail
Select this when you want to send e-mails with the scanned images attached.

You can specify the e-mail client you want to start from the pull-down menu.

Do not start any application
Saves to the folder specified in Save in.

2> Note

» To add an application or folder to the pull-down menu, select Add... from the pull-down menu, then
click Add in the displayed Select Application or Select Destination Folder dialog box and specify
the application or folder.

Instructions
Opens this guide.

Defaults
You can restore the settings in the displayed screen to the default settings.
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Settings (Document Scan) Dialog Box

Click Document Scan on the E: (Scanning from a Computer) tab to display the Settings (Document
Scan) dialog box.

In the Settings (Document Scan) dialog box, you can make advanced scan settings to scan items as
documents.
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= (1) Scan Options Area
= (2) Save Settings Area
= (3) Application Settings Area

32 Important

* When the Settings dialog box is displayed from the Scan screen of My Image Garden, the setting items
for Application Settings do not appear.

(1) Scan Options Area

Select Source
Select the type of item to be scanned.

» Scanning documents: Document
* Scanning magazines: Magazine
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Color Mode
Select the color mode in which to scan the item.

Paper Size
Select the size of the item to be scanned.

When you select Custom, a screen in which you can specify the paper size appears. Select a Unit,
then enter the Width and Height, and then click OK.

Custam 5ize Setting “
widhs ches (1,00 -8.50)
Height: [ 1100 | inches (1.00 - 11.68)
Unet: inches W
| OK | Defaults 1l Cancel

»» Note

+ Click Defaults to restore the specified settings to the default settings.

Resolution
Select the resolution of the item to be scanned.

The higher the resolution (value), the more detail in your image.

= Resolution

»» Note

» Only 300 dpi or 400 dpi can be set when Start OCR is selected in Application Settings.

Image Processing Settings

Click . T | (Plus) to set the following.
3> Note

* When Color Mode is Black and White, only Reduce gutter shadow, Correct slanted text
document, and Detect the orientation of text document and rotate image appear.

Apply Auto Document Fix
Select this checkbox to sharpen text in a document or magazine for better readability.

22 Important

» The color tone may differ from the source image due to corrections. In that case, deselect
the checkbox and scan.

»» Note

» Scanning takes longer than usual when you enable this function.

Sharpen outline
Emphasizes the outline of the subjects to sharpen the image.

Reduce show-through
Sharpens text in an item or reduces show-through in newspapers, etc.

347



Reduce moire
Reduces moire patterns.

Printed materials are displayed as a collection of fine dots. "Moire" is a phenomenon where
uneven gradation or a stripe pattern appears when such photos or pictures printed with fine dots
are scanned.

»» Note

+ Scanning takes longer than usual when you enable Reduce moire.

Reduce gutter shadow
Reduces gutter shadows that appear between pages when scanning open booklets.

»» Note

» Use ScanGear (scanner driver)'s Advanced Mode tab to correct gutter shadows when
scanning non-standard size items or specified areas.
Refer to "Gutter Shadow Correction" for your model from Home of the Online Manual for
details.

Correct slanted text document
Detects the scanned text and corrects the angle (within -0.1 to -10 degrees or +0.1 to +10
degrees) of the document.

22 Important

 The following types of documents may not be corrected properly since the text cannot be
detected correctly.

* Documents in which the text lines are inclined more than 10 degrees or the angles vary
by line

* Documents containing both vertical and horizontal text

» Documents with extremely large or small fonts

» Documents with small amount of text

» Documents containing figures/images

* Hand-written text

+ Documents containing both vertical and horizontal lines (tables)

»» Note

» Scanning takes longer than usual when you enable Correct slanted text document.

Detect the orientation of text document and rotate image
Automatically rotates the image to the correct orientation by detecting the orientation of text in
the scanned document.

32 Important

* Only text documents written in the language selected from Document Language in the
Settings (General Settings) dialog box are supported.

» The orientation may not be detected for the following types of settings or documents since
the text cannot be detected correctly.

* Resolution is outside the range of 300 dpi to 600 dpi
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» Font size is outside the range of 8 points to 48 points
» Documents containing special fonts, effects, italics, or hand-written text
* Documents with patterned backgrounds

In that case, select the Check scan results checkbox and rotate the image in the Save

Settings dialog box.

(2) Save Settings Area

File Name
Enter the file name of the image to be saved. When you save a file, the date and four digits are

appended to the set file name in the "_20XX0101_0001" format.
3> Note

* When you select the Save to a subfolder with current date checkbox, the date and four digits
are appended to the set file name.

Save in
Displays the folder in which to save the scanned images. To add a folder, select Add... from the pull-

down menu, then click Add in the displayed Select Destination Folder dialog box and specify the
destination folder.

The default save folders are as follows.

* Windows 10/Windows 8.1/Windows Vista:

Documents folder

* Windows 8/Windows 7/Windows XP:

My Documents folder

32 Important

* When the Settings dialog box is displayed from My Image Garden, this option does not appear.

Data Format
Select the data format in which to save the scanned images.

You can select JPEG/Exif, TIFF, PNG, PDF, or PDF (Multiple Pages).
32 Important

* You cannot select JPEG/Exif when Color Mode is Black and White.
* When Start OCR is selected in Application Settings, you cannot select PDF or PDF (Multiple

Pages).

PDF Compression
Select the compression type for saving PDF files.

Standard
It is recommended that you normally select this setting.

High
Compresses the file size when saving, allowing you to reduce the load on your network/server.

349



3% Important

» This appears only when PDF or PDF (Multiple Pages) is selected in Data Format.
* When Black and White is selected in Color Mode, this option does not appear.

JPEG Image Quality
You can specify the image quality of JPEG files.

3% Important

» This appears only when JPEG/EXxif is selected in Data Format.

Create a PDF file that supports keyword search
Select this checkbox to convert text in images into text data and create PDF files that support
keyword search.

22 Important

» This appears only when PDF or PDF (Multiple Pages) is selected in Data Format.

»» Note

A0
» PDF files that are searchable in the language selected in Document Language on the [
(General Settings) tab of the Settings dialog box are created.

Save to a subfolder with current date
Select this checkbox to create a current date folder in the folder specified in Save in and save
scanned images in it. The folder will be created with a name such as "20XX_01_01"
(Year_Month_Date).

If this checkbox is not selected, files are saved directly in the folder specified in Save in.

Check scan results
Displays the Save Settings dialog box after scanning.

32 Important

* When the Settings dialog box is displayed from My Image Garden, this option does not appear.

(3) Application Settings Area

Open with an application
Select this when you want to enhance or correct the scanned images.

You can specify the application from the pull-down menu.

Send to an application
Select this when you want to use the scanned images as they are in an application that allows you to
browse or organize images.

You can specify the application from the pull-down menu.

Send to a folder
Select this when you also want to save the scanned images to a folder other than the one specified in
Save in.

You can specify the folder from the pull-down menu.
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Attach to e-mail
Select this when you want to send e-mails with the scanned images attached.

You can specify the e-mail client you want to start from the pull-down menu.

Start OCR
Select this when you want to convert text in the scanned image into text data.

You can specify the application from the pull-down menu.

Do not start any application
Saves to the folder specified in Save in.

»>» Note

» To add an application or folder to the pull-down menu, select Add... from the pull-down menu, then
click Add in the displayed Select Application or Select Destination Folder dialog box and specify
the application or folder.

Instructions
Opens this guide.

Defaults
You can restore the settings in the displayed screen to the default settings.
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Settings (Photo Scan) Dialog Box

Click Photo Scan on the E: (Scanning from a Computer) tab to display the Settings (Photo Scan)
dialog box.

In the Settings (Photo Scan) dialog box, you can make advanced scan settings to scan items as photos.
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= (1) Scan Options Area
= (2) Save Settings Area
= (3) Application Settings Area

22 Important

» When the Settings dialog box is displayed from My Image Garden, the setting items for Application
Settings do not appear.

(1) Scan Options Area

Select Source
Photo is selected.

Color Mode
Select the color mode in which to scan the item.

Paper Size
Select the size of the item to be scanned.
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When you select Custom, a screen in which you can specify the paper size appears. Select a Unit,
then enter the Width and Height, and then click OK.

Custom 5Size Setting ﬂ
Width nches (100 -8.50)
Height: . 1100 | nches (100 - 11.68)
Uret: inches W
| oK _ Defaults Il Cancel

»» Note

+ Click Defaults to restore the specified settings to the default settings.

Resolution
Select the resolution of the item to be scanned.

The higher the resolution (value), the more detail in your image.
= Resolution
Image Processing Settings

Click | * (Plus) to set the following.
22 Important

* When Color Mode is Black and White, Image Processing Settings is not available.

Sharpen outline
Emphasizes the outline of the subjects to sharpen the image.

(2) Save Settings Area

File Name
Enter the file name of the image to be saved. When you save a file, the date and four digits are
appended to the set file name in the "_20XX0101_0001" format.

»» Note

* When you select the Save to a subfolder with current date checkbox, the date and four digits
are appended to the set file name.

Save in
Displays the folder in which to save the scanned images. To add a folder, select Add... from the pull-
down menu, then click Add in the displayed Select Destination Folder dialog box and specify the
destination folder.

The default save folders are as follows.

* Windows 10/Windows 8.1/Windows Vista:

Documents folder
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* Windows 8/Windows 7/Windows XP:

My Documents folder

22 Important

» When the Settings dialog box is displayed from My Image Garden, this option does not appear.

Data Format
Select the data format in which to save the scanned images.

You can select JPEG/Exif, TIFF, or PNG.

22 Important
* You cannot select JPEG/Exif when Color Mode is Black and White.

JPEG Image Quality
You can specify the image quality of JPEG files.

22 Important

» This appears only when JPEG/EXxif is selected in Data Format.

Save to a subfolder with current date
Select this checkbox to create a current date folder in the folder specified in Save in and save
scanned images in it. The folder will be created with a name such as "20XX_01_01"
(Year_Month_Date).

If this checkbox is not selected, files are saved directly in the folder specified in Save in.

Check scan results
Displays the Save Settings dialog box after scanning.

32 Important

* When the Settings dialog box is displayed from My Image Garden, this option does not appear.

(3) Application Settings Area

Open with an application
Select this when you want to enhance or correct the scanned images.

You can specify the application from the pull-down menu.

Send to an application
Select this when you want to use the scanned images as they are in an application that allows you to
browse or organize images.

You can specify the application from the pull-down menu.

Send to a folder
Select this when you also want to save the scanned images to a folder other than the one specified in
Save in.

You can specify the folder from the pull-down menu.

Attach to e-mail
Select this when you want to send e-mails with the scanned images attached.
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You can specify the e-mail client you want to start from the pull-down menu.

Do not start any application
Saves to the folder specified in Save in.

»>» Note

» To add an application or folder to the pull-down menu, select Add... from the pull-down menu, then
click Add in the displayed Select Application or Select Destination Folder dialog box and specify
the application or folder.

Instructions
Opens this guide.

Defaults
You can restore the settings in the displayed screen to the default settings.
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Settings (Custom Scan) Dialog Box

Click Custom Scan on the E: (Scanning from a Computer) tab to display the Settings (Custom Scan)
dialog box.

In the Settings (Custom Scan) dialog box, you can make advanced scan settings to scan according to your
preference.
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= (1) Scan Options Area
= (2) Save Settings Area
= (3) Application Settings Area

22 Important

* When the Settings dialog box is displayed from the Scan screen of My Image Garden, the setting items
for Application Settings do not appear.

(1) Scan Options Area

Select Source

Select the type of item to be scanned. Select Auto to detect the item type automatically and to set
Color Mode, Paper Size, and Resolution automatically as well.
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3% Important

* Item types supported by Auto are photos, postcards, business cards, magazines, newspapers,
documents, and BD/DVD/CD.

+ To scan the following types of items, specify the item type or size. You cannot scan correctly with
Auto.

* A4 size photos

» Text documents smaller than 2L (5 inches x 7 inches) (127 mm x 178 mm), such as
paperback pages with the spine cut off

* Items printed on thin white paper

* Long narrow items such as panoramic photos

» Reflective disc labels may not be scanned as expected.

* Place items correctly according to the type of item to be scanned. Otherwise, items may not be
scanned correctly.

Refer to "Positioning Originals (Scanning from Computer)" for how to place items.

»» Note

» To convert text in the image into text data after scanning, specify Select Source instead of
selecting Auto.

» To reduce moire, set Select Source to Magazine or select the Reduce moire checkbox in
Image Processing Settings.

Color Mode
Select the color mode in which to scan the item.

»» Note

* Only Color is available when Select Source is Auto.

Paper Size
Select the size of the item to be scanned.

When you select Custom, a screen in which you can specify the paper size appears. Select a Unit,
then enter the Width and Height, and then click OK.

Custom Size Setting ﬂ
width nches (1,00 -8.50)
Height: | 1100 | inches (1.00 - 11.68)
Lirat: inches W
| oK _ Defaults Il Cancel

»» Note

» Only Auto is available when Select Source is Auto.

 Click Defaults in the screen in which you can specify the paper size to restore the specified
settings to the default settings.
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Resolution

Select the resolution of the item to be scanned.

The higher the resolution (value), the more detail in your image.

= Resolution

»» Note

* Only Auto is available when Select Source is Auto.

» Only 300 dpi or 400 dpi can be set when Start OCR is selected in Application Settings.

Image Processing Settings

Click - T | (Plus) to set the following. Available setting items vary by Select Source.
* When Select Source is Auto:

Apply recommended image correction

Applies suitable corrections automatically based on the item type.

32 Important

» The color tone may differ from the source image due to corrections. In that case,
deselect the checkbox and scan.

»» Note

» Scanning takes longer than usual when you enable this function.

* When Select Source is Photo:

32 Important

* When Color Mode is Black and White, Image Processing Settings is not available.

Sharpen outline

Emphasizes the outline of the subjects to sharpen the image.

* When Select Source is Magazine or Document:

»» Note

* When Color Mode is Black and White, only Reduce gutter shadow, Correct slanted text
document, and Detect the orientation of text document and rotate image appear.

Apply Auto Document Fix

Select this checkbox to sharpen text in a document or magazine for better readability.

32 Important

» The color tone may differ from the source image due to corrections. In that case,
deselect the checkbox and scan.

»» Note

» Scanning takes longer than usual when you enable this function.
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Sharpen outline
Emphasizes the outline of the subjects to sharpen the image.

Reduce show-through
Sharpens text in an item or reduces show-through in newspapers, etc.

Reduce moire
Reduces moire patterns.

Printed materials are displayed as a collection of fine dots. "Moire" is a phenomenon where
uneven gradation or a stripe pattern appears when such photos or pictures printed with fine
dots are scanned.

»» Note

» Scanning takes longer than usual when you enable Reduce moire.

Reduce gutter shadow
Reduces gutter shadows that appear between pages when scanning open booklets.

»» Note

» Use ScanGear (scanner driver)'s Advanced Mode tab to correct gutter shadows when
scanning non-standard size items or specified areas.
Refer to "Gutter Shadow Correction" for your model from Home of the Online Manual for
details.

Correct slanted text document
Detects the scanned text and corrects the angle (within -0.1 to -10 degrees or +0.1 to +10
degrees) of the document.

32 Important

» The following types of documents may not be corrected properly since the text cannot
be detected correctly.

» Documents in which the text lines are inclined more than 10 degrees or the angles
vary by line

+ Documents containing both vertical and horizontal text

» Documents with extremely large or small fonts

* Documents with small amount of text

» Documents containing figures/images

Hand-written text

» Documents containing both vertical and horizontal lines (tables)

»» Note

» Scanning takes longer than usual when you enable Correct slanted text document.

Detect the orientation of text document and rotate image
Automatically rotates the image to the correct orientation by detecting the orientation of text
in the scanned document.
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3» Important

» Only text documents written in languages that can be selected from Document
Language in the Settings (General Settings) dialog box are supported.

» The orientation may not be detected for the following types of settings or documents
since the text cannot be detected correctly.

* Resolution is outside the range of 300 dpi to 600 dpi

» Font size is outside the range of 8 points to 48 points

» Documents containing special fonts, effects, italics, or hand-written text
» Documents with patterned backgrounds

In that case, select the Check scan results checkbox and rotate the image in the Save
Settings dialog box.

(2) Save Settings Area

File Name
Enter the file name of the image to be saved. When you save a file, the date and four digits are
appended to the set file name in the "_20XX0101_0001" format.

»» Note

» When you select the Save to a subfolder with current date checkbox, the date and four digits
are appended to the set file name.

Save in
Displays the folder in which to save the scanned images. To add a folder, select Add... from the pull-
down menu, then click Add in the displayed Select Destination Folder dialog box and specify the
destination folder.

The default save folders are as follows.

* Windows 10/Windows 8.1/Windows Vista:

Documents folder

* Windows 8/Windows 7/Windows XP:

My Documents folder

32 Important

* When the Settings dialog box is displayed from My Image Garden, this option does not appear.

Data Format
Select the data format in which to save the scanned images.

You can select JPEG/Exif, TIFF, PNG, PDF, PDF (Multiple Pages), or Auto.
32 Important

* When Auto is selected, the save format may differ depending on how you place the item.

= Positioning Originals (Scanning from Computer)

* You cannot select JPEG/Exif when Color Mode is Black and White.
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+ When Start OCR is selected in Application Settings, you cannot select PDF, PDF (Multiple
Pages), or Auto.

»» Note

+ Auto appears only when Auto is selected for Select Source.

JPEG Image Quality
You can specify the image quality of JPEG files.

22 Important

» This appears only when JPEG/Exif or Auto is selected in Data Format.

PDF Compression
Select the compression type for saving PDF files.
Standard
It is recommended that you normally select this setting.
High
Compresses the file size when saving, allowing you to reduce the load on your network/server.

32 Important

» This appears only when PDF, PDF (Multiple Pages), or Auto is selected in Data Format.
+ When Black and White is selected in Color Mode, this option does not appear.

Create a PDF file that supports keyword search

Select this checkbox to convert text in images into text data and create PDF files that support
keyword search.

22 Important

* This appears only when PDF, PDF (Multiple Pages), or Auto is selected in Data Format.

»>» Note

10
» PDF files that are searchable in the language selected in Document Language on the [
(General Settings) tab of the Settings dialog box are created.

Save to a subfolder with current date

Select this checkbox to create a current date folder in the folder specified in Save in and save

scanned images in it. The folder will be created with a name such as "20XX_01_01"
(Year_Month_Date).

If this checkbox is not selected, files are saved directly in the folder specified in Save in.
Check scan results
Displays the Save Settings dialog box after scanning.

22 Important

» This does not appear when Select Source is Auto.
» When the Settings dialog box is displayed from My Image Garden, this option does not appear.
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(3) Application Settings Area

Open with an application
Select this when you want to enhance or correct the scanned images.

You can specify the application from the pull-down menu.

Send to an application
Select this when you want to use the scanned images as they are in an application that allows you to
browse or organize images.

You can specify the application from the pull-down menu.

Send to a folder
Select this when you also want to save the scanned images to a folder other than the one specified in
Save in.

You can specify the folder from the pull-down menu.

Attach to e-mail
Select this when you want to send e-mails with the scanned images attached.

You can specify the e-mail client you want to start from the pull-down menu.

Start OCR
Select this when you want to convert text in the scanned image into text data.

You can specify the application from the pull-down menu.

Do not start any application
Saves to the folder specified in Save in.

> Note

» To add an application or folder to the pull-down menu, select Add... from the pull-down menu, then
click Add in the displayed Select Application or Select Destination Folder dialog box and specify
the application or folder.

Instructions
Opens this guide.

Defaults
You can restore the settings in the displayed screen to the default settings.
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Settings (Scan and Stitch) Dialog Box
ick Scan and Stitch on the (Scanning from a Computer) tab to display the Settings (Scan and
Stitch) dialog box.

In the Settings (Scan and Stitch) dialog box, you can make advanced scan settings for scanning items
larger than the platen.
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= (1) Scan Options Area
= (2) Save Settings Area
= (3) Application Settings Area

22 Important

* When the Settings dialog box is displayed from the Scan screen of My Image Garden, the setting items
for Application Settings do not appear.

(1) Scan Options Area

Select Source
Select the type of item to be scanned.

» Scanning photos: Photo
» Scanning documents: Document
» Scanning magazines: Magazine
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»» Note

» To reduce moire, set Select Source to Magazine or select the Reduce moire checkbox in
Image Processing Settings.

Color Mode
Select the color mode in which to scan the item.

Resolution
Select the resolution of the item to be scanned.

The higher the resolution (value), the more detail in your image.
= Resolution
Image Processing Settings

Click - * | (Plus) to set the following. Available setting items vary by Select Source.

3% Important

* When Color Mode is Black and White, Image Processing Settings is not available.

* When Select Source is Photo:
Sharpen outline
Emphasizes the outline of the subjects to sharpen the image.
* When Select Source is Magazine or Document:

Sharpen outline
Emphasizes the outline of the subjects to sharpen the image.

Reduce show-through
Sharpens text in an item or reduces show-through in newspapers, etc.

Reduce moire
Reduces moire patterns.

Printed materials are displayed as a collection of fine dots. "Moire" is a phenomenon where
uneven gradation or a stripe pattern appears when such photos or pictures printed with fine
dots are scanned.

»» Note

» Scanning takes longer than usual when you enable Reduce moire.

(2) Save Settings Area

File Name
Enter the file name of the image to be saved. When you save a file, the date and four digits are
appended to the set file name in the "_20XX0101_0001" format.

»>» Note

» When you select the Save to a subfolder with current date checkbox, the date and four digits
are appended to the set file name.

364



Save in
Displays the folder in which to save the scanned images. To add a folder, select Add... from the pull-
down menu, then click Add in the displayed Select Destination Folder dialog box and specify the
destination folder.

The default save folders are as follows.

* Windows 10/Windows 8.1/Windows Vista:

Documents folder

* Windows 8/Windows 7/Windows XP:

My Documents folder

3% Important

* When the Settings dialog box is displayed from My Image Garden, this option does not appear.

Data Format
Select the data format in which to save the scanned images.

You can select JPEG/Exif, TIFF, PNG, PDF, or PDF (Multiple Pages).
3% Important

* You cannot select JPEG/Exif when Color Mode is Black and White.

PDF Compression
Select the compression type for saving PDF files.

Standard
It is recommended that you normally select this setting.

High
Compresses the file size when saving, allowing you to reduce the load on your network/server.

22 Important

* This appears only when PDF or PDF (Multiple Pages) is selected in Data Format.
» When Black and White is selected in Color Mode, this option does not appear.

Create a PDF file that supports keyword search
Select this checkbox to convert text in images into text data and create PDF files that support
keyword search.

32 Important

» This appears only when PDF or PDF (Multiple Pages) is selected in Data Format.

»» Note

A0
» PDF files that are searchable in the language selected in Document Language on the [
(General Settings) tab of the Settings dialog box are created.

JPEG Image Quality
You can specify the image quality of JPEG files.
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3% Important

» This appears only when JPEG/Exif is selected in Data Format.

Save to a subfolder with current date
Select this checkbox to create a current date folder in the folder specified in Save in and save
scanned images in it. The folder will be created with a name such as "20XX_01_01"
(Year_Month_Date).

If this checkbox is not selected, files are saved directly in the folder specified in Save in.

Check scan results
Displays the Save Settings dialog box after scanning.

3% Important

* When the Settings dialog box is displayed from My Image Garden, this option does not appear.

(3) Application Settings Area

Open with an application
Select this when you want to enhance or correct the scanned images.

You can specify the application from the pull-down menu.

Send to an application
Select this when you want to use the scanned images as they are in an application that allows you to
browse or organize images.

You can specify the application from the pull-down menu.

Send to a folder
Select this when you also want to save the scanned images to a folder other than the one specified in
Save in.

You can specify the folder from the pull-down menu.

Do not start any application
Saves to the folder specified in Save in.

»>» Note

» To add an application or folder to the pull-down menu, select Add... from the pull-down menu, then
click Add in the displayed Select Application or Select Destination Folder dialog box and specify
the application or folder.

Instructions
Opens this guide.

Defaults
You can restore the settings in the displayed screen to the default settings.
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Settings (ScanGear) Dialog Box
ick ScanGear on the (Scanning from a Computer) tab to display the Settings (ScanGear) dialog
box.

In the Settings (ScanGear) dialog box, you can specify how to save images when scanning items by
starting ScanGear (scanner driver) and how to respond after saving them.
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= (1) Save Settings Area
= (2) Application Settings Area

32 Important

* When the Settings dialog box is displayed from My Image Garden, the setting items for Application
Settings do not appear.

(1) Save Settings Area

File Name
Enter the file name of the image to be saved. When you save a file, the date and four digits are
appended to the set file name in the "_20XX0101_0001" format.

13> Note

» When you select the Save to a subfolder with current date checkbox, the date and four digits
are appended to the set file name.
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Save in
Displays the folder in which to save the scanned images. To add a folder, select Add... from the pull-
down menu, then click Add in the displayed Select Destination Folder dialog box and specify the
destination folder.

The default save folders are as follows.

* Windows 10/Windows 8.1/Windows Vista:

Documents folder

* Windows 8/Windows 7/Windows XP:

My Documents folder

3% Important

* When the Settings dialog box is displayed from My Image Garden, this option does not appear.

Data Format
Select the data format in which to save the scanned images.

You can select JPEG/Exif, TIFF, PNG, PDF, or PDF (Multiple Pages).
3> Note

* When PDF or PDF (Multiple Pages) is selected, images up to 9600 pixels x 9600 pixels can be
scanned.

* When the Enable large image scans checkbox is selected in Save Settings, or when Start
OCR is selected in Application Settings, you can select JPEG/Exif, TIFF, or PNG.

JPEG Image Quality
You can specify the image quality of JPEG files.

22 Important

» This appears only when JPEG/Exif is selected in Data Format.

PDF Compression
Select the compression type for saving PDF files.

Standard
It is recommended that you normally select this setting.

High
Compresses the file size when saving, allowing you to reduce the load on your network/server.

3% Important

» This appears only when PDF or PDF (Multiple Pages) is selected in Data Format.

Create a PDF file that supports keyword search
Select this checkbox to convert text in images into text data and create PDF files that support
keyword search.

3% Important

» This appears only when PDF or PDF (Multiple Pages) is selected in Data Format.
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»» Note

1)
» PDF files that are searchable in the language selected in Document Language on the [
(General Settings) tab of the Settings dialog box are created.

Save to a subfolder with current date
Select this checkbox to create a current date folder in the folder specified in Save in and save
scanned images in it. The folder will be created with a name such as "20XX_01_01"
(Year_Month_Date).

If this checkbox is not selected, files are saved directly in the folder specified in Save in.

Enable large image scans
Select this checkbox to scan images up to 21000 pixels x 30000 pixels and 1.8 GB.

22 Important

» When this checkbox is selected, you cannot select Send to an application, Send to a folder,
Attach to e-mail, or Start OCR.
* When the Settings dialog box is displayed from My Image Garden, this option does not appear.

»>» Note

* When this checkbox is not selected, images up to 10208 pixels x 14032 pixels can be scanned.

Check scan results
Displays the Save Settings dialog box after scanning.

22 Important

* When the Settings dialog box is displayed from My Image Garden, this option does not appear.

(2) Application Settings Area

Open with an application
Select this when you want to enhance or correct the scanned images.

You can specify the application from the pull-down menu.

Send to an application
Select this when you want to use the scanned images as they are in an application that allows you to
browse or organize images.

You can specify the application from the pull-down menu.

Send to a folder

Select this when you also want to save the scanned images to a folder other than the one specified in
Save in.

You can specify the folder from the pull-down menu.

Attach to e-mail
Select this when you want to send e-mails with the scanned images attached.

You can specify the e-mail client you want to start from the pull-down menu.
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Start OCR
Select this when you want to convert text in the scanned image into text data.

You can specify the application from the pull-down menu.

Do not start any application
Saves to the folder specified in Save in.

> Note

» To add an application or folder to the pull-down menu, select Add... from the pull-down menu, then
click Add in the displayed Select Application or Select Destination Folder dialog box and specify
the application or folder.

Instructions
Opens this guide.

Defaults
You can restore the settings in the displayed screen to the default settings.
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Settings (General Settings) Dialog Box

A0
Click the B (General Settings) tab to display the Settings (General Settings) dialog box.

In the Settings (General Settings) dialog box, you can set the product to use, file size restriction on e-mail
attachment, language to detect text in images, and folder in which to save images temporarily.

32 Important

* When the Settings dialog box is displayed from My Image Garden, some options may not appear.

Settings (General Settings)
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Instructions Defaults [+ 4

Product Name
Displays the name of the product that IJ Scan Utility is currently set to use.

If the displayed product is not the one you want to use, select the desired product from the list.

E-mail Attachment Size
You can restrict the size of scanned images to be attached to an e-mail.
You can select Small (Suitable for 640 x 480 Windows), Medium (Suitable for 800 x 600 Windows),
Large (Suitable for 1024 x 768 Windows), or No Change.

Document Language
You can select the language for detecting text in images and for use with search when a PDF file that
supports keyword search is created.

Folder to Save Temporary Files
Displays the folder in which to save images temporarily. Click Browse... to specify the destination
folder.

Instructions
Opens this guide.

Defaults
You can restore the settings in the displayed screen to the default settings.
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Save Settings Dialog Box

Select the Check scan results checkbox in Save Settings of the Settings dialog box to display the Save
Settings dialog box after scanning.

You can specify the data format and destination while viewing the thumbnails of scan results.

3% Important

+ After scanning from My Image Garden, the Save Settings dialog box does not appear.

Save Settings “

[ &8

W @

Save Settngs
Fie Name: B v) (3)
Save in: || Documents v
Duata Format: :.IIEG.I'B-GF v:
IPEG Image Quality: Istandard v

[C5ave ta & subfalder with surrent date

= (1) Preview Operation Buttons
= (2) Scan Results Area
= (3) Save Settings Area

(1) Preview Operation Buttons

LB an
Eal ) eal (Rotate Left 90°)/(Rotate Right 90°)
Rotates scanned images 90 degrees counter-clockwise or clockwise.

£[§ 13
Select the image you want to rotate, then click [ (Rotate Left 90°) or = (Rotate Right 90°).
32 Important

» The preview operation buttons do not appear when the Enable large image scans checkbox is
selected in the Settings (ScanGear) dialog box.
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(2) Scan Results Area

Displays the thumbnails of the scanned images. You can change the save order of images via drag-and-
drop. The file names for saving appear below the thumbnails.

(3) Save Settings Area

File Name
Enter the file name of the image to be saved. When you save a file, the date and four digits are
appended to the set file name in the "_20XX0101_0001" format.

»» Note

* When you select the Save to a subfolder with current date checkbox, the date and four digits
are appended to the set file name.

Save in
Displays the folder in which to save the scanned images. To add a folder, select Add... from the pull-
down menu, then click Add in the displayed Select Destination Folder dialog box and specify the
destination folder.

The default save folders are as follows.

* Windows 10/Windows 8.1/Windows Vista:

Documents folder

* Windows 8/Windows 7/Windows XP:
My Documents folder

Data Format
Select the data format in which to save the scanned images.

You can select JPEG/Exif, TIFF, PNG, PDF, or PDF (Multiple Pages).
22 Important

* You cannot select PDF or PDF (Multiple Pages) in the following cases.

* When scanned by clicking Photo in the IJ Scan Utility main screen

» The Enable large image scans checkbox is selected in Save Settings of the Settings
(ScanGear) dialog box

» Start OCR is selected in Application Settings of the Settings (Document Scan), Settings
(Custom Scan), or Settings (ScanGear) dialog box

* You cannot select JPEG/Exif when Color Mode is Black and White.

JPEG Image Quality
You can specify the image quality of JPEG files.

3% Important

» This appears only when JPEG/Exif is selected in Data Format.

PDF Compression
Select the compression type for saving PDF files.
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Standard
It is recommended that you normally select this setting.
High
Compresses the file size when saving, allowing you to reduce the load on your network/server.

22 Important

* This appears only when PDF or PDF (Multiple Pages) is selected in Data Format.
» When Black and White is selected in Color Mode, this option does not appear.

Create a PDF file that supports keyword search

Select this checkbox to convert text in images into text data and create PDF files that support
keyword search.

32 Important

» This appears only when PDF or PDF (Multiple Pages) is selected in Data Format.

»» Note

A0
» PDF files that are searchable in the language selected in Document Language on the [
(General Settings) tab of the Settings dialog box are created.

Save to a subfolder with current date

Select this checkbox to create a current date folder in the folder specified in Save in and save

scanned images in it. The folder will be created with a name such as "20XX_01_01"
(Year_Month_Date).

If this checkbox is not selected, files are saved directly in the folder specified in Save in.
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Image Stitch Window

Click Stitch in the IJ Scan Utility main screen to display the Image Stitch window.

You can scan the left and right halves of an item larger than the platen and combine them back into one
image. You can scan items up to approximately twice as large as the platen.
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= (1) Settings and Operation Buttons
= (2) Toolbar

= (3) Thumbnail View Area

= (4) Preview Area

23 Note

» The displayed items vary depending on the select source and view.

(1) Settings and Operation Buttons

Select Output Size
B4 (B5 x 2)
Scans the left and right halves of a B4 size item separately.

A3 (Ad x 2)
Scans the left and right halves of an A3 size item separately.

11 x 17 (Letter x 2)
Scans the left and right halves of an item twice as large as Letter size separately.

Full Platen x 2
Scans the left and right halves of an item twice as large as the platen separately.

Scan Direction
Scan from Left
Displays the first scanned image on the left side.
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Scan from Right
Displays the first scanned image on the right side.

Scan Image 1
Start Scanning Image 1
Scans the first item.
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Start Scanning Image 2
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Adjust cropping frames
You can adjust the scan area in preview.

If no area is specified, the image of the size selected in Select Output Size will be saved. If an area
is specified, only the image in the cropping frame will be scanned and saved.

= Adjusting Cropping Frames in the Image Stitch Window

Save
Save
Saves the two scanned images as one image.

Cancel
Cancels Stitch scan.

(2) Toolbar

You can delete the scanned images or adjust the previewed images.

x (Delete)

Deletes the image selected in the Thumbnail View area.

| \I
N (Enlarge/Reduce)
Allows you to enlarge or reduce the preview image.

Left-clicking the Preview area enlarges the displayed image.

Right-clicking the Preview area reduces the displayed image.

&
Eal’ (Rotate Left)

Rotates the preview image 90 degrees counter-clockwise.

Y
e (Rotate 180°)

Rotates the preview image 180 degrees.

3
By (Rotate Right)
Rotates the preview image 90 degrees clockwise.
4
@ (Open Guide)
Opens this page.

(3) Thumbnail View Area

Displays the thumbnails of the scanned images. Appears blank if none has been scanned.

(4) Preview Area

Displays the scanned images. You can adjust the layout by dragging the scanned image or check the
results of the settings made in "(1) Settings and Operation Buttons."
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When no image has been scanned:

After scanning the first item by clicking Start Scanning Image 1:

The image is scanned in the direction specified in Scan Direction, and 2 appears next to it.

After scanning the second item by clicking Start Scanning Image 2:

The two scanned images appear.
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Related Topic

= Scanning Originals Larger than the Platen (Image Stitch)
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Scanning Using Application Software (ScanGear)
» What Is ScanGear (Scanner Driver)?
» Scanning with Advanced Settings Using ScanGear (Scanner Driver)
» Starting ScanGear (Scanner Driver)
» Scanning in Basic Mode
» Scanning in Advanced Mode

» Scanning Multiple Documents from the ADF (Auto Document Feeder) in
Advanced Mode

» Scanning Multiple Documents at One Time with ScanGear (Scanner Driver)
» Correcting Images and Adjusting Colors with ScanGear (Scanner Driver)

» ScanGear (Scanner Driver) Screens

» Positioning Originals (Scanning from Computer)

» Adjusting Cropping Frames (ScanGear)

» General Notes (Scanner Driver)

3% Important

+ Available functions and settings vary depending on your scanner or printer.
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What Is ScanGear (Scanner Driver)?

ScanGear (scanner driver) is software required for scanning documents. It enables you to specify the output
size and make image corrections when scanning.

ScanGear can be started from IJ Scan Utility or applications that are compatible with a standard interface
called TWAIN. (ScanGear is a TWAIN-compatible driver.)

What You Can Do with This Software

This software enables you to preview scan results or set document type and output size, etc. when
scanning documents. It is useful when you want to scan in a specific color tone, as it allows you to make
various corrections and adjust brightness, contrast, etc.

Screens

There are two modes: Basic Mode and Advanced Mode.

Switch modes by clicking a tab on the upper right of the screen.

Basic Mode | Advanced Mode

13%» Note

» ScanGear starts in the last used mode.
» Settings are not retained when you switch modes.

Basic Mode

Use the Basic Mode tab to scan easily by following three simple on-screen steps ( o 9 and
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Advanced Mode

Use the Advanced Mode tab to specify the color mode, output resolution, image brightness, color tone,
etc. when scanning.
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Starting ScanGear (Scanner Driver)

Use ScanGear (scanner driver) to make image corrections and color adjustments when scanning. ScanGear
can be started from IJ Scan Utility or other applications.

»>» Note

» Set up the network environment if you have more than one scanner or have a network compatible
model and changed the connection from USB connection to network connection.

Starting IJ Scan Utility

Follow these steps to start ScanGear from IJ Scan Utility.

1. Start IJ Scan Utility.

Refer to "Starting IJ Scan Utility" for your model from Home of the Online Manual for how to start IJ
Scan Utility.

2. Click ScanGear in the IJ Scan Utility main screen.

The ScanGear screen appears.

Starting from an Application

Follow these steps (example) to start ScanGear from an application.

The procedure varies depending on the application. For details, refer to the application's manual.
1. Start the application.

2. On the menu of the application, select the machine.

> Note

* When you want to use a network compatible model by connecting to a network, select one with
"Network" displayed after the product name.

3. Select the command to scan a document.

The ScanGear screen appears.
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Scanning in Basic Mode

Use the Basic Mode tab to scan easily by following the on-screen steps.

Refer to "Scanning Multiple Documents at One Time with ScanGear (Scanner Driver)" to scan multiple
documents at one time from the Platen.

When scanning from the ADF (Auto Document Feeder), documents are scanned without preview.

=% Important

» The following types of documents may not be scanned correctly. In that case, click @ (Thumbnail) on
the Toolbar to switch to whole image view and scan.

» Photos that have a whitish background

» Documents printed on white paper, hand-written text, business cards, etc.
» Thin documents

» Thick documents

» The following types of documents may not be scanned correctly.

* Documents smaller than 1.2 inches (3 cm) square
» Photos that have been cut to various shapes

13 Note

» When using a model supporting ADF duplex scanning, you can scan both sides of the documents
automatically from the ADF.

1. Place the document on the Platen or ADF, then start ScanGear (scanner driver).

= Positioning Originals (Scanning from Computer)
= Starting ScanGear (Scanner Driver)

2. Set Select Source according to the document placed on the Platen or ADF.
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2% Important

» Some applications do not support continuous scanning from the ADF. For details, refer to the
application's manual.

122> Note

» To scan magazines containing many color photos, select Magazine (Color).

3. Click Preview.

Preview image appears in the Preview area.
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2» Important

» Preview is not displayed when an ADF type is selected for Select Source.

23> Note

» Colors are adjusted based on the document type selected in Select Source.

4. Set Destination.

12> Note

» Skip ahead to Step 7 when an ADF type is selected for Select Source.

5. Set Output Size according to purpose.

Output size options vary by the item selected in Destination.

6. Adjust the cropping frames (scan areas) as required.

Adjust the size and position of the cropping frames on the preview image.

= Adjusting Cropping Frames (ScanGear)
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7. Set Image corrections as required.

8. Click Scan.
Scanning starts.

»» Note

* Click d (Information) to open a dialog box in which you can check the current scan settings
(document type, etc.).

» A response of ScanGear after scanning can be specified in Status of ScanGear dialog after scanning
on the Scan tab of the Preferences dialog box.

Related Topic
= Basic Mode Tab
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Scanning in Advanced Mode

Use the Advanced Mode tab to specify the color mode, output resolution, image brightness, color tone, etc.
when scanning.

Refer to "Scanning Multiple Documents at One Time with ScanGear (Scanner Driver)" to scan multiple
documents at one time.

Refer to "Scanning Multiple Documents from the ADF (Auto Document Feeder) in Advanced Mode" to scan
multiple documents placed on the ADF (Auto Document Feeder).

=% Important

» The following types of documents may not be scanned correctly. In that case, click @ (Thumbnail) on
the Toolbar to switch to whole image view and scan.

» Photos that have a whitish background

» Documents printed on white paper, hand-written text, business cards, etc.
» Thin documents

» Thick documents

» The following types of documents may not be scanned correctly.

* Documents smaller than 1.2 inches (3 cm) square
» Photos that have been cut to various shapes

1. Place the document on the Platen, then start ScanGear (scanner driver).

= Positioning Originals (Scanning from Computer)
= Starting ScanGear (Scanner Driver)

2. Click the Advanced Mode tab.

The tab switches to Advanced Mode.
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23 Note

« Settings are not retained when you switch modes.

3. Set Input Settings according to the document or purpose.

4. Click Preview.

Preview images appear in the Preview area.
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5. Set Output Settings.

6. Adjust the cropping frame (scan area), correct image, and adjust colors as required.

= Adjusting Cropping Frames (ScanGear)

= Image Settings
= Color Adjustment Buttons

7. Click Scan.
Scanning starts.

23 Note

* Click 0 (Information) to open a dialog box in which you can check the current scan settings
(document type, etc.).

» A response of ScanGear after scanning can be specified in Status of ScanGear dialog after scanning
on the Scan tab of the Preferences dialog box.

Related Topic
= Advanced Mode Tab
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Scanning Multiple Documents from the ADF (Auto Document
Feeder) in Advanced Mode

Use the Advanced Mode tab to specify the image brightness, color tone, etc. and scan multiple documents
placed on the ADF (Auto Document Feeder) at one time. When using a model supporting ADF duplex
scanning, you can scan both sides of the documents automatically from the ADF.

When scanning from the ADF, documents are scanned without preview.

1. Place the documents on the ADF of the machine, then start ScanGear (scanner driver).

= Placing Documents (ADF (Auto Document Feeder))
= Starting ScanGear (Scanner Driver)

2. Click the Advanced Mode tab and select Document (ADF Simplex) or Document (ADF
Duplex) for Select Source.
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»» Note

» Settings are not retained when you switch modes.
* You can select Document (ADF Duplex) when using a model supporting ADF duplex scanning.

3. Set Input Settings according to the document or purpose.

4. Set Output Settings.

5. Make image corrections and color adjustments as required.

= Image Settings
= Color Adjustment Buttons
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6. Click Scan.
Scanning starts.

»» Note

* Click d (Information) to open a dialog box in which you can check the current scan settings
(document type, etc.).

» A response of ScanGear after scanning can be specified in Status of ScanGear dialog after scanning
on the Scan tab of the Preferences dialog box.

Related Topic
= Advanced Mode Tab
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Scanning Multiple Documents at One Time with ScanGear
(Scanner Driver)

You can scan two or more photos (small documents) on the Platen at one time on the Basic Mode tab and
Advanced Mode tab.

This section explains how to scan multiple documents from the Basic Mode tab.

32 Important

» To scan multiple documents as a single image, scan in whole image view.
» The following types of documents may not be cropped correctly. In that case, adjust the cropping
frames (scan areas) in whole image view and scan.

» Photos that have a whitish background

* Documents printed on white paper, hand-written text, business cards, etc.
» Thin documents

» Thick documents

= Scanning Multiple Documents in Whole Image View

» The following types of documents may not be scanned correctly.

* Documents smaller than 1.2 inches (3 cm) square
» Photos that have been cut to various shapes

»» Note

* You can also scan multiple documents at one time from the Advanced Mode tab. Use the Advanced
Mode tab to make advanced scan settings such as the color mode, output resolution, image brightness,
and color tone.

» Refer to the corresponding sections below for details on the Basic Mode tab and Advanced Mode tab.

= Basic Mode Tab
= Advanced Mode Tab

1. Place the document on the Platen, then start ScanGear (scanner driver).

= Positioning Originals (Scanning from Computer)
= Starting ScanGear (Scanner Driver)

2. Set Select Source according to the document placed on the Platen.
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3. Click Preview.

Thumbnails of the preview images appear in the Preview area. Cropping frames are specified
automatically according to the document size.
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4. Set Destination.
5. Set Output Size according to purpose.

6. Adjust the cropping frames and set Image corrections as required.

2% Note

* You can correct each image separately. Select the frame you want to correct.
* In thumbnail view, you can only create one cropping frame per image. To create multiple cropping
frames in an image, scan in whole image view.
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= Scanning Multiple Documents in Whole Image View

7. Select the images you want to scan.

Select the checkboxes of the images you want to scan.
8. Click Scan.

Scanning Multiple Documents in Whole Image View

Follow these steps if thumbnails are not displayed correctly when previewed or if you want to scan
multiple documents as a single image.

23» Note

+ Positions of slanted documents are not corrected in whole image view.

1. After previewing images, click :@ (Thumbnail) on the Toolbar.

Switch to whole image view.
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« When the whole image is displayed, the icon changesto ' (Whole Image).

2. Set Destination.

3. Set Output Size according to purpose.
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Invert aspect ratio will be enabled when Output Size is set to anything but Flexible. Click this button
to rotate the cropping frame. Click again to return it to the original orientation.

4. Adjust the cropping frames.

Adjust the size and position of the cropping frames on the preview image. You can also create two or
more cropping frames.

If an area is not specified, the document will be scanned at the document size (Auto Crop). If an area
is specified, only the portion in the specified area will be scanned.

= Adjusting Cropping Frames (ScanGear)

5. Set Image corrections as required.

6. Click Scan.

Areas framed by broken lines are scanned.

»» Note

* A response of ScanGear after scanning can be specified in Status of ScanGear dialog after scanning
on the Scan tab of the Preferences dialog box.
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Correcting Images and Adjusting Colors with ScanGear (Scanner
Driver)

» Correcting Images (Unsharp Mask, Reduce Dust and Scratches, Fading
Correction, etc.)

» Adjusting Colors Using a Color Pattern

¥

Adjusting Saturation and Color Balance

¥

Adjusting Brightness and Contrast

¥

Adjusting Histogram

¥

Adjusting Tone Curve

¥

Setting Threshold
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Correcting Images (Unsharp Mask, Reduce Dust and Scratches,
Fading Correction, etc.)

The Image Settings functions on the Advanced Mode tab of ScanGear (scanner driver) allow you to
enhance the outline of the subjects, reduce dust/scratches, and correct faded colors when scanning images.

‘:.‘:.{..‘.‘ ‘:.‘:.

Setting Items

Click ! (Arrow) of a function and select an item from the pull-down menu.
Reduce Dust and Soatdhes ! [H\:\ne
Fadrg Cormacton ;
Geam Carregtan
Guiler Saclior Coniitann

22 Important

» Do not apply these functions to images without moire, dust/scratches, or faded colors. The color tone
may be adversely affected.
» Refer to "Image Settings" for details and precautions on each function.

13» Note

» Refer to "Scanning in Advanced Mode" to start the Advanced Mode tab of ScanGear and scan.

Adjusting the image brightness and color tone

Set Image Adjustment to Auto, Photo, Magazine, or Document according to the document type.

None Auto
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Reducing show-through in text documents or lightening the base color in
recycled paper, newspapers, etc. when scanning documents

Set Reduce Show-through to ON.

OFF ON

Sharpening slightly out-of-focus images
Set Unsharp Mask to ON.

OFF ON

Reducing gradations and stripe patterns

Set Descreen to ON.
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»» Note

 Printed photos and pictures are displayed as a collection of fine dots. "Moire" is a phenomenon
where uneven gradation or a stripe pattern appears when such photos or pictures printed with fine
dots are scanned. Descreen is the function for reducing this moire effect.

Reducing dust and scratches

Set Reduce Dust and Scratches to Low, Medium, or High according to the degree of dust and
scratches.

None Medium

O

Correcting photos that have faded with time or due to colorcast

Set Fading Correction to Low, Medium, or High according to the degree of fading or colorcast.

None Medium

-

Reducing graininess

Set Grain Correction to Low, Medium, or High according to the degree of graininess.

None Medium

Correcting shadows that appear between pages when scanning open booklets

Set Gutter Shadow Correction to Low, Medium, or High according to the degree of shadows.
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Medium

None

399



Adjusting Colors Using a Color Pattern

You can preview color changes and reproduce natural colors by using the color pattern function in ScanGear
(scanner driver)'s Basic Mode tab.
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Color Adjustment

Correct colors that have faded with time or due to colorcast. "Colorcast" is a phenomenon where a
specific color affects the entire picture due to the weather or ambient strong colors.
Click an arrow in Color Adjustment to emphasize the corresponding color.

Cyan & red, magenta & green, and yellow & blue are complementary color pairs (each pair produces a
shade of gray when mixed). You can reproduce the natural colors of the scene by reducing the cast color
and increasing the complementary color.
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It is recommended that you find a portion in the image where it should be white, and adjust the colors so
that the portion turns white.

Preview image appears in the center. Preview image colors change as you adjust them.

cao.-:.e;r.m?rm:

miE
=Y

Cyan 7
Blue

Below is an example of correcting a bluish image.

Since Blue and Green are too strong, click the Yellow and Magenta arrows to correct.

Before After

»>» Note

» Color adjustments are applied only to the cropping frames (scan areas) or the frame selected in
thumbnail view.

* You can select multiple frames or cropping frames by clicking them while pressing the Ctrl key.

* You can also select a color tone from the color pattern displayed on the left of the Color Pattern
screen.

* You can also use this function to add a specific tint to an image. Increase the magenta to add a warm
tint, and increase the blue to add a cool tint.
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Adjusting Saturation and Color Balance

You can brighten colors that have faded with time or due to colorcast by using 2

(Saturation/Color
Balance) in ScanGear (scanner driver)'s Advanced Mode tab.

SaturationColor Balance
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»>» Note

* Click Defaults to reset all adjustments in the current window.

Saturation
Adjust the image's saturation (vividness). You can brighten colors that have faded with time, etc.

Move 4 (Slider) under Saturation to the left to decrease the saturation (darken the image), and to the
right to increase the saturation (brighten the image). You can also enter a value (-127 to 127).

Eahuration !

o o

Low High

° —m °

Saturation decreased Original image Saturation increased

»>» Note

» The natural color tone of the original image may be lost if you increase saturation too much.
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Color Balance

Adjust images that have a colorcast. "Colorcast" is a phenomenon where a specific color affects the entire
picture due to the weather or ambient strong colors.

Move 4 (Slider) under Color Balance to the left or right to emphasize the corresponding color.

Cyan & Red

Magenta & Green

Yellow & Blue

These are complementary color pairs (each pair produces a shade of gray when mixed). You can
reproduce the natural colors of the scene by reducing the cast color and increasing the complementary
color.

It is usually difficult to correct the image completely by adjusting only one color pair. It is recommended
that you find a portion in the image where it should be white, and adjust all three color pairs so that the
portion turns white.

You can also enter a value (-127 to 127).

Below is an example of an image in which the "Cyan & Red" pair has been adjusted.

Coler Balance

Cyan

—rr— N

Cyan is increased Red is increased

-
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Adjusting Brightness and Contrast

You can adjust images that are too dark or bright, or too flat due to lack of contrast by using
(Brightness/Contrast) in ScanGear (scanner driver)'s Advanced Mode tab.
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»>» Note

. Click ¥ (Down arrow) to switch to detailed view. Click 2 (Up arrow) to return to the previous view.
* Click Defaults to reset all adjustments in the current window.

Channel

Each dot of an image is a mixture of Red, Green, and Blue in various proportions (gradation). These
colors can be adjusted individually as a "channel."

Master
Adjust the Red, Green, and Blue combined.

Red
Adjust the Red channel.

Green
Adjust the Green channel.

Blue
Adjust the Blue channel.
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> Note

* Only Grayscale will be displayed in Channel when Color Mode is Grayscale.

Brightness

Adjust the image brightness.

Move 4 (Slider) under Brightness to the left to darken and right to brighten the image. You can also
enter a value (-127 to 127).

Erightness : o K
Drark Eright
* s ¥
Darkened Original image Brightened

o

'

5

»>» Note

 Highlights may be lost if you brighten the image too much, and shadows may be lost if you darken
the image too much.

Contrast

"Contrast" is the degree of difference between the brighter and darker parts of an image. Increasing
contrast will increase the difference, thus sharpening the image. Decreasing contrast will decrease the
difference, thus softening the image.

Move 4 (Slider) under Contrast to the left to decrease and right to increase the contrast of the image.
You can also enter a value (-127 to 127).

Conirast: o
Low High
0 == °
Decreased contrast Original image Increased contrast

i, _J
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> Note

* Increasing the contrast is effective in adding a three-dimensional feel to soft images. However,
shadows and highlights may be lost if you increase the contrast too much.

406



Adjusting Histogram

You can adjust the image color tone by using a graph (histogram) showing brightness distribution, via A

(Histogram) in ScanGear (scanner driver)'s Advanced Mode tab.

Histogram
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»» Note

* Click Defaults to reset all adjustments in the current window.

Channel

Each dot of an image is a mixture of Red, Green, and Blue in various proportions (gradation). These
colors can be adjusted individually as a "channel."

Master
Adjust the Red, Green, and Blue combined.

Red
Adjust the Red channel.

Green
Adjust the Green channel.

Blue
Adjust the Blue channel.

> Note

* Only Grayscale will be displayed in Channel when Color Mode is Grayscale.

Reading Histograms

You can see the histogram of a specified area for each Channel. The higher the histogram peak, the
more data is distributed to that level.
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(1) Bright area (2) Dark area (3) Whole image
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Adjusting Histograms (Using the Slider)

Select a Channel, then move 4 (Black-point Slider) or .2~ (White-point Slider) to specify the level to be
set as the shadow or highlight.

—

* All parts to the left of 4 (Black-point Slider) will be black (level 0).

* The parts at = (Mid-point Slider) will turn to the color exactly between the black-point and white-
point.

+ All parts to the right of ..~ (White-point Slider) will turn white (level 255).

When Image Adjustment is set to anything but None, the adjustments shown below are performed
automatically.

Moving the Black-point and White-point Sliders
Move the Black-point Slider or White-point Slider to adjust brightness.

Images with more data distributed to the highlight side

Move the Black-point Slider toward the highlight side.

Images with more data distributed to the shadow side

Move the White-point Slider toward the shadow side.
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Images with widely distributed data

Move the Black-point Slider toward the highlight side, and White-point Slider toward the shadow side.

Moving the Mid-point Slider

Move the Mid-point Slider to specify the level to be set as the middle of the tonal range.

Images with more data distributed to the highlight side
Move the Mid-point Slider toward the highlight side.

B

Adjusting Histograms (Using the Droppers)

When you select a Channel and click the Black-point, Mid-point, or White-point Dropper, the mouse

pointer on the preview image changes to a dropper. Click a Dropper displayed below the histogram to
change the setting.
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* The point clicked with
(0 to 245).

(Black-point Dropper) will be the darkest point. You can also enter a value

* The point clicked with i
enter a value (5 to 250).

Vd

(Mid-point Dropper) will be the middle of the tonal range. You can also

* The point clicked with
value (10 to 255).

(White-point Dropper) will be the brightest point. You can also enter a

* Click i (Dropper) for Gray Balance and click the area you want to adjust the color in the preview
image.

The clicked point will be set as the achromatic color reference, and the rest of the image is adjusted
accordingly. For instance, if snow in a photo appears bluish, click the bluish part to adjust the whole image
and reproduce natural colors.
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Adjusting Tone Curve

You can adjust the brightness of an image by selecting the type of graph (tone curve) showing the balance

. 4 . : :
of tone input and output, via | ° (Tone Curve Settings) in ScanGear (scanner driver)'s Advanced Mode
tab.
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»» Note

* Click Defaults to reset all adjustments in the current window.

Channel

Each dot of an image is a mixture of Red, Green, and Blue in various proportions (gradation). These
colors can be adjusted individually as a "channel."

Master
Adjust the Red, Green, and Blue combined.

Red
Adjust the Red channel.

Green
Adjust the Green channel.

Blue
Adjust the Blue channel.

»>» Note

* Only Grayscale will be displayed in Channel when Color Mode is Grayscale.

Reading Tone Curves

With ScanGear, scanning images via a scanner is the input, and displaying to a monitor is the output.
"Tone Curve" shows the balance of tone input and output for each Channel.
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Highlight
Output brightness
Shadow -

Shadow Highlight

Input brightness

Adjusting Tone Curve

In Select Tone Curve, select a tone curve from No correction, Overexposure, Underexposure, High
contrast, Reverse the negative/positive image, and Edit custom curve.

No correction (No adjustment)

Overexposure (Convex curve)

The midtone data of the input side is stretched toward the highlight of the output side, resulting in a bright-
toned image when viewed on a monitor.

Underexposure (Concave curve)

The midtone data of the input side is stretched toward the shadow of the output side, resulting in a dark-
toned image when viewed on a monitor.

High contrast (S curve)

The highlight and shadow of the input side are enhanced, resulting in a high-contrast image.
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Reverse the negative/positive image (Downward-sloping line)

The input and output sides are reversed, resulting in a negative-positive inverted image.

Edit custom curve

You can drag specific points on the Tone Curve to freely adjust the brightness of the corresponding areas.

413



Setting Threshold

You can sharpen text in a document or reduce show-through in newspapers by adjusting the threshold level

A

via (Threshold) in ScanGear (scanner driver)'s Advanced Mode tab.
Threshold
a Custom w
Oefadiz
T Cloze
»>» Note

 This function is available when Color Mode is Black and White.
* Click Defaults to reset all adjustments in the current window.

Adjusting Threshold

The brightness of color and grayscale images is expressed in a value between 0 and 255. However, in
creating black and white images, all colors are mapped to either black (0) or white (255). "Threshold" is
the borderline value that determines a color as black or white.

Move 4 (Slider) to the right to increase the threshold value and thus increase the black areas. Move the
slider to the left to decrease the value and thus increase the white areas. You can also enter a value (0 to
255).

Trreshald Level : [128 (=

Light Dark
@

° Ers
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ScanGear (Scanner Driver) Screens

» Basic Mode Tab
» Advanced Mode Tab

« Input Settings

@« Output Settings

« Image Settings

@« Color Adjustment Buttons
» Preferences Dialog Box

« Scanner Tab

@ Preview Tab

« Scan Tab

@« Color Settings Tab
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Basic Mode Tab

This mode allows you to scan easily by following the on-screen steps.

This section describes the settings and functions available on the Basic Mode tab.
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= (1) Settings and Operation Buttons
= (2) Toolbar
= (3) Preview Area

23> Note

» The displayed items vary by document type and view.
* The preview function is not available when scanning from the ADF (Auto Document Feeder).

(1) Settings and Operation Buttons

Select Source
Photo (Color)
Scan color photos.

Magazine (Color)
Scan color magazines.

Document (Color)
Scan documents in color.

Document (Grayscale)
Scan documents in black and white.

Document (Color) ADF Simplex
Scan documents from the ADF in color.

Document (Grayscale) ADF Simplex
Scan documents from the ADF in black and white.

Document (Color) ADF Duplex (only for models supporting ADF duplex scanning)
Scan both sides of documents from the ADF in color.
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Document (Grayscale) ADF Duplex (only for models supporting ADF duplex scanning)
Scan both sides of documents from the ADF in black and white.

22 Important

» Some applications do not support continuous scanning from the ADF. For details, refer to the
application's manual.

123 Note

* When you select a document type, the unsharp mask function will be active.

* When you select an option other than the ADF types, the image adjustment function which
adjusts images based on the document type will also be active.

+ If you select Magazine (Color), the descreen function will be active.

Display Preview Image
Preview
Performs a trial scan.
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13%» Note

» When using the machine for the first time, scanner calibration starts automatically. Wait a
while until the preview image appears.

Destination
Select what you want to do with the scanned image.

Print
Select this to print the scanned image on a printer.

Image display
Select this to view the scanned image on a monitor.

OCR
Select this to use the scanned image with OCR software.

"OCR software" is software that converts text scanned as an image into text data that can be
edited in word processors and other programs.
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Output Size
Select an output size.

Output size options vary by the item selected in Destination.

Flexible
Allows you to freely adjust the cropping frames (scan areas).

In thumbnail view:

Drag the mouse over a thumbnail to display a cropping frame. When a cropping frame is
displayed, the portion within the cropping frame will be scanned. When no cropping frame is
displayed, each frame is scanned individually.

In whole image view:

When no cropping frame is displayed, the entire Preview area will be scanned. When a cropping
frame is displayed, the portion within the cropping frame will be scanned.

Paper Size (L, A4, etc.)
Select an output paper size. The portion within the cropping frame will be scanned at the size of
the selected paper size. You can drag the cropping frame to enlarge/reduce it while maintaining
the aspect ratio.

Monitor Size (1024 x 768 pixels, etc.)
Select an output size in pixels. A cropping frame of the selected monitor size will be displayed
and the portion within the cropping frame will be scanned. You can drag the cropping frame to
enlarge/reduce it while maintaining the aspect ratio.

Add/Delete...
Opens the Add/Delete the Output Size dialog box, in which you can specify custom output
sizes. You can select this option when Destination is Print or Image display.

Add/Delete the Qutput Size
Dutpnst Sive Hame « Cutpun Sine List =
Tew Sesting |
Wdth 6,00
Heght: | 400
Unt 3 e v

In the Add/Delete the Output Size dialog box, you can specify multiple output sizes and save
them at one time. Saved items will be registered to the Output Size list and can be selected,
along with the predefined items.

Adding:

Enter Output Size Name, Width, and Height, then click Add. For Unit, you can select inches or
mm when Destination is Print but you can only select pixels when Destination is Image
display. The name of the added size appears in Output Size List. Click Save to save the items
listed in Output Size List.
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Deleting:

Select the output size you want to delete in Output Size List, then click Delete. Click Save to
save the items listed in Output Size List.

32 Important

* You cannot delete predefined output sizes such as A4 and 1024 x 768 pixels.

»» Note

» Save up to 10 items.

* An error message appears when you enter a value outside the setting range. Enter a value
within the setting range.

»» Note

+ For details on whether or how the cropping frame is initially displayed on a preview image, refer
to Cropping Frame on Previewed Images in "Preview Tab" (Preferences dialog box).

“nvert aspect ratio
Available when Output Size is set to anything but Flexible.
Click this button to rotate the cropping frame. Click again to return it to the original orientation.

Adjust cropping frames
You can adjust the scan area within the Preview area.

If an area is not specified, the document will be scanned at the document size (Auto Crop). If an area
is specified, only the portion in the cropping frame will be scanned.

= Adjusting Cropping Frames (ScanGear)

Image corrections
Allows you to apply corrections to images.

32 Important

» Apply Auto Document Fix and Correct fading are available when Recommended is selected
on the Color Settings tab of the Preferences dialog box.

»» Note

+ Available functions vary by the document type selected in Select Source.

Apply Auto Document Fix
Sharpens text in a document or magazine for better readability.

32 Important

» Scanning may take longer than usual when this checkbox is selected.

» The color tone may change from the source image due to corrections. In that case, deselect
the checkbox and scan.

 Correction may not be applied properly if the scan area is too small.

Correct fading
Corrects and scans photos that have faded with time or have a colorcast.
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Reduce gutter shadow
Corrects shadows that appear between pages when scanning open booklets.

22 Important

* For precautions on using this function, refer to "Gutter Shadow Correction."

Color Pattern...
Allows you to adjust the image's overall color. You can correct colors that have faded due to
colorcast, etc. and reproduce natural colors while previewing color changes.

= Adjusting Colors Using a Color Pattern

32 Important

 This setting is not available when you select Color Matching on the Color Settings tab of
the Preferences dialog box.

Perform Scan
Scan
Starts scanning.

»» Note

» When scanning starts, the progress will be displayed. Click Cancel to cancel the scan.

Preferences...
Opens the Preferences dialog box in which you can make scan/preview settings.

Close
Closes ScanGear (scanner driver).

(2) Toolbar

You can adjust or rotate preview images. The buttons displayed on the Toolbar vary by view.

In thumbnail view:
1| £l 5 | MM OO E&E & 5Y
=) |l G| v 00 66 | @
In whole image view:

—

= iy =
(Thumbnail) / (Whole Image)
Switches the view in the Preview area.

= (3) Preview Area

c
= (Rotate Left)
Rotates the preview image 90 degrees counter-clockwise.

» The result will be reflected in the scanned image.
* The image returns to its original state when you preview again.
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3
By (Rotate Right)
Rotates the preview image 90 degrees clockwise.

* The result will be reflected in the scanned image.
* The image returns to its original state when you preview again.

bl _“i
ﬂgl& (Auto Crop)

Displays and adjusts the cropping frame automatically to the size of the document displayed in the
Preview area. The scan area is reduced every time you click this button if there are croppable areas
within the cropping frame.

K
KX

(Check All Frames)
Available when two or more frames are displayed.

Selects the checkboxes of the image in thumbnail view.

a0
oo

(Uncheck All Frames)
Available when two or more frames are displayed.

Deselects the checkboxes of the image in thumbnail view.

EE
EIE) (select All Frames)

Available when two or more frames are displayed.

Selects the images in thumbnail view and outlines them in blue.

i (Select All Cropping Frames)
Available when two or more cropping frames are specified.

Turns the cropping frames into thick broken lines and applies the settings to all of them.

%

"""" (Remove Cropping Frame)
Removes the selected cropping frame.

d (Information)

Displays the version of ScanGear and the current scan settings (document type, etc.).

.-"/

© (Open Guide)
Opens this page.

(3) Preview Area

This is where a trial image appears after you click Preview. You can also check the results of the settings
(image corrections, color adjustments, etc.) made in "(1) Settings and Operation Buttons."

When lﬂ] (Thumbnail) is displayed on the Toolbar:

Cropping frames are specified according to the document size, and thumbnails of scanned images are
displayed. Only the images with the checkbox selected will be scanned.
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23> Note

* When multiple images are previewed, different outlines indicate different selection status.

» Focus Frame (thick blue outline): The displayed settings will be applied.

+ Selected Frame (thin blue outline): The settings will be applied to the Focus Frame and Selected
Frames simultaneously. You can select multiple images by clicking them while pressing the Cirl
key.

» Unselected (no outline): The settings will not be applied.

* Double-click a frame to zoom in on the image. Click E E (Frame Advance) at the bottom of the
screen to display the previous or next frame. Double-click the frame again to return the display to its
non-magnified state.

—

L |
When = (Whole Image) is displayed on the Toolbar:

ltems on the Platen are scanned and displayed as a single image. All portions in the cropping frames will
be scanned.
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> Note

* You can specify the cropping frame on the displayed image. In thumbnail view, you can only create
one cropping frame per image. In whole image view, you can create multiple cropping frames.

= Adjusting Cropping Frames (ScanGear)

Related Topic

= Scanning in Basic Mode
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Advanced Mode Tab

This mode allows you to make advanced scan settings such as the color mode, output resolution, image
brightness, and color tone.

This section describes the settings and functions available on the Advanced Mode tab.

e (1) |

Fupcscr Dot ancd Saratches :

Federg Correcion @
Gran Camedion :

Gtk S oM |

RIS

6]z =
(&

= (1) Settings and Operation Buttons
= (2) Toolbar
= (3) Preview Area

12> Note

» The displayed items vary by document type and view.
» The preview function is not available when scanning from the ADF (Auto Document Feeder).

(1) Settings and Operation Buttons

Favorite Settings

You can name and save a group of settings (Input Settings, Output Settings, Image Settings, and
Color Adjustment Buttons) on the Advanced Mode tab, and load it as required. It is convenient to

save a group of settings if you will be using it repeatedly. You can also use this to reload the default
settings.

Select Add/Delete... from the pull-down menu to open the Add/Delete Favorite Settings dialog box.
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Add/Delete Favorite Settings
Seating Marse 2 Farvoeiie Settings List &
Mew Besting [
add =
Cancel

Enter Setting Name and click Add; the name appears in Favorite Settings List.

When you click Save, the item appears in the Favorite Settings list and can be selected, along with
the predefined items.

To delete an item, select it in Favorite Settings List and click Delete. Click Save to save the settings
displayed in Favorite Settings List.

»>» Note

* You can set Add/Delete... in Favorite Settings after preview.
» Save up to 10 items.

Input Settings
Specify the input settings such as the document type and size.

Output Settings
Specify the output settings such as the output resolution and size.

Image Settings
Enable/disable various image correction functions.

Color Adjustment Buttons

Fine corrections to the image brightness and color tones can be made including adjustments to the
image's overall brightness or contrast and adjustments to its highlight and shadow values (histogram)
or balance (tone curve).

Zoom
Zooms in on a frame, or zooms in on the image in the area specified with a cropping frame (scan
area). When zoomed in, Zoom changes to Undo. Click Undo to return the display to its non-
magnified state.

In thumbnail view:

When multiple images are displayed in thumbnail view, clicking this button zooms in on the selected

frame. Click 88| (Frame Advance) at the bottom of the screen to display the previous or next
frame.

»» Note

* You can also zoom in on an image by double-clicking the frame. Double-click the frame again to
return the display to its non-magnified state.

In whole image view:

Rescans the image in the area specified with a cropping frame at higher magnification.
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23 Note

» Zoom rescans the document and displays high-resolution image in Preview.

o

| |
- N (Enlarge/Reduce) on the Toolbar zooms in on the preview image quickly. However, the
resolution of the displayed image will be low.

Preview
Performs a trial scan.

LEIE A EAIENIENI LR

Scan
Starts scanning.
27> Note

» When scanning starts, the progress will be displayed. Click Cancel to cancel the scan.

* When scanning is completed, a dialog box prompting you to select the next action may appear.
Follow the prompt to complete. For details, refer to Status of ScanGear dialog after scanning
in Scan Tab (Preferences dialog box).

« It will take time to process the images if the total size of the scanned images exceeds a certain
size. In that case, a warning message appears; it is recommended that you reduce the total size.
To continue, scan in whole image view.

Preferences...

Opens the Preferences dialog box in which you can make scan/preview settings.

Close
Closes ScanGear (scanner driver).

(2) Toolbar

You can adjust or rotate preview images. The buttons displayed on the Toolbar vary by view.
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In thumbnail view:

] D22 00 B8 | & @
SR RHIEEERZ SR 1 B

5] (Thumbnait) / | Whole Image)
Switches the view in the Preview area.

= (3) Preview Area

— (Clear)
Deletes the preview image from the Preview area.

It also resets the Toolbar and color adjustment settings.

- (Crop)
Allows you to specify the scan area by dragging the mouse.

(Move Image)

Allows you to drag the image until the part you want to see is displayed when an image enlarged in
the Preview area does not fit in the screen. You can also move the image using the scroll bars.

N (Enlarge/Reduce)
Allows you to zoom in on the Preview area by clicking the image. Right-click the image to zoom out.

c
= (Rotate Left)

Rotates the preview image 90 degrees counter-clockwise.

* The result will be reflected in the scanned image.
* The image returns to its original state when you preview again.

3
By (Rotate Right)
Rotates the preview image 90 degrees clockwise.

» The result will be reflected in the scanned image.
* The image returns to its original state when you preview again.

b1 _“i
ﬂd& (Auto Crop)

Displays and adjusts the cropping frame automatically to the size of the document displayed in the
Preview area. The scan area is reduced every time you click this button if there are croppable areas
within the cropping frame.

KR
KR

(Check All Frames)
Available when two or more frames are displayed.

Selects the checkboxes of the image in thumbnail view.
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oo
0o (Uncheck All Frames)
Available when two or more frames are displayed.

Deselects the checkboxes of the image in thumbnail view.

BE
EE (select All Frames)

Available when two or more frames are displayed.

Selects the images in thumbnail view and outlines them in blue.

L3 (Select All Cropping Frames)
Available when two or more cropping frames are specified.

Turns the cropping frames into thick broken lines and applies the settings to all of them.

X

(Remove Cropping Frame)
Removes the selected cropping frame.

d (Information)

Displays the version of ScanGear and the current scan settings (document type, etc.).

P |
= (Open Guide)
Opens this page.

(3) Preview Area

This is where a trial image appears after you click Preview. You can also check the results of the settings

(image corrections, color adjustments, etc.) made in "(1) Settings and Operation Buttons."

When lﬂ (Thumbnail) is displayed on the Toolbar:

Cropping frames are specified according to the document size, and thumbnails of scanned images are

displayed. Only the images with the checkbox selected will be scanned.
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> Note

* When multiple images are previewed, different outlines indicate different selection status.

» Focus Frame (thick blue outline): The displayed settings will be applied.

 Selected Frame (thin blue outline): The settings will be applied to the Focus Frame and Selected
Frames simultaneously. You can select multiple images by clicking them while pressing the Citrl
key.

* Unselected (no outline): The settings will not be applied.

——

L |
When (Whole Image) is displayed on the Toolbar:

Items on the Platen are scanned and displayed as a single image. All portions in the cropping frames will

be scanned.

»>» Note

* You can specify the cropping frame on the displayed image. In thumbnail view, you can only create
one cropping frame per image. In whole image view, you can create multiple cropping frames.

= Adjusting Cropping Frames (ScanGear)

Related Topic

= Scanning in Advanced Mode
= Scanning Multiple Documents from the ADF (Auto Document Feeder) in Advanced Mode
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Input Settings
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Input Settings allows you to set the following items:

Select Source
The type of document to be scanned is displayed. To scan from the Platen, select Platen; to scan from
the ADF (Auto Document Feeder), select Document (ADF Simplex) or Document (ADF Duplex).

32 Important

+ Some applications do not support continuous scanning from the ADF. For details, refer to the
application's manual.

»» Note

* You can select Document (ADF Duplex) when using a model supporting ADF duplex scanning.

Paper Size

Select the size of the document to be scanned. This setting is available in whole image view only.
When scanning both sides of the documents automatically from the ADF, select A4 or Letter.
When you select a size, the Preview area size changes accordingly.

32 Important

« Some applications have a limit to the amount of scan data they can receive. Available scan range
is as follows.

» 21000 pixels x 30000 pixels or less

« If you change Paper Size after previewing, the preview image will be deleted.

»» Note

+ If you are not sure which size you should select for Paper Size, set Paper Size to Full Platen, then

measure the size of the document and enter the values into & (Width) and i (Height).
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Original Orientation
Set the orientation and stapling side of the documents to scan from the ADF.

Click Settings... to open the Orientation dialog box.
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32 Important

» The Orientation dialog box can only be opened when Select Source is Document (ADF
Simplex) or Document (ADF Duplex).

» Binding Location is displayed when using a model supporting ADF duplex scanning.

» Binding Location cannot be specified when Select Source is Document (ADF Simplex).

Color Mode
Select how to scan the document.

Color
Select this mode to scan color documents or to create color images. This mode renders the image
in 256 levels (8 bit) of R(ed), G(reen), and B(lue).

Grayscale
Select this mode to scan black and white photos or to create black and white images. This mode
renders the image in 256 levels (8 bit) of black and white.

Black and White
Select this mode to scan photos and documents in black and white. This mode renders the image
in black and white. The contrast in the image is divided at certain levels (threshold level) into black

and white and is rendered in two colors. The threshold level can be set with 4 (Threshold).

Input Size
In thumbnail view, the cropped document size is displayed after preview.

In whole image view, the Paper Size is displayed before preview, and the cropping frame (scan area)
size is displayed after preview.

You can adjust the cropping frame size by entering the values into = (Width) and tH (Height).

Click e (Change Aspect Ratio) and change it to & (Keep Aspect Ratio) to maintain the aspect ratio

when you specify the cropping frame size.
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3» Important

* Input size settings are available only when Output Size in Output Settings is Flexible. If you
select a size other than Flexible, a cropping frame calculated from Output Size and Output
Resolution is displayed, and its aspect ratio is fixed.

»» Note

» The values you can enter will be within the range of the selected document size. The minimum size
is 96 pixels x 96 pixels when Output Resolution is 600 dpi, scaled at 100 %.

* When Auto Crop is performed in whole image view, the aspect ratio will not be maintained since
the size will be prioritized.

» Refer to "Adjusting Cropping Frames (ScanGear)" for details on cropping frames.
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Output Settings

Output Settings allows you to set the following items:

Output Resolution
Select the resolution to scan at.

The higher the resolution (value), the more detail in your image.

Select a resolution from the options displayed by clicking the button, or enter a value in 1 dpi
increments.

Refer to "Resolution" for your model from Home of the Online Manual for details.

When Select Source is Platen:

You can enter a value within the range of 25 dpi to 19200 dpi.

When Select Source is Document (ADF Simplex) or Document (ADF Duplex):
You can enter a value within the range of 25 dpi to 600 dpi.

Output Size
Select an output size.

Select Flexible to set custom sizes or select a size for printing or displaying. Select Add/Delete... to set
custom size and save it as a new output size option.

Flexible
You can specify the output resolution and scale, and adjust the cropping frames (scan areas).
In thumbnail view:

Drag the mouse over a thumbnail to display a cropping frame. When a cropping frame is displayed,
the portion within the cropping frame will be scanned. When no cropping frame is displayed, each
frame is scanned individually.
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In whole image view:

When no cropping frame is displayed, the entire Preview area will be scanned. When a cropping
frame is displayed, the portion within the cropping frame will be scanned.

»>» Note

» To enlarge/reduce the scanned image, enter values into = (Width) and tH (Height) in
Output Settings or specify a value (by 1 %) for %. Although the maximum value available for
% depends on the Output Resolution, it can be specified for up to 19200 dpi (the maximum
available output resolution).

Paper Size (L, A4, etc.) & Monitor Size (1024 x 768 pixels, etc.)

o (Width), *& (Height), and scale cannot be specified. The preview image will be cropped
according to the selected output size and resolution. The portion within the cropping frame will be
scanned at the size of the selected paper/monitor size. You can drag the cropping frame to enlarge,
reduce, or move it while maintaining the aspect ratio.

Add/Delete...
Opens the Add/Delete the Output Size dialog box, in which you can specify custom output sizes.

Add/Delete the Output Size. IEM |
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In the Add/Delete the Output Size dialog box, you can specify multiple output sizes and save
them at one time. Saved items will be registered to the Output Size list and can be selected, along
with the predefined items.

Adding:

Select Print or Image display for Destination, then enter Output Size Name, Width, and Height,

then click Add. For Unit, you can select inches or mm when Destination is Print but you can only
select pixels when Destination is Image display. The name of the added size appears in Output
Size List. Click Save to save the items listed in Output Size List.

Deleting:

Select the output size you want to delete in Output Size List, then click Delete. Click Save to save
the items listed in Output Size List.

3% Important

* You cannot delete predefined output sizes such as A4 and 1024 x 768 pixels.

»>» Note

» Save up to 10 items for each destination.
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* An error message appears when you enter a value outside the setting range. Enter a value
within the range displayed in the message.

»» Note

 Refer to "Adjusting Cropping Frames (ScanGear)" for details on cropping frames.
 For details on whether or how the cropping frame is initially displayed on a preview image, refer to
Cropping Frame on Previewed Images in "Preview Tab" (Preferences dialog box).

L (Switch Aspect Ratio)
Available when Output Size is set to anything but Flexible.

Click this button to rotate the cropping frame. Click again to return it to the original orientation.

Data Size
The data size when scanned with the current settings is displayed.

»» Note

* When the data size exceeds a certain size, the value appears in red. In that case, a warning
message appears when you click Scan. It is recommended that you adjust the settings to reduce
Data Size. To continue, scan in whole image view.
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Image Settings

t.‘:.{..‘.‘ t.‘:.

22 Important

» Do not apply these functions to images without moire, dust/scratches, or faded colors. The color tone
may be adversely affected.
» Image correction results may not be reflected in the preview image.

123 Note

» Selectable settings depend on Color Mode settings.
» Scanning may take longer than usual when you use Image Settings.

Image Settings allows you to set the following items:

Image Adjustment
When Image Adjustment is set, the brightness of the specified portion of the image is optimized. Images
can be adjusted according to the automatically detected document type or the specified document type.
The result of the adjustment will be reflected in the entire image.

None
Image Adjustment will not be applied.

Auto
Applies Image Adjustment by automatically detecting the document type. It is recommended that
you normally select this setting.

Photo
Applies Image Adjustment suitable for photos.

Magazine
Applies Image Adjustment suitable for magazines.
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Document
Applies Image Adjustment suitable for text documents.

22 Important

* You can set Image Adjustment after preview.
* You can set this setting when Recommended is selected on the Color Settings tab of the
Preferences dialog box.

»» Note

« If the image is not adjusted properly with Auto, specify the document type.
» The color tone may change from the source image due to the Image Adjustment. In that case, set
Image Adjustment to None.

Reduce Show-through
Use this function to reduce show-through in duplex documents or lighten the base color in recycled
paper and other colored paper when scanning documents.

OFF
Show-through will not be reduced.

ON
Select this to reduce show-through in duplex documents or lighten the base color. It is
recommended that you normally select this setting.

32 Important

* Reduce Show-through can be set when Recommended is selected on the Color Settings tab of
the Preferences dialog box and Document or Magazine is selected for Image Adjustment.

Unsharp Mask
Emphasizes the outline of the subjects to sharpen the image when scanning photos.

OFF
Unsharp Mask will not be applied.
ON
Emphasizes the outline of the subjects to sharpen the image. It is recommended that you normally
select this setting.
Descreen
Printed photos and pictures are displayed as a collection of fine dots. "Moire" is a phenomenon where

uneven gradation or a stripe pattern appears when such photos or pictures printed with fine dots are
scanned. Descreen is the function for reducing this moire effect.

OFF
Moire will not be reduced.

ON

Reduces moire. It is recommended that you normally select this setting.

»» Note

» Even if Descreen is set to ON, some moire effects may remain if Unsharp Mask is set to ON. In
that case, set Unsharp Mask to OFF.

437



Reduce Dust and Scratches
Scanned photos may contain white dots caused by dust or scratches. Use this function to reduce such
noise.
None
Dust and scratches will not be reduced.

Low
Select this to reduce small dust particles and scratches. Large ones may remain.

Medium
It is recommended that you normally select this setting.

High
Select this to reduce large dust particles and scratches; however, evidence of the reduction
process may remain or delicate parts of the image may be removed.

32 Important

« This function may not be effective for some types of photos.

»» Note

+ It is recommended that you select None when scanning printed materials.

Fading Correction
Use this function to correct photos that have faded with time or have a colorcast. "Colorcast" is a
phenomenon where a specific color affects the entire picture due to the weather or ambient strong
colors.

None
Fading Correction will not be applied.

Low
Select this to correct a small amount of fading and colorcast.

Medium
It is recommended that you normally select this setting.

High
Select this to correct a large amount of fading and colorcast. This can affect the tone of the image.

32 Important

* You can set Fading Correction after preview.

* You can set this setting when Recommended is selected on the Color Settings tab of the
Preferences dialog box.

» Correction may not be applied properly if the scan area is too small.

Grain Correction
Use this function to reduce graininess (roughness) in photos taken with high-speed or sensitized film.

None
Graininess will not be reduced.

Low
Select this when the photo is slightly grainy.
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Medium
It is recommended that you normally select this setting.

High
Select this when the photo is very grainy. This can affect the gradation and sharpness of the image.

22 Important

» Correction may not be applied properly if the scan area is too small.

Gutter Shadow Correction
Use this function to correct shadows that appear between pages when scanning open booklets.

When you set the Gutter Shadow Correction setting in the preview image, the result will be reflected.
Preview the effects before scanning, as results vary depending on the type of document and how it is
pressed.

Unclear or blurred text/lines caused by curved pages are not corrected.

None
Gutter shadow will not be corrected.

Low
Select this when the effect level is too strong with the medium setting.

Medium
It is recommended that you normally select this setting.

High
Select this when the effect level is too weak with the medium setting.

32 Important

* You can set Gutter Shadow Correction after preview.

» Do not place objects that weigh 4.4 Ibs (2.0 kg) or more on the platen. Also, do not press on the
document with a force exceeding 4.4 Ibs (2.0 kg). If you press heavily, the scanner may not work
correctly or you might break the glass.

« Align the document with the edge of the Platen. If not, the shadow will not be corrected properly.

» Shadows may not be corrected properly depending on the document. If the page background is not
white, shadows may not be detected correctly or may not be detected at all.

» While scanning, press down on the spine with the same amount of pressure you used to preview
the scan. If the binding part is not even, the shadow will not be corrected properly.
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* How to place the document depends on your model and the document to be scanned.

»» Note

» Cover the document with black cloth if white spots, streaks, or colored patterns appear in scan
results due to ambient light entering between the document and the Platen.

« If the shadow is not corrected properly, adjust the cropping frame (scan area) on the preview
image.

= Adjusting Cropping Frames (ScanGear)

440



Color Adjustment Buttons

The Color Adjustment Buttons allow you to make fine corrections to the image brightness and color tones
including adjustments to the image's overall brightness or contrast and adjustments to its highlight and
shadow values (histogram) or balance (tone curve).

£ % € % LI

22 Important

» The Color Adjustment Buttons are not available when you select Color Matching on the Color
Settings tab of the Preferences dialog box.

23 Note

+ Selectable settings depend on Color Mode settings.
* When you adjust the image via the Color Adjustment Buttons, the results will be reflected in the preview
image.

Click a Color Adjustment Button to set the following items:

e

(Saturation/Color Balance)
Adjust the saturation (vividness) and color tone of the image. Use this function to brighten colors that
have faded with time or due to colorcast. "Colorcast" is a phenomenon where a specific color affects the
entire picture due to the weather or ambient strong colors.

= Adjusting Saturation and Color Balance

X (Brightness/Contrast)
Adjust the brightness and contrast of the image. If the image is too dark or too bright, or if the image

quality is flat due to lack of contrast, you can adjust the levels of brightness and contrast.

= Adjusting Brightness and Contrast
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o (Histogram)

A histogram allows you to see the data concentration at each brightness level of an image. You can
specify the brightest level (highlight) and darkest level (shadow) within an image, cut the levels and
expand the middle of the tonal range of the image.

= Adjusting Histogram

(Tone Curve Settings)
Adjust the brightness of an image by selecting the type of graph (tone curve) showing the balance of
tone input and output. You can make fine adjustments to the brightness of a specific area.

= Adjusting Tone Curve

‘4 | (Final Review)
Make a final check of color adjustments. The final synthesized tone curve and the histogram derived

from the subsequent image processing will be displayed. There are no settings to make in this screen.

Firal Review

Chanred = gt o

» For a color image, select a color in Channel to check either Red, Green, or Blue, or select Master
to check three colors together.

« If you place the cursor on the preview image, the portion will be enlarged and its RGB values (only
L when Color Mode is Grayscale) before and after the adjustments will be displayed.

4 (Threshold)

Set the boundary (threshold) at which black and white are divided. By adjusting the threshold level, you
can sharpen text in a document or reduce show-through in newspapers.

= Setting Threshold

Custom
You can name and save a set of tone curve and threshold settings of the Color Adjustment Buttons.

Select Add/Delete... from the pull-down menu; when Color Mode is set to anything but Black and
White, the Add/Delete Tone Curve Settings dialog box opens; when Color Mode is Black and White,
the Add/Delete Threshold Settings dialog box opens.
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Add/Delete Tone Cunve Settings n
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Enter Setting Name and click Add; the name appears in Tone Curve Settings List or Threshold
Settings List. Click Save to save.

To delete an item, select it in Tone Curve Settings List or Threshold Settings List and click Delete.
Click Save to save the settings displayed in Tone Curve Settings List or Threshold Settings List.

You can load and apply the saved tone curve/threshold settings to a preview image. To load the
settings, select the saved item from the pull-down menu.

»» Note

» Save up to 20 items.

Defaults
Reset all adjustments (saturation/color balance, brightness/contrast, histogram, and tone curve).
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Preferences Dialog Box

In the Preferences dialog box, you can make advanced settings to ScanGear (scanner driver) functions via
the Scanner, Preview, Scan, and Color Settings tabs.

Click Preferences... in the ScanGear screen to open the Preferences dialog box.

Preferences EX|
St | Preview | Soan | Color Sestngs

Ayt Power Satirgs __ et
et Setiregs Satings...

Gelect Foldder Where Temperaey Fles aoe Saved
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Seumnd Settings
[ iPtay ivnsir iy SoBeeirey

| iPay s v siaewing i cowrplebed

Calbrabon Sattngs
Eweaiite ab Every Scan FF w

Scanner Tab
Allows you to set the auto power settings, specify the folder in which to save images temporarily, and
set the music file to play during or at the end of a scan.

Preview Tab
Allows you to select what to do with Preview when ScanGear is started, how to display cropping frames
after previewing images, and the cropping size for thumbnails of scanned documents.

Scan Tab
Allows you to select what to do with ScanGear after scanning image.

Color Settings Tab
Allows you to select how to adjust color, and specify the monitor gamma value.
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Scanner Tab
On the Scanner tab, you can specify the following settings.

32 Important

 Available functions and settings vary depending on your scanner or printer.

=

st Sattrgs | setergs... |

Seledt Falder Where Tempareey Files are Savnd
Brewss... |

.M&img:
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[Tl Ptary sevet whan seawving i complated

Calbration Satongs
Ewoite B Every Sonn s

Auto Power Settings
You can set to turn the machine on or off automatically.

Click Settings... to display the Auto Power Settings dialog box.
232 Note

+ If the machine is off or bi-directional communication is disabled, a message may appear because
the computer cannot collect the machine status. In that case, click OK to exit ScanGear (scanner
driver).

Auto Power On
Select Enable to turn on the machine automatically when data is received.

Auto Power Off
Specify the amount of time you want to set from the list. When this time lapses without any data
being received, the machine turns off automatically.
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3% Important

When connected to the network, depending on your model, the power does not turn off
automatically even if Auto Power Off is set.

Refer to "Function Support List by Model (Auto Power Off)" to check if your model supports the
Auto Power Off function.

Quiet Settings

The silent function allows you to reduce the operating noise of this machine. Use this when you wish to
reduce the operating noise such as when scanning or printing at night.

Click Settings... to set the quiet mode.
»» Note

* You can set the quiet mode from the operation panel of the machine, the printer driver, or
ScanGear.

No matter how the setting is made, it applies to operations from the operation panel of the machine
or when printing/scanning from a computer, etc.

+ Scanning or printing may take longer than usual when this function is used.

Quiet Seitings
D et e et roie
O Ak Lo cpset made
) Use quist mode during spedfied hours

QT

Wi the: hoers ane specifed, guiel made & ned apobed 10 operatons
{ropy, drectigrint, ebc) perfemed drectly from the printer,

o | Canerl Defauits

Do not use quiet mode

Select this option when you wish to use the machine with volume of normal operating noise.
Always use quiet mode

Select this option when you wish to reduce the operating noise of the machine.

Use quiet mode during specified hours

Select this option when you wish to reduce the operating noise of the machine during a specified
period of time.

Set the Start time and End time during which quiet mode is to be activated.

22 Important

» The time specified in Start time and in End time must be different.
* If your scanner or printer does not support fax functions, quiet mode is not applied to

operations (copy, direct print, etc.) performed directly from the machine even if the hours are
specified.

Select Folder Where Temporary Files are Saved

Displays the folder in which to save images temporarily. To change the folder, click Browse... to specify
another one.
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Sound Settings
You can set the machine to play music during/at the end of a scan.

Select the Play music during scanning or Play sound when scanning is completed checkbox, then
click Browse... and specify a sound file.

You can specify the following files.
« MIDI file (*.mid, *.rmi, *.midi)
* Audio file (*.wav, *.aif, *.aiff)
* MP3 file (*.mp3)
Calibration Settings
When you set Execute at Every Scan to ON, the scanner will be calibrated every time before
previewing and scanning, to reproduce correct color tones in scanned images.

»» Note

» Even when Execute at Every Scan is set to OFF, the scanner may be calibrated automatically in
some cases (such as immediately after you turn the machine on).
+ Calibration may take time depending on your computer.
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Preview Tab

On the Preview tab, you can specify the following settings.

Praferences “

Seprner | Preview | Soan | Colr Sestngs

P B G080 &1 Soneiens &
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W Desplay savved preview mage
{ihgne

Crogping Frames of Preveewed Tnages =
W Esevube Bl £ P o O £ v mid ELhes
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Croppreg Size for Trambnal View |
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Preview at Start of ScanGear
Select what to do with Preview when ScanGear (scanner driver) is started.

Automatically execute preview
ScanGear will automatically start previewing at startup.

Display saved preview image
The previously previewed image will be displayed.

The Color Adjustment Button settings, the Toolbar settings, and the Advanced Mode tab settings
are also saved.

None
No preview image will be displayed at startup.

»» Note

+ Select None if you do not want to save the preview image.

Cropping Frame on Previewed Images
Select how to display cropping frames after previewing images.

Execute auto cropping on previewed images
The cropping frame (scan area) will automatically be displayed in the document size after
previewing.

Display the last frame on previewed images
A cropping frame of the same size as the last used cropping frame will be displayed after
previewing.

None
No cropping frame will be displayed after previewing.
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Cropping Size for Thumbnail View
Select the cropping size for thumbnails of scanned documents.

Larger
Displays 105 % (in width and height) of the area displayed for the standard size.

Standard
The standard size.

Smaller
Displays 95 % (in width and height) of the area displayed for the standard size.

»» Note

» When you change the Cropping Size for Thumbnail View setting, the preview images will be
refreshed and cropped to the new size. As the preview images are refreshed, the color
adjustments and other settings applied to them are reset.
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Scan Tab

On the Scan tab, you can specify the following settings.

“eorner | review | 58 | Sl Sestngs |

Stabys of Scanbaer chalog afier scanming ;
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{1 Danet dose ScanGear motomabicaly

) Dimplay the dislog o salact next achon

Status of ScanGear dialog after scanning
Select what to do with ScanGear (scanner driver) after scanning images.

Close ScanGear automatically
Select this to return to the original application when scanning is completed.

Do not close ScanGear automatically
Select this to return to the ScanGear screen for another scan when scanning is completed.

Display the dialog to select next action
Select this to open a screen and select what to do when scanning is completed.

Ganrvireg i corpinbed. Sebert the aotion you prefer by take:
(8] Retouch and save the mage  (Close ScanGear dalog)
() can caber images (D not chone Scanizear])

100 not deplay s daiog agan

‘o sy modif'y this se1ting on [Scan] tab of [Freferences] dislog.

[ o |

13> Note

» Even if Do not close ScanGear automatically or Display the dialog to select next action is set,
some applications may not support it.
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Color Settings Tab

On the Color Settings tab, you can specify the following settings.

Preferences “
Seorner | Preview | Soan | Coler Seltngs
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Color Adjustment
Select one of the following.

Recommended
Select this to vividly reproduce the tone of a document on the screen. It is recommended that you
normally select this setting.

Color Matching
Select this to automatically match the scanner, monitor, and color printer colors, thus reducing time and
trouble to manually match the monitor and printer colors.

Source(Scanner)
Select scanner profile.

Target
Select target profile.

Monitor
Select this checkbox to display preview image with optimum correction for monitor.

Defaults

Returns to the default Color Matching settings.

»» Note

» The Color Adjustment Buttons on the Advanced Mode tab are not available when you select
Color Matching.
+ This function is available when Color Mode is Color.

None
Select this to disable color correction provided by ScanGear (scanner driver).
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»» Note

» Depending on your scanner or printer, this setting may not be available when scanning from the ADF
(Auto Document Feeder).

* You can select one when Color Mode is Color or Grayscale.

» Color Matching is available when ScanGear, monitor, color management-compliant application (such as
Adobe Photoshop), and printer are set up correctly.

Refer to the corresponding manual for the monitor, printer, and application settings.

Monitor Gamma
By setting the gamma value of a monitor, you can adjust the input data to the brightness characteristics
of the monitor. Adjust the value if your monitor's gamma value does not match the default value set in
ScanGear, and the colors of the original image are not accurately reflected in the monitor.

Click Defaults to return to the default Monitor Gamma value (2.20).

»» Note

» Refer to the manual of your monitor to check its gamma value. If it is not written in the manual,
contact the manufacturer.
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Positioning Originals (Scanning from Computer)

Learn how to place items on the platen or ADF (Auto Document Feeder) of your scanner or printer. Place
items correctly according to the type of item to be scanned. Otherwise, items may not be scanned correctly.

22 Important

» Do not place objects on the document cover. When you open the document cover, the objects may fall

into your scanner or printer, resulting in malfunction.
* Close the document cover when scanning.

» Do not touch the operation panel buttons or LCD (Liquid Crystal Display) when opening/closing the

document cover. May result in unintended operation.

= Placing Iltems (Platen)

= Placing Documents (ADF (Auto Document Feeder))

Placing Items (Platen)

Place items as described below to scan by detecting the item type or size automatically.

32 Important

* When scanning by specifying the paper size in IJ Scan Utility or ScanGear (scanner driver), align an
upper corner of the item with the corner at the arrow (alignment mark) of the platen.
» Photos that have been cut to various shapes and items smaller than 1.2 inches (3 cm) square cannot

be cropped accurately when scanning.

» Reflective disc labels may not be scanned as expected.

For Photos, Postcards, Business Cards, or BD/DVD/CD

For Magazines, Newspapers, or Documents

Placing a Single Iltem:

ly striped area cannot be scanned.

b

e
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Place the item face-down on the platen, with 0.4 inch (1 cm)
or more space between the edges (diagonally striped area)
of the platen and the item. Portions placed on the diagonal-
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upper corner of the item with the corner at the arrow
(alignment mark) of the platen. Portions placed on the
diagonally striped area cannot be scanned.
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22 Important

3% Important

* Large items (such as A4 size photos) that cannot be
placed away from the edges/arrow (alignment mark) of
the platen may be saved as PDF files. To save in a for-
mat other than PDF, scan by specifying the data for-
mat.

» Refer to "Loading Originals" for your model from
Home of the Online Manual for details on the por-
tions in which items cannot be scanned.

Placing Multiple ltems:

Allow 0.4 inch (1 cm) or more space between the edges (di-
agonally striped area) of the platen and items, and between
items. Portions placed on the diagonally striped area cannot
be scanned.
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(A) more than 0.4 inch (1 cm)
3> Note

* You can place up to 12 items.

* You can place up to four items when the Compress
scanned images upon transfer checkbox is selected
in the Settings dialog box of IJ Scan Utility.

» With network connection, items may not be scanned
correctly when five or more items are placed. In that
case, reduce the number of items placed on the platen
to four or less, then scan again.

* Positions of slanted items (10 degrees or less) are cor-
rected automatically.

Placing Documents (ADF (Auto Document Feeder))

22 Important

* Do not leave thick items on the platen when scanning from the ADF. May result in paper jam.

» Place and align documents of the same size when scanning two or more documents.

» Refer to "Originals You Can Load" for your model from Home of the Online Manual for details on
supported document sizes when scanning from the ADF.

1. Open the document tray.
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2. Place the documents on the ADF, then adjust the document guides to the width of the
documents.

Insert the documents face-up until a beep sounds.

4

<
-~

22> Note

* When scanning duplex documents, place the front sides facing up. They will not be scanned in
the correct page order if placed the other way around.
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Adjusting Cropping Frames (ScanGear)

"Cropping" is the act of selecting the area you want to keep in an image and discarding the rest when
scanning it.

On the Basic Mode tab and Advanced Mode tab, you can specify cropping frames (scan areas) on the
image(s) displayed in the Preview area of the screen.

When you perform a scan, each area specified with a cropping frame will be scanned as a separate image.

»>» Note

+ In whole image view, you can specify multiple cropping frames on the preview image.
» Refer to "Adjusting Cropping Frames in the Image Stitch Window" for your model from Home of the
Online Manual for how to adjust cropping frames with IJ Scan Utility.

Initial Cropping Frame

In thumbnail view:

No cropping frame is specified. You can drag the mouse over a thumbnail to specify a cropping frame.

In whole image view:

An active cropping frame is automatically specified around the preview image. You can drag the cropping
frame in the Preview area to specify the area.

»>» Note

* You can change the auto crop setting in the Preferences dialog box. Refer to Cropping Frame on
Previewed Images in "Preview Tab" for details.

Cropping Frame Types

(1) Thick cropping frame (rotating or stationary)
Represents a selected cropping frame. Appears only in whole image view. You can select multiple
cropping frames by clicking them while pressing the Ctrl key. Output size, image corrections, and
other settings on the Basic Mode tab or Advanced Mode tab will be applied to all the selected
cropping frames.
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(2) Thin cropping frame

In thumbnail view:

Output size, image corrections, and other settings on the Basic Mode tab or Advanced Mode tab
will be applied.

In whole image view:

Represents an unselected cropping frame. The settings on the Basic Mode tab or Advanced Mode
tab will not be applied.

Adjusting a Cropping Frame

The cursor will change into = jt Rﬂ '3;] (Arrow) when it is positioned over a cropping frame. If you
click and drag the mouse in the direction of the arrow, the cropping frame will expand or contract
accordingly.

The cursor will change into G%ED (Crosshair Arrow) when it is positioned within a cropping frame. Click and
drag the mouse to move the entire cropping frame.

»>» Note

» On the Advanced Mode tab, you can specify the cropping frame size by entering the values into =
(Width) and = (Height) in Input Settings.

* You can rotate a cropping frame 90 degrees by clicking it (Switch Aspect Ratio). However, B
(Switch Aspect Ratio) is not available when Output Size is Flexible.

Creating Multiple Cropping Frames

In thumbnail view:

You can only create one cropping frame per image.
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In whole image view:

Click and drag the mouse in a space outside the existing cropping frame to create a new cropping frame
in the Preview area. The new cropping frame will be the active cropping frame, and the old cropping frame
will be the unselected cropping frame.

You can create multiple cropping frames and apply different scan settings to each cropping frame.
You can also select multiple cropping frames by clicking them while pressing the Ctrl key.

If you select multiple cropping frames and change the settings on a tab at the right of ScanGear, the
settings will be applied to all the selected cropping frames.

When you create a new cropping frame, it retains the settings of the latest cropping frame.
2> Note

* Create up to 12 cropping frames.
» Scanning takes longer than usual when multiple cropping frames are selected.

Deleting Cropping Frames

In thumbnail view:

To delete a cropping frame, click an area outside the cropping frame on an image.
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In whole image view:
X

To delete a cropping frame, select it and click =~ (Remove Cropping Frame) on the Toolbar.
Alternatively, press the Delete key.

When there are multiple cropping frames, all the selected cropping frames (active cropping frame and
selected cropping frames) are deleted simultaneously.
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General Notes (Scanner Driver)

ScanGear (scanner driver) is subject to the following restrictions. Keep these points in mind when using it.

Scanner Driver Restrictions

When using the NTFS file system, the TWAIN data source may not be invoked. This is because the
TWAIN module cannot be written to the winnt folder for security reasons. Contact the computer's
administrator for help.

Some computers (including laptops) connected to the machine may not resume correctly from
standby mode. In that case, restart the computer.

Do not connect two or more scanners or multifunction printers with scanner function to the same
computer simultaneously. If multiple scanning devices are connected, you cannot scan from the
operation panel of the machine and also may experience errors while accessing the devices.
Scanning may fail if the computer has resumed from sleep or standby mode. In that case, follow these
steps and scan again.

1. Turn off the machine.
2. Exit ScanGear, then disconnect the USB cable from the computer and reconnect it.
3. Turn on the machine.

ScanGear cannot be opened in multiple applications at the same time. Within an application,
ScanGear cannot be opened for the second time when it is already open.

Be sure to close the ScanGear window before closing the application.

When using a network compatible model by connecting to a network, the machine cannot be
accessed from multiple computers at the same time.

When using a network compatible model by connecting to a network, scanning takes longer than
usual.

Make sure that you have adequate disk space available when scanning large images at high
resolutions. For example, at least 300 MB of free space is required to scan an A4 document at 600
dpi in full-color.

ScanGear and WIA driver cannot be used at the same time.

Do not enter the computer into sleep or hibernate state during scanning.

Applications with Restrictions on Use

If you start Media Center included in Windows XP Media Center Edition 2005, you may not be able to
scan using the operation panel of the machine. In that case, restart the computer.

You cannot scan images with Media Center included in Windows XP Media Center Edition 2005. Scan
with other applications such as IJ Scan Utility.

Some applications may not display the TWAIN user interface. In that case, refer to the application's
manual and change the settings accordingly.

Some applications do not support continuous scanning of multiple documents. In some cases, only
the first scanned image is accepted, or multiple images are scanned as one image. For such
applications, do not scan multiple documents from the ADF (Auto Document Feeder).

To import scanned images into Microsoft Office 2000, first save them using IJ Scan Utility, then import
the saved files from the Insert menu.
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When scanning Platen size images into Microsoft Office 2003 (Word, Excel, PowerPoint, etc.), click
Custom Insert in the Insert Picture from Scanner or Camera screen. Otherwise, images may not
be scanned correctly.

When scanning images into Microsoft Office 2007/Microsoft Office 2010 (Word, Excel, PowerPoint,
etc.), use Microsoft Clip Organizer.

Images may not be scanned correctly in some applications. In that case, increase the operating
system's virtual memory and retry.

When image size is too large (such as when scanning large images at high resolution), your computer
may not respond or the progress bar may remain at 0 % depending on the application. In that case,
cancel the action (for example by clicking Cancel on the progress bar), then increase the operating
system's virtual memory or reduce the image size/resolution and retry. Alternatively, scan the image
via IJ Scan Utility first, then save and import it into the application.
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Other Scanning Methods

» Scanning with WIA Driver

» Scanning Using the Control Panel (Windows XP Only)
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Scanning with WIA Driver

You can scan an item from a WIA (Windows Image Acquisition)-compliant application.

WIA is a driver model implemented in Windows XP or later. It allows you to scan items without using an
application.

The procedure varies depending on the application. The following procedures are examples only.

Refer to the application's manual for details.

Scanning with WIA Driver 2.0

The following is an example of scanning using "Windows Fax and Scan."

1. Place the item on the platen.

= Positioning Originals (Scanning from Computer)

2. Select New on the File menu of "Windows Fax and Scan," then click Scan....

The scan setting screen appears.

3. Specify the settings.

Scanner
The currently set product name is displayed. To change the scanner, click Change... and select
the product you want to use.

Profile
Select Photo (Default) or Documents according to the type of item to be scanned. To save a
new Profile, select Add profile.... You can specify the details in the Add New Profile dialog box.

Source
Select a scanner type.

Paper size
This setting is not available for your scanner or printer.

Color format
Select the color mode in which to scan the item.

File type
Select a data format from JPEG, BMP, PNG, and TIFF.

Resolution (DPI)
Enter the resolution. Specify a value between 50 dpi and 600 dpi.

= Resolution

Brightness
Move the slider to adjust the brightness. Move it to the left to darken and right to brighten the
image. You can also enter a value (-100 to 100).
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Contrast
Move the slider to adjust the contrast. Moving it to the left will decrease the contrast of the image,
thus softening the image. Moving it to the right will increase the contrast of the image, thus
sharpening the image. You can also enter a value (-100 to 100).

Preview or scan images as separate files
Select this checkbox to preview or scan multiple images as separate files.

4. Click Preview to preview the image.

The preview image appears on the right.

5. Click Scan.

Scanning starts, then the scanned image appears in the application.

Scanning with WIA Driver 1.0

The following is an example of scanning using "Paint."

1. Place the item on the platen.

= Positioning Originals (Scanning from Computer)

2. Click From scanner or camera from the File menu of Paint. (Select the command to
scan an item in the application.)

3. Select the type of picture according to the item to be scanned.

Select from Color picture, Grayscale picture, Black and white picture or text, and Custom
Settings.

> Note

» To scan with the values previously set in Adjust the quality of the scanned picture, select
Custom Settings.

4. Click Adjust the quality of the scanned picture and set the preferences as required.

Brightness
Move the slider to adjust the brightness. Move it to the left to darken and right to brighten the
image. You can also enter a value (-127 to 127).

Contrast
Move the slider to adjust the contrast. Moving it to the left will decrease the contrast of the image,
thus softening the image. Moving it to the right will increase the contrast of the image, thus
sharpening the image. You can also enter a value (-127 to 127).

Resolution (DPI)
Enter the resolution. Specify a value between 50 dpi and 600 dpi.

= Resolution
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Picture type
Select the type of scan you want for your item.

Reset
Click to restore the original settings.

5. Click Preview to preview the image.

The preview image appears on the right. Drag [l to specify the scan area.

6. Click Scan.

Scanning starts, then the scanned image appears in the application.
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Scanning Using the Control Panel (Windows XP Only)

You can scan images via the Control Panel of Windows XP using the WIA driver.
1. From the Start menu, select Control Panel.

2. Click Printers and Other Hardware > Scanners and Cameras, then double-click Canon
XXX series (where "XXX" is the model name).

The Scanner and Camera Wizard dialog box appears.
3. Click Next.

4. Select Picture type according to the item to be scanned.
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»» Note

» To scan with the values previously set in Custom settings, select Custom.

5. Click Custom settings to set the preferences as required.

Properties

Bechtion A _ Ficture e
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Brightness

Move the slider to adjust the brightness. Move it to the left to darken and right to brighten the image.
You can also enter a value (-127 to 127).
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Contrast
Move the slider to adjust the contrast. Moving it to the left will decrease the contrast of the image,
thus softening the image. Moving it to the right will increase the contrast of the image, thus
sharpening the image. You can also enter a value (-127 to 127).

Resolution (DPI)
Enter the resolution. Specify a value between 50 dpi and 600 dpi.

= Resolution

Picture type
Select the type of scan you want for your item.

Reset
Click to restore the original settings.

6. Click Preview to preview the image.

The preview image appears on the right. Drag M to specify the scan area.

7. Click Next and follow the instructions.
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Scanning Tips
» Resolution
» Data Formats

» Color Matching
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Resolution

The data in the image you have scanned is a collection of dots carrying information about brightness and
color. The density of these dots is called "resolution," and resolution will determine the amount of detail your
image contains. The unit of resolution is dots per inch (dpi). Dpi is the number of dots per inch (2.5 cm).

The higher the resolution (value), the more detail in your image; the lower the resolution (value), the less
detail.

ey

How to Set the Resolution

You can set the resolution in the following screens.
I1J Scan Utility:

Resolution on the E: (Scanning from a Computer) tab of the Settings dialog box

ScanGear (Scanner Driver):

Output Resolution in Output Settings on the Advanced Mode tab

Appropriate Resolution Settings

Set the resolution according to the use of the scanned image.

Appropriate
Item Type Use Color Mode i
Resolution
Copyin
.py|. 9 Color 300 dpi
(Printing)
Creating a postcard Color 300 dpi
Color photo
Saving to a computer Color 300 dpi
Using on a website or attaching to e- .
. Color 150 dpi
mail
Saving to a computer Grayscale 300 dpi
Black and white photo Using on a website or attaching to e- )
. Grayscale 150 dpi
mail
. Color, Grayscale, or .
Copying Black and White 300 dpi
Text document (document or
. . . Color, Grayscale, or .
magazine) Attaching to e-mail ) 150 dpi
Black and White
Scanning text using OCR Color or Grayscale 300 dpi
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3% Important

« If you double the resolution, the data size of the scanned image quadruples. If the file is too large, the
processing speed will slow down significantly, and you will experience inconvenience such as lack of
memory. Set the minimum required resolution according to the use of the image.

7> Note

» When you will be printing the scanned image by enlarging it, scan by setting a higher resolution than
the recommended one above.

470



Data Formats

You can select a data format when saving scanned images. You should specify the most suitable data
format according to how you want to use the image on which application.
Available data formats vary by application and operating system (Windows or Mac OS).

See below for the characteristics of each image data format.

PNG (Standard File Extension: .png)
A data format often used on websites.

PNG is suitable for editing saved images.

JPEG (Standard File Extension: .jpg)
A data format often used on websites and for digital camera images.

JPEG features high compression rates. JPEG images slightly degrade every time they are saved, and
cannot be returned to their original state.

JPEG is not available for black and white images.

TIFF (Standard File Extension: .tif)
A data format featuring a relatively high compatibility between various computers and applications.

TIFF is suitable for editing saved images.

»>» Note

» Some TIFF files are incompatible.
+ |J Scan Utility supports the following TIFF file formats.

+ Uncompressed, black and white binary
* Uncompressed, RGB (8 bits per channel)
» Uncompressed, Grayscale

PDF (Standard File Extension: .pdf)
A data format for electronic documents, developed by Adobe Systems Incorporated.

It can be used on various computers and operating systems, and fonts can be embedded as well; therefore,
people in different environments can exchange the files without being aware of the differences.
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Color Matching

"Color Matching" is the act of making adjustments so that the color tones match between the original item,
the monitor display, and the color printout. On your scanner or printer, the color tones are adjusted as shown
below.

Example: When sRGB is selected as the output profile (target):

Input Profile (Source)

Scanner ‘

ScanGear (Scanner Driver)

'

QOutput Profile (Target)

sRGB ‘
I
I I
Qs/ Application/
Application Printer Driver
Monitor Printer ‘

The image's color space is converted from the scanner's color space to SRGB by ScanGear.

When displaying on a monitor, the image's color space is converted from sRGB to the monitor's color space
based on the operating system's monitor settings and the application's working space settings.

When printing, the image's color space is converted from sRGB to the printer's color space based on the
application's print settings and the printer driver's settings.
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Positioning Originals (Scanning from Computer)

Learn how to place items on the platen of your scanner or printer. Place items correctly according to the
type of item to be scanned. Otherwise, items may not be scanned correctly.

22 Important

» Do not place objects on the document cover. When you open the document cover, the objects may fall
into your scanner or printer, resulting in malfunction.
* Close the document cover when scanning.

Placing Items

Place items as described below to scan by detecting the item type or size automatically.

32 Important

* When scanning by specifying the paper size in IJ Scan Utility or ScanGear (scanner driver), align an
upper corner of the item with the corner at the arrow (alignment mark) of the platen.

» Photos that have been cut to various shapes and items smaller than 1.2 inches (3 cm) square cannot
be cropped accurately when scanning.

» Reflective disc labels may not be scanned as expected.

For Photos, Postcards, Business Cards, or BD/DVD/CD For Magazines, Newspapers, or Documents

Place the item face-down on the platen and align an
upper corner of the item with the corner at the arrow
(alignment mark) of the platen. Portions placed on the
diagonally striped area cannot be scanned.

Placing a Single Iltem:

Place the item face-down on the platen, with 0.4 inch (1
cm) or more space between the edges (diagonally striped
area) of the platen and the item. Portions placed on the di-

agonally striped area cannot be scanned. &

1

1

A4 !

1 |1

1 |1

1 |1

1 |1

1 |1

1 |1

1 |1

1 |1

1 |1

1 |1

1 |1

1 |1

1 |1

1 |1

:: [T s s s S S S S S S S S T R A A A S S S A A
11
11
L|!'!'!'!'PPPPPPPPPPPPPPPPPPPPPPP.‘

2% Important
» Important + Refer to "Loading Originals" for your model from

Home of the Online Manual for details on the por-

* Large items (such as A4 size photos) that cannot be tions in which items cannot be scanned

placed away from the edges/arrow (alignment mark) of
the platen may be saved as PDF files. To save in a
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format other than PDF, scan by specifying the data
format.

Placing Multiple Items:

Allow 0.4 inch (1 cm) or more space between the edges
(diagonally striped area) of the platen and items, and be-
tween items. Portions placed on the diagonally striped area
cannot be scanned.

T

e

ITw

Tw

LTRE T T Frrrrrrrrrrrrrrarrrrrrrr

(A) more than 0.4 inch (1 cm)
»» Note

* You can place up to 12 items.
* Positions of slanted items (10 degrees or less) are
corrected automatically.
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Scanning from Computer (Mac OS)
» Using IJ Scan Utility
» Using Scanner Driver
» Scanning Tips

» Positioning Originals (Scanning from Computer)
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Troubleshooting

Frequently Asked Questions

* Printing Does Not Start

» Paper Is Blank/Printing Is Blurry/Colors Are Wrong/White Streaks Appear
* An Error Occurs

* Print Results Are Unsatisfactory

» Message Appears

» Cannot Install MP Drivers

» Paper Jams

Examples of Problems

@ Machine Does Not Move

» Power Does Not Come On

» Power Shuts Off By lItself

+ Printing Does Not Start

» Paper Jams

» Scanning Problems (Windows)
» Scanning Problems (Mac OS)

« Cannot Set Correctly

« Cannot Connect to Computer Properly
« Cannot Install MP Drivers
» Easy-WebPrint EX Does Not Start or Easy-WebPrint EX Menu Does Not Appear (Windows)

@ Print/Scan Results Are Unsatisfactory

* Printing Does Not Start

» Copying/Printing Stops

* Print Results Are Unsatisfactory

No Ink Comes Out

» Paper Jams

» Paper Does Not Feed Properly/"No Paper" Error
» Scan Results Are Unsatisfactory (Windows)

» Scan Results Are Unsatisfactory (Mac OS)

« Error or Message Appears

» An Error Occurs

» Message Appears

* List of Support Code for Error

* 1J Scan Utility Error Messages (Windows)

* |J Scan Utility Error Messages (Mac OS)

» ScanGear (Scanner Driver) Error Messages
» Scanner Driver Error Messages
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Operation Problems

-
L]
-
L]
-
L]
-
L]

Printing Problems

Scanning Problems (Windows)

Scanning Problems (Mac OS)
Mechanical Problems

Installation and Download Problems

Errors and Messages

If You Cannot Solve a Problem

Repairing Your Machine
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Printing Problems
» Printing Does Not Start
» Paper Jams

» Print Results Are Unsatisfactory

¥

No Ink Comes Out

¥

Paper Does Not Feed Properly/”"No Paper" Error

¥

Copying/Printing Stops
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Q

Printing Does Not Start

A

(W SIN Make sure machine is securely plugged in and press ON button to turn it on.
The ON lamp flashes while the machine is initializing. Wait until the ON lamp stops flashing and remains lit.

»» Note

« If you are printing large data such as photos or other graphics, printing may take longer to start. The ON
lamp flashes while the computer is processing data and sending it to the machine. Wait until printing starts.

OV VAN Make sure machine is properly connected to computer.

When the machine is connected to your computer with a USB cable, check the following:

« If you are using a relay device such as a USB hub, disconnect it, connect the machine directly to the
computer, and retry the printing. If printing starts normally, there is a problem with the relay device. Contact
the vendor of the relay device.

» There could also be a problem with the USB cable. Replace the USB cable and retry the printing.

If printing from a computer, delete unnecessary print jobs.

¢ For Windows:

= Deleting the Undesired Print Job

* For Mac OS:
= Deleting the Undesired Print Job

LW YA |s your machine's printer driver is selected when printing?

The machine will not print properly if you are using a printer driver for a different printer.
* For Windows:

Make sure "Canon XXX series Printer" (where "XXX" is your machine's name) is selected in the Print dialog
box.

»» Note

+ To make the machine the one selected by default, select Set as Default Printer.

* For Mac OS:

Make sure your machine's name is selected in Printer in the Print dialog.

»» Note

» To make the machine the one selected by default, select the machine for Default printer.
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Set correct printer port. (Windows)

Make sure the correct printer port is set.

1. Log in using an account with administrator privileges.

2. Make the following settings.

In Windows 10, right-click Start button and select Control Panel > View devices and printers.

In Windows 8.1 or Windows 8, select Control Panel from Settings charm on Desktop > Hardware
and Sound > Devices and Printers.

In Windows 7, select Devices and Printers from Start menu.
In Windows Vista, select Start menu > Control Panel > Hardware and Sound > Printers.

In Windows XP, select Start menu > Control Panel > Printers and Other Hardware > Printers and
Faxes.

3. Open printer driver properties.

In Windows 10, Windows 8.1, Windows 8, or Windows 7, right-click "Canon XXX series Printer" icon
(where "XXX" is your machine's name), and then select Printer properties.

In Windows Vista or Windows XP, right-click "Canon XXX series Printer" icon (where "XXX" is your
machine's name), and then select Properties.

4. Click Ports tab to check port settings.

Make sure a port named "USBnnn" (where "n" is a number) with "Canon XXX series Printer" appearing in
Printer column is selected for Print to the following port(s).

If setting is incorrect:
Reinstall the MP Drivers from the Setup CD-ROM or the Canon website.

If printing does not start even though the machine is connected to the computer using a USB cable and
the port named "USBnnn" is selected:

In Windows 10, click Start button and select All apps, Canon Utilities, Canon My Printer, Canon My
Printer, and then select Diagnose and Repair Printer. Follow the on-screen instructions to set the
correct printer port, and then select your machine's name.

In Windows 8.1 or Windows 8, select My Printer on Start screen to start My Printer. If My Printer is
not displayed on Start screen, select Search charm, and then search for "My Printer".

Set the correct printer port on Diagnose and Repair Printer. Follow the on-screen instructions to set
the correct printer port, and then select your machine's name.

In Windows 7, Windows Vista, or Windows XP, click Start and select All programs, Canon Utilities,
Canon My Printer, Canon My Printer, and then select Diagnose and Repair Printer. Follow the on-
screen instructions to set the correct printer port, and then select your machine's name.

If the problem is not resolved, reinstall the MP Drivers from the Setup CD-ROM or the Canon website.

Is print data extremely large? (Windows)

Click Print Options on Page Setup sheet of the printer driver. Then set Prevention of Print Data Loss to On in
the dialog that appears.

* This may reduce print quality.

If printing from your computer, restart computer.
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Q

Paper Jams

A

When paper is jammed, the Alarm lamp flashes and a troubleshooting message is displayed on the
computer screen automatically. Take the appropriate action described in the message.

* For Windows:

« For Mac OS:

[ BN ] & Canon 880 series - 1 Job
@ o
Pause Sottings
Support Code {1300)Paper is jam...ed properly due to the paper jam. @

testprint

* The screen differs depending on the OS you are using.
To remove the jammed paper, see List of Support Code for Error (Paper Jams).

23 Note

* You can also search for details on resolving the errors indicated by the support code shown.

= Search
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Q

Print Results Are Unsatisfactory

A

If the print results are unsatisfactory due to white streaks, misaligned lines, or uneven colors, check the
paper and print quality settings first.

Do page size and media type settings match size and type of loaded paper?

If these settings do not match, it is not possible to obtain the proper result.

If you are printing a photograph or an illustration, an incorrect paper type setting may reduce the quality of the
printout color.

Also, if you print with an incorrect paper type setting, the printed surface may be scratched.

In borderless printing, uneven coloring may occur depending on the combination of the paper type setting and
the loaded paper.

The method for checking the paper and print quality settings differs depending on what you are using your
machine for.

Check the page size and media type settings using the printer driver.
* For Windows:

= Printing with Easy Setup

* For Mac OS:

= Printing with Easy Setup

Make sure appropriate print quality is selected using printer driver.

Select a print quality suited to the paper and to what you are printing. If you notice blurs or uneven colors,
increase the print quality setting and retry the printing.

You can check the print quality setting using the printer driver.
+ For Windows:

= Changing the Print Quality and Correcting Image Data

+ For Mac OS:
= Changing the Print Quality and Correcting Image Data

LS |f problem is not resolved, check other causes.

See also the sections below:

= Cannot Complete Printing

= Paper Is Blank/Printing Is Blurry/Colors Are Wrong/White Streaks Appear

= Colors Are Unclear

= | ines Are Misaligned
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= |ines Incomplete or Missing (Windows)

= |mages Incomplete or Missing (Windows)

= |nk Blots / Paper Curl

= Paper Is Smudged / Printed Surface Is Scratched

= Back of Paper Is Smudged

= Vertical Line Next to Image

= Uneven or Streaked Colors
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Q

Cannot Complete Printing

A

Select setting not to compress printing data. (Windows)

If you select the setting not to compress the printing data with an application software you are using, the printing
result may be improved.

Click Print Options on Page Setup sheet of the printer driver. Select Do not allow application software to
compress print data check box and click OK.

* Clear the check box once printing is complete.

Is print data extremely large? (Windows)

Click Print Options on Page Setup sheet of the printer driver. Then set Prevention of Print Data Loss to On in
the dialog that appears.

* This may reduce print quality.

Your hard disk may not have sufficient free space to store job.

Delete unnecessary files to free up disk space.
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Q

Paper Is Blank/Printing Is Blurry/Colors Are Wrong/White Streaks
Appear

- Paper Is Blank

- Printing Is Blurry

=* Colors Are Wrong
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- White Streaks Appear

EEEEEr - ‘“bi
ll.‘»}!'{
-Il-.__.-_----ri!-

A

Check paper and print quality settings.

= Print Results Are Unsatisfactory

W ¥AN Print nozzle check pattern and perform any necessary maintenance operations
such as print head cleaning.
Print the nozzle check pattern to determine whether the ink ejects properly from the print head nozzles.

For details on printing the nozzle check pattern, print head cleaning, and print head deep cleaning, see If Printing
Is Faint or Uneven.

+ If nozzle check pattern is not printed correctly:

After performing the print head cleaning, print the nozzle check pattern and examine the pattern.
« If problem is not resolved after performing print head cleaning twice:

Perform print head deep cleaning.

« If problem is not resolved after performing print head deep cleaning:
Perform system cleaning.
o From computer:

m For Windows:

= Cleaning the Print Heads

m For Mac OS:
= Cleaning the Print Heads

> From operation panel:

To perform system cleaning, press and hold the Stop button until the Alarm lamp flashes 5 times, and
then release the button.

32 Important

+ Before performing system cleaning, check the remaining ink level of all colors. If the remaining ink
level is below the single dot (a), refill the ink tank of corresponding color. Performing system
cleaning when the remaining ink level is not enough may damage the machine.
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If the problem is not resolved yet, the print head may be damaged. Contact your nearest Canon service

center to request a repair.

32 Important

» Do not tilt the machine when moving it since the ink may leak out.

» When transporting the machine for repairing it, see Repairing Your Machine.

When an ink tank runs out of ink, refill the ink tank.

If the remaining ink level is below the lower limit line (A), refill the ink tank with the corresponding color of ink.

After refilling the ink tank, perform system cleaning.
* From computer:
o For Windows:

= Cleaning the Print Heads

o For Mac OS:
= Cleaning the Print Heads
* From operation panel:

To perform system cleaning, press and hold the Stop button until the Alarm lamp flashes 5 times, and then

release the button.

22 Important

» Before performing system cleaning, check the remaining ink level of all colors. If the remaining ink level
is below the single dot (a), refill the ink tank of corresponding color. Performing system cleaning when
the remaining ink level is not enough may damage the machine.
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When using paper with one printable surface, make sure paper is loaded with
printable side facing up.

Printing on the wrong side of such paper may cause unclear prints or prints with reduced quality.
Load paper with the printable side facing up.

Refer to the instruction manual supplied with the paper for detailed information on the printable side.
+ When copying, see also the sections below:

Is platen glass dirty?

Clean the platen glass.

= Cleaning the Platen Glass and Document Cover

Make sure original is properly loaded on platen glass.

= | oading Originals

Is original loaded with side to be copied facing down on platen glass?

Did you copy a printout done by this machine?

If you use a printout done by this machine as the original, print quality may be reduced depending on the
condition of the original.

Reprint from the computer if you can reprint from it.
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Q

Colors Are Unclear

A

Is nozzle check pattern printed properly?

Print the nozzle check pattern to determine whether the ink ejects properly from the print head nozzles.

For details on printing the nozzle check pattern, print head cleaning, and print head deep cleaning, see If Printing
Is Faint or Uneven.

+ If nozzle check pattern is not printed correctly:

After performing the print head cleaning, print the nozzle check pattern and examine the pattern.
« If problem is not resolved after performing print head cleaning twice:

Perform print head deep cleaning.
« If problem is not resolved after performing print head deep cleaning:

Perform system cleaning.

o From computer:
m For Windows:

= Cleaning the Print Heads

m For Mac OS:
= Cleaning the Print Heads
> From operation panel:

To perform system cleaning, press and hold the Stop button until the Alarm lamp flashes 5 times, and
then release the button.

22 Important

+ Before performing system cleaning, check the remaining ink level of all colors. If the remaining ink
level is below the single dot (a), refill the ink tank of corresponding color. Performing system
cleaning when the remaining ink level is not enough may damage the machine.

If the problem is not resolved yet, the print head may be damaged. Contact your nearest Canon service
center to request a repair.

22 Important

» Do not tilt the machine when moving it since the ink may leak out.
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* When transporting the machine for repairing it, see Repairing Your Machine.

When an ink tank runs out of ink, refill the ink tank.

If the remaining ink level is below the lower limit line (A), refill the ink tank with the corresponding color of ink.

After refilling the ink tank, perform system cleaning.
* From computer:
e For Windows:

= Cleaning the Print Heads

> For Mac OS:
= Cleaning the Print Heads
* From operation panel:

To perform system cleaning, press and hold the Stop button until the Alarm lamp flashes 5 times, and then
release the button.

32 Important

+ Before performing system cleaning, check the remaining ink level of all colors. If the remaining ink level
is below the single dot (a), refill the ink tank of corresponding color. Performing system cleaning when
the remaining ink level is not enough may damage the machine.

»>» Note

* Printed colors may not match screen colors due to basic differences in the methods used to produce
colors. Color control settings and environmental differences can also affect how colors appear on the
screen. Therefore, colors of printing results may be different from those on the screen.
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Q

Lines Are Misaligned

I

A

Check paper and print quality settings.

= Print Results Are Unsatisfactory

Perform print head alignment.

If printed lines are misaligned or print results are otherwise unsatisfactory, adjust the print head position.

= Aligning the Print Head
»» Note

+ If the problem is not resolved after performing the print head alignment, perform print head alignment
manually from your computer.

¢ For Windows:

= Aligning the Print Head Position

* For Mac OS:

= Aligning the Print Head Position

Increase print quality and try printing again.

Increasing the print quality using the printer driver may improve the print result.

491



Q

Lines Incomplete or Missing (Windows)

A

Are you using Page Layout Printing or Binding Margin function?

When the Page Layout Printing or Binding margin function is in use, thin lines may not be printed. Try thickening
the lines in the document.

LW VAN |s print data extremely large?

Click Print Options on Page Setup sheet of the printer driver. Then set Prevention of Print Data Loss to On in
the dialog that appears.

* This may reduce print quality.
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Q

Images Incomplete or Missing (Windows)

A

Select setting not to compress printing data.

If you select the setting not to compress the printing data with an application software you are using, the printing
result may be improved.

Click Print Options on Page Setup sheet of the printer driver. Select Do not allow application software to
compress print data check box and click OK.

* Clear the check box once printing is complete.

LW VAN |s print data extremely large?

Click Print Options on Page Setup sheet of the printer driver. Then set Prevention of Print Data Loss to On in
the dialog that appears.

* This may reduce print quality.
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Q

Ink Blots / Paper Curl

= Ink Blots

-~ Paper Curl

Check paper and print quality settings.

= Print Results Are Unsatisfactory

If intensity is set high, reduce intensity setting and try printing again.

If you are printing with a high intensity setting on plain paper, the paper may absorb too much ink and become
wavy, causing paper abrasion.

Check the intensity setting in the printer driver.
« For Windows:

= Adjusting Intensity

* For Mac OS:
= Adjusting Intensity

Use Photo Paper to print photos.

To print data with high color saturation such as photographs or images with dark colors, we recommend that you
use Photo Paper Plus Glossy Il or other Canon specialty paper.

= Media Types You Can Use
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Q

Paper Is Smudged / Printed Surface Is Scratched

- Paper Is Smudged

— AL I

Smudged Edges Smudged Surface

:' Printed Surface Is Scratched

A

Check paper and print quality settings.

= Print Results Are Unsatisfactory

Check paper type.

» Make sure you are using the right paper for what you are printing.

= Media Types You Can Use

» For borderless printing, use a paper suitable for borderless printing.

If the paper you are using is not suitable for borderless printing, the print quality may be reduced at the top

and bottom edges of the paper.

= Printing Area

Correct curl before loading paper.

When using Photo Paper Plus Semi-gloss, even if the sheet is curled, load one sheet at a time as it is. Rolling
this paper in the opposite direction to flatten it may crack the paper surface and reduce the print quality.

We recommend putting unused paper back into the package and storing it flat.

* Plain Paper

Turn the paper over and reload it to print on the other side.
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Leaving the paper loaded on the rear tray for a long time may cause the paper to curl. In this case, load the
paper with the other side facing up. It may resolve the problem.
« Other Paper

If the paper corners curl more than 0.1 inch / 3 mm (A) in height, the paper may smudge or may not feed
properly. Follow the instructions below to correct the paper curl.

(A)

1. Roll up paper in opposite direction to paper curl as shown below.

HO

2. Check that paper is now flat.

We recommend printing curl-corrected paper one sheet at a time.

»» Note

+ Depending on paper type, the paper may smudge or may not feed properly even if it is not curled inward.
Follow the instructions below to curl the paper outward up to 0.1 inch / 3 mm (B) in height before printing.
This may improve the print result.

(C)

(C) Print side

We recommend feeding paper that has been curled outward one sheet at a time.

Set printer to prevent paper abrasion.

Adjusting the setting to prevent paper abrasion will widen the clearance between the print head and the paper. If
you notice abrasion even with the media type set correctly to match the paper, set the machine to prevent paper
abrasion using the operation panel or the computer.

This may reduce the print speed.
* Once you have finished printing, undo this setting. Otherwise, it will apply to subsequent print jobs.
* From operation panel

Press and hold the Stop button until the Alarm lamp flashes 15 times, and then release the button and
press the Color button to enable the Prevent paper abrasion function.
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To disable the Prevent paper abrasion function, press and hold the Stop button until the Alarm lamp
flashes 15 times, and then release the button and press the Black button.

* From computer
o For Windows:

Open the printer driver setup window, select Custom Settings in Maintenance sheet, select Prevent
paper abrasion check box, and then click OK.

To open the printer driver setup window, see How to Open the Printer Driver Setup Window.

o For Mac OS:

In the Canon IJ Printer Utility, select Custom Settings in the pop-up menu, select Prevent paper
abrasion check box, and then click Apply.

To open the Canon IJ Printer Utility, see Opening the Canon IJ Printer Utility.

If intensity is set high, reduce intensity setting and try printing again.

If you are printing with a high intensity setting on plain paper, the paper may absorb too much ink and become
wavy, causing paper abrasion.

Check the intensity setting in the printer driver.
* For Windows:

= Adjusting Intensity

+ For Mac OS:
= Adjusting Intensity

Do not print outside recommended printing area.

If you print outside the recommended printing area of your paper, ink may stain the lower edge of the paper.

Resize the document using application software.

= Printing Area

Is platen glass dirty?

Clean the platen glass.

= Cleaning the Platen Glass and Document Cover

Is paper feed roller dirty?

Clean the paper feed roller.

= Cleaning the Paper Feed Roller

> Note

+ Cleaning the paper feed roller abrades it, so do this only when necessary.

Is inside of machine dirty?

During duplex printing, ink may stain the inside of the machine, smudging the printout.

Perform the bottom plate cleaning to clean the inside of the machine.
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= Cleaning the Inside of the Machine (Bottom Plate Cleaning)

> Note

» To prevent staining inside the machine, be sure to set the correct paper size.

Set longer ink drying time.

This allows the printed surface to dry, preventing smudges and scratches.
» For Windows:
1. Make sure machine is turned on.
2. Open printer driver setup window.

= How to Open the Printer Driver Setup Window

3. Click Maintenance tab and Custom Settings.
4. Drag Ink Drying Wait Time slide bar to set wait time and click OK.
5. Check message and click OK.
* For Mac OS:
1. Make sure machine is turned on.
2. Open Canon IJ Printer Utility.
= Opening the Canon IJ Printer Utility
3. Select Custom Settings in pop-up menu.
4. Drag Ink Drying Wait Time: slide bar to set wait time and click Apply.
5. Check message and click OK.
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Q

Back of Paper Is Smudged

Check paper and print quality settings.

= Print Results Are Unsatisfactory

WAl Perform bottom plate cleaning to clean inside of machine.
= Cleaning the Inside of the Machine (Bottom Plate Cleaning)

»» Note

» During duplex printing or too much printing, ink may stain the inside of the machine.
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Q

Vertical Line Next to Image

A

Is loaded paper size correct?

If the loaded paper is larger than the size you specified, a vertical line may appear in the margin. A small amount
of ink is ejected for cleaning.

Set the paper size to match the loaded paper.

= Print Results Are Unsatisfactory

»» Note

+ The direction of the vertical line pattern may vary depending on the image data or the print setting.
» This machine performs automatic cleaning when necessary to keep printouts clean.

Although the ink is normally ejected onto the ink absorber at the outer edge of the paper, it may get onto
the paper if the loaded paper is larger than the set size.
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Q

Uneven or Streaked Colors

:' Uneven Colors

:' Streaked Colors

A

Check paper and print quality settings.

= Print Results Are Unsatisfactory

W ¥AN Print nozzle check pattern and perform any necessary maintenance operations
such as print head cleaning.
Print the nozzle check pattern to determine whether the ink ejects properly from the print head nozzles.

For details on printing the nozzle check pattern, print head cleaning, and print head deep cleaning, see If Printing
Is Faint or Uneven.

+ If nozzle check pattern is not printed correctly:

After performing the print head cleaning, print the nozzle check pattern and examine the pattern.
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« If problem is not resolved after performing print head cleaning twice:
Perform print head deep cleaning.
« |If problem is not resolved after performing print head deep cleaning:
Perform system cleaning.
o From computer:
m For Windows:

= Cleaning the Print Heads

m For Mac OS:
= Cleaning the Print Heads

o From operation panel:
To perform system cleaning, press and hold the Stop button until the Alarm lamp flashes 5 times, and

then release the button.

22 Important

» Before performing system cleaning, check the remaining ink level of all colors. If the remaining ink
level is below the single dot (a), refill the ink tank of corresponding color. Performing system
cleaning when the remaining ink level is not enough may damage the machine.

If the problem is not resolved yet, the print head may be damaged. Contact your nearest Canon service
center to request a repair.

32 Important

» Do not tilt the machine when moving it since the ink may leak out.

» When transporting the machine for repairing it, see Repairing Your Machine.

OLCCIN Perform print head alignment.
= Aligning the Print Head
3> Note

« If the problem is not resolved after performing the print head alignment, perform print head alignment
manually from your computer.

¢ For Windows:

= Aligning the Print Head Position

* For Mac OS:
= Aligning the Print Head Position
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Q

No Ink Comes Out

A

Check the remaining ink level.

= Checking Ink Status

Are print head nozzles clogged?

Print the nozzle check pattern to determine whether the ink ejects properly from the print head nozzles.

For details on printing the nozzle check pattern, print head cleaning, and print head deep cleaning, see If Printing
Is Faint or Uneven.

+ If nozzle check pattern is not printed correctly:

After performing the print head cleaning, print the nozzle check pattern and examine the pattern.
« If problem is not resolved after performing print head cleaning twice:

Perform print head deep cleaning.
+ If problem is not resolved after performing print head deep cleaning:

Perform system cleaning.

o From computer:
m For Windows:

= Cleaning the Print Heads

m For Mac OS:
= Cleaning the Print Heads
o From operation panel:

To perform system cleaning, press and hold the Stop button until the Alarm lamp flashes 5 times, and
then release the button.

22 Important

+ Before performing system cleaning, check the remaining ink level of all colors. If the remaining ink
level is below the single dot (a), refill the ink tank of corresponding color. Performing system

cleaning when the remaining ink level is not enough may damage the machine.
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If the problem is not resolved yet, the print head may be damaged. Contact your nearest Canon service
center to request a repair.

22 Important

» Do not tilt the machine when moving it since the ink may leak out.

* When transporting the machine for repairing it, see Repairing Your Machine.
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Q

Paper Does Not Feed Properly/“"No Paper" Error

A

OIS Make sure paper is loaded.
= | oading Paper

When loading paper, consider the following.

* When loading two or more sheets of paper, align the edges of the sheets before loading the paper.

* When loading two or more sheets of paper, make sure the paper stack does not exceed the paper load
limit.
However, paper may not feed correctly at the maximum capacity, depending on the type of paper or

environmental conditions (very high or low temperature and humidity). In such cases, reduce the amount of
paper you load at a time to less than half of the paper load limit.

+ Always load the paper in portrait orientation, regardless of the printing orientation.

* When you load the paper, place the print side facing UP and slide the paper guides to align with both sides
of the paper.

= | oading Paper

Is paper too thick or curled?

= Media Types You Cannot Use

When loading envelopes, consider the following:

When printing on envelopes, see Loading Paper, and prepare the envelopes before printing.

Once you have prepared the envelopes, load them in portrait orientation. If the envelopes are placed in
landscape orientation, they will not feed properly.

Make sure media type and paper size settings match with loaded paper.

Make sure there are not any foreign objects in rear tray.

~\
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If the paper tears in the rear tray, see Paper Jams to remove it.

If there are any foreign objects in the rear tray, be sure to turn off the machine, unplug it and remove the foreign
object.

32 Important

* Do not tilt the machine or do not it upside down. Doing so may cause the ink to leak.

LW YAN Clean paper feed roller.

= Cleaning the Paper Feed Roller
> Note

* Cleaning the paper feed roller abrades it, so do this only when necessary.

If the measures above do not solve the problem, contact your nearest Canon service center to request a
repair.

32 Important

* Do not tilt the machine when moving it since the ink may leak out.

» When transporting the machine for repairing it, see Repairing Your Machine.
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Q

Copying/Printing Stops

Is paper loaded?

Make sure paper is loaded.

If necessary, load paper.

Do documents to be printed have many photographs or illustrations?

It takes time for the machine and the computer to process large data such as photos or other graphics, so it may
seem that the machine is not working.

Also, if you are printing data that requires a lot of ink on successive sheets of plain paper, the machine may
pause temporarily. In either case, wait until the process is complete.

»» Note

« If you are printing a document with a large printing area or printing several copies, printing may pause to
allow the ink to dry.

€M Has machine been printing continuously for a long period?

If the machine has been printing continuously for a long time, the print head or other parts around it may
overheat. The machine may stop printing at a line break for a period of time and then resume printing.

In this case, wait a while without doing anything. If the printing does not resume, interrupt your print session and
turn the machine off for at least 15 minutes.

/' Caution

* Print head and surrounding area can become extremely hot. Never touch print head or nearby
components.

If copying stops before it is completed, retry copying.

If a certain time passes after some errors occurred while copying, the machine stops the operation.
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Scanning Problems (Windows)
» Scanning Problems
» Scan Results Are Unsatisfactory
» Software Problems
» |J Scan Utility Error Messages

» ScanGear (Scanner Driver) Error Messages
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Scanning Problems
» Scanner Does Not Work
» ScanGear (Scanner Driver) Does Not Start

» Error Message Appears and the ScanGear (Scanner Driver) Screen Does Not
Appear

» Cannot Scan Multiple Originals at One Time

» Cannot Scan Properly with Auto Scan

» Slow Scanning Speed

* "There is not enough memory." Message Is Displayed
» Computer Stops Operating during Scanning

» Scanner Does Not Work after Upgrading Windows

» Scanned Image Does Not Open

509



Q

Scanner Does Not Work

A

Make sure that your scanner or printer is turned on.
Connect the USB cable to a different USB port on the computer.

If the USB cable is connected to a USB hub, remove it from the USB hub and
connect it to a USB port on the computer.

Restart the computer.
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Q

ScanGear (Scanner Driver) Does Not Start

A

Make sure that MP Drivers is installed.

If not installed, install MP Drivers from the Setup CD-ROM or the web page.

LN Select your scanner or printer on the application's menu.

22 Important

« If your scanner or printer name is displayed multiple times, select the one that does not include WIA.

»» Note

» The operation may differ depending on the application.
* Use the WIA driver when scanning from a WIA-compliant application.

= Scanning with WIA Driver

Make sure that the application supports TWAIN.

You cannot start ScanGear (scanner driver) from applications not supporting TWAIN.

Scan and save images with |J Scan Utility and open the files in your
application.
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Q

Error Message Appears and the ScanGear (Scanner Driver) Screen
Does Not Appear

A

L SN Make sure that your scanner or printer is turned on.

Turn off your scanner or printer, then reconnect the USB cable and replug the
power cord.

Connect the USB cable to a different USB port on the computer.

If the USB cable is connected to a USB hub, remove it from the USB hub and
connect it to a USB port on the computer.

Make sure that MP Drivers is installed.

If not installed, install MP Drivers from the Setup CD-ROM or the web page.

Select your scanner or printer on the application's menu.
»» Note

» The operation may differ depending on the application.

Make sure that the application supports TWAIN.

You cannot start ScanGear (scanner driver) from applications not supporting TWAIN.

Exit ScanGear if it is running on another application.
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Q

Cannot Scan Multiple Originals at One Time

A

Make sure that the items are placed correctly.

= Positioning Originals (Scanning from Computer)

Check if you can properly scan one item.

Some applications do not support multiple image scanning. In that case, scan each item individually.
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Q

Cannot Scan Properly with Auto Scan

A

Make sure that the items are placed correctly.

= Positioning Originals (Scanning from Computer)

Multiple item scanning may not be supported.

Some applications do not support multiple image scanning. In that case, scan each item individually.
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Q

Slow Scanning Speed

A

To view the image on a monitor, set the output resolution to around 150 dpi. To
print, set it to around 300 dpi.

= Resolution

Set Fading Correction, Grain Correction, etc. to None.

Refer to "Image Settings" for your model from Home of the Online Manual for details.

In 1J Scan Utility, deselect the Correct slanted text document / Detect the
orientation of text document and rotate image checkbox and scan again.

= Settings (Document Scan) Dialog Box
= Settings (Custom Scan) Dialog Box
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Q

"There is not enough memory." Message Is Displayed

A

Exit other applications and try again.

oI @A8 Reduce the resolution or output size and scan again.

= Resolution
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Q

Computer Stops Operating during Scanning

A

Restart the computer, reduce the output resolution in ScanGear (scanner
driver) and scan again.

Refer to "Output Settings" for your model from Home of the Online Manual for details.

(AN Delete unnecessary files to obtain sufficient free hard disk space, then scan
again.
Error message may appear if there is not enough hard disk space to scan and save, when the image size is too

large (such as when scanning a large item at high resolution).

WL |n Folder to Save Temporary Files of |[J Scan Utility, specify a folder on a
drive with sufficient free space.

= Settings (General Settings) Dialog Box

Multiple devices may be connected to USB ports.

Disconnect devices other than your scanner or printer.
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Q

Scanner Does Not Work after Upgrading Windows

A

Disconnect the USB cable, then uninstall (delete) and reinstall MP Drivers and 1J
Scan Utility.

Step 1: Uninstall MP Drivers.

Refer to "Deleting the Unnecessary MP Drivers" for your model from Home of the Online Manual for how to
delete MP Drivers.

Step 2: Uninstall IJ Scan Utility.

* Windows 10/Windows 8.1/Windows 8/Windows 7/Windows Vista:

Click Control Panel > Programs > Programs and Features.
Select Canon IJ Scan Utility and click Uninstall/Change.
When a confirmation appears, click Yes.

When uninstallation is complete, click OK.

Pobd =

IJ Scan Utility is deleted.
»» Note

+ A confirmation or warning dialog box may appear when installing, uninstalling, or starting up
software.
This dialog box appears when administrative rights are required to perform a task.
If you are logged on to an administrator account, follow the on-screen instructions.

* Windows XP:

From the Start menu, select Control Panel > Add or Remove Programs.
Select Canon IJ Scan Utility, then click Change/Remove.

When a confirmation appears, click Yes.

When uninstallation is complete, click OK.

oD

IJ Scan Utility is deleted.

Step 3: Reinstall MP Drivers and IJ Scan Utility.
Reinstall MP Drivers and IJ Scan Utility from the Setup CD-ROM or the web page.
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Q

Scanned Image Does Not Open

A

If the data format is not supported by the application, scan the image again and
select a popular data format such as JPEG when saving it.

Refer to the application's manual for details. If you have any questions, contact the manufacturer of the
application.
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Scan Results Are Unsatisfactory
» Scan Quality (Image Displayed on the Monitor) Is Poor
» Scanned Image Is Surrounded by Extra White Areas
» Cannot Scan at the Correct Size
» Original Is Placed Correctly, but the Scanned Image Is Slanted

» Scanned Image Is Enlarged (Reduced) on the Computer Monitor
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Q

Scan Quality (Image Displayed on the Monitor) Is Poor

A

Increase the scanning resolution if the image is jagged.

= Resolution
= Settings Dialog Box

Set the display size to 100 %.

Some applications do not display images clearly if the display size is too small.

If moire (stripe pattern) appears, take the following measures and scan again.

+ Set one of the following settings in the Settings (Document Scan) dialog box, Settings (Custom Scan)
dialog box, or Settings (Scan and Stitch) dialog box of IJ Scan Utility, then scan from the |J Scan Utility
main screen.

o Set Select Source to Magazine and set Color Mode to Color
> Select the Reduce moire checkbox in Image Processing Settings

= Settings (Document Scan) Dialog Box
= Settings (Custom Scan) Dialog Box
= Settings (Scan and Stitch) Dialog Box

+ On the Basic Mode tab of ScanGear (scanner driver), select Magazine (Color) in Select Source.
Refer to "Basic Mode Tab" for your model from Home of the Online Manual for details.
* On the Advanced Mode tab of ScanGear, set Descreen in Image Settings to ON.

Refer to "Image Settings" for your model from Home of the Online Manual for details.

»» Note

« If moire appears when you scan a digital print photo, take the above measures and scan again.

Check the monitor's color depth.

Refer to Help of Windows or the monitor's manual for details on how to check the monitor's color depth.

O I Clean the platen and document cover.

If the document is in poor condition (dirty, faded, etc.), then set Reduce Dust
and Scratches, Fading Correction, Grain Correction, etc. in Image Settings on the
Advanced Mode tab of ScanGear.

Refer to "Image Settings" for your model from Home of the Online Manual for details.
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If the color tone of images is different from the original document, take the
following measures and scan again.
* On the Advanced Mode tab of ScanGear, set Image Adjustment in Image Settings to None.
Refer to "Image Settings" for your model from Home of the Online Manual for details.
* On the Color Settings tab in the Preferences dialog box of ScanGear, set Color Matching.

Refer to "Color Settings Tab" for your model from Home of the Online Manual for details.
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Q

Scanned Image Is Surrounded by Extra White Areas

A

Specify the scan area.

u W

=
Click ﬁ_l'k (Auto Crop) in whole image view of ScanGear (scanner driver) to automatically display the cropping
frame (scan area) according to the item size.

You can also manually specify the scan area in thumbnail view or when there are white margins along the item
(for example, in photos), or when you want to create custom cropping frames.

= Adjusting Cropping Frames in the Image Stitch Window

»» Note

» Refer to "Adjusting Cropping Frames (ScanGear)" for your model from Home of the Online Manual for how
to adjust cropping frames with ScanGear (scanner driver).
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Q

Cannot Scan at the Correct Size

A

Make sure that the items are placed correctly.

= Positioning Originals (Scanning from Computer)
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Q

Original Is Placed Correctly, but the Scanned Image Is Slanted

A

When Document or Magazine is selected for Select Source, deselect the
Correct slanted text document checkbox and scan the item again.

= Settings (Document Scan) Dialog Box
= Settings (Custom Scan) Dialog Box
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Q

Scanned Image Is Enlarged (Reduced) on the Computer Monitor

A

Change the display setting in the application.

Refer to the application's manual for details. If you have any questions, contact the manufacturer of the
application.

»» Note

* You cannot reduce the image size in Paint. To reduce the display size, open the images in an application.

Change the resolution setting in ScanGear (scanner driver) and scan again.

The higher the resolution, the larger the resulting image will be.

= Resolution
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Software Problems

» The E-mail Client You Want to Use Does Not Appear in the Screen for Selecting
an E-mail Client
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Q

The E-mail Client You Want to Use Does Not Appear in the Screen
for Selecting an E-mail Client

A

Check that the e-mail client's MAPI is enabled.
Refer to the e-mail client's manual for how to set MAPI.

If the problem is not solved even when MAPI is enabled, select None (Attach Manually) in the screen for
selecting an e-mail client, then manually attach the image to the outgoing e-mail.
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IJ Scan Utility Error Messages

If an error message for IJ Scan Utility appears, check the error code and follow the corresponding solution.

Error Code Error Message Solution
152 There is not enough memory. Exit other applications to in- » The memory required to start
crease available memory. IJ Scan Utility cannot be ob-
tained; exit other applications.
153 The image you attempted to scan is in a size that cannot be * Reduce the resolution or out-
opened in the specified application. Change the settings so put size and scan again.
that the image size is reduced.
201 A required file is missing or corrupted, or settings are incorrect. * Delete MP Drivers, then rein-
Try the installation again. stall MP Drivers from the Set-
up CD-ROM or the web page.
Refer to "Deleting the Unnec-
essary MP Drivers" for your
model from Home of the On-
line Manual for how to delete
MP Drivers.
202 An internal error has occurred. Take the following measures. * An internal error has occurred.
- Check the scanner status. Take the following measures.
- Restart the scanner. . > Check the scanner status.
- Re.start the computer, thlen try again. - Restart the scanner.
- Reinstall the scanner driver. - Restart the computer,
then try again.
> Reinstall MP Drivers.
230 A scanner driver supporting this software is not installed. In- * Reinstall MP Drivers from the
stall it and try again. Setup CD-ROM or the web
page.
231 Cannot complete the scan. The disk space is insufficient. * Delete unnecessary files on
the hard disk and scan again.
232 Cannot save the file. The disk is write-protected. » Cancel the write protection on
the disk.
Cancel the protection or use another disk.
242 Cannot write file. » Check the access permission
on the folder in Folder to
Save Temporary Files in the
Settings (General Settings)
dialog box or Save in in the
corresponding Settings dialog
box.
243 Cannot read file. » Check the access permission
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on the folder in Folder to
Save Temporary Files in the
Settings (General Settings)




dialog box or Save in in the
corresponding Settings dialog

box.
244 You do not have the required privileges to access the specified » Grant access permission to
folder. the specified folder.
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ScanGear (Scanner Driver) Error Messages

If an error message for ScanGear (scanner driver) appears, check the error code and follow the
corresponding solution.

- Scanner is turned off.

- (If using Wired LAN connection) It is disconnected from
Wired LAN.

- (If using wireless LAN connection) Signal strength is

531

Error Code Error Message Solution
1 Error in scanner. * Make sure that your scanner or
4 Turn off scanner and follow instructions in User's Guide. printer and the computer are con-
Scanner driver will be closed. nected correctly.
10 * Delete MP Drivers, then reinstall
122 MP Drivers from the Setup CD-
151 ROM or the web page.
175 Refer to "Deleting the Unnecessary
MP Drivers" for your model from
176 Home of the Online Manual for how
177 to delete MP Drivers.
* Your scanner or printer may be
damaged.
Restart the computer, then recon-
nect your scanner. If the same er-
ror message still appears, contact
the service center.
140 Printer is in use or an error has occurred. Check status. » Wait for the device operation to fin-
Scanner driver will be closed. ish, then scan.
145 Cannot communicate with scanner for these reasons: » Make sure that your scanner or
- Scanner is turned off. printer is turned on.
- Scanner is disconnected. « Delete MP Drivers, then reinstall
(It is disconnected from LAN, if using on LAN.) MP Drivers from the Setup CD-
ROM or the web page.
Please Che.Ck anq try again. Refer to "Deleting the Unnecessary
Scanner driver will be closed. MP Drivers" for your model from
155 Cannot communicate with scanner. Home of the Online Manual for how
Cable may be disconnected or scanner may be turned to delete MP Drivers.
off. * Make sure that the selected appli-
Check status. cation source is correct. Refer to
Scanner driver will be closed. the application's manual for details.
156 Cannot communicate with scanner for these reasons: * Check the printer status.
- Scanner is turned off. » With USB connection, check the
- USB cable is disconnected. connection of the USB cable and
reconnect as required.
Please check and try again. « With network connection, check the
Scanner driver will be closed. connection status and reconnect as
required.
157 Cannot communicate with scanner for these reasons:

With network connection, specify
the scanner to use with IJ Network
Scanner Selector EX.




poor due to obstructions.
- Network connection is prohibited by security software.
- Different scanner on the network is selected.

Please check and try again.

Click [Scanner Selection] if you want to select another
scanner.

Scanner driver will be closed.

152 Running out of memory. « The memory required to start
Increase available memory. ScanGear (scanner driver) cannot
Scanner driver will be closed. be obtained; exit other applications.
201 A required file is missing or corrupted, or settings are in- * Delete MP Drivers, then reinstall
correct. MP Drivers from the Setup CD-
Try the installation again. ROM or the web page.
Scanner driver will be closed. Refer to "Deleting the Unnecessary
MP Drivers" for your model from
Home of the Online Manual for how
to delete MP Drivers.
202 An internal error has occurred. * An internal error has occurred.

Scanner driver will be closed. Take the following meas-
ures.

- Check the scanner status.

- Restart the scanner.

- Restart the computer, then try again.

- Reinstall the scanner driver.
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Take the following measures.

o Check the scanner status.

o Restart the scanner.

o Restart the computer, then try
again.

o Reinstall MP Drivers.

Follow the procedure below to
check if WIA (Windows Image Ac-
quisition) is running or in started
state.

Windows 10/Windows 8.1/Win-
dows 8/Windows 7/Windows Vis-
ta:

Click Control Panel > System and
Security > Administrative Tools,
and then double-click Services to
check if WIA (Windows Image Ac-
quisition) is running or in started
state.

Windows XP:

From the Start menu, click Control
Panel > Performance and Main-
tenance > Administrative Tools,
then double-click Services.

There may be interference with
other drivers; delete unnecessary
drivers.




Your application may not properly
comply with TWAIN. Scan using
another application.

203 There is not enough free disk space to complete the » Delete unnecessary files on the
scan. hard disk and scan again.
Scanner driver will be closed.
206 The scanner is not available while in use by another ap- + Exit the ScanGear in use.
plication or user.
207 Scanner is not selected. » With network connection, specify
Click [Scanner Selection] to select scanner. the scanner to use with IJ Network
Scanner driver will be closed. Scanner Selector EX.
208 IJ Network Scanner Selector cannot be found. * Delete MP Drivers, then reinstall
Reinstall scanner driver. MP Drivers from the Setup CD-
Scanner driver will be closed. ROM or the web page.
Refer to "Deleting the Unnecessary
MP Drivers" for your model from
Home of the Online Manual for how
to delete MP Drivers.
250 An error has occurred.  Turn the device off and then back
Turn the device off and then back on. on.
Scanner driver will be closed.
252 Cannot write or read file.  Exit running applications, check

that there is sufficient free space
on the hard disk, then scan again.
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Mechanical Problems
» Power Does Not Come On
» Power Shuts Off By Itself
» Cannot Connect to Computer Properly

» Printer Status Monitor Not Displayed (Windows)
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Q

Power Does Not Come On

Press ON button.

Make sure power plug is securely connected to machine, and then turn it back
on.

Unplug machine, leave it for at least 2 minutes, and then plug it back in and
turn it on again.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

22 Important

» Do not tilt the machine when moving it since the ink may leak out.

* When transporting the machine for repairing it, see Repairing Your Machine.
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Q

Power Shuts Off By Itself

A

If machine is set to turn off automatically after a certain time, disable this setting.

If you have set the machine to turn off automatically after a specified time, the power will shut off by itself once
that time has elapsed.

+ If you are using a Windows and if you do not want the machine to turn off automatically:

Open the printer driver setup window and in Auto Power in Maintenance sheet, select Disable for Auto
Power Off.

* If you are using a Mac OS and if you do not want the machine to turn off automatically:

Open Canon |J Printer Utility, select Power Settings in the pop-up menu, and then select Disable for Auto
Power Off on Auto Power.

»» Note

* You can also enable the machine to turn on/off automatically from the operation panel.

= Turning on/off Machine Automatically

« If you are using a Windows, you can also enable the machine to turn on/off automatically from ScanGear
(scanner driver).

= Scanner Tab
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Cannot Connect to Computer Properly

Q Printing or Scanning Is Slow/Hi-Speed USB Connection Does Not
Work/"This device can perform faster" Message Appears (Windows)

A

If your system environment does not support Hi-Speed USB, the machine operates at the slower speed of
USB 1.1. In this case, the machine works properly but printing or scanning speed may slow down due to
the communication speed.

Check following to make sure your system environment supports Hi-Speed
USB connection.

* Does the USB port on your computer support Hi-Speed USB connection?

» Does the USB cable or the USB hub support Hi-Speed USB connection?

Be sure to use a certified Hi-Speed USB cable. We recommend that the USB cable be no longer than 10
feet / 3 meters or so.

» Does the operating system of your computer support Hi-Speed USB connection?
Install the latest update for your computer.
* Is the Hi-Speed USB driver working properly?

If necessary, obtain and install the latest version of the Hi-Speed USB driver for your computer.

32 Important

» For more information, contact the manufacturer of your computer, USB cable, or USB hub.
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Q

Printer Status Monitor Not Displayed (Windows)

A

Is printer status monitor enabled?
Make sure Enable Status Monitor is selected on the Option menu of the printer status monitor.
1. Open printer driver setup window.

= How to Open the Printer Driver Setup Window

2. On Maintenance sheet, click View Printer Status.

3. Select Enable Status Monitor on Option menu if it is not selected.

538



Installation and Download Problems
» Cannot Install MP Drivers

» Easy-WebPrint EX Does Not Start or Easy-WebPrint EX Menu Does Not Appear
(Windows)
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Q

Cannot Install MP Drivers

A

= For Windows:
= For Mac OS:

For Windows:

« If installation does not start when you insert Setup CD-ROM:
Follow the instructions below to start the installation.
1. Make the following settings.
> In Windows 10, click Start button > File Explorer, and then click This PC from list on left.

> In Windows 8.1 or Windows 8, select Explorer icon in Taskbar on Desktop, and then select
This PC (Computer for Windows 8) from list on left.

> In Windows 7 or Windows Vista, click Start, and then click Computer.

o In Windows XP, click Start, and then click My Computer.

2. Double-click j CD-ROM icon in the window that appears.
If the contents of the CD-ROM appear, double-click MSETUP4.EXE.

If you cannot install the MP Drivers with the Setup CD-ROM, install them from the Canon
website.

»>» Note

* If the CD-ROM icon does not appear, try the following:
* Remove the CD-ROM from your computer and reinsert it.
» Restart your computer.

If the icon still does not appear, try a different disc and see if it appears. If it does, there is a
problem with the Setup CD-ROM. Contact your nearest Canon service center to request a repair.
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* If you cannot get past the Printer Connection screen:

Canon G2000 series

Printer Conneclion
“ake sure thatthe printer is connected to the computer, and tum onthe printer,

4 The printer is not dete ced, Checx the connechon,

Cancal J

= Cannot Proceed beyond Printer Connection Screen

* Other cases:
Reinstall the MP Drivers.

If the MP Drivers were not installed correctly, uninstall the MP Drivers, restart your computer, and then
reinstall the MP Drivers.

= Deleting the Unnecessary MP Drivers

Reinstall the MP Drivers with the Setup CD-ROM or install them from the Canon website.
»>» Note

« If the installer was stopped due to a Windows error, Windows operation may be unstable, and
you may not be able to install the drivers. Restart your computer and then reinstall the drivers.

For Mac OS:

Download the drivers from the support page of Canon website and reinstall it.
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Q

Easy-WebPrint EX Does Not Start or Easy-WebPrint EX Menu Does
Not Appear (Windows)

A

If Easy-WebPrint EX does not start or its menu does not appear on Internet Explorer, check the following.

Is Canon Easy-WebPrint EX displayed on Toolbars menu in Internet
Explorer's View menu?

If Canon Easy-WebPrint EX is not displayed, Easy-WebPrint EX is not installed on your computer. Install the
latest version of Easy-WebPrint EX from the Canon website.

»» Note

« If Easy-WebPrint EX is not installed, a message asking you to install it may appear in the notification area
on the desktop. Click the message and follow the instructions to install Easy-WebPrint EX.

+ Internet access is required to install or download Easy-WebPrint EX.

LA |s Canon Easy-WebPrint EX selected on Toolbars menu in Internet Explorer's
View menu?
If Canon Easy-WebPrint EX is not selected, Easy-WebPrint EX is disabled. Select Canon Easy-WebPrint EX

to enable it.

Check the following to make sure your system environment supports Easy-
WebPrint EX.

+ Is it installed on the computer with proper system requirements?
+ Did you start it using a compatible version of Internet Explorer?

Visit Canon website for more information of the system requirements of Easy-WebPrint EX.
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Errors and Messages
» An Error Occurs
» Message Appears

» "The printer is performing another operation” Appears on Computer Screen
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An Error Occurs

If an error occurs in printing, for example if the paper runs out or jams, a troubleshooting message appears
automatically. Take the appropriate action described in the message.

When an error occurs, the Alarm lamp flashes and a support code (error number) appears on the computer
screen. For some errors, the Alarm lamp and the ON lamp flashes alternately. Check the status of the

lamps and the message, and take the appropriate action.

Support Code Corresponding to Number of Flashes of Alarm Lamp

Example of 2 times flashing:

(A) (B) (A (B)

(A) Flashes
(B) Goes off
Number of flashes | Cause Support Code
2 flashes Machine is out of paper or paper does not feed. 1000
3 flashes Paper is jammed in paper output slot or in rear tray. 1300
4 flashes Cartridge is not installed properly. 1470
5 flashes Print head may be damaged. 1403
Cartridge cannot be recognized. 1471
Appropriate cartridge is not installed. 1476
7 flashes Cartridge is not installed in correct position. 1474
More than one cartridge of the same color is installed. 1475
8 flashes Ink absorber is almost full. 1700, 1701
9 flashes Protective material or tape may still be attached to cartridge holder. | 1890
14 flashes Cartridge cannot be recognized. 1473
15 flashes Cartridge cannot be recognized. 1472

Support Code Corresponding to Number of Alternate Flashes of ON Lamp

and Alarm Lamp

Example of 2 times flashing:
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(A) (B) (A) (B)
(A) Alternately flashes
(B) Goes off
Number of flashes Cause Support Code
2 flashes Printer error has occurred. 5100
7 flashes Printer error has occurred. 5B00, 5B01
10 flashes An error requiring a repair has occurred. | B202, B203, B204, B205
Other cases than above | Printer error has occurred. 5011, 5012, 5050, 5200, 5400, 5700, 6800,
6801, 6930, 6931, 6932, 6933, 6936, 6937,
6938, 6940, 6941, 6942, 6943, 6944, 6945,
6946

When a Support Code and a Message Are Displayed on Computer Screen:

¢ For Windows:

Cam!mhiﬂ!r—m

—c

Paper has nun oul
Media Type: - Plain Paper
Fage Size : Ad

N g
4

1. Load papar inta the raar iray 2 Preas tha orirtar's Stan
Bt

 Emor Persisis

| Cancel Pting |

¢ For Mac OS:
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L w & Canon meries - 1 .Job

Pause Gotlings

port Code (T000)No paper. L...ess the Start button on the printer. @

testprint

* The screen differs depending on the OS you are using.

»» Note

* You can also search for details on resolving the errors indicated by the support code shown.

= Search

To resolve errors that do not have support codes, see Message Appears.
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Message Appears

This section describes some of the errors and messages that may appear.

»» Note

» A support code (error number) is displayed on the computer for some errors. For details on errors that
have support code, see List of Support Code for Error.

= Error Regarding Power Cord Being Unplugged Is Displayed (Windows)

= \Writing Error/Output Error/Communication Error (Windows)

= Other Error Messages (Windows)

= |Inkjet Printer/Scanner/Fax Extended Survey Program Screen Is Displayed (Windows)

= [nkjet Printer/Scanner/Fax Extended Survey Program Icon Appears (Mac OS)

Q Error Regarding Power Cord Being Unplugged Is Displayed
(Windows)

A

The machine may have been unplugged while it was on.
Check the error message that appears on the computer and click OK.
The machine starts printing.

See Notice for Unplugging the Power Cord for unplugging the power cord.

Q Writing Error/Output Error/Communication Error (Windows)

A

If ON lamp is off, make sure machine is plugged in and turn it on.

The ON lamp flashes while the machine is initializing. Wait until the ON lamp stops flashing and remains lit.

OV VAN Make sure correct printer port is set in printer driver.

* In the following instructions, "XXX" signifies your machine's name.
1. Log in using an account with administrator privileges.
2. Make the following settings.
* In Windows 10, right-click Start button and select Control Panel > View devices and printers.

* In Windows 8.1 or Windows 8, select Control Panel from Settings charm on Desktop > Hardware
and Sound > Devices and Printers.

* In Windows 7, select Devices and Printers from Start menu.
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* In Windows Vista, select Start menu > Control Panel > Hardware and Sound > Printers.

* In Windows XP, select Start menu > Control Panel > Printers and Other Hardware > Printers
and Faxes.

3. Open printer driver properties.

* In Windows 10, Windows 8.1, Windows 8, or Windows 7, right-click "Canon XXX series Printer" icon
(where "XXX" is your machine's name), and then select Printer properties.

* In Windows Vista or Windows XP, right-click "Canon XXX series Printer" icon (where "XXX" is your
machine's name), and then select Properties.

4. Click Ports tab to check port settings.

Make sure a port named "USBnnn" (where "n" is a number) with "Canon XXX series Printer" appearing
in Printer column is selected for Print to the following port(s).

* If setting is incorrect:

Reinstall the MP Drivers from the Setup CD-ROM or the Canon website.

If printing does not start even though the machine is connected to the computer using a USB cable
and the port named "USBnnn" is selected:

In Windows 10, click Start button and select All apps, Canon Utilities, Canon My Printer, Canon
My Printer, and then select Diagnose and Repair Printer. Follow the on-screen instructions to set
the correct printer port, and then select your machine's name.

In Windows 8.1 or Windows 8, select My Printer on Start screen to start My Printer. If My Printer is
not displayed on Start screen, select Search charm, and then search for "My Printer".

Set the correct printer port on Diagnose and Repair Printer. Follow the on-screen instructions to
set the correct printer port, and then select your machine's name.

In Windows 7, Windows Vista, or Windows XP, click Start and select All programs, Canon
Utilities, Canon My Printer, Canon My Printer, and then select Diagnose and Repair Printer.
Follow the on-screen instructions to set the correct printer port, and then select your machine's
name.

If the problem is not resolved, reinstall the MP Drivers from the Setup CD-ROM or the Canon
website.

Make sure USB cable is securely plugged in to machine and computer.

When the machine is connected to your computer with a USB cable, check the following:

« If you are using a relay device such as a USB hub, disconnect it, connect the machine directly to the
computer, and retry the printing. If printing starts normally, there is a problem with the relay device.
Contact the vendor of the relay device.

» There could also be a problem with the USB cable. Replace the USB cable and retry the printing.

O\ Make sure MP Drivers are installed correctly.

Uninstall the MP Drivers following the procedure described in Deleting the Unnecessary MP Drivers and
reinstall them from the Setup CD-ROM or the Canon website.

When machine is connected to your computer with a USB cable, check
device status from your computer.
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Follow the procedure below to check the device status.
1. Open the Device Manager on your computer as shown below.
If the User Account Control screen appears, follow the on-screen instructions.
* In Windows 10, right-click Start button and select Device Manager.

* In Windows 8.1 or Windows 8, select Control Panel from Settings charm on Desktop > Hardware
and Sound > Device Manager.

* In Windows 7 or Windows Vista, click Control Panel, Hardware and Sound, and Device Manager.

* In Windows XP, click Control Panel, Performance and Maintenance, System, and Device
Manager on Hardware sheet.

2. Double-click Universal Serial Bus controllers and USB Printing Support.

If the USB Printing Support Properties screen does not appear, make sure the machine is correctly
connected to the computer.

= BN I Make sure USB cable is securely plugged in to machine and computer.

3. Click General tab and check for a device problem.

If a device error is shown, see Windows Help to resolve it.

Q Other Error Messages (Windows)

A

If an error message appears outside printer status monitor, check the
following:
» "Could not spool successfully due to insufficient disk space"”
Delete any unnecessary files to increase the amount of free space on the disk.
* "Could not spool successfully due to insufficient memory"
Close other applications to increase the available memory.
If you still cannot print, restart your computer and retry the printing.
+ "Printer driver could not be found"

Uninstall the MP Drivers following the procedure described in Deleting the Unnecessary MP Drivers and
reinstall them from the Setup CD-ROM or the Canon website.

* "Could not print Application name - File name"

Try printing again once the current job is complete.

Q Inkjet Printer/Scanner/Fax Extended Survey Program Screen Is
Displayed (Windows)

A
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If the Inkjet Printer/Scanner/Fax Extended Survey Program is installed, a screen appears asking for
permission to send the machine and application usage information every month for about ten years.

Read the information on the screen and follow the instructions below.

|

Thank you for your coopention in Inkjet PrinterfScannrFax Extended Sunaey Progeram.

4
J For development and marketing of products that better meet customer needs, Canon reguests that
the mformation below, refated to your Canon product, be sent to Canon (in case of using your Canon
preduct in Ching, to the legaly approved research company) through the Intemat.

|information rebted to Canon nkjet printer/scanner) fax -
|HComputer's 05 version, Bnguage, and deplay setting nformation

|HDevice driver and applcation software usage logs

|-Printer’s ID number, instalation date and tme, type of ink installed, ink use informartion, number of sheets printed,

land maintenance information

|H*aper use information, panting environment/ conditions, and questionnare resuls

|{Some of tha above information may not be sant depending on your model )

| your Canon product & shared for use, the above information recorded in the shared product will be sent. If you are
|to agree, please convey this fact to the wsers who share the product and obtain ther agreement as wel beforehand,

Ita bhie emsae s wsll nak gand snwe mfarrmaban ranarding waor fareenkar (aveant Hhak bebad sheua) Ar wane masernsl

If you agree to the above, chck [Agree]. Otherwise, dick [Do not agree].

I you wigh to uninstall this program, cick [Uninstall], This wil uninstall the program, and no further survey will be mada.

¥ Unnstal

Do not agree Agree

* If you agree to participate in survey program:

Click Agree and follow the on-screen instructions. The printer usage information is sent via the
Internet. Once you have completed the procedure, the information is subsequently sent automatically
and the confirmation screen does not reappear.

> Note

» When the information is being sent, a warning such as an Internet security message may appear.
Make sure the program name is "[JPLMUIl.exe" and allow it.

« If you clear Send automatically from the next time check box, the information will not be sent
automatically from next time and a confirmation screen will appear at the time of the next survey.
To send the information automatically, see Changing confirmation screen setting:.

« If you do not agree to participate in survey program:
Click Do not agree. The confirmation screen closes and the survey is skipped. The confirmation
screen will reappear one month later.
* To uninstall Inkjet Printer/Scanner/Fax Extended Survey Program:
To uninstall the Inkjet Printer/Scanner/Fax Extended Survey Program, click Uninstall and follow the
on-screen instructions.
» Changing confirmation screen setting:
1. Make the following settings.

° In Windows 10, right-click Start button and select Programs and Features.
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> In Windows 8.1 or Windows 8, select Control Panel from Settings charm on Desktop >
Programs > Programs and Features.

o In Windows 7, or Windows Vista, select Start menu > Control Panel > Programs >
Programs and Features.

o In Windows XP, select Start menu > Control Panel > Add or Remove Programs.

»>» Note

* In Windows 10, Windows 8.1, Windows 8, Windows 7, or Windows Vista, a confirmation/
warning dialog box may appear when installing, uninstalling or starting up software.

This dialog box appears when administrative rights are required to perform a task.

If you are logged in on an account with administrator privileges, follow the on-screen
instructions.

2. Select Canon Inkjet Printer/Scanner/Fax Extended Survey Program.
3. Select Change.

If you select Yes after you have followed the on-screen instructions, the confirmation screen will
appear at the time of the next survey.

If you select No, the information will be sent automatically.

»» Note

+ If you select Uninstall (or Remove in Windows XP), the Inkjet Printer/Scanner/Fax
Extended Survey Program is uninstalled. Follow the on-screen instructions.

Q Inkjet Printer/Scanner/Fax Extended Survey Program Icon Appears
(Mac OS)

A

If the Inkjet Printer/Scanner/Fax Extended Survey Program is installed, the printer and application
software usage information is sent every month for about ten years. The Inkjet Printer/Scanner/Fax
Extended Survey Program icon appears in the Dock when it is time to send the printer usage
information.

Click the icon, read the information that appears, and then follow the instructions below.
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B Canon Inkjet Printer/Scanner/Fax Extended Survey Program

"».l.-_l Thank you for your cooparation in Inkjet Printer/ScannenFax Extended Survey

Program.

For development and marketing of preducts that better meet customer needs, Canon requests
that the information below, related to your Canon product, be sant 1o Canon (in case of using
your Canan product in China, 1o the legally approved research company) through the Internet.

Inlormaton related 0 Canon inkjet printerscannenax

-Compuiers OS version, language. and display setting inlormaton

“Device driver and applcation software usage logs

=Printer's ID numbsar, installation dad and tme, type of ink installed, ink yse indgrmation, number of
sheets prined, and mainenance infrmation

-Paper use inlormasen, prining environmenticonditions, and questionnaine results

(Some of the above information may noi be seni depending on your madel ]

IFyour Canon produd is shanrsd for use, the above infrmation reconded in e shaned product will be
sanl. Fyou are o agres, please convey this fact 1o the uSens who shane the product and obilain thesr
agreamant as well badorahand.

In this sunay. we will nol send any information ragarulng wour computer (excepd thal listed above) or
wiir mesrsnnal infarmation. For this readson. fonem the indoemation Mal is ssnt i us. wi ans unahle o

If you agree to tha above, click [Agree]. Otherwise, click [Do not agree].

i you wish to turn off this program, click [Turn off]. This will disable the program, and no further
survay will be made.

Turn off

Do not agree Agree

« If you agree to participate in survey program:

Click Agree and follow the on-screen instructions. The printer usage information is sent via the
Internet. Once you have completed the procedure, the information is subsequently sent automatically
and the confirmation screen does not reappear.

»>» Note

« If you clear Send automatically from the next time check box, the information will not be sent
automatically the next time and the Inkjet Printer/Scanner/Fax Extended Survey Program icon
will appear in the dock at the time of the next survey.

* If you do not agree to participate in survey program:
Click Do not agree. The confirmation screen closes and the survey is skipped. The confirmation
screen will reappear one month later.

* To stop sending information:

Click Turn off. This stops the Inkjet Printer/Scanner/Fax Extended Survey Program, and information
is not sent. To resume the survey, see Changing setting:.

» To uninstall Inkjet Printer/Scanner/Fax Extended Survey Program:
1. Stop Inkjet Printer/Scanner/Fax Extended Survey Program.

= Changing setting:
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2. Select Applications from Go menu of Finder, double-click Canon Utilities folder and Inkjet
Extended Survey Program folder.

3. Move Canon Inkjet Printer/Scanner/Fax Extended Survey Program.app file to Trash.
4. Restart computer.

Empty Trash and restart your computer.

* Changing setting:

To display the confirmation screen every time the printer usage information is sent or to resume
surveying, follow the procedure below.

1. Select Applications from Go menu of Finder, double-click Canon Utilities folder and Inkjet
Extended Survey Program folder.

2. Double-click Canon Inkjet Printer/Scanner/Fax Extended Survey Program icon.
@ Extended Survey Program Preferences
. T i -

{'E Do nott display the confirmation screen when information
s sant

The survey program s turned on.

Turn off I v wieh 10t oM this proagram, click [Tuin o8]

> Do not display the confirmation screen when information is sent:
If the check box is selected, the information will be sent automatically.

If the check box is not selected, Inkjet Printer/Scanner/Fax Extended Survey Program
icon will appear in the Dock at the time of the next survey. Click the icon and follow the on-
screen instructions.

o Turn off/Turn on button:
Click the Turn off button to stop the Inkjet Printer/Scanner/Fax Extended Survey Program.

Click the Turn on button to restart the Inkjet Printer/Scanner/Fax Extended Survey Program.
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Q

"The printer is performing another operation” Appears on
Computer Screen

A

L SIN Printer installation may not be complete.
Refer to the printed manual "Getting Started" and complete the printer installation.

»» Note

« During installation, the printer requires the operation that ink is loaded into the inside of printer from the ink
tank. This operation takes about 6 minutes to complete. Wait until the operation is complete.

This message may appear while the printer is in operation.

This message closes when the operation is complete. Wait until the operation is complete.

554



If You Cannot Solve a Problem

If there is a problem that you cannot solve following the instructions in this chapter, contact Canon through
the Support page of the Canon website or contact your nearest Canon service center.

Canon support staff are trained to be able to provide technical support to satisfy customers.

/% Caution

« If the machine emits any unusual sound, smoke, or odor, turn it off immediately. Unplug the machine
and contact the seller you bought it from or your nearest Canon service center. Never attempt to repair
or disassemble the machine yourself.

« If you attempt to repair or take apart the machine, your warranty will be invalidated even if it has not

expired.

Before contacting the service center, note the following:
* Product name

(Your machine's name is written on the front cover of the setup manual.)
+ Serial number (see setup manual)
* Details of problem

* What you tried to solve the problem, and what happened
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Repairing Your Machine

When transporting the machine for repairing it, follow the procedure below to prepare.

32 Important

» When transporting the machine, make sure to avoid the followings.

You cannot take ink out of ink tanks.
Do not tilt the machine. Ink may leak.

Please handle with care and ensure the box remains flat and NOT turned upside down or on its
side, as the printer may be damaged and ink in the printer may leak.

Pack the machine in a sturdy box so that it is placed with its bottom facing down, using sufficient
protective material to ensure safe transport.

Do not remove the cartridge. Ink may leak.

When transporting the machine, we recommend packing the machine in a plastic bag so that ink
does not leak.

When a shipping agent is handling transport of the machine, have its box marked "THIS SIDE UP"
to keep the machine with its bottom facing down. Mark also with "FRAGILE" or "HANDLE WITH
CARE".

1. Make sure machine is turned on.

If the machine cannot be turned on, unplug it and go to step 4.

2. If an error has occurred, press machine's Black or Color button.

After the Alarm lamp is turned off, go to step 3.

If the error is not cleared, press ON button to turn the machine off, and then unplug it. If the machine
cannot be turned off, unplug it. Go to step 4.

3. Set machine to transporting mode.

Press and hold Stop button, and then release button when Alarm lamp flashes 7 times. The machine is
set to transporting mode and turned off. Unplug the machine.

4. Make sure that cartridge holder has moved to far right.

If the cartridge holder is not to the right, move it to far right.
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5. Make sure that tank caps are properly closed.

6. Retract the paper output tray and output tray extension, and then close the paper support.

7. Unplug the printer cable from the computer and from the machine, then unplug the power
cord from the machine.

8. Use adhesive tape to secure all the covers on the machine to keep them from opening
during transportation. Then pack the machine in the plastic bag.

9. Attach the protective material to the machine when packing the machine in the box.
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List of Support Code for Error

Support code appears on your computer screen when errors occur.
A "support code" is an error number, and appears along with an error message.

When an error occurs, check the support code displayed on the computer screen and take the appropriate
action in response.

Support Code Appears on Computer Screen

1000 to 1222

1000 1200 1300 1403 1470 1471

1472 1473 1474 1475 1476 1640

1700 1701 1890

2000 to 2ZZZ

2900 2901

5000 to 52ZZ

5011 5012 5050 5100 5200 5400

5700 5B00 5B01

* 6000 to 62Z2Z

6000 6800 6801 6930 6931 6932

6933 6936 6937 6938 6940 6941

6942 6943 6944 6945 6946

* A000 to Z2Z2ZZ

B202 B203 B204 B205

For paper jam support codes, see also List of Support Code for Error (Paper Jams).
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List of Support Code for Error (Paper Jams)

If paper jams, remove it following the appropriate procedure as shown below.
* If you can see the jammed paper at the paper output slot or the rear tray:
= 1300
« If the paper tears and you cannot remove it from the paper output slot or from the rear tray:

= Paper |s Jammed inside Machine

» Cases other than above:

= Other Cases
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1300

Cause

Paper is jammed in paper output slot or in rear tray.

What to Do

Remove the jammed paper following the procedure below.

1. Slowly pull out paper, either from paper output slot or from rear tray, whichever is easier.

Hold the paper with both hands, and pull it out slowly so as not to tear it.

»» Note

« If you cannot pull out the paper, turn the machine back on. The paper may be ejected
automatically.

« If paper becomes jammed during printing and you need to turn off the machine to remove it,
press the Stop button to stop the printing before you turn off the machine.

« If the paper tears and you cannot remove the jammed paper from the paper output slot or the
rear tray, remove the paper from inside the machine.

= Paper Is Jammed inside Machine

2. Reload paper and press machine's Black or Color button.
The printer resumes printing. Reprint the page you were printing if it was not printed properly due to
the paper jam.
If you turned off the machine in step 1, the print data that was sent to the machine is erased. Redo the

printing.
»» Note

* When reloading the paper, make sure you are using suitable paper and loading it correctly.

* We recommend using paper sizes other than A5 to print documents with photos or graphics. A5
paper may curl and jam as it leaves the machine.
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Paper Is Jammed inside Machine

If the jammed paper tears and you cannot remove the paper either from the paper output slot or from the
rear tray, or if the jammed paper remains inside the machine, remove the paper following the instructions
below.

»>» Note

* If paper becomes jammed during printing and you need to turn off the machine to remove it, press the
Stop button to stop the printing before you turn off the machine.

1. Turn off machine and unplug it.

2. Open scanning unit / cover.

3% Important

* Do not touch clear film (A), white belt (B), or tubes (C).

3. Check if jammed paper is under cartridge holder.

If the jammed paper is under the cartridge holder, move the cartridge holder to the far right or left,
whichever makes it easier to remove the paper.

When moving the cartridge holder, hold the top of the cartridge holder and slide it slowly to the far right
or left.
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5. Slowly pull out paper, so as not to tear it.
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6. Make sure all jammed paper is removed.

If the paper tears when you pull out it, a bit of paper may remain in the machine. Check the following and
remove any remaining paper.

* Any paper left under the cartridge holder?
» Any small bits of paper left in the machine?

* Any paper left in the left and right empty spaces (D) in the machine?

7. Close scanning unit / cover.

All jobs in the print queue are canceled. Redo the printing.

»» Note

» When reloading the paper, make sure you are using suitable paper and loading it correctly. If a
paper jam message appears on your computer screen when you resume printing after removing
all the jammed paper, there may be some paper still inside the machine. Check the machine again
for any remaining bits of paper.

If the measures above do not solve the problem, contact your nearest Canon service center to request a
repair.
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3% Important

* Do not tilt the machine when moving it since the ink may leak out.

* When transporting the machine for repairing it, see Repairing Your Machine.
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Other Cases

Check the following:

Is anything blocking paper output slot?

Are there any foreign objects in rear tray?

If there are any foreign objects in the rear tray, be sure to turn off the machine, unplug it, and then remove the
foreign object.

32 Important

* Do not tilt the machine or do not it upside down. Doing so may cause the ink to leak.

(SN |s paper curled?

Correct curl before loading paper.
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1000

Cause
Possible causes include the following.
* There is no paper in the rear tray.

» Paper is not loaded properly.

What to Do
Take the corresponding actions below.
* Load paper in the rear tray.
« Align the paper guides with the both edges of the paper when you load paper.

After carrying out the above measures, press the machine's Black or Color button.
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1200

Cause

Scanning unit/cover is open.

What to Do

Close the scanning unit / cover and wait for a while.

Do not close it while you are refilling an ink tank.
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1403

Cause

Print head may be damaged.

What to Do

Contact your nearest Canon service center to request a repair.

22 Important

» Do not tilt the machine when moving it since the ink may leak out.

* When transporting the machine for repairing it, see Repairing Your Machine.
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1470

Cause

Cartridge is not installed properly.

What to Do

Open the scanning unit / cover, and then push the cartridge locking cover to make sure the cartridges are
installed properly.

Alternatively, push the joint button.

32 Important

* Remove the label and the protective tape of the cartridge to install it.

*<

"

After that, close the scanning unit / cover.
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1471

Cause

Cartridge cannot be recognized.

What to Do

Printing cannot be executed because the cartridge may not be installed properly or may not be compatible
with this machine.

Install the appropriate cartridge.

If you want to cancel printing, press the machine's Stop button.
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1472

Cause

Cartridge cannot be recognized.

What to Do

Printing cannot be executed because the cartridge may not be installed properly or may not be compatible
with this machine.

Install the appropriate cartridge.

If you want to cancel printing, press the machine's Stop button.
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1473

Cause

Cartridge cannot be recognized.

What to Do

Printing cannot be executed because the cartridge may not be installed properly or may not be compatible
with this machine.

Install the appropriate cartridge.

If you want to cancel printing, press the machine's Stop button.
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1474

Cause

Cartridge is not installed in correct position.

What to Do

Make sure each cartridge is installed in the correct position.

If printing is in progress, press the machine's Stop button to cancel printing, and then install the cartridge.
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1475

Cause

More than one cartridge of the same color is installed.

What to Do

Install the cartridge in the correct position.
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1476

Cause

Appropriate cartridge is not installed.

What to Do

Printing cannot be executed because the cartridge is not compatible with this machine.
Install the appropriate cartridge.

If you want to cancel printing, press the machine's Stop button.
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1640

Cause

The remaining ink level in one of the ink tanks may have reached the lower limit line shown on the ink
tank.

What to Do

To check the remaining ink level, visually inspect the remaining ink in the ink tank. If the remaining ink
level is below the lower limit line, refill the ink tank with the corresponding color of ink.

= Refilling Ink Tanks

If printing is continued when the remaining ink level is below the lower limit line, the printer may consume
a certain amount of ink to return to printable status and may also become damaged.

To continue printing, press the printer's Start button. After this operation, the remaining ink level
notification function will not operate.

To reuse this function, refill each color of ink to the upper limit line shown on the ink tank and press the
printer's Start button for at least 5 seconds. If any ink tank is not refilled to the upper limit line, a significant
error may occur in the accuracy of the remaining ink level notification function.
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1700

Cause

Ink absorber is almost full.

What to Do

Press the machine's Black or Color button to continue printing. Contact your nearest Canon service
center to request a repair.

32 Important

» Do not tilt the machine when moving it since the ink may leak out.

» When transporting the machine for repairing it, see Repairing Your Machine.
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1701

Cause

Ink absorber is almost full.

What to Do

Press the machine's Black or Color button to continue printing. Contact your nearest Canon service
center to request a repair.

32 Important

» Do not tilt the machine when moving it since the ink may leak out.

» When transporting the machine for repairing it, see Repairing Your Machine.
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1890

Cause

Protective material or tape may still be attached to cartridge holder.

What to Do

Open the scanning unit / cover and make sure the protective material and tape have been removed from
the cartridge holder.

If the protective material or tape is still there, remove it and close the scanning unit / cover.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

32 Important

» Do not tilt the machine when moving it since the ink may leak out.

» When transporting the machine for repairing it, see Repairing Your Machine.
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2900

Cause

Scanning print head alignment sheet failed.

What to Do

Press the machine's Black or Color button. Check the following points, perform automatic print head
alignment again.

» Make sure the print head alignment sheet is set in the correct position and orientation on the platen
glass.

* Make sure the platen glass and the print head alignment sheet are not dirty.
» Make sure the loaded paper is correct.

For automatic print head alignment, load A4 or Letter-sized plain paper.
* Make sure the print head nozzle is not clogged.

Check the print head condition by printing the nozzle check pattern.

If the error is not resolved, perform manual print head alignment.
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2901

Cause

Print head alignment pattern has been printed and machine is waiting to scan sheet.

What to Do

Scan the printed alignment pattern.

1. Load print head alignment sheet on platen glass.

Place the printed side down and align the mark ¥ inthe upper left corner of the sheet with the

alignment mark M

2. Slowly close the document cover and press machine's Black or Color button.

The machine starts scanning the print head alignment sheet, and automatically adjusts the print head
position.
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5011

Cause

Printer error has occurred.

What to Do

Turn off the machine and unplug it.

Plug in the machine again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

22 Important

* Do not tilt the machine when moving it since the ink may leak out.

» When transporting the machine for repairing it, see Repairing Your Machine.
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5012

Cause

Printer error has occurred.

What to Do

Turn off the machine and unplug it.

Plug in the machine again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

32 Important

* Do not tilt the machine when moving it since the ink may leak out.

» When transporting the machine for repairing it, see Repairing Your Machine.
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5050

Cause

Printer error has occurred.

What to Do

Turn off the machine and unplug it.

Plug in the machine again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

32 Important

* Do not tilt the machine when moving it since the ink may leak out.

» When transporting the machine for repairing it, see Repairing Your Machine.
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5100

Cause

Printer error has occurred.

What to Do

Cancel printing and turn off the machine.
Check the following:
» Make sure cartridge holder motion is not impeded by stabilizer, jammed paper, etc.
Remove any impediment.
» Make sure the cartridges are properly installed.
Turn the machine back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

22 Important

* When clearing an impediment to cartridge holder motion, be careful not to touch clear film (A), white
belt (B), or tubes (C).

* Do not tilt the machine when moving it since the ink may leak out.

» When transporting the machine for repairing it, see Repairing Your Machine.
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5200

Cause

Printer error has occurred.

What to Do

Check the remaining ink level, and then refill the ink tank if necessary.
Turn off the machine and unplug it.
Wait about 10 minutes.
Plug in the machine again and turn it back on.
If the ink tank is refilled because it runs out of ink, perform system cleaning.
* From computer:
o For Windows:

= Cleaning the Print Heads

o For Mac OS:
= Cleaning the Print Heads
» From operation panel:

To perform system cleaning, press and hold the Stop button until the Alarm lamp flashes 5 times, and
then release the button.

3% Important

» Before performing system cleaning, check the remaining ink level of all colors. If the remaining
ink level is below the single dot (a), refill the ink tank of corresponding color. Performing system
cleaning when the remaining ink level is not enough may damage the machine.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

32 Important

» Do not tilt the machine when moving it since the ink may leak out.

» When transporting the machine for repairing it, see Repairing Your Machine.
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5400

Cause

Printer error has occurred.

What to Do

Turn off the machine and unplug it.

Plug in the machine again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

32 Important

* Do not tilt the machine when moving it since the ink may leak out.

» When transporting the machine for repairing it, see Repairing Your Machine.

587



5700

Cause

Printer error has occurred.

What to Do

Turn off the machine and unplug it.

Plug in the machine again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

32 Important

* Do not tilt the machine when moving it since the ink may leak out.

» When transporting the machine for repairing it, see Repairing Your Machine.
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5B00

Cause

Printer error has occurred.

What to Do

Contact your nearest Canon service center to request a repair.

22 Important

» Do not tilt the machine when moving it since the ink may leak out.

* When transporting the machine for repairing it, see Repairing Your Machine.
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5B01

Cause

Printer error has occurred.

What to Do

Contact your nearest Canon service center to request a repair.

22 Important

» Do not tilt the machine when moving it since the ink may leak out.

* When transporting the machine for repairing it, see Repairing Your Machine.
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6000

Cause

Printer error has occurred.

What to Do

Turn off the machine and unplug it.

Plug in the machine again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

32 Important

* Do not tilt the machine when moving it since the ink may leak out.

» When transporting the machine for repairing it, see Repairing Your Machine.

591



6800

Cause

Printer error has occurred.

What to Do

Turn off the machine and unplug it.

Plug in the machine again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

32 Important

* Do not tilt the machine when moving it since the ink may leak out.

» When transporting the machine for repairing it, see Repairing Your Machine.
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6801

Cause

Printer error has occurred.

What to Do

Turn off the machine and unplug it.

Plug in the machine again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

32 Important

* Do not tilt the machine when moving it since the ink may leak out.

» When transporting the machine for repairing it, see Repairing Your Machine.
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6930

Cause

Printer error has occurred.

What to Do

Turn off the machine and unplug it.

Plug in the machine again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

32 Important

* Do not tilt the machine when moving it since the ink may leak out.

» When transporting the machine for repairing it, see Repairing Your Machine.
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6931

Cause

Printer error has occurred.

What to Do

Turn off the machine and unplug it.

Plug in the machine again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

32 Important

* Do not tilt the machine when moving it since the ink may leak out.

» When transporting the machine for repairing it, see Repairing Your Machine.
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6932

Cause

Printer error has occurred.

What to Do

Turn off the machine and unplug it.

Plug in the machine again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

32 Important

* Do not tilt the machine when moving it since the ink may leak out.

» When transporting the machine for repairing it, see Repairing Your Machine.
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6933

Cause

Printer error has occurred.

What to Do

Turn off the machine and unplug it.

Plug in the machine again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

32 Important

* Do not tilt the machine when moving it since the ink may leak out.

» When transporting the machine for repairing it, see Repairing Your Machine.
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6936

Cause

Printer error has occurred.

What to Do

Turn off the machine and unplug it.

Plug in the machine again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

32 Important

* Do not tilt the machine when moving it since the ink may leak out.

» When transporting the machine for repairing it, see Repairing Your Machine.
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6937

Cause

Printer error has occurred.

What to Do

Turn off the machine and unplug it.

Plug in the machine again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

32 Important

* Do not tilt the machine when moving it since the ink may leak out.

» When transporting the machine for repairing it, see Repairing Your Machine.
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6938

Cause

Printer error has occurred.

What to Do

Turn off the machine and unplug it.

Plug in the machine again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

32 Important

* Do not tilt the machine when moving it since the ink may leak out.

» When transporting the machine for repairing it, see Repairing Your Machine.
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6940

Cause

Printer error has occurred.

What to Do

Turn off the machine and unplug it.

Plug in the machine again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

32 Important

* Do not tilt the machine when moving it since the ink may leak out.

» When transporting the machine for repairing it, see Repairing Your Machine.
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6941

Cause

Printer error has occurred.

What to Do

Turn off the machine and unplug it.

Plug in the machine again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

32 Important

* Do not tilt the machine when moving it since the ink may leak out.

» When transporting the machine for repairing it, see Repairing Your Machine.
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6942

Cause

Printer error has occurred.

What to Do

Turn off the machine and unplug it.

Plug in the machine again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

32 Important

* Do not tilt the machine when moving it since the ink may leak out.

» When transporting the machine for repairing it, see Repairing Your Machine.
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6943

Cause

Printer error has occurred.

What to Do

Turn off the machine and unplug it.

Plug in the machine again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

32 Important

* Do not tilt the machine when moving it since the ink may leak out.

» When transporting the machine for repairing it, see Repairing Your Machine.
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6944

Cause

Printer error has occurred.

What to Do

Turn off the machine and unplug it.

Plug in the machine again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

32 Important

* Do not tilt the machine when moving it since the ink may leak out.

» When transporting the machine for repairing it, see Repairing Your Machine.
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6945

Cause

Printer error has occurred.

What to Do

Turn off the machine and unplug it.

Plug in the machine again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

32 Important

* Do not tilt the machine when moving it since the ink may leak out.

» When transporting the machine for repairing it, see Repairing Your Machine.
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6946

Cause

Printer error has occurred.

What to Do

Turn off the machine and unplug it.

Plug in the machine again and turn it back on.

If this does not solve the problem, contact your nearest Canon service center to request a repair.

32 Important

* Do not tilt the machine when moving it since the ink may leak out.

» When transporting the machine for repairing it, see Repairing Your Machine.
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B202

Cause

An error requiring a repair has occurred.

What to Do

Turn off the machine and unplug it.

Contact your nearest Canon service center to request a repair.

32 Important

» Do not tilt the machine when moving it since the ink may leak out.

* When transporting the machine for repairing it, see Repairing Your Machine.
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B203

Cause

An error requiring a repair has occurred.

What to Do

Turn off the machine and unplug it.

Contact your nearest Canon service center to request a repair.

32 Important

» Do not tilt the machine when moving it since the ink may leak out.

* When transporting the machine for repairing it, see Repairing Your Machine.
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B204

Cause

An error requiring a repair has occurred.

What to Do

Turn off the machine and unplug it.

Contact your nearest Canon service center to request a repair.

32 Important

» Do not tilt the machine when moving it since the ink may leak out.

* When transporting the machine for repairing it, see Repairing Your Machine.
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B205

Cause

An error requiring a repair has occurred.

What to Do

Turn off the machine and unplug it.

Contact your nearest Canon service center to request a repair.

32 Important

» Do not tilt the machine when moving it since the ink may leak out.

* When transporting the machine for repairing it, see Repairing Your Machine.
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